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Welcome to the NinjaTrader Help Guide

The NinjaTrader Help Guide is your reference to product features descriptions and detailed
instructional content on their use. Instructional content is delivered via text, images and
video where applicable. This Help Guide also serves as a reference to NinjaScript used in the
development of automated trading systems (strategies)  and custom indicators.

In addition to this Help Guide, NinjaTrader hosts multiple live on-line training sessions per
week on various aspects of our product.

Additional information and a schedule of upcoming training events.

Thank you for choosing NinjaTrader.

Good trading,
NinjaTrader Customer Service

-o-

What's New in Version 6.5
General
 Added: Multiple workspaces
 Added: Critical data backup utility and reminder service
 Added: Email image of a grid (such as performance data)
 Added: S&P 500 instrument list to the Instrument Manager
 Added: User defined stock symbol list import
 Added: Real-time tick filtering (option)
 Added: Support for ICE exchange on selected broker adapters
 Added: TimeLastTick column for Market Analyzer
 Added: Reset Instrument Manager to default settings
 Improved: Reduced RAM memory usage on Instruments
 Improved: Time & Sales window now supports "Always On Top"
 Improved: Time & Sales window now supports configurable font
 Improved: Time & Sales window now support background color
 Improved: Level II window now supports configurable font
 Improved: Level II window now supports "Always On Top"
 Improved: Performance tab now displays what NinjaScript strategy an execution belongs

to
 Improved: Price controls reset to last traded price by middle mouse button click

(previously double click)
 Improved: Application global exception handling
 Improved: User defined instrument lists are now selectable from some Instrument Selector

dialog windows such as Charts

http://www.ninjatrader.com/webnew/trading_online_events.htm


p18

© NinjaTrader, LLC, 2005

www.ninjatrader.com

 Improved: Double clicking on data grid column header will resize the column width to the
the current widest text value

 Improved: Interest rate futures are now always quoted in 32nd's (110 3/64 is represented
as 110'025)

Charts
 Added: Range bar interval type
 Added: Regression Channel draw tool
 Added: Arrow Line draw tool
 Added: CandleStickPattern detection indicator
 Added: Chart template selection in the Format Data Series dialog window when creating a

new chart
 Added: User defined "Remove Draw Objects" dialog window
 Added: Reload Historical Data from within a chart
 Added: Clickable arrow icon is displayed in the top right corner that resets the current bar

as the last displayed bar when it is off screen
 Added: Email image directly from within a chart
 Added: VolumeUpDown indicator
 Added: RangeCounter indicator
 Added: Ability to delete historical data from the database
 Added: Can change instrument by just typing the instrument name into a chart
 Improved: Bar outline (candle stick) is now configurable for width, DashStyle in addition to

color
 Improved: Chart can be panned to the left
 Improved: Session begin/end time can now span across midnight
 Improved: Session begin/end time properties are visually suppressed in Chart Properties

when a non-intraday time frame is selected
 Improved: Crosshair color automatically changes between color of black and white

dependant on chart background color
 Improved: Crosshair is now active as you move your mouse over any chart window that

does not have immediate focus
 Improved: Global crosshair automatically scrolls charts forward and backward in time

ensuring that the time axis is always displayed in all charts that have global crosshair
enabled

 Improved: Global crosshair horizontal line no longer displays if horizontal value received
from the transmitting chart is not part of the receiving chart's y scale

 Improved: Zoom box is now white if chart background is a dark color
 Improved: X axis displays day labels on session break on an intraday chart
 Improved: X axis includes labels for day, month and year breaks
 Improved: X axis formatting of labels and grid lines for daily, weekly, monthly and yearly

charts
 Improved: Draw objects have a configurable "Auto scale" property
 Improved: Draw objects are no longer bound by the visual boundaries of a chart and can

be partially moved off the chart canvas
 Improved: Draw objects can extend into the chart's right side margin
 Improved: Fibonacci draw objects no longer have a 300% level limitation
 Improved: Fibonacci draw objects have a configurable "Show text" property
 Improved: Gann Fan draw object has a configurable "Show text" property
 Improved: Andrew's Pitchfork draw object has a configurable "Show text" property
 Improved: Minute bars are now built using tick time stamps of 00:00 to 00:59 (end of bar

time stamp still is maintained)
 Improved: Changed y-scaling logic when current bar is last bar on chart and at
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upper/lower chart extremes to reduce flickering caused by constant y-axis rescaling
 Improved: Day Break lines are now Session Break lines and display at the first bar of a

new session instead midnight
 Improved: Pressing F5 to reload NinjaScript objects no longer remove custom draw objects

from panels numbered greater than 1
 Improved: Chart "Last Date" is now set to the current date when connecting to a real-time

provider after using the Market Replay Connection
 Improved: Pivot indicator has three modes of which to calculate the prior day HLC values

used in the Pivot calculations
 Improved: Woodies CCI indicator now supports displacement
 Improved: Woodies CCI now has an optional CCI Panel
 Improved: Woodies CCI has additional user configurable plots
 Improved: Woodies CCI Chopzone and Sidewinder plot values are now exposed for

automated strategy development

NinjaScript - Generalregion between upper and lower Bollinger Band plots)
 Added: DrawRegressionChannel()
 Added: DrawRegion() for drawing chart regions (For example, filling in 
 Added: DrawTextFixed()
 Added: DrawArrowLine()
 Added: BoolSeries class
 Added: DateTimeSeries class
 Added: StringSeries class
 Added: FloatSeries class
 Added: GetMedian()
 Added: ClearOutputWindow()
 Added: CandleOutlineColor 
 Improved: HighestBar() now accepts an IDataSeries object as an argument
 Improved: LowestBar() now accepts an IDataSeries object as an argument
 Improved: DrawText() now includes a yPixelOffset parameter
 Improved: Print() method now accepts DateTime structures as an argument
 Improved: Indicator or strategy display names in a chart can now optionally be suppressed
 Improved: NinjaScript archive files now have the extension .zip and can be imported by

clicking on the file
 Changed: Removed NinjaScript display name concept
 Changed: Slope() method now uses bars ago as opposed to absolute bar value

NinjaScript Indicators
 Added: OnMarketData() method
 Added: OnMarketDepth() method
 Added: TriggerCustomEvent() method for synchronization of internal current bar pointers

for handling user defined custom events
 Improved: IndicatorBase.Plot() method is now synchronized with the CurrentBar logic

allowing you to access DataSeries objects from within the Plot() method
 Changed: Pivots indicator methods are changed. EXISTING CALLS TO THIS FUNCTION

WILL NOT WORK, PLEAS ENSURE YOUR CODE IS UPDATED.
 Changed: Current bar values in a DataSeries objects are no longer internal reset to a null

value prior to an OnBarUpdate() call
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NinjaScript Strategies
 Added: OnMarketData() method
 Added: OnMarketDepth() method
 Added: OnOrderUpdate() method
 Added: OnExecution() method
 Added: OnPositionUpdate() method
 Added: OnConnectionStatus() method
 Added: Exposed RealtimeErrorHandling property
 Added: Orders can now be placed within any BarsInProgress context in a multi-time frame

or instrument strategy
 Added: "Live until canceled" orders for advanced programming approaches
 Added: TriggerCustomEvent() method for synchronization of BarsInProgress for handling

user defined custom events
 Added: Real-time and real-time + historical individual strategy performance can now be

accessed via selecting a strategy in the Control Center window Strategies tab and selecting
the Strategy Performance menu

 Added: Control Center window Strategies tab can now remove a selected strategy
 Added: GetTrades() method
 Added: Performance.RealtimeTrades TradeCollection
 Improved: SetStopLoss(), SetTrailStop() and SetProfitTarget() can now be called after

entering a position
 Improved: Multi-instrument strategies are optimized since they no longer create redundant

market data or depth streams
 Improved: TradeCollection objects are now standard collections and can be accessed by an

index
 Improved: Help Guide documentation on working with Performance class and

TradeCollection objects

NinjaScript Editor
 Added: Icon to launch the Output window
 Added: Column displaying error code that links to additional information on the error in the

compile errors grid
 Added: Row coloring to distinguish compile errors in the current script vs other scripts
 Added: Microsoft Visual Studio debugging support
 Improved: Double clicking on a compile error now opens up the offending script in another

editor if the error is not in the currently loaded script
 Improved: Changed column orders of compile errors
 Improved: Only one instance of a NinjaScript object can be opened at any given time
 Improved: Filter out compiler warnings

Strategy Wizard
 Added: BarsSinceEntry
 Added: BarsSinceExit
 Added: CrossAbove/CrossBelow as selectable methods in addition to a selectable operator
 Added: Falling
 Added: Rising
 Added: Slope

Strategy Analyzer
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 Improved: A subsequent identical backtest is no longer run internally (results now saved in
memory) when clicking between different tabs after a backtest run

 Improved: Market order are filled before any other order when calculating if orders are
filed in a backtest

 Improved: Stop market orders in backtest no longer can fill outside of a bar

Automated Trading Interface
 Added: All orders are now manageable (previously only orders placed through the ATI)
 Added: CashValue() function
 Added: BuyingPower() function
 Added: StopOrders() function that returns order ID values for all stop orders of an ATM

strategy
 Added: TargetOrders() function that returns order ID values for all stop orders of an ATM

strategy
 Improved: Position functions return account positions at any given time (previously, the

ATI needed to be initialized by placing an order)
 Changed: NTClosePosition() function now takes the account name parameter as previously

documented. EXISTING CALLS TO THIS FUNCTION WILL NOT WORK, PLEAS
ENSURE YOUR CODE IS UPDATED.

Connectivity Adapters
 Added: TD Ameritrade support
 Added: Interactive Brokers - Charting support for NYSE Advance/Decline line (AD-NYSE)
 Improved: Zen-Fire - Internally supports backup server configuration in case primary

authentication server is unreachable
 Improved: Zen-Fire - Support account balance
 Improved: Zen-Fire - Support net change in the Market Analyzer
 Improved: MBT - MBT Navigator window opens in the same position it was last closed
 Improved: MBT - Support for MBT Navigator Version 11
 Improved: DTNiQ - Support forex real-time and historical data
 Improved: DTNiQ - Support for DTN native time stamps on real-time data
 Improved: DTNiQ - Support for pre and post market data if provided by DTNiQ

-o-

Release Notes
NinjaTrader Version 6.5.1000.19 Production Release - December 8, 2010
Status Iss

ue
#

Category Comments

Chang
ed

424
6

IB Adapter Now supports Interactive Brokers TWS Version 911

Fixed 415
1

Adapters Help > NT Account menu did  not show up under some scenarios

NinjaTrader Version 6.5.1000.18 Production Release - September 29, 2010
Status Iss

ue
#

Category Comments
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Chang
ed

408
5

GAIN AdapterCRITICAL: Major change to GAIN connection - GAIN users please
read 
http://www.ninjatrader-support2.com/announcements/GAIN_Annou
ncement.php

NinjaTrader Version 6.5.1000.17 Production Release - September 8, 2010
Status Iss

ue
#

Category Comments

Chang
ed

405
3

MiscellaneousTT Transaction Credit trade data is now submitted securely via
HTTPS

NinjaTrader Version 6.5.1000.16 Production Release - June 10, 2010
Status Iss

ue
#

Category Comments

Fixed 363
2

TradeStation TradeStation ELD files had bugs that could cause TradeStation 8.8
to crash

NinjaTrader Version 6.5.1000.15 Production Release - March 10, 2010
Status Iss

ue
#

Category Comments

Chang
ed

350
0

IQFeed/DTN
adapter

Internal change to support upcoming IQFeed server change to
support 2 digit year codes. !! IQFeed/DTN Users must  upgrade
to this new release before March 31st, 2010.

Improv
ed

351
2

Zen-Fire
adapter

Connectivity improvement to historical data servers

NinjaTrader Version 6.5.1000.14 Production Release - October 15, 2009
Status Iss

ue
#

Category Comments

Chang
ed

286
4

GAIN adapterNow support GAIN UK accounts

Chang
ed

281
2

Zen-Fire
adapter

Now supports exchange name in symbol map

Fixed 285
1

Instrument
Manager

Barchart.com and PFGBEST.com instrument expirations greater than
2010 did not work

Fixed 288
5

MBT adapter Partial fills could cause unsolicited changes to order quantity

NinjaTrader Version 6.5.1000.13 Production Release - September 9, 2009
Status Iss

ue
#

Category Comments

Chang
ed

281
3

GAIN adapterNow logs into GAIN's new high performance rate server

Chang
ed

281
2

Patsystems
adapter

Now supports the latest Patsystems server software

Fixed 281
1

PFGBEST.co
m adapter

Realizned account level PnL did not work as expected

NinjaTrader Version 6.5.1000.12 Production Release - August 12, 2009
Status Iss

ue
#

Category Comments

http://www.ninjatrader-support2.com/announcements/GAIN_Announcement.php
http://www.ninjatrader-support2.com/announcements/GAIN_Announcement.php
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Chang
ed

274
5

Mail Application generated email now is routed to a different POP server

Chang
ed

277
5

IB adapter Now supports TWS version 895

Chang
ed

277
6

IB adapter Updated internal logic to handle IB changes to Z contract fill prices

Fixed 278
2

Indicators MAMA indicator was calculated incorrectly

Fixed 277
4

Instrument
Manager

Futures expirations greater than 2010 could cause issues with
Zen-Fire, MB Trading & PFGBEST.com

Fixed 277
9

External
adapter

TradeStation real-time data did not work with futures instruments
whose  expiration was > 2010

NinjaTrader Version 6.5.1000.11 Production Release - June 15, 2009
Status Iss

ue
#

Category Comments

Improv
ed

275
8

TD
AMERITRADE
adapter

Stop prices are now checked against current market and rejected if
price is invalid

Chang
ed

274
5

IQFeed
adapter

FX instruments are now mapped to FXCM

Chang
ed

275
4

Futures
Betting
adapter

Changed internal timeout values on some requests to reflect new
server side changes

Fixed 274
3

TD
AMERITRADE
adapter

Updated to TDA DLL V100 which resolves issue on downloading
historical data

Fixed 274
8

Automated
Trading
Interface

TradeStation "reentrancy" issue with latest TradeStation version

Fixed 274
4

Charts AutoScale property may not have worked correctly if set via
NinjaScript

Fixed 276
8

Chart Trader In extremely rare situation a live account could have been selected
while in Global Simulation Mode

NinjaTrader Version 6.5.1000.10 Production Release - May 4, 2009
Status Iss

ue
#

Category Comments

Added 272
7

eSignal
adapter

Support for SGX (Singapore) exchange

Added 271
9

Zen-Fire
adapter

Support for FXCM

Chang
ed

271
0

IB adapter Options events are now filtered

Chang
ed

273
1

MBT adapter Applied unique NinjaTrader ID

Chang
ed

272
3

Track Data
adapter

Depricated support for futures

Chang
ed

272
1

TD
AMERITRADE
adapter

No longer restricted to only TDA Express accounts

Chang
ed

272
2

TD
AMERITRADE
adapter

Upgraded to TDA API V97
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Fixed 273
9

TD
AMERITRADE
adapter

Orders could have been stuck in 'Pending Change' state

Fixed 273
3

TD
AMERITRADE
adapter

Reduced frequency of internal keep alive logic

Fixed 273
2

TD
AMERITRADE
adapter

Orders could have been stuck in 'Pending Cancel' state

Fixed 272
6

PFGBEST.co
m adapter

Last Close price was not update and would impact NetChange
column in Market Analyzer

Fixed 272
5

PFGBEST.co
m adapter

Rejected order changes on ICE were not processed correctly

Fixed 272
4

MBT adapter Did not correctly retreive forex lot size data

Fixed 273
7

NinjaScript Redundant TraceOrder output now removed

Fixed 272
9

Charts Parabolic SAR now uses industry standard formula vs less popular
formula previously used

Fixed 271
1

Charts Parabolice SAR did not work correctly when 'Calculate on bar close'
was set to false

Fixed 272
8

Charts Aroon indicators used highest/lowest closing prices instead of
industry accepted highest high and lowest low

Fixed 272
0

Market
Analyzer

Indicator columns in the columns dialog window were not restored
correctly on NT restart

NinjaTrader Version 6.5.1000.9 Production Release - March 19, 2009
Status Iss

ue
#

Category Comments

Improv
ed

267
3

Database Repair process now removes null records from execution tables

Improv
ed

269
6

TD
AMERITRADE
adapter

Now supports real-time data for TICK index

Improv
ed

270
0

NinjaScript Added "WaitForOcoClosingBracket" specifically for TD AMERITRADE
users

Chang
ed

264
0

TD
AMERITRADE
adapter

GTC market orders now converted to DAY market orders

Chang
ed

268
6

TD
AMERITRADE
adapter

Incorporated latest TDA DLL

Chang
ed

270
2

TD
AMERITRADE
adapter

Internal position tracking now resets on each connect from the TDA
reported position vs calculating from historical executions table to
better support correct order action mapping of Buy <-->
BuyToCover etc...

Chang
ed

266
9

IB adapter Now supports TWS 892

Fixed 263
6

Charting Indicators could have been assigned to an incorrect panel

Fixed 263
4

NinjaScript Strategies did not trigger live trades if WaitUntilFlat == true &&
CalculateOnBarClose == false && (TIF ==  Day || ExitOnClose ==
true)

Fixed 263
8

NinjaScript IOrder properties "AvgFillPrice" and "Filled" may not have been set
on ExitOnClose handling

Fixed 264
2

NinjaScript Trade pairs in the Performance Viewer could have been incorrect
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Fixed 266
6

NinjaScript PercentComplete did not always work on Volume bars

Fixed 267
2

NinjaScript BarsSinceExit did not work for SetTrailStop() exits

Fixed 268
3

NinjaScript DrawRegion() method did not work High, Low, Typica series from
bars

Fixed 268
9

NinjaScript Export could fail on some occasions (now allow manual additiona of
system indicators to resolve issue)

Fixed 263
9

Automated
Trading
Interface

TradeStation email interface did not accept quantity format such as
"30'000"

Fixed 263
1

ATM
strategies

Could throw exception if Reverse At Target was enabled but the
outer most bracket did not hold a profit target order

Fixed 264
4

PFGBEST.co
m adapter

Did not send stop and limit prices consistently on stop limit orders.
The latest PFG API must  be installed from our website

Fixed 268
1

PFGBEST.co
m adapter

Trash fill messages were not filtered out which could negatively
impact position calculations

Fixed 268
4

PFGBEST.co
m adapter

Filter out snap data from real-time feed

Fixed 270
7

PFGBEST.co
m adapter

Exchange busted filled order messages were not handled correctly

Fixed 266
7

Patsystems
adapter

Executions may have been dropped in rare circumstances

Fixed 265
5

Market
Replay

Application would throw an exception if SuperDOM cursor was in
pending change mode and the red "X" was pressed

NinjaTrader Version 6.5.1000.8 Production Release - December 9, 2008
Status Iss

ue
#

Category Comments

Added 261
9

PFGBEST.co
m adapter

Support prior day close value

Chang
ed

261
9

GAIN adapterChanged URL of demo server

Fixed 261
3

MBT adapter Real-time trade data did not work as expected for currencies

Fixed 263
9

IB adapter Non default time formats could cause issues on historical data
requests

Fixed 262
9

Barchart.com
adapter

Last traded price real-time event could have been thrown
redundantly

Fixed 263
2

Strategy
Analyzer

Switching to the Chart tab after backtesting a multi-series strategies
could yield unexpected behavior

Fixed 262
2

Charts Pivot indicators could cause NinjaTrader to stop loading historical
data in rare situations

Fixed 262
1

Market
Replay

Indicator could be removed in rare situation when rewinding replay

Fixed 261
5

Market
Replay

Switching from MR to live connection could change chart days back
setting

Fixed 262
0

Vendor
Licensing

Pressing Update button on existing record did not always work
correctly

NinjaTrader Version 6.5.1000.7 Production Release - October 23, 2008
Status Iss

ue
#

Category Comments

Added 255
9

Automated
Trading
Interface

Instrument mappings to support eSignal futures symbol notations
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Added 257
8

Charts Changed DMI to Directional Movement Index and added DMIIndex
which is Dynamic Momentum Index

Added 258
0

PFGBEST.co
m adapter

Now supports daily historical data

Added 259
3

Trading
Technologies
adapter

Support for TF on ICE - You must check with broker to see if they
will support it and for proper configuration instructions

Chang
ed

260
0

Zen-Fire
adapter

Daily high/low is now simulated in NinjaTrader. Will be accurate
provided you disconnect and reconnect in between sessions.

Chang
ed

260
2

Zen-Fire
adapter

Daily volume for ICE and NYBOT are now simulated since it is no
longer provided through current API version. Will be accurate
provided you disconnect and reconnect in between sessions

Fixed 258
3

Charts Autoscale for vertical lines are now disabled

Fixed 256
4

Charts Extremely high "Days back" setting under Tools > Options could
crash application when creating a new chart

Fixed 256
9

Charts Parabolic SAR indicator had incorrect values on some bars

Fixed 257
1

Charts Horizontal grid lines settings did not work correctly on indicator
panels

Fixed 257
3

Charts Pivot indicator could yield incorrect results on daily charts and range
weekly or monthly

Fixed 257
6

Charts Woodies CCI indicator neutral zone could have been displayed
incorrectly under certain conditions

Fixed 255
6

Connection
Wizard

Pressing "Back" button while configuring a DTN connection would
crash the application

Fixed 258
2

PFGBEST.co
m adapter

Historical data could load with gaps

Fixed 259
8

PFGBEST.co
m adapter

Did not correctly skip bad formatted refresh data resulting in the
potential to have an incorrect position reported

Fixed 255
7

Interactive
Brokers
adapter

Auto start of TWS did not work on some PC configurations

Fixed 257
0

Interactive
Brokers
adapter

TWS could send duplicate order events for part filled orders
resulting in situations where NinjaScript strategies would generate a
"Unable to match order state to execution" error message

Fixed 256
3

TDAMERITRA
DE adapter

Orders could be marked with Buy instead of BuyToCover

Fixed 256
2

Interactive
Brokers
adapter

TF symbol mapping was incorrect due to change at IB

Fixed 256
5

MBT Adapter Trade events could be incorrectly filtered

Fixed 255
8

Automated
Trading
Interface

Positions and Orders may not have been reported immediately after
connecting

Fixed 258
1

General Rapid order change (millisecond) could have been ignored

Fixed 258
6

General NinjaTrader did not run while Microsoft .NET 3.5 SP1 was installed

Fixed 258
7

Strategy
Analyzer

Display results during a walk forward optimization could lock up
application in certain conditions

Fixed 259
8

NinjaScript EnterShortStop() overload did not return an IOrder object

NinjaTrader Version 6.5.1000.6 Production Release - September 10, 2008
Status Iss

ue
#

Category Comments
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New 249
5

PFG adapter PFG API version number is now logged

New 250
5

PFG adapter Real-time data now uses PFG native time stamp (Must install latest
PFG API from the Connection Guide on our website)

New 252
8

IB adapter Total view is now supported

Chang
ed

253
4

PFG adapter PFG demo accounts are no longer supported for order submission,
users can connect but orders must be routed through the Sim101
account

Chang
ed

255
2

PFG adapter Surpressed 10060 socket errors login failed messages

Fixed 252
4

PFG adapter COM exceptions in certain situations

Fixed 250
5

PFG adapter Historical minute data had incorrect time stamps

Fixed 253
0

PFG adapter Incorrect order state transitions on multiple partial fills of an order

Fixed 250
0

BarChart.com
adapter

LastClose was not reported correctly and resulted in NetChange
calculations to be incorrect

Fixed 255
1

BarChart.com
adapter

Streaming data was not processed correctly if connected prior to
market open

Fixed 249
3

eSignal
adapter

Historical and real-time volume on 1 minute bars could be off

Fixed 253
3

IB adapter Exchange mapping for former CBOT traded instruments could result
in redundant instruments created on processing IB events

Fixed 254
8

IB adapter Removed tracing of account information

Fixed 249
9

Market
Replay

A chart would not update if a new chart was opened during a replay
session with a template

Fixed 250
6

MBT adpater Connection could lose support instrument types on
connect/reconnect

Fixed 251
0

NinjaScript 'Exit on close' parameter in Strategy dialog window was not always
visible

Fixed 252
2

NinjaScript Order changes on a working order pair to close and open a new
position ammended the opening order first

Fixed 252
5

NinjaScript Indicator/Strategy wizard user defined input fields were limited to
values of 9,999

Fixed 252
6

NinjaScript BarsSinceEntry() and Exit() did not work correctly on multi-series
strategies

Fixed 253
2

NinjaScript Inflight exit executions may not have been plotted on a chart
running a NinjaScript strategy

Fixed 254
4

NinjaScript Partial fill executions could trigger OnExecution() prior to the
associated OnOrderStatus() being thrown

Fixed 255
0

NinjaScript Partial fills could throw off internal exit order handling

Fixed 252
9

Strategy
Analyzer

Switching tabs during a backtest could cause an application
exception

Fixed 251
2

FX Pro Limit and stop price fields were not reset to zero after selecting a
new instrument

Fixed 253
8

Charts Drawing fibonacci retracements with both anchor points on the
same bar triggered unexpected behaviour

Fixed 254
0

Charts Global cross hair inconsistent behaviour

Fixed 254
5

Charts CurrentDayOHL indicator did not work correctly on the 1st day of a
chart

NinjaTrader Version 6.5.1000.5 Production Release - July 28, 2008
 Improved 2451: Zen-Fire adapter - Upgraded to new RAPI
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 Changed 2489: 
 Changed 2431: Options - Minimum look back value on Tools > Options > Data is now set

to a value of 1
 Changed 2449: Instrument Manager - Default list must have at least 1 instrument
 Changed 2463: TD AMERITRADE adapter - GTC orders now expire 180 days out instead of

2 month default from TDA
 Changed 2480: PFGBEST.com adapter - Removed default IP and Port values for order

server
 Fixed 2432: Market Replay - Application could crash under certain rare condition
 Fixed 2433: PFGBEST.com adapter - Price formatting for instruments with code 'Q' was

incorrect
 Fixed 2439: PFGBEST.com adapter - New PFGBEST.com API installer download here
 Fixed 2467: TD AMERITRADE adapter - TIF GTD/GTC did not work on OCO orders
 Fixed 2434: Strategy Wizard - Did not correctly handling string with the escape sequence
 Fixed 2436: NinjaScript - OnMarketData() and OnMarketDepth() methods could throw an

exception after starting a strategy in some situations
 Fixed 2466: NinjaScript - PlaySound() method was not ignored on Historical data in

indicators
 Fixed 2475: NinjaScript - User coded exception in Dispose() method was not trapped and

resulted in application crash
 Fixed 2481: NinjaScript - BarsSinceExit() and BarsSinceEntry() did not work as expected in

a multi-series strategy
 Fixed 2486: NinjaScript - Memory leaks on multi-series strategies
 Fixed 2454: Charts - Copy/paste of draw object on occasion could crash the application
 Fixed 2455: Charts - Setting "Extend right" property on Fibonacci extension did not work

as expected if saved as 'Default'
 Fixed 2458: Charts - X-axis time label was not consistent with Data Box time display if

cross hair moved in between bars
 Fixed 2487: Charts - WoodiesCCI indicator did not display correct values on non-intraday

charts
 Fixed 2488: Charts - Real-time charts would not update in some situation since the last

date did not roll forward from the prior day to the next
 Fixed 2457: Strategy Analyzer - Draw down was displayed cumulative instead of per

selected period
 Fixed 2484: Grids - Quantity fields on trades and executions did not correctly export to

Excel
 Fixed 2490: General - Account Groups were not removed from account drop down lists on

disconnect

NinjaTrader Version 6.5.1000.4 Production Release - June 19, 2008
 Added 2418: Support for 1/2 pips to correctly work with Interactive Brokers FX Ideal Pro

(users please check IB Connection Guide for instructions)
 Added 2423: Dynamic SuperDOM now supports FX trading across all providers (highly

advise against when quotes coming in 1/10 pips since its unusable)
 Added 2426: Interactive Brokers adapter - ^VOL instrument now supported
 Added: Barchart.com adapter - Officially released and out of beta status
 Improved 2384 & 2410: eSignal adapter - Time stamp handling improvements
 Improved 2386: NinjaScript - Logs now include version number of 3rd party DLL's
 Improved 2407: NinjaScript - Importing enhancements
 Improved 2392: PFG adapter - Trace exception message if PFG COM component creation

fails
 Improved 2395: PFG adapter - New PFG API installer download here

http://www.ninjatrader.com/webnew/support_PFG.htm
http://www.ninjatrader.com/webnew/support_interactivebrokers.htm
http://www.ninjatrader.com/webnew/support_PFG.htm
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 Improved 2396: Trading Technologies adapter - Handling of incoming fills during a
disconnect

 Improved 2397: Historical Data Import - Error message when importing a record where the
closing price was outside of the bar high/low range

 Changed 2419: Instrument Manager - Corrected settings for "NG"
 Changed 2416: Historical Data Export - Removed price formatting on exporting
 Fixed 2428: PFG adapter - Automatic reconnect after a loss of connection could set

changed orders to cancelled
 Fixed 2382: NinjaScript - Fisher Transform and MAMA indicators could cause strategies

based on these indicators to behave differently in real-time vs backtest
 Fixed 2387: NinjaScript - Cancelling out entry orders that reversed an existing position

would leave the associated close position order active
 Fixed 2409: NinjaScript - Method names of 2 or less characters could cause an exception
 Fixed 2429: NinjaScript - Adding reference to 'NinjaTrader.Custom.dll' could cause issues
 Fixed 2391: Indicators - Exceptions were thrown if an indicator used Volume of an input

series but the series did not contain volume
 Fixed 2393: Indicators - Pivot indicator weekly/monthly pivots did not use correct time

range
 Fixed 2412: Indicators - Darvas buy and sell signal properties were not set correctly when

embedded in another indicator or strategy
 Fixed 2424: Indicators - Swing indicator did not calculate correctly in some situations
 Fixed 2389: C2 adapter - Error messages were not always accurately reported
 Fixed 2385: General - Some in product website links were out of date
 Fixed 2399: Interactive Brokers adapter - All orders of an OCO group were cancelled by NT

in some situations
 Fixed 2400: Interactive Brokers adapter - Volume for historical data for non US stocks

were multiplied by 100
 Fixed 2402: Barchart.com adapter - Changed mapping for DJIA, DJTA, SP500 and NYA
 Fixed 2410: eSignal adapter - Incorrect handling of time stamp on daily bars in some

situations
 Fixed 2403: Market Replay - Cancelling all orders in SuperDOM via clicking on large red "X"

could cause an exception
 Fixed 2404: Charts - Unnecessary log entries in some situations where a chart was closed

while data was still loading
 Fixed 2408: Charts - Internal logic flaw in dealing with ticks time stamped with midnight
 Fixed 2421: Charts - Cross hair y-axis label could leave a ghost image in upper right hand

corner of chart
 Fixed 2413: ATM Strategy - Enabling AutoBreakeven after an ATM Strategy was already

activated did not work as expected
 Fixed: Zen-Fire adapter - Order changes, submission or cancellations could get stuck in a

pending state
 Fixed 2430: SuperDOM - Quick Button short cut keys (CTRL & SHFT) did not place correct

order types

NinjaTrader Version 6.5.1000.3 Production Release - May 23, 2008
 Added: Zen-Fire adapter - Alert message on alert traces and improved API tracing
 Added: PFG adapter - New PFG Client API (Users should install from our website PFG

connection guide page)
 Improved 2349: Barchart.com adapter - Now supports historical tick data
 Improved 2355: Interactive Brokers adapter - Added delays to better work around IB

pacing violations on historical data requests
 Changed 2344: eSignal adapter - Inconsistent bars (Open > High) are no longer filtered
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out but capped at the high or low and included in stream
 Changed 2357: Barchart.com adapter - All account user names must being with prefix "NT"
 Changed 2363: Trading Technologies adapter - Trim leading and trailing white space on

account parameter when creating a connection
 Changed 2366: NinjaScript - Events  triggered by order methods are now deferred and

thrown once user generated code in OnBarUpdate() is executed in Market Replay
 Fixed 2332: Strategy Wizard - User defined inputs of type "string" did not work as

expected
 Fixed 2340: NinjaScript - BarsSinceEntry() could be incorrect by 1 when running tick by

tick
 Fixed 2345: NinjaScript - Importing a corrupt zip file could throw an exception
 Fixed 2350: NinjaScript - Simulated stop orders were not correctly handled by internal

order handling rules
 Fixed 2351: NinjaScript - Strategy started on Strategies tab was not properly disposed of

as it was removed from the grid
 Fixed 2353: NinjaScript - Rounding bug on Instrument.MasterInstrument.Round2TickSize()
 Fixed 2360: NinjaScript - FirstTickOfBar property was true if a tick both closed and opened

a bar
 Fixed 2367: NinjaScript - Realized PnL on Strategies tab was not in sync with CumProfit

property
 Fixed 2368: NinjaScript - Auto cancelling opposing orders (stop/targets) did not work in

real-time with natively supported OCO handling such as Interactive Brokers
 Fixed 2373: NinjaScript - Calling EnterShortStop() did not work as expected if already in a

long position
 Fixed 2335: Instrument Manager - Incorrect tool tip text
 Fixed 2336: Charts - Volume of a tick that opened a new range bar was added to the prior

range bar instead of the new one
 Fixed 2342: Charts - Charts on opened but non-displayed workspaces would not update on

connecting after NT restart
 Fixed 2348: Charts - Changing lookback period on tick charts could in some situations

cause the application to crash
 Fixed 2359: Charts - Removed internal GetBars() exception that showed up in some

situations
 Fixed 2362: Indicators - Darvas indicator did not work as expected in real-time
 Fixed 2364: Indicators - KAMA indicator was incorrect
 Fixed 2358: Market Replay - Charts did not maintain days back setting as replay crossed

over midnight
 Fixed 2337: Th AMERITRADE adapter - Workaround to correctly reported volume on each

tick based on calculating the different on daily volume reports
 Fixed 2354: PFG adapter - Incorrect order properties reported as order state changed in

some situations
 Fixed 2374: Barchart.com adapter - Currency time stamps were off by an hour
 Fixed 2378: Barchart.com adapter - Abort on historical data requests did not work

correctly
 Fixed 2365: Interactive Brokers adapter - Incorrect volume reported by IB could cause the

application to freeze
 Fixed 2338: Vendor license management - Issue with free trial periods on <Default>

module cold not be updated

NinjaTrader Version 6.5.1000.2 Production Release - May 2, 2008
 Added 2299: NinjaScript - GetBar() method
 Added 2325: PFG adapter - (BETA)
 Added 2330: BarChart adapter for real-time/historical market data (BETA)
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 Added 2321: Automated Trading Interface - New .NET interface including sample C#
application

 Added 2329: Zen-Fire adapter - Improved tracing capabilities
 Improved 2256: Connecting - Can not connect to both GAIN and MBT or IB provided that

the GAIN connection is established first
 Improved 2263: NinjaScript - Global internal order handling rules are now local per

instrument in a strategy instead of per strategy
 Improved 2295: NinjaScript - Most internal order handling rule violations are sent to

NinjaScript Output window
 Improved 2264: MBT adapter - Now detects the instrument types supported in customer

account on connection
 Improved 2311: OpenTick adapter - Supports configurable server names
 Improved 2278: Chart Trader - Position PnL now updates instantly as display unit is

toggled
 Improved 2328: NinjaScript - IExecution.IOrder object passed back in OnExecution() now

holds the most synchronized state of the order instead of the most recent
 Changed 2260: Backup - Window caption on back progress window was not set correctly
 Changed 2269: Simulation and Market Replay controls now display in the Windows task

bar
 Changed 2283: CandleStickPattern indicator - Can now be used in the strategy wizard (

MAY BREAK EXISTING USER CODE)
 Fixed 2265: TD AMERITRADE adapter - Order in state "PENDING" was not always correctly

processed
 Fixed 2268: TD AMERITRADE adapter - Could not connect using free license key if there

was an active order in the TDA account
 Fixed 2271: Patsystems adapter - Order properties were not always correctly maintained

on internal order change
 Fixed 2291: eSignal adapter - Removed filtering on duplicate bid events
 Fixed 2322: OpenTick adapter - Filter out redundant/invalid data
 Fixed 2262: Charts - Copy and paste of some draw objects did not work as expected
 Fixed 2266: Charts - Dragging chart splitter could on rare occasions throw an exception
 Fixed 2275: Charts - PriorDayOHLC indicator displayed incorrect values in real-time on 1st

bar of the day
 Fixed 2287: Charts - Current daily bar is not constructed for indexes
 Fixed 2288: Charts - Daily bars may not have been constructed for current day with

OpenTick adapter
 Fixed 2289: Charts - Heiken Ashi indicator may have removed some draw objects
 Fixed 2292: Charts - Y-axis scaling did not work as expected with plotted execution

markers
 Fixed 2293: Charts - RangeCounter indicator now works with RangeAlt bar type
 Fixed 2294: Charts - Daily charts were not displayed rare regional settings such as

(Czechia)
 Fixed 2296: Charts - Selecting custom dash style in Pen editor for a plot could cause crash

the application
 Fixed 2305: Charts - Internal state of chart was not persisted correctly when saving a

workspace in certain situations
 Fixed 2315: Charts - RegressionChannel indicator could have divide by zero exceptions
 Fixed 2323: Charts - Fixed several issues related to internal bar management
 Fixed 2326: Charts - Redundant reload occurred when forcing a historical data reload

within a chart
 Fixed 2297: Historical Data - Importing with ticks with two 12:00 AM time stamps could

crash the application
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 Fixed 2306: Historical Data - Merging of bars over midnight could create duplicate bars
 Fixed 2272: Strategy Wizard - Checking for Realized PnL produced non-compilable code
 Fixed 2285: Strategy Analyzer - <On the fly> did not work as expected
 Fixed 2254: Automated Trading Interface - Did not work correctly for non-default accounts
 Fixed 2259: Mail To Support - Did not work if 1st attempt was interrupted during file zip

procedure
 Fixed 2284: Account Performance Tab - Summary value could be rendered incorrect color

although value is accurate

NinjaTrader Version 6.5.1000.1 Production Release - April 2, 2008
 Added 2201: NinjaScript - New DrawText() method signature to support new parameter

yPixelOffset parameter
 Added 2204: Interactive Brokers adapter - Support for Bolsa Madrid (BM) exchange
 Added 2232: Indicators - CandleStickPattern detection indicator
 Added 2234: NinjaScript - OHLC data series are now public for use in custom fill methods
 Improved 2195: Simulation - Rejected orders due to unsupported instrument type is now

logged
 Improved 2208: HeikenAshi indicator - Now displays the true Open and Close price of a bar
 Improved 2239: IQFeed adapter - Now detects L2 authorization
 Improved 2235: NinjaScript - New TraceOrder message in case a stop/target method call is

ignored
 Changed 2213: Trading Technologies adapter - Changed mapping for Z to "Z" instead of

"Z|CBOT"
 Changed 2217: Stock List Import - Stocks are now added to a instrument list with

"Default" exchange as default
 Changed 2242: NinjaScript - Strategy class now has the same using statements as

indicators
 Fixed 2186: Strategy Analyzer - Saving backtest results did not work as expected
 Fixed 2189: TD AMERITRADE adapter - Did not connect using simulation license keys
 Fixed 2190: Backup - Caption text was incorrect on one of the dialog windows
 Fixed 2197: NinjaScript - Setting PanelUI property did not work as expected
 Fixed 2206: NinjaScript - FirstTickOfBar was not set correctly if an incoming tick generated

multiple bars
 Fixed 2214: NinjaScript - Internal position close logic on multi-series strategies did not

work as expected in some use cases
 Fixed 2216: NinjaScript - Changed some system indicator implementations (such as TSI)

to prevent application locks ups
 Fixed 2225: NinjaScript - Strategy Draw() methods was not consistent in internal checks

for the current BarsInProgress
 Fixed 2249: NinjaScript - Execution time stamps on back test of multiseries strategy could

be incorrect
 Fixed 2250: NinjaScript - GetProfitLoss() could throw exception during backtest on

currency instruments
 Fixed 2253: Strategy Analyzer - Backtest of an instrument list was not abortable
 Fixed 2202: Historical Data - Loading historical bars data from database did not work as

expected in certain use cases
 Fixed 2237: Market Replay - Last date did not work as expected in some cases for charts
 Fixed 2203: TradeStation Email Interface - 1/64 and 1/128 tick sizes did not work correctly

for 1/2 ticks
 Fixed 2221: Stock List Import - Target instrument list did not save new instruments
 Fixed 2223: Charts - Bar spikes were introduced on chart under certain use cases
 Fixed 2230: Charts - Draw text did not work as expected if user defined default settings
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were saved
 Fixed 2238: Charts - Default ratio of Gann Fan is now relative to an instrument's tick size
 Fixed 2252: Charts - Fibonacci Extensions did not draw lines if "Extend right" was disabled
 Fixed 2226: IQFeed adapter - Performance issue related to progress window on download

of historical data
 Fixed 2228: IQFeed adapter - Post session last trade price was not correctly supported
 Fixed 2230: IQFeed adapter - Splits could have incorrect years (1900) and split factors

were reversed
 Fixed 2231: Patsystems adapter - Order properties may have been incorrect on accepted

order states
 Fixed 2229: Instrument Manager - Creating a currency instrument with a name less than 6

characters would throw an exception
 Fixed 2240: Level II window - Application could crash if resetting grid columns with hidden

columns
 Fixed 2248: Account Performance - Could fail to generate on rare situations
 Fixed 2251: Market Analyzer - Column condition dialogs could be inaccessible if Always On

Top was enabled
 Fixed 2244: Formatting prices for 0.01 ticksizes in currency pairs did not always work

correctly

NinjaTrader Version 6.5.0.10 Beta Release - March 4, 2008
 Improved 2119: TradeStation Email Interface - Workspace multiplier parameter now

accepts fraction values (0.5 for example)
 Improved 2151: TradeStation Email Interface - Exceptions in the TS generated email are

now trapped and logged
 Improved 2122: TD AMERITRADE adapter - Message is logged if live account is not enabled

for "Express Trading"
 Improved 2169: IB adapter - ATM strategies now generate stop/targets for FX instruments

when the entry order is filled (ensures IB does not route orders to IBIDEAL on small partial
fills)

 Improved 2172: External DataFeed - TradeStation index instruments are now supported
 Improved 2175: External DataFeed - Better volume values in NTExternaDatafeed
 Improved 2167: Backup - Workspaces are now saved implicitly on back up
 Improved 2168: Backup - Restore process adjusts references if config file was not

recovered
 Changed 2121: eSignal adapter - Mapping for SI instrument
 Changed 2121: eSignal adapter - Synthetic FX volume now set to 100,000 instead of 1
 Changed 2178: Instruments - Instrument Reset only works if disconnected
 Fixed 2125 & 2130: Charts - Pivots and WoodiesPivots indicators did not work correctly in

some cases
 Fixed 2129: Charts - Abort button did not work for historical data requests to IB
 Fixed 2139: Charts - Abort button is disabled with IQFeed historical data request since not

abortable
 Fixed 1254: Charts - Multiple executions on the same bar were not always plotted correctly
 Fixed 2156: Charts - Historical tick based charts were not reloaded correctly producing

problems when switching between real-time and market replay connection
 Fixed 2170: Charts - Application could crash on running over midnight in some cases
 Fixed 2157: Chart Trader - Position line was not draw to the y-axis
 Fixed 2131: NinjaScript - Import/Export process now references correct user custom

installation folders
 Fixed 2145: NinjaScript - Time stamp of imported file was not correctly set
 Fixed 2152: NinjaScript - BarColor and BackColor were not always reset correctly after

removing an indicator from the chart
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 Fixed 2173: NinjaScript - Exceptions were thrown when TraceOrders was enabled if an
empty bar series existed

 Fixed 2181: NinjaScript - FloatSeries and IntSeries could cause memory leaks
 Fixed 2134: Direction Edition - Strategy menus are removed
 Fixed 2141: Chart Trader - Missing orders types on context menu
 Fixed 2142: TD AMERITRADE adapter - Performance glitch on requesting transaction data
 Fixed 2147: OpenTick adapter - Did not unsubscribe from market data correctly resulting

in unnecessary log entries
 Fixed 2149: Yahoo adapter - Updating splits and dividends did not always work as

expected
 Fixed 2155: Zen-Fire adapter - Some NYBOT instruments were not properly handled
 Fixed 2177: eSignal adapter - Only use GMT time stamps
 Fixed 2144: Workspaces - Better handling of corrupt workspace files
 Fixed 2162: Backup - Restore failed as some directories did not exists on a fresh NT

installation
 Fixed 2179: Stock List Import - Exception if there were duplicates
 Fixed 2153: Market Replay - Application could crash when working with replay files that

crossed midnight
 Fixed 2161: Application could crash if currency instruments were selected/deselected in

some cases
 Fixed 2138: Application could hang on simultaneous requests to historical and real-time

market data

NinjaTrader Version 6.5.0.9 Beta Release - February 13, 2008
 Added: TD Ameritrade support (adapter in beta). If you would like to test this please

send an email to sales at ninjatrader dot com to request a license key.
 Added 2087: NinjaScript - NinjaScript objects can now be debugged at run time using MS

Visual Studio
 Improved 2114: Charts - Y-axis will not autore-scale as much when changing the scale

manually. This is STILL not fixed scaling.
 Improved 2093: Charts - Pivot indicators can now optionally calculate prior day HLC values

from daily bars if the provider supports it. Any NinjaScript objects referencing the
Pivot or WoodiesPivot indicators code will break as there are new method
signatures. Please see information.

 Improved 2076: Interactive Brokers adapter - Better real-time trade event handling for
T&S and volume reporting

 Improved 2083: Interactive Brokers adapter - Optimized the historical data request
processing

 Improved 2088: Interactive Brokers adapter - Supports historical data for expired futures
contracts

 Improved 2090: Market Analyzer - "# bars to look back" parameter set to zero will no
longer load historical data

 Changed 2097: TT adapter - Execution times are now time stamped with local PC time
 Changed 2105: Zen-Fire adapter - Reverted to NT6 login failed handling
 Changed 2114: Interactive Brokers adapter - Added database mappings for ZK, ZL, ZM, ZE

etc..
 Changed 2108: Collective2 - Orders generated externally to NinjaTrader are excluded from

C2 processing
 Fixed 2104: MBT adapter - Could crash on some Vista installations
 Fixed 2063: Charts - Data Box and Mini Data Box did not update as the chart scrolled
 Fixed 2067:  Charts - Format Data Series settings were not reflective of the chart from

where it was called
 Fixed 2077: Charts - Application could crash on pressing enter on the quick access
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instrument field with a blank field
 Fixed 2080: Charts - In Chart Trader the "Stop limit offset" parameter did not work as

expected when set to a value of zero
 Fixed 2082: Charts - Chart Trader PnL stopped updated as the current bar was scrolled off

the chart to the right
 Fixed 2092: Charts - Session break was incorrectly calculated on minute based time

frames and sessions spanned midnight
 Fixed 2094: Charts - Y-axis scale was incorrect on interest rate futures if chart was zoomed

out too much
 Fixed 2099: Charts - Custom indicators could disappear from a chart based on unexpected

user programmed settings
 Fixed 2100: Charts - Horizontal lines could suddenly have a slope after some time has

passed
 Fixed 2101: Charts - WoodiesCCI indicator did not correctly recognize a crossover when

CCI was exactly a value of zero
 Fixed 2064: Market Replay - Strategies did not correctly execute after rewinding the replay
 Fixed 2102: Market Replay - Alert parameter "RearmSeconds" diod not work as expected
 Fixed 2059: NinjaScript - WaitUntilFlat option did not work as expected
 Fixed 2084: NinjaScript - Strategy tab in Control Center displayed incorrect position avg

price for "WaitUntilFlat" running strategies
 Fixed 2062: NinjaScript - Calling CancelOrder() mutiple times on the same order could

throw assertions
 Fixed 2091: NinjaScript - FirstBarOfSession property was never set to true for Range bars

and any custom bar types
 Fixed 2086: NinjaScript - Calling the Add() method in a strategy with an indicator on

indicator did not correctly plot on the chart
 Fixed 2069: NinjaScript - ExitOnClose handling no longer terminates a strategy in

real-time operation. CRITICAL CHANGE
 Fixed 2074: NinjaScript - Changed Output window implementation to be more memory

friendly
 Fixed 2079: NinjaScript Import - Strategy only assemblies would not import
 Fixed 2095: FX Pro and Basic Entry - Press "BE" button would also ammend any entry stop

orders to break even price
 Fixed 2075: Grids - Application could crash on removing a grid row
 Fixed 2078: Grids - Resolved some grid issues

NinjaTrader Version 6.5.0.8 Beta Release - January 26, 2008
 Improved 2053: Interactive Brokers adapter - Custom price formatting to address

formatting issues such as ZS futures contract
 Changed 2054: Indicators - BarTimer indicators no longer displays negative values
 Fixed 2055: Workspaces - Restoring workspaces in some situations could crash the

application 
 Fixed 2029: Strategy Wizard - Selecting "Falling" would crash the application after

installing .NET 2.0 SP1 
 Fixed 2045: Backup - Resolved some memory issues with data backup process
 Fixed 2058: NinjaScript - Application could crash as backtest orders went live on a

simulation account

NinjaTrader Version 6.5.0.7 Beta Release - January 24, 2008
 Added 2033: Control Center - Help > About now includes the version number of the .NET

runtime
 Improved 2040: MBT adapter - Added additional low level traces
 Improved 2048: FuturesBetting adapter - Now supports migrated CBOT to CME products
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 Changed 2028: NinjaScript - The new .NTNS extension introduced in the prior release has
been reverted

 Changed 2034: TT Credit Processing - IB FX excluded from calculations
 Changed 2035: Patsystems adapter - Exceptions caught on processing orders and

executions now throw an alert instead of just a log
 Fixed 2041: Zen-Fire adapter - Positions could have been incorrectly reported over a

holiday 
 Fixed 2029: Charts - Removing the label property of an indicator and then open the

DataBox would terminate the indicator
 Fixed 2045: Charts - Data spike on last bar resulting from problem with merging data
 Fixed 2047: Charts - Market data was not always subscribed in rare situations
 Fixed 2027 & 2044: Workspaces - File > Workspace > Save As did not always work as

expected
 Fixed 2039: Workspaces - Two workspaces could be merged together in some situations
 Fixed 2042: Workspaces - Save As on the Default workspace behaviour was not consistent
 Fixed 2031: NinjaScript - BarsInProgress did was not synchronized correctly in a

multi-series strategy with a daily and intraday series
 Fixed 2030: NinjaScript - Stop loss and profit target price were not always rounded to

TickSize
 Fixed 2032: NinjaScript - Potential race condition that could lock up the application on

internal order management
 Fixed 2023: NinjaScript Editor - Compiler references dialog did not re-size correctly

NinjaTrader Version 6.5.0.6 Beta Release - January 16, 2008
 Added 2006: Zen-Fire adapter - NYBOT support
 Added 2103: IB adapter - IB message bulletins now are logged with source id
 Added 2016: TickSize - 0.02 now supported
 Added 2019: Instrument Manager - FGBX now supported
 Added 2008: Instrument Manager - Added mapping for Patsystems GC and SI
 Improved 2009: IB adapter - Bid price is now used for last price with currencies
 Improved 2010: IB adapter - Default exchange for currencies now routes to IDEALPRO

exchange
 Changed 2025: NinjaScript - Slope() method now uses bars ago logic instead of absolute

bar value (CODE BREAKING)
 Fixed 2024: IB adapter - CBOT to CME migration for Level 2 data did not work
 Fixed 2001: Charts - Large period range bars could cause the application to crash
 Fixed 2104: Charts - OutOfMemory exception could crash the application
 Fixed 2018: Charts - From to date rolling forward could cause problems
 Fixed 2105: Indicators - MAMA indicator calculations were incorrect
 Fixed 2002: NinjaScript - Negative index values in draw methods could throw an

exception (this is no longer supported)
 Fixed 2003: Woodies CCI - Did not work on custom bar types
 Fixed 2005: Market Analyzer - Application could crash if loading bars during connecting
 Fixed 2012: Workspaces - Inconsistent names could cause the application to crash
 Fixed 2011: Options - Opening the options screen could crash the application in rare

situations
 Fixed 2008: Patsystems adapter - Application could hang on connect if an instrument was

not correctly mapped in the Instrument Manager

NinjaTrader Version 6.5.0.5 Beta Release - January 12, 2008
 Added 1864: Indicators - Woodies CCI panel now has a range bar counter
 Added 1909: Indicators - RangeCounter
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 Added 1936: Charts - Can change instrument by just typing the instrument name into a
chart

 Added 1924: Historical Data - Can now delete historical data in the database
 Added 1893: NinjaScript - ClearOutputWindow() method
 Added 1913: Mail To Support - Option to send workspace and template files
 Added 1972: Interactive Brokers adapter - Now supports FX trading
 Improved 1867: ATI - ATI functions can now reference the "Default" account name instead

of only by empty string
 Improved 1874: Grids - Saving grids includes a time stamp in the file name
 Improved 1890: NinjaScript - Import function now checks version to ensure that newer

files can not be imported into older versions
 Improved 1911: NinjaScript - DrawTextFixed() is now drawn on top of other draw objects
 Improved 1916: NinjaScript - All files under "Custom\Vendor" folder are included in

compiling a custom DLL
 Improved 1928: NinjaScript - Compiler exceptions are now trapped
 Improved 1935: NinjaScript - Exported NinjaScript files now have the extension .zip and

can be imported by just double clicking on the file (.zip imports still supported)
 Improved 1904: Backup - Restore function now checks version to ensure that newer files

can not be restored to older versions
 Improved 1934: Backup - Backup files now have the extension .ntbk and can be restored

by just double clicking on the file (.zip archives from prior version can not be restored)
 Improved 1908: Charts - Detect out of memory exception during historical data download

and provide user with option to reduce amount of data requested
 Improved 1925: Charts - Performance when draw objects were off screen
 Improved 1932: Charts - Added some monitor handling to avoid dead locks when working

with internal data pools
 Improved 1948: Market Analyzer - Now supports custom DataSeries properties in an

indicator column
 Improved 1978: Market Analyzer - Reduced delays on connecting
 Improved 1971: DTN adapter - Now supports for minor news feeds
 Improved 1993: Stock List Import - Now assigns all instruments in the list to the list
 Changed 1907: Strategy Analyzer - Consistency check on user defined inputs is stricter
 Changed 1974: NinjaScript - Error handling on overfill detection now attempts to close a

position in addition to cancelling remaining orders and strategy termination
 Changed 1991: NinjaScript - Warning message to restart application if an assembly has

been imported
 Changed 1878: Global exception handling now traces the exception message in addition to

the call stack (debugging purposes)
 Changed 1881: Removed "Options" from the Tools > Options > Commission tab since

NinjaTrader does not officially support trading options
 Changed 1882: Removed the "From" parameter when running a NinjaScript strategy from

the Strategies tab
 Changed 1885: Indicator - BarTime indicator error message
 Changed 1922: Instrument Selector - Changing to a different instrument list no longer

automatically selects the first instrument in the list
 Changed 1975: ATM Strategies - Stop orders in a stop only strategy no longer are assigned

OCO ids (internal change to support upcoming TD Ameritrade adapter)
 Changed 1998: Dynamic SuperDOM - Sub-pip currency not supported
 Fixed 1963: Strategy Analyzer - Market orders could be in a forever "Working" state
 Fixed 1983: Strategy Analyzer - Indicators may not have been displayed properly in rare

situations
 Fixed 1992: Strategy Analyzer - Incorrect results in a backtest using some tick based
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intervals (phantom bars on range bars)
 Fixed 1865: NinjaScript - Real-time strategy operation did not work as expected in certain

situations
 Fixed 1870: NinjaScript - Part filled exit order would cancel itself
 Fixed 1872: NinjaScript - OnPositionUpdate() method was called redundantly in real-time
 Fixed 1875: NinjaScript - BarColor property did not work for Line On Close or HiLo bars
 Fixed 1889: NinjaScript - Bars.PercentComplete returned a value of zero on historical bars

instead of returning a value of one
 Fixed 1940: NinjaScript - Concurrency check for entry/exit orders did not ignore orders

already canceled in backtest
 Fixed 1947: NinjaScript - Exit orders could have been cancelled when they should not have

been
 Fixed 1949: NinjaScript - Position.GetProfitLoss did not work in backtest
 Fixed 1950: NinjaScript - Accessing user defined inputs (properties) in Initialize() method

did not work
 Fixed 1951: NinjaScript - DrawRegion() did not accept DataSeries objects such as High,

Close etc...
 Fixed 1955: NinjaScript - SwingHighBar and SwingLowBar methods in the Swing indicator

did not always return correct values
 Fixed 1970: NinjaScript - CurrentBar index value was not set correctly on new event driven

methods such as OnOrderStatus()
 Fixed 1996: NinjaScript - DrawTextFixed() only drew on price panel
 Fixed 1921: NinjaScript Editor - Could crash the application under certain conditions
 Fixed 1917 & 1918: Strategy Analyzer - Could crash the application under certain

conditions
 Fixed 1866: Simulator - Switching delay settings from a value of zero to greater than zero

would cause simulator orders to be resubmitted
 Fixed 1919: Simulator - Stop Limit orders could not be placed for currencies
 Fixed 1868: Charts - Draw objects with anchor lines off screen were not always rendered
 Fixed 1869: Charts - Zoom cursor stayed as zoom in icon when clicked twice followed by

clicking on the zoom out icon
 Fixed 1876: Charts - Saving a template with custom indicator that held a public property

for a Color/Font/Pen would crash the application
 Fixed 1898: Charts - Global Cross Hair was offset by one day on a Daily chart
 Fixed 1900: Charts - On some chart interval types indicators did not always update

correctly
 Fixed 1927: Charts - Global Cross Hair could crash the application under certain conditions
 Fixed 1931: Charts - Bar interval values were not persisted correctly between charts
 Fixed 1933: Charts - Rapid historical data reload calls could crash the application
 Fixed 1953: Charts - "Snap to OHLC" drawing option was not ignored when drawing in

indicator panels
 Fixed 1954: Charts - Changing an instrument with Global Crosshair enabled could cause

the application to crash
 Fixed 1982: Charts - Abort on historical data requests larger than 10 days on tick based

intervals were ignored
 Fixed 1984: Charts - X axis grid lines were not properly aligned on zoom in when they

were only a few bars on the chart
 Fixed 1994: Charts - "From date" of chart was not rolled forward in some cases
 Fixed 1997: Charts - Switching between candles to line on close and back to candle would

result in incorrect candle outline display color
 Fixed 1897: Indicators - Some plots did not update on current bar
 Fixed 1910: Indicators - Woodies CCI Panel range counter was not accurate
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 Fixed 1958: Indicators - Woodies CCI plotting issues
 Fixed 1902: Indicators - PeriodD and Smooth parameters were swapped
 Fixed 1871: Connection Wizard - Historical data server settings were not persisted

correctly
 Fixed 1873: Workspaces - Corrupt workspace file would crash the application
 Fixed 1877: Automated Trading Interface - NTClosePosition() function now takes the

account name parameter as previously documented. EXISTING CALLS TO THIS
FUNCTION WILL NOT WORK, PLEASE ENSURE YOUR CODE IS UPDATED.

 Fixed 1879: Instrument Manager - Deleting instruments in some cases would crash the
application

 Fixed 1880: Market Replay Connection - Performance Tab > Trades > Chart would crash
the application

 Fixed 1888: Market Replay Connection - Prior version replay files did not replay correctly
all the time

 Fixed 1899: Market Replay Connection - Chart did not always update after terminating a
high speed replay

 Fixed 1946: Market Replay Connection - Recording connected to OpenTick adapter did not
work as expected

 Fixed 1884: Performance Tab - Trades were sometimes reported with incorrect strategy
name

 Fixed 1914: Performance Tab - Commissions on currencies was inaccurate
 Fixed 1886: Simulated Data Feed - Trend control's screen position was not persisted on

disconnect
 Fixed 1966: Zen-Fire adapter - Account values were not reported if initial value reported

from API was zero
 Fixed 1903: OpenTick adapter - Daily High/Low/Open were incorrect
 Fixed 1943: OpenTick adapter - Daily Volume events were not processed
 Fixed 1979: DTN adapter - Could lock up the application on historical data requests
 Fixed 1976: Trading Technologies adapter - Order qty changes may not have been

displayed correctly
 Fixed 1905: Time & Sales - Daily High/Low row back color could continuously plot
 Fixed 1906: TradeStation Interface - The NTDataDownload Easy Language strategy pointed

to the NT6 folder instead of NT 6.5
 Fixed 1912: Instrument Manager - TickSize for currencies could be incorrect if the option

"Support sub-pips" was enabled
 Fixed 1942: Instrument Manager - Searching for an instrument using an invalid regular

expression would throw and exception
 Fixed 1929: Grids - Settings were not persisted in some cases
 Fixed 1930: File Dialog Windows - Several issues with directory locations
 Fixed 1938: Workspaces -Default workspace was not registered as application was started

for the first time
 Fixed 1945: Workspaces - Duplicate Control Center windows could have been loaded
 Fixed 1941: Options - Real-time tick filter offset percentage incremented by a factor of

three instead of one by the mouse wheel
 Fixed 1987, 1989 & 1990: ATM Strategies - Changing quantity on strategy generated

orders could result in infinite order bracket creation

NinjaTrader Version 6.5.0.4 Beta Release - November 27, 2007
 Added 1795: T&S Window - Now supports back color property
 Added 1838: NinjaScript - Running an FX strategy will issue a warning regarding how FX

lot sizes work
 Added 1849: NinjaScript - FloatSeries class
 Improved 1816: Market Replay - Simulation engine fill behaviour now in sync with ultra
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fast replay speeds for increased realism with forward testing automated strategies
 Improved 1796: Zen-Fire adapter - Now supports net change in the Market Analyzer
 Improved 1799: Zen-Fire adapter - Now support account balance in the Accounts tab
 Improved 1801: Grids - Multi-row deletion is optimized
 Improved 1803: Workspaces - Now use relative file names so workspaces are transferrable

between PC's
 Improved 1804: DTN adapter - Normalize historical time stamps to ensure they are in

sequential order
 Improved 1827: MBT adapter - Orders are submitted with the route "MBTR" if "MBTX" does

not exist
 Improved 1805: Charts - Draw objects are now resized when anchor point is moved, any

other point of a draw object will move the object
 Improved 1806: Charts - Anchor point of rectangle has been moved to each corner and can

be resized both verticaly and horizontally simultaneously
 Improved 1828: Charts - Mouse cursor changes to reflect either moving a draw object or

resizing it based on cursor location over a draw object
 Improved 1860: Charts - Performance optimizations in internal bar building functions
 Improved 1830: Indicators - Woodies CCI indicator now exposes ".ZoneBars" property

indicating the color of the CCI histogram bar
 Improved 1846: Indicators - Woodies CCI indicator now works with range bars
 Improved 1843: Indicators - Woodies CCI Panel enhancements
 Improved 1807: Simulator - Zero value delay settings are now supported
 Improved 1857: Simulator - Market orders for FX are more realistically handled
 Improved 1808: Market Replay - Additional replay speed levels
 Improved 1831: Interest rate futures are now always quoted in 32nd's (110 3/64 is

represented as 110'025)
 Improved 1833: NinjaScript export process now includes checks for user defined methods

in the strategy folder accessed by indicators
 Changed 1863: New FX order quantity handling critical for backtesting and real-time

operation. See Help Guide section under "Running Live NinjaScript Strategies" for critical
detailed information.

 Changed 1798: NinjaScript - Internal backtest order token values now use GUID to stay
consistent with live order token values

 Changed 1809: NinjaScript - Simultaneous entry orders on opposite sides of market are no
longer allowed and the second entry order will be ignored

 Changed 1802: SMTP Server - Processed shut down only if SMTP server was actually
running

 Changed 1815: PnL calculations for currencies (FX) was overhauled
 Changed 1822: Charts - Renamed "Bar outline" to "Candle outline"
 Changed 1829: Charts - "Auto scale" property now defaults to a value of false for fibonacci

and pitchfork draw objects
 Changed 1842: Charts - Format Data Series will have the "Default" template selected if a

prior selected template is not persisted
 Changed 1844: Charts - Format Data Series last known settings are preserved across all

workspace instead of per workspace
 Changed 1861: Indicators - BuySellVolume and VolumeProfile indicators now store local

bid/ask price variables to ensure accurate last price comparisons
 Changed 1848: eSignal adapter - Volume of 1 is now simulated for currencies (FX)
 Changed 1826: Order Grid - Removed order change and cancel buttons when this grid is

displayed in the Strategy Analyzer or a performance tab
 Changed 1862: Removed "Turn Around" performance statistic since it is redundant
 Fixed 1790: Charts - You could not enter an interval value greater than 36,500 via the

Format Data Series dialog window
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 Fixed 1793: Charts - Timestamps on bars could be out of sync
 Fixed 1797: Charts - Drawing issues with Andrews Pitch Fork
 Fixed 1810: Charts - BarTime indicator did not work on session times that spanned

midnight
 Fixed 1813: Charts - Internal bar building for tick based intervals was not always in

sequential order
 Fixed 1819: Charts - Empty charts could crash application
 Fixed 1820: Charts - Andrews Pitch Fork could lock up application if rescaling the chart at

extreme y axis values
 Fixed 1823: Charts - Global crosshair on an empty chart could crash the application
 Fixed 1836: Charts - Drawing to the right of the last visible bar with "Snap to OHLC"

enabled would crash the application
 Fixed 1841: Charts - Tick bars were not built correctly
 Fixed 1855: Charts - Fibonacci time extensions disapeared from a chart if the anchor

points were offscreen
 Fixed 1786: Market Analyzer - "Exclude weekend" property was not persisted
 Fixed 1787: NinjaScript - OnPositionUpdate() method reflected account position and not

strategy position
 Fixed 1791: NinjaScript - Some strategy Draw() methods could cause an application crash

if a strategy was run from the Strategies tab
 Fixed 1792: NinjaScript - Incorrect error message on an application crash during walk

forward optimization
 Fixed 1794: NinjaScript - Issues with the conversion of historical to live orders in a

multi-series strategy
 Fixed 1851 & 1852: NinjaScript - DrawRegion() did not work as expected
 Fixed 1814: Strategy Analyzer - Performance graphs scaling could be incorrect
 Fixed 1850: Strategy Analyzer - Chart could plot redundant indicators
 Fixed 1817: Strategy Wizard - Improved pivot indicator was not correctly recognized
 Fixed 1789: Workspaces - User changed default settings (drawing tool user defined

settings) were not persisted between different workspaces
 Fixed 1854: Workspaces - A "ghost" workspace could have been listed as active workspace

on application restart
 Fixed 1800: DTN adapter - Application could crash if duplicate instruments with the same

symbol map was requested
 Fixed 1839: eSignal adapter - Real-time tick time stamps were not calculated correctly
 Fixed 1811: Time and Sales - Resizing window could display gray space on right margin
 Fixed 1845: Time and Sales - Could crash the application on start up
 Fixed 1859: Time and Sales - Last price to level 1 market data comparisons was not

accurate
 Fixed 1847: SuperDOM - Negative limit stop limit orders could not be submitted
 Fixed 1818: Simulator - OCO handling was disabled if broker connection was lost but price

feed still working
 Fixed 1821: Market Replay - Moving slider ahead in time did not construct chart bars

correctly
 Fixed 1834: Price control display did not receive focus when middle clicking in it to retrieve

last traded price
 Fixed 1835: Price control display display a zero value if connected to two providers
 Fixed 1840: Instrument look up in the instrument selector control was not set to the

instrument type already selected when pressing the "..." button
 Fixed 1858: Negative FX subpip display for point based PnL was not displayed correctly

NinjaTrader Version 6.5.0.3 Beta Release - November 9, 2007
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 Added: Indicator - VolumeUpDown
 Added: NinjaScript - IntSeries
 Added: Charts - Hollow out of range icon appears in top right corner of chart if current bar

is moved to the left of the right most edge
 Fixed: Charts - Andrews pitchfork could disappear at right edge of chart
 Fixed: NinjaScript - SetStopLoss() and SetTrailStop() did not work for short positions
 Fixed: eSignal adapter - real-time data for forex and indexes did not work
 Fixed: GAIN adapter - Unrealized PnL on simulation accounts did not work
 Fixed: FX Pro - Disabled maximize button
 Fixed: Grids - Columns could disappear from a grid
 Fixed: Grids - Unchecking a visibility check box in grid properties had no effect

-o-

Risks of Electronic Trading with
NinjaTrader
There are risks associated with electronic trading in general. Below are risks that you must be
aware of with respect to NinjaTrader.

OCO Handling (One Cancels Other)
NinjaTrader supports multiple different connectivity providers (brokers, exchange gateways
and data feeds) that each have different levels of support for advanced order handling
features such as OCO orders. An OCO order is simply a group of linked orders where if one is
either filled or canceled, all other orders that belong to it's OCO group is canceled. If your
connectivity provider does not support OCO orders natively, NinjaTrader will simulate them on
your local PC. It is important to understand how these order types behave.

 OCO does not imply that once one order is filled, related orders in the same OCO
group are guaranteed to be canceled. It means that once an order is filled or canceled,
any remaining orders in the same OCO group will try to be canceled. It is possible (in
rare occasions) that order(s) that are part of the OCO group will be filled before the
cancellation request has been acknowledged. As an example, let's say you have a stop
loss and profit target order as part of an OCO group. The profit target is filled, the
market rapidly turns around, the OCO cancellation request is submitted, the stop loss
order is filled before the cancellation request is acknowledged. The narrower the
spread between your OCO orders the higher the risk of getting filled on an order before
it is canceled in fast moving markets. 

 Local PC held simulated OCO orders are dependant on order status events returning
from your connectivity provider to trigger the cancellation of OCO orders. If
NinjaTrader is offline (internet connection is down or PC crashed) then the simulated
OCO functionality will not be operational. 

In Flight Executions
There are several functions within NinjaTrader that are based on the current state of your
account at the moment the function is invoked. These functions are:

 Close Position
 Flatten Everything

In flight executions are orders that are partially or completely filled between the time that you
invoke one of the above functions and the time your connectivity provider acknowledges the
order submission/modification/cancellation requests submitted by these functions. Here is an
example:

1. You have an open long position for three contracts and several working stop loss and profit
target orders for three contracts each
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2. You invoke the command "Flatten Everything" which proceeds to cancel all working orders
and submit a market order to close the three contract position

3. One of your profit target orders is filled before the cancellation request arrives at the
exchange

4. The market order to close the position is also filled for three contracts

5. You now have an open short position for three contracts

This example is generally a rare occurrence. After invoking any of the above commands it is
always prudent to check the Control Center's Positions Tab and Orders Tab to ensure that all
orders were canceled and positions flattened. To avoid these situations you should be
cautious of using the "Close Position" function when you have orders that are working within
a few ticks of the inside market.

NinjaTrader Volume Based Simulated  Stop Orders
Please see the section and understand the risks should you use our volume based simulated
stop orders.

-o-

Purchase NinjaTrader
NinjaTrader is a free application for advanced charting, market analytics, system development
and trade simulation. Should you wish to trade live, please see our available purchase options
at our website.

You can also contact us:

NinjaTrader, LLC
1236 Clarkson Street
Denver, CO 80218 USA
email: sales@ninjatrader.com

-o-

Performance Tips
There are many variables that contribute to overall performance of the NinjaTrader
application.

 Different connectivity providers (market data vendors and broker technologies) that
NinjaTrader supports vary in their level of real-time data service. For example, providers
who deliver unfiltered tick data (submit all market ticks) will impose heavier processing
load than a vendor that provides throttled market data.

 The load you place on the NinjaTrader application (running 200 charts will consume more
processing power than running only 20 charts)

 The capability of your PC hardware (are you running a brand new state of the art machine
or a 4 year old PC with limited RAM)

The following are some suggestions that can help you fine tune your NinjaTrader installation
to run optimally:

Charting
 Set chart indicators "Calculate on bar close" property to a value of 'True'

http://www.ninjatrader.com/web/subscribe_trading_platform.htm
http://www.ninjatrader.com/web/subscribe_trading_platform.htm
sales@ninjatrader.com
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 Increase your chart refresh interval by increasing the value of the chart property "Display
update interval (sec)"

 Reduce the number of bars on your chart (days back or bars back settings under Format 
Data  Series" dialog window

 Reduce the number running indicators
 If you are running a custom or 3rd party indicator or strategy, remove them to isolate if

these custom NinjaScript objects may be a CPU or memory drain

Lagging Market Data
 There are many variables that can impact market data latency
 Connecting wirelessly can drastically impact performance during heavy volume periods.

Depending on signal strength, your modem/router is unable to push all the data through.
This can be resolved by connecting directly into the modem/router via a hard line.

 Serious abnormal increases in market volume
 Data provider servers could be lagging
 Limited bandwidth internet service (56K dial up modem is not acceptable for example)
 Inadequate PC hardware or running too many applications on your PC

Market Analyzer
 "# bars to look back property" set this number to the minimum number of bars required to

properly initialize any indicator columns. The higher the number, the longer it will take to
load data and the more memory (RAM) NinjaTrader will use to hold the data in memory.

Miscellaneous
 Within the Control Center window, select Tools > Options > Data and uncheck "Run market

replay recorder"
 Within the Control Center window, select Tools > Options > Data and uncheck *"Store

real-time bar data"
 Reduce the number of applications running on your PC

* "Store real-time bar data" should only be checked if are using a connectivity provider that
does NOT provide historical data

Time & Sales Window
 Set the "Timer refresh" property to a value of 'True'

Level II Window
 Set the "Timer refresh" property to a value of 'True'

Workspaces
 Hidden workspaces consume CPU cycles so check under File > Workspaces to see all of the

workspaces that are open and close any that you seldom or never use.

Diagnostics Tab
This is a tab within the Control Center window that you should only use if directed by a
NinjaTrader Customer Service Representative. If your NinjaTrader installation is feeling
extremely sluggish after following some of the tips above, then and only then follow these
steps below.

1. From within the Control Center window select the menu Tools > Options > General check
"Show diagnostics tab"

2. Click on the "Diagnostics" tab in the Control Center window
3. The ONLY items that should be checked are "Connect", "Order" and "to file only", please

uncheck anything else that may be checked
4. From within the Control Center window select the menu Tools > Options > General 

uncheck "Show diagnostics tab"
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-o-

Getting Help and Support

Getting Help & Support
NinjaTrader Support Policy
It is critical that you can rely on the support and service you receive from your trading
platform provider. It is for this reason that NinjaTrader prides itself on its top quality support
model that ensures you receive lightning fast and accurate turn around to your support
inquiries. We have found that delivering support electronically allows us to provide high levels
of service in a cost efficient manner. Electronic support inquiries can be processed thirty times
faster than traditional telephone support models which ensures that you get the necessary
information when you need it. No more leaving messages in phantom voice mail boxes and no
more waiting for thirty minutes in a telephone queue! Does this mean we do not have
telephone support? Absolutely not! If we can't resolve your support inquiry electronically, we
will be on the telephone with you right away and if required, login remotely to your PC to
expidite a resolution!

So how do I get support?
 This help guide is interlaced with over one hour of instructional video and images
 Pressing F1 key anywhere in the NinjaTrader application will load context sensitive help
 Daily live interactive online training sessions (schedule)
 Some of our connectivity providers are staffed with NinjaTrader support specialists. Please

check with your provider to find out if they have live support for NinjaTrader.
 NinjaTrader Support Forum available 24 hours a day 7 days a week
 Send "Mail To Support" from the Help menu of the NinjaTrader application
 support@ninjatrader.com

Support Priority
It is preferred that you send us a support email from the "Mail To Support" sub menu under
the Help menu of the NinjaTrader application since it provides us with additional trouble
shooting information, however, when sending an email to support@ninjatrader.com, please
provide the following information:
 Operating system
 Current NinjaTrader version (located in Help-->About)
 License code (located in Help-->About)
 Explanation of your problem

Current subscribers (evident by providing a license code) will receive priority support.

-o-

Installation and Set Up
To run NinjaTrader your system must meet these specifications:

 PC running either Windows XP, Windows Vista or Windows Server 2003

http://www.ninjatrader.com/webnew/trading_online_events.htm
http://www.ninjatrader-support.com/vb/index.php
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 Min resolution of 1024 x 768
 P4 Processor or higher
 100 MB free hard drive space
 1GB RAM with Windows XP, 2GB RAM with Windows Vista (should be a minimum)
 Microsoft .Net Framework 2.0 (Download)
 Account connection provider specific set up requirements

-o-

Help Video Requirements
There are Macromedia Flash based video clips interlaced throughout this help guide. To test if
you can play the videos please attempt to play the test video by clicking on the image below. 

If the video did not play, then you need Macromedia's Flash Player.

 Get Flash PLayer

-o-

Video Library
Within this Help Guide are numerous help videos. Below is a shortcut list to all available
videos within this Help Guide.

Quick start guide Getting up to speed in minutes with NinjaTrader
ATM Strategies

Strategy parameters Overview on strategy parameters
Manage strategy
templates

Overview on how to save and manage strategies

Auto breakeven Overview on auto breakeven
Auto chase Overview on auto chase
Auto trail Overview on auto trail

Automated Trading
Running a NinjaScript
strategy

Overview on configuring and running an automed NinjaScript
strategy

TradeStation Email
Interface

Overview on setting up an automated trading link between TS and
NT

Setting Up Account Connections
Interactive Brokers Walk through of establishing a NinjaTrader/Interactive Brokers

connection
Patsystems Walk through of establishing a NinjaTrader/Patsystems connection

Charts
Charts overview Overview of NinjaTrader charting capabilities
Navigating a chart Overview of the various chart navigation options
Working with indicators Overview on working with indicators in charts
Drawing tools Overview on working with drawing tools in charts

Control Center Window
Order tab Overview on working with the order tab
Log tab Overview on the log tab

http://www.microsoft.com/downloads/details.aspx?familyid=0856eacb-4362-4b0d-8edd-aab15c5e04f5&displaylang=en
http://www.ninjatrader.com/web/trading_software_support_setup.htm
http://www.macromedia.com/shockwave/download/download.cgi?P1_Prod_Version=ShockwaveFlash&promoid=BIOW
http://www.ninjatrader.com/V5_Videos/QuickStartGuide.html
http://www.ninjatrader.com/V5_Videos/PositionStrategies.html
http://www.ninjatrader.com/V5_Videos/ManageTemplates.html
http://www.ninjatrader.com/V5_Videos/ManageTemplates.html
http://www.ninjatrader.com/V5_Videos/AutoBreakeven.html
http://www.ninjatrader.com/V5_Videos/AutoChase.html
http://www.ninjatrader.com/V5_Videos/AutoTrail.html
http://www.ninjatrader-support.com/Videos/TradeStationEmailInterface.html
http://www.ninjatrader-support.com/Videos/TradeStationEmailInterface.html
http://www.ninjatrader-support.com/Videos/connectingInteractiveBrokers.html
http://www.ninjatrader-support.com/Videos/connectingPatsystems.html
http://www.ninjatrader.com/V6_Videos/NT6ChartingOverview.html
http://www.ninjatrader.com/V6_Videos/NT6ChartingNavigation.html
http://www.ninjatrader.com/V6_Videos/NT6ChartingAddIndicator.html
http://www.ninjatrader.com/V6_Videos/NT6ChartingDrawingTools.html
http://www.ninjatrader.com/V5_Videos/OrderTab.html
http://www.ninjatrader.com/V5_Videos/LogTab1.html
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Data Grids
Data grids Working with data grids

Instrument Manager
Searching for
instruments

Overview on searching for available instruments

Instrument list Adding/removing instruments from the default instrument list
Contract Rollover Overview on rolling over a futures contract

Market Analyzer
Market Analyzer
overview

Overview of the Market Analyzer

Adding columns Overview on adding a column
Alert conditions Overview on adding an alert condition to a column
Color conditions Overview on adding a color condition to a column
Filter conditions Overview on adding a filter condition to a column

Market Replay
Market replay Overview on market replay

Strategy Analyzer
Strategy Analyzer
overview
Running a backtest
Running an
optimization
Walk forward
optimization

Strategy Wizard (NinjaScript)
Strategy Wizard Overview of the Strategy Wizard
Condition Builder Construction conditions and actions in the Strategy Wizard

SuperDOM
Price ladder display Overview of the price ladder display
Order display Overview of the price ladder order display
Consolidated order
display

Overview on how the price ladder display consolidates the display of
orders

Submitting orders Overview on how to submit orders in the SuperDOM
Simulated stop orders Overview on simulated stop orders
Cancelling orders Overview on how to cancel orders
Modifying order price Overview on how to modify the price of an order
Modifying order size Overview on how to modify the size of an order

-o-

Quick Start Guide
This quick start guide provides step by step instructions for performing the most basic
NinjaTrader function of placing an order and having a stop loss and a profit target order
automatically submitted. This section does not replace what you need to know about general
NinjaTrader operation. Please be sure to review the Help Guide in it's entirety.

This guide assumes that you have installed NinjaTrader and are successfully connected to
your connectivity provider of choice.

NOTE: This quick start guide is not applicable to NinjaTrader Direct users since NinjaTrader's
Advanced Strategy Management (ATM) functionality is not included in the NinjaTrader Direct
Edition.

http://www.ninjatrader.com/V5_Videos/DataGrid1.html
http://www.ninjatrader.com/V5_Videos/InstrumentManager1.html
http://www.ninjatrader.com/V5_Videos/InstrumentManager1.html
http://www.ninjatrader.com/V5_Videos/InstrumentManager2.html
http://www.ninjatrader-support.com/Videos/RollOver.html
http://www.ninjatrader.com/V6_Videos/NT6MarketAnalyzerOverview.html
http://www.ninjatrader.com/V6_Videos/NT6MarketAnalyzerOverview.html
http://www.ninjatrader.com/V6_Videos/NT6MarketAnalyzerAddColumn.html
http://www.ninjatrader.com/V6_Videos/NT6MarketAnalyzerAlertCondition.html
http://www.ninjatrader.com/V6_Videos/NT6MarketAnalyzerColorCondition.html
http://www.ninjatrader.com/V6_Videos/NT6MarketAnalyzerFilterCondition.html
http://www.ninjatrader.com/V5_Videos/MarketReplay.html
http://www.ninjatrader.com/V6_Videos/NT6StrategyAnalyzerBacktest.html
http://www.ninjatrader.com/V6_Videos/NT6StrategyAnalyzerOptimization.html
http://www.ninjatrader.com/V6_Videos/NT6StrategyAnalyzerOptimization.html
http://www.ninjatrader.com/V6_Videos/NT6StrategyWizard.html
http://www.ninjatrader.com/V6_Videos/NT6ConditionBuilder.html
http://www.ninjatrader.com/V5_Videos/PriceLadder1.html
http://www.ninjatrader.com/V5_Videos/OrderDisplay1.html
http://www.ninjatrader.com/V5_Videos/OrderDisplay2.html
http://www.ninjatrader.com/V5_Videos/OrderDisplay2.html
http://www.ninjatrader.com/V5_Videos/OrderSubmit1.html
http://www.ninjatrader.com/V5_Videos/NegativeLimit.html
http://www.ninjatrader.com/V5_Videos/OrderCancel1.html
http://www.ninjatrader.com/V5_Videos/OrderModification1.html
http://www.ninjatrader.com/V5_Videos/OrderModification2.html
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1. From the Control Center window select the Tools-->Instrument Manager menu to bring up
the Instrument Manager window. It is possible that there may already be instruments defined
in the instrument list (left pane of the Instrument Manager) and if so, you can review the next
few steps but no action is required.

2. Find the ES (SP Emini) contract and select it
3. Set the exchange to Globex and the Expiry to September, 2005 (or the current front
month)
4. Press the left arrow button to add the instrument to the instrument list (visible in the left
pane as ES 09-05)
5. Press the "OK" button to exit the Instrument Manager
6. From the Control Center window, select File-->New-->SuperDOM Window... to bring up a
new SuperDOM order entry window.
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7. From the instrument drop down list, select ES 09-05 to start market  data and depth
display in the SuperDOM
8. Select "<Custom>" from the strategy control list
9. Set a value of 6 ticks for both the "Stop loss" and "Profit target" parameter fields
10. With your mouse button, click on the buy "Market" cell. This will submit a market order to
buy 1 contract that once filled automatically submits a stop loss and profit target
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11. Average entry price for the open position will be displayed as a brown cell
12. Stop loss and profit target orders
13. Current unrealized profit and loss
14. Current position size

-o-

Connecting through a proxy server
If you are on a network that is connecting to the internet through a proxy server you must
follow these instructions in order to ensure that NinjaTrader license checking does not fail.

1. Open the file C:\Program Files\<NinjaTrader Folder>\bin\NinjaTrader.exe.config using MS
Notepad or any other text editor

2. Replace the text "False" with "True"
3. Save the file
4. Restart NinjaTrader

NinjaTrader will now use your PC settings for the proxy server.

-o-

Knowledge Base
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Instruments

Rolling Over a Futures Contract

To rollover a futures contract:

1. Within the NinjaTrader Control Center window, select the menu Tools-->Instrument
Manager
2. Select the expired contract on the left list of instruments and press the ">" button
3. In the master list of instruments, search for the instrument you wish to rollover and select
it
4. In the lower portion of the Instrument Manager, ensure the correct exchange is selected,
then select the new expriration date (For Example: 09-06 for September 2006) and press the
"<" button to add it back to the list

-o-

Account Connections

Connections Overview
You must establish an account connection to either a NinjaTrader provided connection, your
broker or a data feed in order to receive market data and trade either live or in simulation.
NinjaTrader comes with the following default installed connections:

 External Data Feed Connection
 Market Replay Connection
 Simulated Data Feed Connection

You must configure your own broker or data feed accounts using the Connection Wizard. Once
a connection is created, you can establish a connection from the Control Center window
File-->Connect menu.

-o-

Creating an Account Connection
Within the Control Center window, select the Tools-->Account Connections... menu. This will
launch the Account Connection Set Up window. A connection is where you set up your user
name, password  and any relevant information that allows you to establish a connection to
your connectivity provider which is your broker and/or data feed service. You can access
broker/technology specific connection help information via the NinjaTrader website Support
Center.
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Within the Account Connection Set Up window you can establish a connection, add a
connection, change a connection or remove a connection. The following steps uses eSignal as
connectivity provider. This provider is used for demonstration purposes.

1. Press the "Add..." button to launch the connection wizard.

2. After pressing the "Next" button, you will be prompted to supply:

 User defined connection *name
 Select the connectivity provider
 Optional back up data feed connection
 Historical Data Options (visibility of these options are dependent on the provider and your

license)

* Only use alphanumeric characters in the connection name
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3. After pressing the "Next" button, you will be presented with provider specific parameters
that you must enter in order to establish a connection. Each different provider may have
different options. For specific information relative to your connectivity provider, select the
Connection Help... menu from within the NinjaTrader Control Center window.

4. Once you have entered in all of the required connectivity information and pressed the
"Next" button, your set up information will be presented to you at which time you must press
the "Finish" button. The newly created connection will be displayed in the Account Connection
Set Up window window and from the File-->Connect-->Your Connection menu in the Control
Center window.
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-o-

Multiple Connections
NinjaTrader supports multiple simultaneous connections to different connectivity providers
and in some cases, to the same connectivity provider allowing you to:

 Connect to and trade through multiple brokers simultaneously
 Connect to your broker and your data feed provider simultaneously

Primary and Secondary Data Feeds
You may or may not want to use your brokers data feed as your primary data feed. For
example, you may want to use eSignal as your primary data feed and your broker as back up.
If this is the case, connect to eSignal first and then establish your broker connection.
Whenever you request data for a particular market, NinjaTrader will request data from the
eSignal connection first and then your broker connection second if a market data request fails
from eSignal. During the connection creation process, you also have the ability to assign a
back up data feed connection. By doing so, you tell NinjaTrader to fail over to the back up
data feed if the primary feed is disconnected. This will only work if the back up data feed
connection is live.

Connection Order is Significant
If you are establishing multiple connections that overlap in their provided market data
services, the connection order you establish is critical. NinjaTrader will check for required
market data services in the order your connections are established.

For example:

BrokerA - Provides real-time market and historical data
BrokerB - Provides only real-time market data

If you connect to BrokerA first and BrokerB second, when requesting market data NinjaTrader
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will request the data stream for both real-time and historical data from BrokerA even if you
trade against BrokerB. It is possible you want to use the real-time market data from BrokerB
(you perceive it to be faster) then you should connect to BrokerB first and BrokerA second.
What about historical data? No problem since NinjaTrader is smart enough to realize that
although it uses BrokerB for real-time data it will request historical data from BrokerA. 

-o-

External Data Feed Connection
The External Data Feed Connection is a default connection installed with NinjaTrader. In
combination with the DLL or COM Interfaces, it provides 3rd party applications the ability to
drive NinjaTrader with market data.

This connection targets those traders who have programming experience and wish to create a
market data link between their charting or custom application and NinjaTrader which allows
them to use the full functionality of NinjaTrader's simulator. Please refer to the Ask and Bid
functions of the DLL or COM Interface.

-o-

Market Replay Connection
The Market Replay Connection is a default connection installed with NinjaTrader. It's purpose
is for replaying NinjaTrader recorded data files. See the Market Replay section of the Help
Guide for further details.

-o-

Simulated Data Feed Connection
The Simulated Data Feed Connection is a default connection installed with NinjaTrader. It's
purpose is to play internally generated market data for simulation. This connection can be
used for:

 Offline simulated training and practice of NinjaTrader
 Offline testing of strategies
 Offline testing of trade automation using NinjaScript strategies or the NinjaTrader 

Automated Trading Interface

For the simulated data feed you must provide a starting price for any instrument you wish to
initiate an internally generated simulated feed. Via the Control Center window, Tools-->
Instrument Manager, find the instrument you wish to simulate data for, select it, press the
"Edit" button and set the "Sim feed start price" value as per the image below.

** This connection is a random internally generated market and has NO correlation
to real market data **
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Once you are connected to the Simulated Data Feed Connection, you can control the trend of
the data feed using the "Trend" slider control.

-o-

Connecting to Collective2
You can use NinjaTrader to automatically submit orders to your C2 (Collective2) account.

How does it work?
Real-time orders generated and submitted to any account (live brokerage or simulation) by
NinjaTrader can be enabled to have a market order submitted to C2 servers.

 The interface supports futures, forex and equities (options are NOT supported)
 A single market order is submitted upon an order of any type (market, limit, stop or stop

limit) has been reported as filled or part filled
 A single market order is submitted for the full order quantity amount (even if it was only

part filled)
 A market order quantity can be offset based on an optional quantity multiplier
 Orders generated while connected to the Market Replay, Simulated Data Feed or External

Data Feed connections will NOT be transmitted to C2
 Users of the NinjaTrader Multi-Broker Version are able to have their NinjaTrader generated

C2 orders distributed as trade signals to your C2 subscribers
 In the event that C2 servers are not responding, NinjaTrader will queue orders and submit

them in the correct sequence
 NinjaTrader will attempt to resubmit queued orders 5 times over a 2.5 minute period, if

this threshold is breached, a notification window will pop up and inform you of all orders
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that have not been submitted and prompt you to synchronize you C2 account via their web
interface. Further C2 communicated will cease until NinjaTrader is restarted.

* If your C2 system has paying subscribers, you MUST use the paid for NinjaTrader
Multi-Broker Version otherwise you will NOT be able to send trade signals from NinjaTrader to
your C2 account.

Review the following 12 steps to set up NinjaTrader to C2 integration.

Initial Set Up
You must set up an Account Group(s) to instruct NinjaTrader to submit market orders to C2
servers. An Account Group accomplishes the following:

 Determines if real-time orders for a specific live or simulation account should replicate
orders to C2 servers

 Determines what C2 strategy ID an order is associated to
 Determines if the real-time order quantity should be offset by a multiplier amount

1. From the NinjaTrader Control Center window, select the menu Tools > Options to bring up
the "Options" dialog window

2. Within the "Options" dialog, select the "Misc" tab and press the "Account Groups" button to
bring up the "Account Groups" dialog window

3. Type in a name for the Account Group based on the strict naming convention outlined
below

4. Assign an account(s) from the list of available accounts
5. Press the "Save" button to save the Account Group
6. Press the "Close" button to close the "Account Groups" dialog window

Anytime you execute a real-time order into an account(s) assigned to a C2 Account Group
from any order entry window, Automated Trading Interface or an automated NinjaScript
strategy, a C2 order will be submitted for all C2 enabled the instruments. 

Account Group Naming Conventions
The name of a C2 Account Group must be in the format below ensuring that you have
semicolons (;) between parameters:

C2;Strategyid;YourPassword;QuantityMultiplier

"C2" in the above example MUST be in caps since it is case sensitive.

StrategyId
Your C2 strategy id used for tracking a C2 strategy.

YourPassword
Your C2 account password.

QuantityMultiplier (Optional)
A factor that will be multiplied by the order quantity to derive the quantity of the market
order submitted to C2. For example: If you are trading 10 lots in your account and you
specify a value of "0.5", the C2 order will be submitted at a quantity of 5. If the result is an
uneven number, NinjaTrader will round up to the nearest whole number.

Example #1
StrategyId = 1982131
YourPassword = candle
No quantity multiplier
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Example #2
StrategyId = 98761
YourPassword = jump
Quantity multiplier of 0.5

Enabling an Instrument
You must enable an instrument by 'tagging' the C2 symbol with an asterisk (*) prefix. This
ensures that only orders for those instruments you have enabled will be routed to C2.

7. From the NinjaTrader Control Center window, select the menu Tools > Instrument Manager
to bring up the "Instrument Manager" window

8. Search for the instrument you wish to enable, highlight it and pres the "Edit" button to
bring up the "Instrument Editor"

9. In the "Instrument Editor" window, select the "Misc" tab and scroll down to the "Symbol
Map" section

10. Next to "Collective2", add an asterisk (*) in front of the C2 symbol map name (MSFT
would be *MSFT)

11. Press the "OK" button
12. Press the "OK"  button once more

The image below depicts the ES (S&P Emini) instrument currently disabled (there is no
asterisk prefix)
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The  image below depicts the ES (S&P Emini) instrument enabled (asterisk prefix)

You are now set for NinjaTrader to submit orders to C2. Keep in mind the following:

 C2 orders will be placed when you execute a real-time order within an account that is
assigned to a C2 Account Group and the traded instrument has been enabled

 You MUST disable an instrument if you do not want C2 orders to be generated

Synchronization
It is possible for various reasons that the communication between NinjaTrader and C2 can be
disrupted resulting in the potential of unsubmitted orders. In this event (excluding an
unexpected application or computer crash) a notification box will pop up. It is your
responsibility to logon to your C2 account via (www.collective2.com) and manually
synchronize your C2 account to your actual live trading account position size.

-o-

Connecting to TradeStation Data Feed
You can use NinjaTrader (even the free Simulation Edition) with TradeStation's real-time data
feed.

Initial Set Up
1. NinjaTrader must be installed
2. Start TradeStation
3. Select the menu File-->Import/Export EasyLanguage
4. Select "Import EasyLanguage file (ELD, ELS or ELA)"
5. Click "Next"
6. Select the file <NinjaTrader Installation Folder>\bin\AutoTrade\NINJATRADER.ELD"
7. Click "Next"
8. Click "Next"

www.collective2.com
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9. Click "Finish" and confirm any upcoming query box by clicking "OK"

Connecting
1. Start NinjaTrader and connect to the "External Data Feed Connection" via the Control
Center window, File-->Connect menu
2. Start TradeStation
3. Within TradeSation, open a chart window (@ES for example) and via the right mouse click
context menu, select "Insert Strategy..."
4. From the dialog window "Insert Strategies" select "NTExternalFeed" strategy and press the
"OK" button
5. A new window will appear "Format Analysis Techniques & Strategies", press the "CLOSE"
button
6. Within NinjaTrader, select the current ES contract from the instrument list (ES 03-07 for
the March 2007 contract as an example) from any of the order entry or chart window

You will now receive real-time data from TradeStation in NinjaTrader.

* Only level one data will be transmitted. Market depth is not supported.

-o-

Account Groups

Account Groups Overview
Account Groups allow you to group individual accounts into a group account. These account
groups will show up in any of the order entry interface's account selection list. If selected, any
order placed will be replicated and sent to each account that belongs to the group. 

NOTE: Subsequent cancellations and or order modifications will NOT be replicated against
each order, you must manage each replicated order individually.

-o-

Managing Account Groups
Create Account Group

1. From within the Control Center window, select the menu Tools-->Options, then select the
"Misc" tab and press the button "Account Groups"
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2. Select an account that you wish to add to your account group from the available account
list
3. Press the "left arrow" button to move this account to the "Assigned accounts" list
4. Give the account group a name
5. Press the "Save" button

The "My Group" account will now be available in all account selection lists in all order entry
interfaces.

Remove Account Group
1. Select an account group via the selection list (icon #3 in the image above)
2. Press the "Remove" button

-o-

Alerts Window

Overview
The Alerts window displays triggered user defined alerts. Alert conditions can be defined
within the Market Analyzer window, News window or alerts can be triggered within a custom
NinjaScript indicator or strategy.

-o-

Automated Trading

Automated Trading Interface

Automated Trading Interface Overview
NinjaTrader's ATI (Automated Trading Interface) provides efficient protocols to communicate
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trading signals from various external sources to NinjaTrader for the automation of order
execution.

NOTE: This interface is ONLY used for processing trade signals generated from
external applications and is not a full blown brokerage/market data API. If you are
interested in automated trading using native NinjaScript strategies please proceed
to the following help guide section.

NinjaTrader provides a TradeStation Email Interface, File Interface, DLL Interface, .NET
Interface and COM Interface which ensures that you can communicate with NinjaTrader from
any application such as but not limited to:

 Popular charting applications such as but not limited to TradeStation, eSignal, NeoTicker
and Investor RT

 Custom applications written in but not limited to Visual Studio .NET, Visual Basic, Delphi
and MS Excel

 Black box trading systems

The automated trading interface is bi-directional. To enable automated trading, select the
Automated Trading menu from the Control Center's File menu.

-o-

What can I do and how?
Through automation you can:

 Place orders
 Initiate a NinjaTrader ATM Strategy
 Change orders
 Cancel orders
 Close ATM Strategies and positions
 Flatten accounts
 Cancel all orders
 Retrieve information on positions and orders

NinjaTrader provides four methods for communicating from an external application to
NinjaTrader for trade automation. The Email Interface requires absolutely no programming
experience whatsoever, other methods require various level of programming/scripting
experience.

TradeStation Email Interface 
The TradeStation Email Interface allows you to take advantage of TradeStation's email
notification capabilities right out of the box. Run your TradeStation strategy in real time,
order signals are emailed within your computer (never leaves your PC) to NinjaTrader which
processes the order through to your broker.

File Interface
The file interface uses standard text files as input. These files are called order instruction files
(OIF) and have specific format requirements. NinjaTrader processes the OIF the instant the
file is written to the hard drive and subsequently deletes the file once the processing
operation is complete. 

DLL Interface
NinjaTrader provides a DLL named NtDirect.dll that supports various functions for automated
trading.
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.NET Interface
NinjaTrader provides a Client Class with methods to support various functions for automated
trading.

COM Interface
NinjaTrader provides a COM interface that supports various functions for automated trading.

So which method should I use?

TradeStation Systems
- If you are not running your own strategies or you have limited or no programming
experience you should use the Email Interface
- You are running your own system and you are comfortable with Easy Language and want to
have bi-directional control of your real-time order processing you should use the
pre-configured TradeStation NinjaTrader functions that use the DLL interface.

eSignal Systems
- You should use the pre-configured eSignal NinjaTrader functions that use the DLL interface

Other Charting Applications
- You should use either the DLL, .NET or COM interface if your charting application supports
these interface types or use the File Interface

Custom Applications
- You should use either the DLL, .NET or COM interface

-o-

Commands and Valid Parameters
The following section is only relevant for the File, DLL and COM interfaces. All three interfaces
share common interface functions/methods that take as arguments the parameters defined in
the tables below. You can automate your trading through eight different commands.
Command definitions are also provided below.

PARAMETERS VALID VALUES
COMMAND CANCEL, CANCELALLORDERS, CHANGE, CLOSEPOSITION,

CLOSESTRATEGY, FLATTENEVERYTHING, PLACE, REVERSEPOSITION
ACCOUNT The name of the account the command is to be processed
INSTRUMENT Instrument name
ACTION BUY, SELL
QTY Any integer value

ORDER TYPE MARKET, LIMIT, STOP, STOPLIMIT
LIMIT PRICE Any decimal value (use decimals not commas 1212.25 for example)
STOP PRICE Any decimal value
TIF DAY, GTC
OCO ID Any string value
ORDER ID Any string value (must be unique for each line/file)
STRATEGY Strategy template name (must exist in NinjaTrader)
STRATEGY ID Any string value (must be unique for each line/file)

The following table displays required (R) and optional (O) values for each different command
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value.
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Folllowing are descriptions of each available command. 

CANCEL COMMAND
This command will cancel an order and requires an order id value and an optional strategy id
value. The order id value must match either the order id value given to an order placed
through the PLACE command or, an order name such as ENTRY*, EXIT*, STOP*, SIMSTOP* or
TARGET*. The star (*) represents an integer value such as TARGET1 or TARGET2. Order
names are only valid if a valid strategy id value is passed. The strategy id value must match a
strategy id value given to a strategy in the PLACE command. 

CANCELALLORDERS COMMAND
This command will cancel all active orders across all accounts and broker connections.

CHANGE COMMAND
This command will change the parameters of an order and requires an order id value, optional
price and quantity values and an optional strategy id value. The order id value must match
either the order id value given to an order placed through the PLACE command or, an order
name such as ENTRY*, EXIT*, STOP*, SIMSTOP* or TARGET*. The star (*) represents an
integer value such as TARGET1 or TARGET2. Order names are only valid if a valid strategy id
value is passed. Pass in zero (0) values for price and quantity if you do not wish to change
these order parameters. Price values must be in US decimal format. 1212.25 is correct while
1212,25 is not.  

CLOSEPOSITION COMMAND
This command will close a position and requires an account name value and an instrument
name value. The instrument name value is the name of the NinjaTrader instrument including
the exchange name. For equities, the symbol is sufficient. This command will cancel any
working orders and flatten the position. 

CLOSESTRATEGY COMMAND
This command will close a strategy and requires a strategy id value. The strategy id value
must match a strategy id given to a strategy in the PLACE command. This command will close
the specified strategy.
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FLATTENEVERYTHING COMMAND
This command will cancel all active orders and flatten all positions across all accounts and
broker connections. 

PLACE COMMAND
This command will place orders, place orders that initiate a NinjaTrader ATM strategy or place
orders that are applied to an active NinjaTrader position strategy. Providing the optional
strategy name field with a valid strategy template name will result in execution of that
strategy once the order is partially or completely filled. Pass in an optional unique string value
for the strategy id in order to reference that strategy via other commands. To apply an order
to an active strategy (existing strategies stop loss and target orders are amended) pass in the
active strategy id value and leave the strategy name field blank. Pass in an optional unique
string value for the order id in order to reference that order via other commands. If specifying
a strategy template name, there is no need to pass in an order id as the strategy based
orders can be referenced by their internally generated names such as TARGET1, STOP1 and
so on.

REVERSEPOSITION COMMAND
This command will reverse the current position and place an order in the opposite direction.
The field requirements are identical to the PLACE commmand.

-o-

Initialization
If using either the DLL or COM based interface, it is important to understand how the ATI is
initialized with respect to referencing account names. The ATI is initialized to the first account
name used in the first calling function.

Some functions accept an account name as a parameter. In most if not all functions, these
parameters can be left blank in which case the "Default" account as specified under the
Tools-->Options window of the Control Center window will be used. If your default account is
set to 'Sim101' and you call functions and leave the account parameter blank, you the
Sim101 account will be automatically used. 

Example:

Default account = Sim101
A function call is made with "" empty string as the account name argument
Sim101 account is automatically used
Subsequent function calls must use empty string if you want to  reference the Sim101
account
If you call a function and pass in the argument "Sim101", invalid information will be returned 

-o-

Trading currencies (FX) and options
To trade currencies (FOREX) and/or options through the ATI you must explicity reference the
NinjaTrader instrument name in any functions that accept an instrument  name as an
argument from the calling application.

-o-

File Interface
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Order Instruction Files (OIF)
OIFs must be written to the folder "My Documents\<NinjaTrader Folder>\incoming" and be
named oif*.txt. You can simply send an oif.txt file however, it is suggested that you
increment each OIF so that you end up with unique file names such as oif1.txt, oif2.txt,
oif3.txt. The reason is that if you send a lot of OIFs in rapid succession, you do run the risk of
file locking problems if you always use the same file name. This will result in a situation
where your file is not processed. Each file must contain correctly formatted line(s) of
parameters. You may stack the instruction lines so that each file contains as many instruction
lines as you desire. The delimiter required is the semicolon. Although this section is a good
reference for generating correctly formatted OIF, it is highly suggested that you use the 
Automated Trading OIF Builder to generate OIF strings for comparison to your OIF
generation. Files are processed the instant they are written to the hard disk without delay.

Please reference the Commands and Valid Parameters section for detailed information on
available commands and parameters.

The folllowing are examples of the required format for each of the availabe commands.
Required fields are embraced by <> where optional fields are embraced by [].

CANCEL COMMAND

CANCEL;;;;;;;;;;<ORDER ID>;;[STRATEGY ID]

CANCELALLORDERS COMMAND

CANCELALLORDERS;;;;;;;;;;;;

CHANGE COMMAND

CHANGE;;;;<QUANTITY>;;<LIMIT PRICE>;<STOP PRICE>;;;<ORDER ID>;;[STRATEGY ID]

CLOSEPOSITION COMMAND
CLOSEPOSITION;<ACCOUNT>;<INSTRUMENT>;;;;;;;;;;

CLOSESTRATEGY COMMAND

CLOSESTRATEGY;;;;;;;;;;;;<STRATEGY ID>

FLATTENEVERYTHING COMMAND

FLATTENEVERYTHING;;;;;;;;;;;;

PLACE COMMAND

PLACE;<ACCOUNT>;<INSTRUMENT>;<ACTION>;<QTY>;<ORDER TYPE>;[LIMIT
PRICE];[STOP PRICE];<TIF>;[OCO ID];[ORDER ID];[STRATEGY];[STRATEGY ID]

REVERSEPOSITION COMMAND

REVERSEPOSITION;<ACCOUNT>;<INSTRUMENT>;<ACTION>;<QTY>;<ORDER
TYPE>;[LIMIT PRICE];[STOP PRICE];<TIF>;[OCO ID];[ORDER ID];[STRATEGY];[STRATEGY
ID]

-o-

Information Update Files
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Information Update Files
NinjaTrader provides update information files that are written to the folder "My
Documents\<NinjaTrader Folder>\outgoing". The contents of this folder will be deleted when
either Automated Trading is disabled or NinjaTrader application shuts down.

Order State Files
Orders that are assigned an order id value in the "PLACE" command will generate an order
state update file with each change in order state. The file name is 'orderId.txt' where orderId
is the order id value passed in from the "PLACE" command. Possible order state values can be
found here.  The format of this file is:

Order State;Filled Amount;Average FillPrice

Position Update Files
Position update files are generated on every update of a position. The name of the file is
Instrument Name + Instrument Exchange_AccountName_Position.txt. An example would be
ES 0905 Globex_Sim101_Position.txt. The format of the file is:

Market Position; Quantity; Average Entry Price

Valid Market Position values are either LONG, SHORT or FLAT.

Connection State Files
Connection state files  are written with each change of connection state. The name of the file
is ConnectionName.txt where connectionName is the name of the connection given in the 
Connection Manager. The format of the file is:

Connection State

Valid connection state values are CONNECTED or DISCONNECTED.

-o-

Automated Trading OIF Builder
The Automated Trading OIF Builder is a utility that will generate correctly formatted OIF
based on user input. This utility will help you become familiar with the OIF formats that
NinjaTrader expects to see. You can also test these files in real-time by ensuring that "AT
Interface" is enabled via the Control Center's File menu and checking "Write file" in the
Automated Trading OIF builder.
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-o-

DLL Interface

DLL Interface Functions
Both the DLL Interface and COM Interface share the same functions. They are contained in
NTDirect.dll located in the C:\WINDOWS\system32 folder.

int Ask(string instrument, double price, int size)
Sets the ask price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int AskPlayback(string instrument, double price, int size, string timestamp)
Sets the ask price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double AvgEntryPrice(string instrument, string account)
Gets the average entry price for the specified instrument/account combination.

double AvgFillPrice(string orderId)
Gets the average entry price for the specified orderId.

int Bid(string instrument, double price, int size)
Sets the bid price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int BidPlayback(string instrument, double price, int size, string timestamp)
Sets the bid price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double BuyingPower(string account)
Gets the buying power for the specified account. *Not all brokerage technologies support this
value.
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double CashValue(string account)
Gets the cash value for the specified account. *Not all brokerage technologies support this
value.

int Command(string command, string account, string instrument, string action, int
quantity, string orderType, double limitPrice, double stopPrice,
        string timeInForce, string oco, string orderId, string strategy, string strategyId
)
Function for submitting, cancelling and changing orders, positions and strategies. Refer to
the Commands and Valid Parameters section for detailed information. A return value of 0
indicates success and -1 indicates an error. The Log tab will list context sensitive error
information.

int ConfirmOrders(int confirm)
The parameter confirm indicates if an order confirmation message will appear. This toggles
the global option that can be set manually via NinjaTrader Control Center Tools-->Options,
"Confirm order placement" checkbox. A value of 1 sets this option to true, any other value
sets this option to false.

int Connected(int showMessage)
Returns a value of zero if the DLL has established a connection to the NinjaTrader server
(application) and if the ATI is currently enabled or, -1 if it is disconnected. Calling any
function in the DLL will automatically initiate a connection to the server. The parameter
showMessage indicates if a message box is displayed in case the connection can not be
established. A value of 1 = show message box, any other value = don't show message box.

int Filled(string orderId)
Gets the number of contracts/shares filled for the orderId.

int Last(string instrument, double price, int size)
Sets the last price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int LastPlayback(string instrument, double price, int size, string timestamp)
Sets the last price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double MarketData(string instrument, int type)
Gets the most recent price for the specified instrument and data type. 0 = last, 1 = bid, 2 =
ask. You must first call the SubscribeMarketData() function prior to calling this function.

int MarketPosition(string instrument, string account)
Gets the market position for an instrument/account combination. Returns 0 for flat, negative
value for short positive value for long.

string NewOrderId()
Gets a new unique order id value.

string Orders(string account)
Gets a string of order ids of all orders of an account separated by '|'. *If a user defined order
id was not originally provided, the internal token id value is used since it is guaranteed to be
unique.

string OrderStatus(string orderId)
Gets the order state (see definitions) for the orderId. Returns an empty string if the order id
value provided does not return an order.

double RealizedPnL(string account)
Gets the realized profit and loss of an account.
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int SetUp(string host, int port)
Optional function to set the host and port number.  By default, host is set to "localhost" and
port is set to 36973. The default port number can be set via the General tab under Options. If
you change these default values, this function must be called before any other function. A
return value of 0 indicates success and -1 indicates an error.

string StopOrders(string strategyId)
Gets a string of order ids of all stop loss orders of an ATM strategy separated by '|'. Internal
token id value is used since it is guaranteed to be unique.

string Strategies(string account)
Gets a string of strategy ids of all ATM strategies of an account separated by '|'. Duplicate ID
values can be returned if strategies were initiated outside of the ATI. 

int StrategyPosition(string strategyId)
Gets the position for a strategy. Returns 0 for flat, negative value for short and positive value
for long.

int SubscribeMarketData(string instrument)
Starts a market data stream for the specific instrument. Call the MarketData() function to
retrieve prices. Make sure you call the UnSubscribeMarketData() function to close the data
stream. A return value of 0 indicates success and -1 indicates an error.

string TargetOrders(string strategyId)
Gets a string of order ids of all profit target orders of an ATM strategy separated by '|'.
Internal token id value is used since it is guaranteed to be unique.

int TearDown()
Disconnects the DLL from the NinjaTrader server. A return value of 0 indicates success and -1
indicates an error.

int UnsubscribeMarketData(string instrument)
Stops a market data stream for the specific instrument. A return value of 0 indicates success
and -1 indicates an error.

-o-

eSignal Sample Code
The eSignal sample code below illustrates the use of the NinjaTrader NtDirect.dll within an
eSignal EFS script. The function preMain() loads the  various DLL functions. The function
main() places an order. There is also additional wrapper samples created as examples. The
sample is also saved as an EFS file located at <NinjaTrader Installation
Folder>\bin\AutoTrade\NTSample.efs.
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/* Copyright (c) 2005, NinjaTrader LLC ninjatrader@ninjatrader.com. All rights
reserved. */ 

var dll         = new DLL("NtDirect.dll");
var orderPlaced = false;
var printDone   = false;

function preMain() 
{ 
    setPriceStudy(true);
    setStudyTitle("NT Sample"); 
    dll.addFunction("AvgEntryPrice",    DLL.DOUBLE, DLL.STDCALL, "AvgEntryPrice",
DLL.STRING, DLL.STRING);
    dll.addFunction("AvgFillPrice",     DLL.DOUBLE, DLL.STDCALL, "AvgFillPrice", DLL.STRING,
DLL.STRING);
    dll.addFunction("BuyingPower", DLL.String, DLL.STDCALL, "BuyingPower", DLL.DOUBLE);
    dll.addFunction("CashValue", DLL.String, DLL.STDCALL, "CashValue", DLL.DOUBLE);
    dll.addFunction("Command",          DLL.INT, DLL.STDCALL, "Command", DLL.STRING,
DLL.STRING, DLL.STRING, DLL.STRING, DLL.INT, DLL.STRING, DLL.DOUBLE, 
                                            DLL.DOUBLE, DLL.STRING, DLL.STRING, DLL.STRING,
DLL.STRING, DLL.STRING);
    dll.addFunction("ConfirmOrders",        DLL.INT, DLL.STDCALL, "ConfirmOrders", DLL.INT);
    dll.addFunction("Connected",        DLL.INT, DLL.STDCALL, "Connected", DLL.INT);
    dll.addFunction("Filled",           DLL.INT, DLL.STDCALL, "Filled", DLL.STRING,
DLL.STRING);
    dll.addFunction("MarketPosition",   DLL.INT, DLL.STDCALL, "MarketPosition", DLL.STRING,
DLL.STRING);
    dll.addFunction("NewOrderId",       DLL.STRING, DLL.STDCALL, "NewOrderId");
    dll.addFunction("Orders",                    DLL.STRING, DLL.STDCALL, "Orders",
DLL.STRING);
    dll.addFunction("OrderStatus",      DLL.STRING, DLL.STDCALL, "OrderStatus",
DLL.STRING, DLL.STRING);
    dll.addFunction("RealizedPnL",                    DLL.STRING, DLL.STDCALL, "RealizedPnL",
DLL.DOUBLE);
    dll.addFunction("SetUp",            DLL.INT, DLL.STDCALL, "SetUp", DLL.STRING, DLL.INT);
    dll.addFunction("Strategies",     DLL.STRING, DLL.STDCALL, "Strategies", DLL.STRING);
    dll.addFunction("StrategyPosition", DLL.INT, DLL.STDCALL, "StrategyPosition",
DLL.STRING);
    dll.addFunction("TearDown",         DLL.INT, DLL.STDCALL, "TearDown");
} 

function main() 
{ 
    if (isLastBarOnChart() && NTConnected(1))
    {
        if (!orderPlaced)
        {
            if (NTBuyMarket("MyOrderId", 1) == 0)        // buy 1 unit at market, assign
order id (optionally)
                orderPlaced = true;
        }
        else
        {
            // print some information on the current position and order
            debugPrint("Position size: "    + NTMarketPosition("")              + "\r\n");                
            debugPrint("AvgEntryPrice: "  + NTAvgEntryPrice("")               + "\r\n");
            debugPrint("OrderStatus: "     + NTOrderStatus("MyOrderId")    + "\r\n");
            debugPrint("Filled #: "           + NTFilled("MyOrderId")         + "\r\n");
            debugPrint("AvgFillPrice: "      + NTAvgFillPrice("MyOrderId")   + "\r\n");
            debugPrint("RealizedPnL: " + NTRealizedPnL("") + "\r\n");
        }
    }
}

// Get the average entry price of a position of an account. "account" is optional.
function NTAvgEntryPrice(account) {
    return dll.call("AvgEntryPrice", getSymbol(), account);
}

// Get the average fill price of an order at an account.
function NTAvgFillPrice(orderId) {
    return dll.call("AvgFillPrice", orderId, account);
}

// Get the buying power of an account.
function NTBuyingPower(account) {
    return dll.call("BuyingPower",  account);
}

// Place a buy limit order. "orderId" is optional (set to "" it not applicable).
function NTBuyLimit(orderId, quantity, limitPrice) {
    return NTCommand("Place", "", "Buy", quantity, "Limit", limitPrice, 0, "", "", orderId, "",
"");
}

// Place a buy market order. "orderId" is optional (set to "" it not applicable).
function NTBuyMarket(orderId, quantity) {
    return NTCommand("Place", "", "Buy", quantity, "Market", 0, 0, "", "", orderId, "", "");
}

// Place a buy stop order. "orderId" is optional (set to "" it not applicable).
function NTBuyStop(orderId "Buy", quantity, "StopLimit", limitPrice, stopPrice, "", "",
orderId, "", "");
}

// Cancel an order by its order id.
function NTCancel(orderId) {
    return NTCommand("Cancel", "", "", 0, "", 0, 0, "", "", orderId, "", "");
}

// Cancel all orders at all accounts.
function NTCancelAllOrders() {
     return NTCommand("CancelAllOrders", "", "", 0, "", 0, 0, "", "", "", "", "");
}

// Get the cash value of an account.
function NTCashValue(account) {
    return dll.call("CashValue",  account);
}

// Change an order by its order id.
function NTChange(orderId, quantity, limitPrice, stopPrice) {
    return NTCommand("Change", "", "", quantity, "", limitPrice, stopPrice, "", "", orderId, "",
"");
}

// Close any position of the current instrument at an account. "account" is optional
(set to "" it not applicable).
function NTClosePosition(account) {
    return NTCommand("ClosePosition", account, "", 0, "", 0, 0, "", "", "", "", "");
}

// Submits a NinjaTrader command.
function NTCommand(command, account, action, quantity, orderType, limitPrice, stopPrice,
timeInForce, oco, orderId, template, strategy) {
    return dll.call("Command", command, account, getSymbol(), action, quantity, orderType, 
                        limitPrice, stopPrice, timeInForce, oco, orderId, template, strategy);
}

// Indicates if the connection to NinjaTrader is established. 0 = connected, -1 not
connected.
function NTConnected() {
    return (dll.call("Connected") == 0)
}

// Get the filled of an order at an account.
function NTFilled(orderId) {
    return dll.call("Filled", orderId, account);
}

// Close all positions and cancels all order at all account.
function NTFlattenEverything() {
    return NTCommand("FlattenEverything", "", "", 0, "", 0, 0, "", "", "", "", "");
}

// Get a double value by its name.
function NTGetDouble(name) {
    return dll.call("GetDouble", name);
}

// Get an integer value by its name.
function NTGetInt(name) {
    return dll.call("GetInt", name);
}

// Get a string value by its name.
function NTGetString(name) {
    return dll.call("GetString", name);
}

// Get the market position of the current instrument at na account. "account" is
optional (set to "" it not applicable).
function NTMarketPosition(account) {
    return dll.call("MarketPosition", getSymbol(), account);
}

// Get a new unqiue order id.
function NTNewOrderId() {
    return dll.call("NewOrderId");
}

// Gets a string of order ids of all orders of an account separated by '|'. If a user
defined order id was not originally provided, the internal token id 
// value is used since it is guaranteed to be unique.
function NTOrders(account) {
    return dll.call("Orders", account);
}

// Get the current status of an order. 
function NTOrderStatus(orderId) {
    return dll.call("OrderStatus", orderId, account);
}

// Get the realized P&L of an account. 
function NTRealizedPnL(account) {
    return dll.call("RealizedPnL", account);
}

// Place a sell limit order. "orderId" is optional (set to "" it not applicable).
function NTSellLimit(orderId, quantity, limitPrice) {
    return NTCommand("Place", "", "Sell", quantity, "Limit", limitPrice, 0, "", "", orderId, "",
"");
}

// Place a sell market order. "orderId" is optional (set to "" it not applicable).
function NTSellMarket(orderId, quantity) {
    return NTCommand("Place", "", "Sell", quantity, "Market", 0, 0, "", "", orderId, "", "");
}

// Place a sell stop order. "orderId" is optional (set to "" it not applicable).
function NTSellStop(orderId, quantity, stopPrice) {
    return NTCommand("Place", "", "Sell", quantity, "Stop", 0, stopPrice, "", "", orderId, "",
"");
}

// Place a sell stop limit order. "orderId" is optional (set to "" it not applicable).
function NTSellStopLimit(orderId, quantity, limitPrice, stopPrice) {
    return NTCommand("Place", "", "Sell", quantity, "StopLimit", limitPrice, stopPrice, "", "",
orderId, "", "");
}

// Gets a string of strategy IDs of all strategies of an account separated by '|'.
Duplicate ID values can be returned if strategies were initiated outside of the ATI. 
function NTStrategies(account) {
    return dll.call("Strategies", account);
}

// Get the position of a strategy.
function NTStrategyPosition(strategyId) {
    return dll.call("StrategyPosition", strategyId);
}
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TradeStation Sample Code
The TradeStation sample code below illustrates the use of the NinjaTrader NtDirect.dll within
an TradeStation Easy Language function script.

{ Copyright (c) 2005, NinjaTrader LLC ninjatrader@ninjatrader.com }

DefineDLLFunc: "NtDirect.dll", int, "Command", lpstr, lpstr, lpstr, lpstr, int, lpstr, double,
double, lpstr, lpstr, lpstr, lpstr, lpstr;

inputs: Cmd(string), Account(string), Action(string), Quantity(numericsimple),
OrderType(string), LimitPrice(numericsimple), StopPrice(numericsimple),
TimeInForce(string), Oco(string), OrderId(string), Template(string), Strategy(string);

NTCommand = Command(Cmd, Account, GetSymbolName, Action, Quantity, OrderType,
LimitPrice, StopPrice, TimeInForce, Oco, OrderId, Template, Strategy);

-o-

COM Interface

COM Interface Functions
Both the DLL Interface and COM Interface share the same functions.

int Ask(string instrument, double price, int size)
Sets the ask price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int AskPlayback(string instrument, double price, int size, string timestamp)
Sets the ask price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double AvgEntryPrice(string instrument, string account)
Gets the average entry price for the specified instrument/account combination.

double AvgFillPrice(string orderId)
Gets the average entry price for the specified orderId.

int Bid(string instrument, double price, int size)
Sets the bid price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int BidPlayback(string instrument, double price, int size, string timestamp)
Sets the bid price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double BuyingPower(string account)
Gets the buying power for the specified account. *Not all brokerage technologies support this
value.

double CashValue(string account)
Gets the cash value for the specified account. *Not all brokerage technologies support this
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value.

int Command(string command, string account, string instrument, string action, int
quantity, string orderType, double limitPrice, double stopPrice,
        string timeInForce, string oco, string orderId, string strategy, string strategyId
)
Function for submitting, cancelling and changing orders, positions and strategies. Refer to
the Commands and Valid Parameters section for detailed information. A return value of 0
indicates success and -1 indicates an error. The Log tab will list context sensitive error
information.

int ConfirmOrders(int confirm)
The parameter confirm indicates if an order confirmation message will appear. This toggles
the global option that can be set manually via NinjaTrader Control Center Tools-->Options,
"Confirm order placement" checkbox. A value of 1 sets this option to true, any other value
sets this option to false.

int Connected(int showMessage)
Returns a value of zero if the DLL has established a connection to the NinjaTrader server
(application) and if the ATI is currently enabled or, -1 if it is disconnected. Calling any
function in the DLL will automatically initiate a connection to the server. The parameter
showMessage indicates if a message box is displayed in case the connection can not be
established. A value of 1 = show message box, any other value = don't show message box.

int Filled(string orderId)
Gets the number of contracts/shares filled for the orderId.

int Last(string instrument, double price, int size)
Sets the last price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int LastPlayback(string instrument, double price, int size, string timestamp)
Sets the last price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double MarketData(string instrument, int type)
Gets the most recent price for the specified instrument and data type. 0 = last, 1 = bid, 2 =
ask. You must first call the SubscribeMarketData() function prior to calling this function.

int MarketPosition(string instrument, string account)
Gets the market position for an instrument/account combination. Returns 0 for flat, negative
value for short positive value for long.

string NewOrderId()
Gets a new unique order id value.

string Orders(string account)
Gets a string of order ids of all orders of an account separated by '|'. *If a user defined order
id was not originally provided, the internal token id value is used since it is guaranteed to be
unique.

string OrderStatus(string orderId)
Gets the order state (see definitions) for the orderId. Returns an empty string if the order id
value provided does not return an order.

double RealizedPnL(string account)
Gets the realized profit and loss of an account.

int SetUp(string host, int port)
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Optional function to set the host and port number.  By default, host is set to "localhost" and
port is set to 36973. The default port number can be set via the General tab under Options. If
you change these default values, this function must be called before any other function. A
return value of 0 indicates success and -1 indicates an error.

string StopOrders(string strategyId)
Gets a string of order ids of all stop loss orders of an ATM strategy separated by '|'. Internal
token id value is used since it is guaranteed to be unique.

string Strategies(string account)
Gets a string of strategy ids of all ATM strategies of an account separated by '|'. Duplicate ID
values can be returned if strategies were initiated outside of the ATI. 

int StrategyPosition(string strategyId)
Gets the position for a strategy. Returns 0 for flat, negative value for short and positive value
for long.

int SubscribeMarketData(string instrument)
Starts a market data stream for the specific instrument. Call the MarketData() function to
retrieve prices. Make sure you call the UnSubscribeMarketData() function to close the data
stream. A return value of 0 indicates success and -1 indicates an error.

string TargetOrders(string strategyId)
Gets a string of order ids of all profit target orders of an ATM strategy separated by '|'.
Internal token id value is used since it is guaranteed to be unique.

int TearDown()
Disconnects the DLL from the NinjaTrader server. A return value of 0 indicates success and -1
indicates an error.

int UnsubscribeMarketData(string instrument)
Stops a market data stream for the specific instrument. A return value of 0 indicates success
and -1 indicates an error.

-o-

Using the COM Interface with Visual Basic
6.0
Following are screen shots of how to add the NinjaTrader COM Interface to a Visual Basic 6.0
project. From within Visual Basic Editor:

1. Open the Object Browser window



p75

© NinjaTrader, LLC, 2005

www.ninjatrader.com

2. Select the "References..." menu from the right mouse click context menu within the Object
Browser window.

3. Select NinjaTrader Client and press the "OK" button.
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4. Select "NinjaTrader_Client" from the select drop down list.

5. Class "IClient" has all available methods/functions.
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-o-

Visual Basic 6.0 Sample Code
Following is a very brief example of instantiating the COM Interface and placing a buy market
order.

'Declare and instantiate object
Dim myClient As NinjaTrader_Client.Client
Set myClient = New NinjaTrader_Client.Client

'Place a buy market order for MSFT (Microsoft)
result = myClient.Command("PLACE", "", "MSFT", "BUY", 100, "MARKET", 0, 0, "", "", "", "",
"")

-o-

.NET Interface

Client Class
Client class method definitions.

int Ask(string instrument, double price, int size)
Sets the ask price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int AskPlayback(string instrument, double price, int size, string timestamp)
Sets the ask price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double AvgEntryPrice(string instrument, string account)
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Gets the average entry price for the specified instrument/account combination.

double AvgFillPrice(string orderId)
Gets the average entry price for the specified orderId.

int Bid(string instrument, double price, int size)
Sets the bid price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int BidPlayback(string instrument, double price, int size, string timestamp)
Sets the bid price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double BuyingPower(string account)
Gets the buying power for the specified account. *Not all brokerage technologies support this
value.

double CashValue(string account)
Gets the cash value for the specified account. *Not all brokerage technologies support this
value.

int Command(string command, string account, string instrument, string action, int
quantity, string orderType, double limitPrice, double stopPrice,
        string timeInForce, string oco, string orderId, string strategy, string strategyId
)
Function for submitting, cancelling and changing orders, positions and strategies. Refer to
the Commands and Valid Parameters section for detailed information. A return value of 0
indicates success and -1 indicates an error. The Log tab will list context sensitive error
information.

int ConfirmOrders(int confirm)
The parameter confirm indicates if an order confirmation message will appear. This toggles
the global option that can be set manually via NinjaTrader Control Center Tools-->Options,
"Confirm order placement" checkbox. A value of 1 sets this option to true, any other value
sets this option to false.

int Connected(int showMessage)
Returns a value of zero if the DLL has established a connection to the NinjaTrader server
(application) and if the ATI is currently enabled or, -1 if it is disconnected. Calling any
function in the DLL will automatically initiate a connection to the server. The parameter
showMessage indicates if a message box is displayed in case the connection can not be
established. A value of 1 = show message box, any other value = don't show message box.

int Filled(string orderId)
Gets the number of contracts/shares filled for the orderId.

int Last(string instrument, double price, int size)
Sets the last price and size for the specified instrument. A return value of 0 indicates success
and -1 indicates an error.

int LastPlayback(string instrument, double price, int size, string timestamp)
Sets the last price and size for the specified instrument for use when synchronizing
NinjaTrader playback with an external application playback. A return value of 0 indicates
success and -1 indicates an error. The timeStamp parameter format is "yyyyMMddhhmmss".

double MarketData(string instrument, int type)
Gets the most recent price for the specified instrument and data type. 0 = last, 1 = bid, 2 =
ask. You must first call the SubscribeMarketData() function prior to calling this function.
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int MarketPosition(string instrument, string account)
Gets the market position for an instrument/account combination. Returns 0 for flat, negative
value for short positive value for long.

string NewOrderId()
Gets a new unique order id value.

string Orders(string account)
Gets a string of order ids of all orders of an account separated by '|'. *If a user defined order
id was not originally provided, the internal token id value is used since it is guaranteed to be
unique.

string OrderStatus(string orderId)
Gets the order state (see definitions) for the orderId. Returns an empty string if the order id
value provided does not return an order.

double RealizedPnL(string account)
Gets the realized profit and loss of an account.

int SetUp(string host, int port)
Optional function to set the host and port number.  By default, host is set to "localhost" and
port is set to 36973. The default port number can be set via the General tab under Options. If
you change these default values, this function must be called before any other function. A
return value of 0 indicates success and -1 indicates an error.

string StopOrders(string strategyId)
Gets a string of order ids of all stop loss orders of an ATM strategy separated by '|'. Internal
token id value is used since it is guaranteed to be unique.

string Strategies(string account)
Gets a string of strategy ids of all ATM strategies of an account separated by '|'. Duplicate ID
values can be returned if strategies were initiated outside of the ATI. 

int StrategyPosition(string strategyId)
Gets the position for a strategy. Returns 0 for flat, negative value for short and positive value
for long.

int SubscribeMarketData(string instrument)
Starts a market data stream for the specific instrument. Call the MarketData() function to
retrieve prices. Make sure you call the UnSubscribeMarketData() function to close the data
stream. A return value of 0 indicates success and -1 indicates an error.

string TargetOrders(string strategyId)
Gets a string of order ids of all profit target orders of an ATM strategy separated by '|'.
Internal token id value is used since it is guaranteed to be unique.

int TearDown()
Disconnects the DLL from the NinjaTrader server. A return value of 0 indicates success and -1
indicates an error.

int UnsubscribeMarketData(string instrument)
Stops a market data stream for the specific instrument. A return value of 0 indicates success
and -1 indicates an error.

-o-

C# Sample Application
A C# sample application is located in C:\Program Files\<NinjaTrader Installation
Folder>\bin\AutoTrade\NinjaTraderCSharpSampleApplication.zip
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eSignal Integration

eSignal Integration
NinjaTrader installs an EFS script that contains a set of convenience functions that uses the
DLL interface for trade automation. These functions provide order submission, modification
and cancellation capabilities, global operation capabilities and strategy initiation and
management capabilities. You can execute trades from within an eSignal indicator/formula on
the tick that the trade signal occurred.

-o-

Set Up
You can view the sample script by following the instructions below.

- Copy the file C:\Program Files\NinjaTrader Installation Folder\bin\AutoTrade\NTSample.efs
- To the folder <eSignal Installation Folder>\Formulas\Download
- In eSignal, right click on chart and select the menu Formula > Download > NTSample

-o-

eSignal Functions
*Submitting an account value is optional. If no account value is passed in as an argument,
pass in empty string "" and the default account is used as specified under the ATI tab.

Data Retrieval Functions

double NTAvgEntryPrice(string acccount)
Gets the average entry price for the selected instrument/account combination.

double NTAvgFillPrice(string orderId)
Gets the average fill price of an order.

bool NTConnected(int showMessage)
Gets the current connection state of the ATI. Returns true when connected, false when
disconnected. The parameter showMessage indicates if a message box is displayed in case the
connection can not be established. A value of 1 = show message box, any other value = don't
show message box.

int NTFilled(string orderId)
Gets the number of contracts/shares filled for the orderId.

int NTMarketPosition(string account)
Gets the market position for the selected instrument/account combination. Returns 0 for flat,
negative for short and positive for long.

string NTNewOrderId()
Gets a unique order id.

string NTOrders(string account)
Gets a string of order ids of all orders of an account separated by '|'. *If a user defined order
id was not originally provided, the internal token id value is used since it is guaranteed to be
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unique.

string NTOrderStatus(string orderId)
Gets the order state (see definitions) for the orderId. Returns an empty string if the order id
value provided does not return an order.

double NTRealizedPnL(string account)
Gets the realized profit and loss of an account.

string NTStopOrders(string strategyId)
Gets a string of order ids of all stop loss orders of an ATM strategy separated by '|'. Internal
token id value is used since it is guaranteed to be unique.

string NTStrategies(string account)
Gets a string of strategy ids of all ATM strategies of an account separated by '|'. Duplicate ID
values can be returned if strategies were initiated outside of the ATI. 

string NTStrategyPosition(string strategyId)
Gets the position of a strategy. Returns 0 for flat, negative for short and positive for long.

string TargetOrders(string strategyId)
Gets a string of order ids of all profit target orders of an ATM strategy separated by '|'.
Internal token id value is used since it is guaranteed to be unique.

Global Functions

int NTCancelAllOrders()
Cancels all orders across all connections across all accounts. A return value of 0 indicates
success and -1 indicates an error. Success indicates success in submitting the command NOT
that all orders are in fact cancelled.

int NTCommand(string command, string account, string action, int quantity, string
orderType, double limitPrice, double stopPrice,
        string timeInForce, string oco, string orderId, string strategy, string strategyId
)
Function for submitting, cancelling and changing orders, positions and strategies. Refer to
the Commands and Valid Parameters section for detailed information. A return value of 0
indicates success and -1 indicates an error. The Log tab will list context sensitive error
information.

int NTConfirmOrders(int enable)
Enables order confirmation dialog box. 0 = false, 1 = true. This is a global NinjaTrader setting
that can be also set via the Control Center window Tools-->Options menu.

int NTClosePosition(string account)
Closes the selected instrument/account position. A return value of 0 indicates success and -1
indicates an error. Success indicates success in submitting the command NOT that the
position has in fact been closed.

int NTFlattenEverything()
Closes all positions and cancels all orders across all connections across all accounts. A return
value of 0 indicates success and -1 indicates an error. Success indicates success in submitting
the command NOT that all orders are in fact cancelled and all positions are in fact closed.

Order Modification Functions

int NTCancel(string orderId)
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Cancels an order by orderId.  A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order has in fact been
cancelled.

int NTChange(string orderId, int quantity, double limitPrice, double stopPrice)
Change and order by orderId. If you want to change an order that was automatically
submitted by an internal NinjaTrader strategy, use the intCommand function and pass in the
strategyId and order name (STOP1 or TARGET1 etc) via the orderId parameter. A return value
of 0 indicates success and -1 indicates an error. Success indicates success in submitting the
command NOT that the order has in fact been changed.

Order Placement Functions

* Submitting an orderId value is optional. Optionally leave it to empty string "".

int NTBuyLimit(string orderId, int quantity, double limitPrice)
Sends a buy limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTBuyMarket(string orderId, int quantity)
Sends a buy market order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTBuyStop(string orderId, int quantity, double stopPrice)
Sends a buy stop order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTBuyStopLimit(string orderId, int quantity, double limitPrice, double stopPrice)
Sends a buy stop limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellLimit(string orderId, int quantity, double limitPrice)
Sends a sell limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellMarket(string orderId, int quantity)
Sends a sell market order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellStop(string orderId, int quantity, double stopPrice)
Sends a sell stop order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellStopLimit(string orderId, int quantity, double limitPrice, double stopPrice)
Sends a sell stop limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.
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eSignal Sample Code
The following EFS sample strategy "NTSample" is located in the <NinjaTrader installation
folder>\bin\AutoTrade\NTSample.efs folder. This sample is intended demonstrate the use of
NinjaTrader functions in EFS and NOT to illustrate any best practice or approach in function
implementations. 
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/* Copyright (c) 2005, NinjaTrader LLC ninjatrader@ninjatrader.com. All rights
reserved. */ 

var dll         = new DLL("NtDirect.dll");
var orderPlaced = false;
var printDone   = false;

function preMain() 
{ 
    setPriceStudy(true);
    setStudyTitle("NT Sample"); 
    dll.addFunction("AvgEntryPrice",    DLL.DOUBLE, DLL.STDCALL, "AvgEntryPrice",
DLL.STRING, DLL.STRING);
    dll.addFunction("AvgFillPrice",     DLL.DOUBLE, DLL.STDCALL, "AvgFillPrice", DLL.STRING,
DLL.STRING);
    dll.addFunction("BuyingPower", DLL.String, DLL.STDCALL, "BuyingPower", DLL.DOUBLE);
    dll.addFunction("CashValue", DLL.String, DLL.STDCALL, "CashValue", DLL.DOUBLE);
    dll.addFunction("Command",          DLL.INT, DLL.STDCALL, "Command", DLL.STRING,
DLL.STRING, DLL.STRING, DLL.STRING, DLL.INT, DLL.STRING, DLL.DOUBLE, 
                                            DLL.DOUBLE, DLL.STRING, DLL.STRING, DLL.STRING,
DLL.STRING, DLL.STRING);
    dll.addFunction("ConfirmOrders",        DLL.INT, DLL.STDCALL, "ConfirmOrders", DLL.INT);
    dll.addFunction("Connected",        DLL.INT, DLL.STDCALL, "Connected", DLL.INT);
    dll.addFunction("Filled",           DLL.INT, DLL.STDCALL, "Filled", DLL.STRING,
DLL.STRING);
    dll.addFunction("MarketPosition",   DLL.INT, DLL.STDCALL, "MarketPosition", DLL.STRING,
DLL.STRING);
    dll.addFunction("NewOrderId",       DLL.STRING, DLL.STDCALL, "NewOrderId");
    dll.addFunction("Orders",                    DLL.STRING, DLL.STDCALL, "Orders",
DLL.STRING);
    dll.addFunction("OrderStatus",      DLL.STRING, DLL.STDCALL, "OrderStatus",
DLL.STRING, DLL.STRING);
    dll.addFunction("RealizedPnL",                    DLL.STRING, DLL.STDCALL, "RealizedPnL",
DLL.DOUBLE);
    dll.addFunction("SetUp",            DLL.INT, DLL.STDCALL, "SetUp", DLL.STRING, DLL.INT);
    dll.addFunction("StopOrders", DLL.STRING, DLL.STDCALL, "StopOrders",
DLL.STRING);
    dll.addFunction("Strategies",     DLL.STRING, DLL.STDCALL, "Strategies", DLL.STRING);
    dll.addFunction("StrategyPosition", DLL.INT, DLL.STDCALL, "StrategyPosition",
DLL.STRING);
    dll.addFunction("TargetOrders", DLL.STRING, DLL.STDCALL, "TargetOrders",
DLL.STRING);
    dll.addFunction("TearDown",         DLL.INT, DLL.STDCALL, "TearDown");
} 

function main() 
{ 
    if (isLastBarOnChart() && NTConnected(1))
    {
        if (!orderPlaced)
        {
            if (NTBuyMarket("MyOrderId", 1) == 0)        // buy 1 unit at market, assign
order id (optionally)
                orderPlaced = true;
        }
        else
        {
            // print some information on the current position and order
            debugPrint("Position size: "    + NTMarketPosition("")              + "\r\n");                
            debugPrint("AvgEntryPrice: "  + NTAvgEntryPrice("")               + "\r\n");
            debugPrint("OrderStatus: "     + NTOrderStatus("MyOrderId")    + "\r\n");
            debugPrint("Filled #: "           + NTFilled("MyOrderId")         + "\r\n");
            debugPrint("AvgFillPrice: "      + NTAvgFillPrice("MyOrderId")   + "\r\n");
            debugPrint("RealizedPnL: " + NTRealizedPnL("") + "\r\n");
        }
    }
}

// Get the average entry price of a position of an account. "account" is optional.
function NTAvgEntryPrice(account) {
    return dll.call("AvgEntryPrice", getSymbol(), account);
}

// Get the average fill price of an order at an account.
function NTAvgFillPrice(orderId) {
    return dll.call("AvgFillPrice", orderId, account);
}

// Get the buying power of an account.
function NTBuyingPower(account) {
    return dll.call("BuyingPower",  account);
}

// Place a buy limit order. "orderId" is optional (set to "" it not applicable).
function NTBuyLimit(orderId, quantity, limitPrice) {
    return NTCommand("Place", "", "Buy", quantity, "Limit", limitPrice, 0, "", "", orderId, "",
"");
}

// Place a buy market order. "orderId" is optional (set to "" it not applicable).
function NTBuyMarket(orderId, quantity) {
    return NTCommand("Place", "", "Buy", quantity, "Market", 0, 0, "", "", orderId, "", "");
}

// Place a buy stop order. "orderId" is optional (set to "" it not applicable).
function NTBuyStop(orderId, quantity, stopPrice){
    return NTCommand("Place", "", "Buy", quantity, "Stop", 0, stopPrice, "", "", orderId, "",
"");
}

// Cancel an order by its order id.
function NTCancel(orderId) {
    return NTCommand("Cancel", "", "", 0, "", 0, 0, "", "", orderId, "", "");
}

// Cancel all orders at all accounts.
function NTCancelAllOrders() {
     return NTCommand("CancelAllOrders", "", "", 0, "", 0, 0, "", "", "", "", "");
}

// Get the cash value of an account.
function NTCashValue(account) {
    return dll.call("CashValue",  account);
}

// Change an order by its order id.
function NTChange(orderId, quantity, limitPrice, stopPrice) {
    return NTCommand("Change", "", "", quantity, "", limitPrice, stopPrice, "", "", orderId, "",
"");
}

// Close any position of the current instrument at an account. "account" is optional
(set to "" it not applicable).
function NTClosePosition(account) {
    return NTCommand("ClosePosition", account, "", 0, "", 0, 0, "", "", "", "", "");
}

// Submits a NinjaTrader command.
function NTCommand(command, account, action, quantity, orderType, limitPrice, stopPrice,
timeInForce, oco, orderId, template, strategy) {
    return dll.call("Command", command, account, getSymbol(), action, quantity, orderType, 
                        limitPrice, stopPrice, timeInForce, oco, orderId, template, strategy);
}

// Indicates if the connection to NinjaTrader is established. 0 = connected, -1 not
connected.
function NTConnected() {
    return (dll.call("Connected") == 0)
}

// Get the filled of an order at an account.
function NTFilled(orderId) {
    return dll.call("Filled", orderId, account);
}

// Close all positions and cancels all order at all account.
function NTFlattenEverything() {
    return NTCommand("FlattenEverything", "", "", 0, "", 0, 0, "", "", "", "", "");
}

// Get a double value by its name.
function NTGetDouble(name) {
    return dll.call("GetDouble", name);
}

// Get an integer value by its name.
function NTGetInt(name) {
    return dll.call("GetInt", name);
}

// Get a string value by its name.
function NTGetString(name) {
    return dll.call("GetString", name);
}

// Get the market position of the current instrument at na account. "account" is
optional (set to "" it not applicable).
function NTMarketPosition(account) {
    return dll.call("MarketPosition", getSymbol(), account);
}

// Get a new unqiue order id.
function NTNewOrderId() {
    return dll.call("NewOrderId");
}

// Gets a string of order ids of all orders of an account separated by '|'. If a user
defined order id was not originally provided, the internal token id 
// value is used since it is guaranteed to be unique.
function NTOrders(account) {
    return dll.call("Orders", account);
}

// Get the current status of an order. 
function NTOrderStatus(orderId) {
    return dll.call("OrderStatus", orderId, account);
}

// Get the realized P&L of an account. 
function NTRealizedPnL(account) {
    return dll.call("RealizedPnL", account);
}

// Place a sell limit order. "orderId" is optional (set to "" it not applicable).
function NTSellLimit(orderId, quantity, limitPrice) {
    return NTCommand("Place", "", "Sell", quantity, "Limit", limitPrice, 0, "", "", orderId, "",
"");
}

// Place a sell market order. "orderId" is optional (set to "" it not applicable).
function NTSellMarket(orderId, quantity) {
    return NTCommand("Place", "", "Sell", quantity, "Market", 0, 0, "", "", orderId, "", "");
}

// Place a sell stop order. "orderId" is optional (set to "" it not applicable).
function NTSellStop(orderId, quantity, stopPrice) {
    return NTCommand("Place", "", "Sell", quantity, "Stop", 0, stopPrice, "", "", orderId, "",
"");
}

// Place a sell stop limit order. "orderId" is optional (set to "" it not applicable).
function NTSellStopLimit(orderId, quantity, limitPrice, stopPrice) {
    return NTCommand("Place", "", "Sell", quantity, "StopLimit", limitPrice, stopPrice, "", "",
orderId, "", "");
}

// Get a string of order IDs of all stop orders of a strategy separated by '|'.
function NTStopOrders(strategyId) {
    return dll.call("StopOrders", strategyId);
}

// Gets a string of strategy IDs of all strategies of an account separated by '|'.
Duplicate ID values can be returned if strategies were initiated outside of the ATI. 
function NTStrategies(account) {
    return dll.call("Strategies", account);
}

// Get the position of a strategy.
function NTStrategyPosition(strategyId) {
    return dll.call("StrategyPosition", strategyId);
}

// Get a string of order IDs of all target orders of a strategy separated by '|'.
function NTTargetOrders(strategyId) {
    return dll.call("TargetOrders", strategyId);
}
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-o-

eSignal Tips
1. Via the Tools-->Options, Misc tab accessible from the Control Center window you can set a
default account. You can optionally leave the account parameters empty in any of the  
eSignal NinjaTrader functions and NinjaTrader will use the default account set here.

2. To ensure you do not place duplicate orders in the event that a eSignal chart reloads you
can check for the condition "isLastBarOnChart()"

3. You can check NTMarketPosition for a flat position before placing an order

4. You can create an orderId using the current bar time stamp + instrument name. Before
placing an order, call NTOrderStatus and see if you get a valid return value. If yes, then the
the signal has already been processed. 

-o-

TradeStation Integration

Email Interface

Overview
The TradeStation Email Interface is targeted to individuals who are not familiar with
programming in Easy Language and want to run TradeStation strategies and automate order
flow to any supported NinjaTrader broker. The interface works as follows:

1. You apply a strategy in your TradeStation chart that generates buy/sell orders
2. TradeStation will send email notification for Strategy Orders Activated, Filled, Cancelled
and Replaced to NinjaTrader
3. NinjaTrader will process these emails and execute them as orders either to the NinjaTrader
simulator or your live brokerage account

-o-

Symbol Mapping
Please see the TradeStation Symbol Mapping section.

-o-

Running concurrent strategies in the same market
NinjaTrader uses a number of different properties of the TradeStation generated email to
identify unique orders as they are sent to NinjaTrader.

They are:

 Instrument name
 Action (Buy, Sell etc...)
 Signal name
 Workspace name
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If you are running concurrent strategies on the same market you should ensure that you
either -

 Make all signal names unique or
 Run the concurrent strategies in different TradeStation workspaces

This will ensure accurate processing of your automated signals.

-o-

Set Up
The following set up is for TradeStation Version 8.XX

Setting Up NinjaTrader

1. Start NinjaTrader
2. Select the Tools-->Options menu from the Control Center window
3. Select the ATI tab

4. Set the default account to Sim101 (you can always set this to your live brokerage account
later but we recommend leaving it to Sim101)
5. Check "Enable SMTP server" option
6. Set your Order Handling options
7. Set your Stop Order Handling options
6. Connect to your broker via File-->Connect within the Control Center window (make sure
you have set up a connection to your broker)
7. Enable the Automated Trading Interface via File-->AT Interface within the Control Center
window (a pale green "ATI" will light up in lower right hand corner of the Control Center
window)

Symbol Mapping For Futures Contracts (Stocks and Forex traders may skip this step)

8. Set your symbol mapping for futures contracts
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Setting Up AntiVirus Software

9. Antivirus software which scans outgoing emailing can impair the link between TradeStation
and NinjaTrader. If your PC has AntiVirus software installed and scans outgoing mail, each
mail notification sent from TradeStation to NinjaTrader will be scanned and therefore add
significant delay in automatically processing your trading signals. Please consult your
AntiVirus software Help Guide to determine how to disable the scanning of outgoing email.

Setting Up TradeStation Workspace

10. Start TradeStation
11. Set up your workspace options

Setting Up TradeStation Email Notification

12. Add a TradeManager window to your workspace by clicking on the icon on the left pane as
per the image below

13. Click once on the TradeManager window that appears then select from the TradeStation
main menu View-->TradeManager preferences
14. Select the "Notification" tab as per the image below and select "Strategy Active Order"
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15. Press the "Configure..." button to bring up the "Messaging" window as show below
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16. Enter the information exactly as shown above in items 1 through 4; you can press "Test"
button which will send a test message to NinjaTrader and show up in the Control Center Log
tab. If you receive an error when attempting to send a test message, please ensure
that you have no other SMTP server running on your PC and make sure that any
competetive product is uninstalled.
17. Press "OK"
18. Repeat steps 15 through 17 for "Strategy Canceled Order", "Strategy Filled Order" and
"Strategy Replaced Order"

Setting Up a TradeStation Strategy

19. Open a chart(s) of the instrument that you will run your strategy on
20. Right click in the chart and select the menu "Insert Strategy..." and select a strategy

21. Your strategy will appear in the "Format Analysis Techniques & Strategies" window as
show above
22. Check the "Generate strategy orders for display in TradeManager's Strategy Orders tab"
box and press "Close"

* Following this set up procedure, orders will NOT be sent to any live TS brokerage account,
only to NinjaTrader.

That's it! Your strategy will now be automated for execution through NinjaTrader.

-o-

Order Handling Options
Via the Tools-->Options, ATI Tab you can set the following order handling options:
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Submit market order on TS fill
Submits a market order when NinjaTrader receives a "strategy filled order" notification email
from TradeStation. This is the recommended option.

Submit "as-is"
Submits orders as specified (limit, market, stop, stop limit) when NinjaTrader receives a
"strategy active order" notification email from TradeStation. Upon receiving the subsequent
"strategy filled order" notification email from TradeStation, NinjaTrader will convert any
unfilled shares/contracts to either market order or marketable limit order (substantially higher
than inside market if buying or below market if selling) depending on the instrument type
after a user defined number of seconds.

NOTE: If trading currencies (Forex) it is advised to start a market data stream (any order
entry window) for the market you are trading. Since limit buy orders above the offer or limit
sell below the bid are invalid orders that are rejected from your broker, NinjaTrader will check
the TradeStation requested limit price against the current market price and if it would result
in a rejected order, it will convert to a market order. 

Submit and forget
Submits orders as specified (limti, market stop, stop limit) when NinjaTrader receives a
"strategy active order" notification. There is a high probability that your TradeStation strategy
position size will be out of synchronization with your live brokerage account using this option.
It requires manual user interaction and is NOT recommended.

Synchronization Time Out
Excluding the "Submit and forget" option, NinjaTrader will notify you after the specified
number of seconds if an order is out of sync with TradeStation's reported order fill amount. An
example would be if TradeStation reported a market order fill of 1 contract, NinjaTrader
submits a market order but the order is not filled for some reason after the the specified
amount of time, you will be notified.

Order Confirmation
You can choose to have NinjaTrader prompt you for approval before submitting your order to
your brokerage account. You can enable this via the Tools-->Options, General Tab "Confirm
order placement".

Special Handling for FX Through GAIN Capital/FOREX.com
GAIN will reject a limit order to buy at the offer or above or to sell at the bid or below.
NinjaTrader can check the current market rate on limit order submission and automatically
convert to market if the limit price is invalid according to GAIN but in your favor resulting in a
fill. To have NinjaTrader check for these conditions, you must be subscribed to rate data for
the currency pair being traded. We suggest opening a Market Analyzer window via the File-->
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New menu and adding all traded currency pairs to this grid. This ensures that there is
available rate data for NinjaTrader to cross check an incoming limit price against.

-o-

Stop Order Handling
Via the Tools-->Options, ATI Tab you can set the following stop order handling options:

If you have "Submit market order on TS fill" enabled via Order Handling Options, the
following Stop Order Handling is ignored.

Submit "as-is"
Submits the stop order as specified.

Convert to stop limit
Will convert a stop order to a stop limit order. The limit price is calculated based on the user
defined "Limit price offset as ticks" value.

Convert to simulated stop market
Submits a simulated stop market order which is a local PC held order that submits a market
order once the stop price is hit.

Submit market order if stop order was rejected
Submits a market order in the event that a stop order is rejected for any reason. 

Behavior as follows:

1. Stop order worse than current last traded price --> Market order submitted (desired
outcome)

2. Stop order rejected due to insufficient funds --> Market order submitted and also rejected 
(not desired but no risk)

3. Stop order rejected due to price outside of range --> Market order submitted and likely
filled (risky)

4. Stop order rejected due to limit price worse than stop price --> Market order submitted
and likely filled (risky)

DISCLAIMER: If this option is enabled, it is your responsibility to ensure that your TS
EL code is sending valid stop prices to NinjaTrader otherwise you risk getting filled
when you may not want to.

-o-

Workspace Options
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Creating a workspace within TradeStation with the corrrect naming convention is critical to
enabling TradeStation to properly communicate with NinjaTrader.

*You may have multiple charts/strategies running in a single workspace

Creating a New TradeStation Workspace
From within TradeStation, you can create a new workspace by selecting the menu
File-->New-->Workspace. This will create an untitled workspace in TradeStation. You must
then select the menu File-->Save Workspace As... and provide a workspace name following
the naming conventions below.

Workspace Naming Convention Functions
The workspace name must contain "NinjaTrader;" without the quotations otherwise
NinjaTrader will NOT process any trade signals received from TradeStation.

Account Name
You can optionally add your brokerage account name(s) to the workspace name to identify an
account that NinjaTrader will route orders to. If the account name is missing NinjaTrader will
route orders to the default account set in Tools-->Options, ATI, General tab. The account
name must be specified as 
"Account=YourAccount" without quotations and where YourAccount is the name/number of
your brokerage account.

Multiple Accounts
You can add multiple accounts in the workspace name to inform NinjaTrader to replicate the
TradeStation order across more than one account. Add a comma "," withough the quotations
after each account name. For example; "Account=Account1,Account2"

Quantity Multiplier
You can optionally associate a quantity multiplier with each account that you have specified in
the workspace name. This optional value will be multiplied by the TradeStation's strategy
quantity amount. For example; if your TradeStation strategy has a quantity amount of 1
contract and you want to trade 2 contracts 
and you do not want to modify this amount in the strategy itself you can add "=2" after the
account name in the workspace which would multiple the strategy contract amount by a
factor of 2. The text would look like "Account=YourAccount=2"

Aliases - Chart Instrument "A" --> Execute Orders in Instrument "B"
You can redirect orders to a different instrument than the instrument that your TradeStation
strategy is actually running on. For example, you can run a strategy on $SPX.X but have
orders actually placed to the S&P Emini contract. The text would look like "
Map=$SPX.X,ESH07" where $SPX.X is the TradeStation chart instrument followed by a
comma and then ESH07 which is the S&P Emini March 2007 contract which is the contract
that will be traded. Since you can have multiple charts running in a workspace, you can add
multiple mapping relationships. For example "Map=$SPX.X,ESH07,$COMPX,MSFT" would
map the $SPX.X to ESHO7 and $COMPX would map to MSFT.

Workspace Name Examples
Following are samples of valid TradeStation workspace names. Remember, separate functions
with a semi colon ";".

The following workspace name routes orders to the Default account specified under Tools -->
Options --> ATI tab
NinjaTrader

The following workspace name routes orders to account # 1235
NinjaTrader;Account=1235
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The following workspace name routes an order to account #7777 and another order to
account #1311 with the original strategy quantity multiplied by a factor of 2
NinjaTrader;Account=7777,1311=2

The following workspace name routes orders to account #123 and maps trade signals
generated by the $SPX.X chart to the S&P Emini March 2007 contract
NinjaTrader;Account=123;Map=$SPX.X,ESH07

Multiple Workspaces
You may create multiple workspaces provided that they each contain "NinjaTrader;" without
the quotations in their name. For example, you could have two workspaces named   
"NinjaTrader1;" and "NinjaTrader2;"

-o-

DLL Based Integration

Overview
DLL based integration is targeted for system developers who are familiar with Easy Language
and have basic programming experience. NinjaTrader installs an Easy Language script that
contains a set of convenience functions that uses the DLL interface for trade automation.
These functions provide order submission, modification and cancellation capabilities, global
operation capabilities and strategy initiation and management capabilities. You can execute
trades from within a TradeStation indicator on the tick that the trade signal occurred.
NinjaTrader also provides a script for driving TradeStation market data to NinjaTrader. See
the Connecting to TradeStation Data Feed for more details.

-o-

Set Up
Following is the installation procedure for installing the TradeStation EasyLanguage
NinjaTrader functions.

1. NinjaTrader must be installed
2. Start TradeStation
3. Select the menu File-->Import/Export EasyLanguage
4. Select "Import EasyLanguage file (ELD, ELS or ELA)"
5. Click "Next"
6. Select the file <NinjaTrader Installation Folder>\bin\AutoTrade\NINJATRADER.ELD"
7. Click "Next"
8. Click "Next"
9. Click "Finish" and confirm any upcoming query box by clicking "OK"
10. When you actually start creating EL scripts that communicate with NinjaTrader, ensure
that Automated Trading is enabled from within NinjaTrader via the File menu

A collection of NinjaTrader functions and a sample strategy named "NTSample" are imported
and ready to be used.

-o-

TradeStation Functions
*Submitting an account value is optional. If no account value is passed in as an argument,
pass in empty string "" and the default account is used as specified under the ATI tab.
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Data Retrieval Functions

double NTAvgEntryPrice(string acccount)
Gets the average entry price for the selected instrument/account combination.

double NTAvgFillPrice(string orderId)
Gets the average fill price of an order.

bool NTConnected(int showMessage)
Gets the current connection state of the ATI. Returns true when connected, false when
disconnected. The parameter showMessage indicates if a message box is displayed in case the
connection can not be established. A value of 1 = show message box, any other value = don't
show message box.

int NTFilled(string orderId)
Gets the number of contracts/shares filled for the orderId/account combination.

int NTMarketPosition(string account)
Gets the market position for the selected instrument/account combination. Returns 0 for flat,
negative for short and positive for long.

string NTNewOrderId
Gets a unique order id.

string NTOrders(string account)
Gets a string of order ids of all orders of an account separated by '|'. *If a user defined order
id was not originally provided, the internal token id value is used since it is guaranteed to be
unique.

string NTOrderStatus(string orderId)
Gets the order state (see definitions) for the orderId. Returns an empty string if the order id
value provided does not return an order.

double NTRealizedPnL(string account)
Gets the realized profit and loss of an account.

string NTStopOrders(string strategyId)
Gets a string of order ids of all stop loss orders of an ATM strategy separated by '|'. Internal
token id value is used since it is guaranteed to be unique.

string NTStrategies(string account)
Gets a string of strategy ids of all ATM strategies of an account separated by '|'. Duplicate ID
values can be returned if strategies were initiated outside of the ATI. 

string NTStrategyPosition(string strategyId)
Gets the position of a strategy. Returns 0 for flat, negative for short and positive for long.

string TargetOrders(string strategyId)
Gets a string of order ids of all profit target orders of an ATM strategy separated by '|'.
Internal token id value is used since it is guaranteed to be unique.

Global Functions

int NTCancelAllOrders
Cancels all orders across all connections across all accounts. A return value of 0 indicates
success and -1 indicates an error. Success indicates success in submitting the command NOT
that all orders are in fact cancelled.
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int NTCommand(string command, string account,  string action, int quantity, string
orderType, double limitPrice, double stopPrice,
        string timeInForce, string oco, string orderId, string strategy, string strategyId
)
Function for submitting, cancelling and changing orders, positions and strategies. Refer to
the Commands and Valid Parameters section for detailed information. A return value of 0
indicates success and -1 indicates an error. The Log tab will list context sensitive error
information.

int NTConfirmOrders(int enable)
Enables order confirmation dialog box. 0 = false, 1 = true. This is a global NinjaTrader setting
that can be also set via the Control Center window Tools-->Options menu.

int NTClosePosition(string account)
Closes the selected instrument/account position. A return value of 0 indicates success and -1
indicates an error. Success indicates success in submitting the command NOT that the
position has in fact been closed.

int NTFlattenEverything
Closes all positions and cancels all orders across all connections across all accounts. A return
value of 0 indicates success and -1 indicates an error. Success indicates success in submitting
the command NOT that all orders are in fact cancelled and all positions are in fact closed.

Order Modification Functions

int NTCancel(string orderId)
Cancels an order by orderId.  A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order has in fact been
cancelled.

int NTChange(string orderId, int quantity, double limitPrice, double stopPrice)
Change and order by orderId. If you want to change an order that was automatically
submitted by an internal NinjaTrader strategy, use the intCommand function and pass in the
strategyId and order name (STOP1 or TARGET1 etc) via the orderId parameter. A return value
of 0 indicates success and -1 indicates an error. Success indicates success in submitting the
command NOT that the order has in fact been changed.

Order Placement Functions

* Submitting an orderId value is optional. Optionally leave it to empty string "".

int NTBuyLimit(string orderId, int quantity, double limitPrice)
Sends a buy limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTBuyMarket(string orderId, int quantity)
Sends a buy market order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTBuyStop(string orderId, int quantity, double stopPrice)
Sends a buy stop order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTBuyStopLimit(string orderId, int quantity, double limitPrice, double stopPrice)
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Sends a buy stop limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellLimit(string orderId, int quantity, double limitPrice)
Sends a sell limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellMarket(string orderId, int quantity)
Sends a sell market order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellStop(string orderId, int quantity, double stopPrice)
Sends a sell stop order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

int NTSellStopLimit(string orderId, int quantity, double limitPrice, double stopPrice)
Sends a sell stop limit order. A return value of 0 indicates success and -1 indicates an error.
Success indicates success in submitting the command NOT that the order was successfully
submitted.

-o-

TradeStation Sample Code
The following EasyLanguage sample strategy "NTSample" is installed during the set up
procedure. This sample is intended to demonstrate the use of NinjaTrader functions in
EasyLanguage and NOT to illustrate any best practice or approach in function
implementations. 
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{ Copyright (c) 2005, NinjaTrader LLC ninjatrader@ninjatrader.com }

inputs: FastLength(9), SlowLength(18) ;
variables: FastAvg(0), SlowAvg(0), Success(0);

if LastBarOnChart and NTConnected(1) then begin
       if NTMarketPosition("") = 0 then begin
               { place an order, if there is no position yet }
               if AverageFC(Close, FastLength) > AverageFC(Close, SlowLength) then begin
                         Success = NTBuyMarket("MyOrderId", 1); { buy 1 unit at market, assign
order id (optionally) }
               end else begin
                         Success = NTSellMarket("MyOrderId", 1); { sell 1 unit at market, assign
order id (optionally) }
               end;
       end else begin
               { print some information on the current position and order }
               Print("Position size: " + NumToStr(NTMarketPosition(""), 0)); 
               Print("AvgEntryPrice: " + NumToStr(NTAvgEntryPrice(""), 2));
               Print("OrderStatus: " + NTOrderStatus("MyOrderId"));
               Print("Filled #: " + NumToStr(NTFilled("MyOrderId"), 0));
               Print("AvgFillPrice: " + NumToStr(NTAvgFillPrice("MyOrderId"), 2));
       end;
end;

-o-

Running NT on a different PC than TS
You can run NinjaTrader on different PC than where TradeStation is running via the DLL
interface only.

1. Define the SetUp function by adding the following line to your EL script:

DefineDLLFunc:  "NtDirect.dll", int, "SetUp", lpstr, int

2.  You must call the SetUp function before calling any other DLL function. Following is
sample code on how to accomplish this.

if CurrentBar = 1 then begin
    SetUp("remote-machine-name-or-ip", 36973);
end;

Where remote-machine-name-or-ip is the name or IP address of your PC.

* You can see the NTExternalFeed strategy for an example.

-o-

TradeStation Tips
1. Via the Tools-->Options, Misc tab accessible from the Control Center window you can set a
default account. You can optionally leave the account parameters empty in any of the 
TradeStation NinjaTrader functions and NinjaTrader will use the default account set here.
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2. To ensure you do not place duplicate orders in the event that a TradeStation chart reloads
you can check for the condition "LastBarOnChart"

3. You can check NTMarketPosition for a flat position before placing an order

4. You can create an orderId using the current bar time stamp + instrument name. Before
placing an order, call NTOrderStatus and see if you get a valid return value. If yes, then the
the signal has already been processed.

-o-

Running Live NinjaScript Strategies

Overview
The following section explains how to automate a NinjaScript Strategy. Please keep in mind
that a strategies real-time performance can and will vary from your backtested results.

-o-

Setting Real-Time Strategy Options
Prior to running a NinjaScript Strategy against a live account, you must first understand and
set the real-time handling options for a NinjaScript strategy. These options can be found
under Tools > Options > Strategies tab.

-o-

You can run a NinjaScript strategy in real-time in a live or simulation account. Following are
some key points and instructions on on how to run a NinjaScript strategy from a chart.

 NinjaTrader MUST be connected to a live brokerage or market data vendor
 Strategy menu options will NOT appear if not connected live
 You can not run Chart Trader on a chart while you have a running strategy applied to the

chart
 On terminating (stop running) a strategy, all strategy generated trade markers or draw

objects will be removed from the chart
 A NinjaScript Strategy is a self contained automated trading system and orders generated

are live and not virtual. Cancelling strategy generated orders manually can cause your
strategy to stop executing as you designed it. If you want to manually cancel an order,
terminate the strategy itself.

 Running and terminated strategies for the session are also displayed in the Control Center
window Strategies tab

 If running an FX strategy please review the "Running FX Strategies" section for critical
information

1. Within the NinjaTrader Control Ceneter window, open a a chart via File > New > Chart and
select the instrument, interval type and period that you want to run the strategy on
2. Set Chart Properties to your preferences
3. As per the image below, either select the "Strategies..." menu from within the right mouse
button click context menu, the Strategies icon from the tool bar or press the CTRL-S keys
simultaneously on your keyboard bring up the Strategy dialog window
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4. You can add/remove and set up live strategies from within the Strategy dialog window
pictured below

1. List of availabe strategies
2. List of live strategies currently running on the chart
3. Selected strategy's properties
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5. From the list of available strategies (section 1 in the image above) select a strategy and
either press the "New" button or double click on the strategy
6. Once added to the list of applied strategies (section 2 in the image above), you can now
edit the strategy's properties
7. Set the strategies properties (section 3 in the image above)
8. Press the "OK" button to run the strategy
9. To terminate (stop running) a strategy, you can highlight a running strategy and press the
"Remove" button within the Strategy dialog window 

Property Definitions
Parameters section Sets any strategy specific user defined inputs
Account Sets the account the strategy will execute orders in
Calculate on bar close If true, will only calculate the strategy's value on the close of a bar

else its calculated with each incoming tick
Label Sets a text value that will be displayed on the chart to represent the

strategy
Min. bars required Sets the minimum number of bars required before the backtest will

start processing
Fill type Sets the algorithm for processing and filling orders on the historical

data portion of the chart
Slippage Sets the slippage amount in ticks for the historical portion of the chart
Entries per direction Sets the maximum number of entries allowed per direction while a

position is active based on the "Entry handling" property
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Entry handling Sets the manner in how entry orders are handled. If set to
"AllEntries", the strategy will process all entry orders until the
maximum allowable entries set by the "Entries per direction" property
has been reached while in an open position. If set to "UniqueEntries",
strategy will process entry orders until the maximum allowable entries
set by the "Entries per direction" property per each uniquely named
entry.

Error handling Sets the real-time order error handling
Exit on close When enabled, open positions are closed on the last bar of a session
Exit on close seconds Sets the number of seconds prior to the end of a session that the any

an open position(s) of a strategy is closed
Stop & target
submission

Sets how stop and target orders are submitted

Set order quantity Sets how the order size is determined, options are:
"by default quantity" - User defined order size
"by strategy" - Takes the order size specified programmatically within
the strategy
"by account" - Allows you to set a virtual account value that is used to
determine maximum order size based on margin settings per
instrument set in the Instrument Manager

Time in force Sets the order time in force

-o-

Running a NinjaScript Strategy from Strategies Tab
You can run a NinjaScript strategy in real-time in a live or simulation account. Following are
some key points and instructions on on how to run a NinjaScript strategy from the Strategies
tab of the Control Center window.

 NinjaTrader MUST be connected to a live brokerage or market data vendor
 A NinjaScript Strategy is a self contained automated trading system and orders generated

are live and not virtual. Cancelling strategy generated orders manually can cause your
strategy to stop executing as you designed it. If you want to manually cancel an order,
terminate the strategy itself.

 Strategies initiated from the Strategies tab will NOT appear in a chart
 If running an FX strategy please review the "Running FX Strategies" section for critical

information

1. Within the NinjaTrader Control Ceneter which will bring up the "New Strategy" properties
window
window, select the "Strategies" tab, then click on the right mouse button to bring up the
context menu in the image below and select the "New Strategy..." menu 
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2. Within the "New Strategy" properties window pictured below, select the strategy you wish
to run
3. Select the instrument and interval that you want to run your strategy on
4. Set the amount of historical data required to initialize your strategy and define the session
time
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5. Set the rest of the strategy's properties
6. Press the "OK" button to add the strategy to the Strategies tab grid
7. Press the "Start" button to run the strategy

8. To terminate (stop running) a strategy, press the "Stop" button

Property Definitions
Parameters section Sets any strategy specific user defined inputs
Instrument Sets the instrument the strategy will run on
Type Sets the interval type (Tick bars, minute  bars etc...)
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Value Sets the bar compression value (1 minute bars in the above image)
From Sets the start date for the historical data set
Exclude weekend If true, will exclude weekend data from the historical dataseries
Session begins Starting time of the intraday session for the historical dataseries
Session ends Starting time of the intraday session for the historical dataseries
Account Sets the account the strategy will execute orders in
Calculate on bar close If true, will only calculate the strategy's value on the close of a bar

else its calculated with each incoming tick
Label Sets a text value that will be displayed on the chart to represent the

strategy
Min. bars required Sets the minimum number of bars required before the backtest will

start processing
Fill type Sets the algorithm for processing and filling orders on the historical

data portion of the chart
Slippage Sets the slippage amount in ticks for the historical portion of the chart
Entries per direction Sets the maximum number of entries allowed per direction while a

position is active based on the "Entry handling" property
Entry handling Sets the manner in how entry orders are handled. If set to

"AllEntries", the strategy will process all entry orders until the
maximum allowable entries set by the "Entries per direction" property
has been reached while in an open position. If set to "UniqueEntries",
strategy will process entry orders until the maximum allowable entries
set by the "Entries per direction" property per each uniquely named
entry.

Exit on close When enabled, open positions are closed on the last bar of a session
Exit on close seconds Sets the number of seconds prior to the end of a session that the any

an open position(s) of a strategy is closed
Stop & target
submission

Sets how stop and target orders are submitted

Set order quantity Sets how the order size is determined, options are:
"by default quantity" - User defined order size
"by strategy" - Takes the order size specified programmatically within
the strategy
"by account" - Allows you to set a virtual account value that is used to
determine maximum order size based on margin settings per
instrument set in the Instrument Manager

Time in force Sets the order time in force

-o-

Running FX Strategies
It is important to understand how order quantities behave when running a real-time FX
strategy in a live brokerage account. This is relevant for:

 Currency and point based performance calculations
 Actual order size being submitted to your live brokerage account

Running FX NinjaSript Strategies in the Strategy Analyzer, Simulated Data Feed
Connection or Market Replay
Running an FX strategy in the Strategy Analyzer for a historical backtest, in real-time
connected to either the Simulated Data Feed or Market Replay order quantities will always
represent the total units of the base currency being traded. A lot size of one equals a base
currency unit of one and DOES NOT equal a typical "standard" lot size of 100,000. Therefore,
if you want to trade a standard lot you would use an order quantity of 100,000.
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Running FX NinjaScript Strategies on a Live Brokerage Connection
Running an FX strategy on a live brokerage connection either in a live funded account or a
simulation (Sim101) account order quantities will reflect the lot size convention that your
brokerage trades in. For example, if your brokerage displays a lot size of 1 when reporting an
open position that equals 100,000 units of the base currency (a "standard" lot) then use a
value of 1 to trade 100,000 base units.

CRITICAL
Based on the above information, if you are backtesting in the Strategy Analyzer using order
quantities of 100,000 and you now wish to trade live in your brokerage account where 1 lot is
equal to 100,000 MAKE SURE that you adjust your strategy's order quantity from 100,000 to
1 to ensure you are trading the correct quantity.

-o-

Advanced Trade Management (ATM)

Advanced Strategy Management
Overview
NinjaTrader provides you with flexibility to trade with or without an Advanced Trade
Management (ATM) strategy. ATM is designed to provide discretionary traders with
semi-automated features to manage their positions. This is NOT to be confused with
NinjaScript Strategies for automated trading systems.

What is an ATM Strategy?
Before you enter a trade you already know where you are going to place your profit target or
targets, where you will set your stop loss and how many contracts you will trade. You may
also have rules and conditions for managing your trade such as; once there is 1 point in profit
you will move your stop loss to breakeven and once there is 2 points in profit you will move
your stop loss to protect 1 point in profit. These rules and conditions make up your personal
trade methodology or what we call it, your strategy. In NinjaTrader, an ATM Strategy is a
collection of orders that represent your entries, exits, stops and targets along with
sub-strategies (auto breakeven, auto chase, auto trail etc...) that govern how these orders
are managed. By pre-defining your personal trading strategy in NinjaTrader, you are free to
concentrate on the trade and not on the management of orders and positions. NinjaTrader
does this all for you automatically.

Do I have to use an ATM Strategy?
Absolutely not. NinjaTrader is incredibly flexible in that you can trade independent of an ATM
Strategy and manually submit and manage all of your own orders? You can also choose to
manage a portion of an open position by an ATM Strategy and leave another portion to be
managed independantly. It's completely up to you.

What are the advantages to using an ATM Strategy?
There are several:
 Reduce errors in order management
 Speed (orders are submitted and modified at PC speed instead of human speed)
 Discipline (less prone to applying 'too much' discretion)
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 Consistency with your trading
 Reduces emotions

-o-

ATM Strategy

ATM Strategy Overview
What is an ATM Strategy?
An ATM Strategy is the master strategy that helps you automate the management of a
position. Let's break it down. In trading, a position is defined as the total contracts/shares
held long or short for a specific instrument in a specific account.  An ATM Strategy can be
thought of as:

"A collection of user defined rules/conditions that create and manage a set of stop loss and
profit target orders that are used to govern a portion or an entire open position"

Let's assume the following:

 We want to go long the SP Emini for 5 contracts
 We want a stop loss set 2.5 points from our entry price
 We want a profit target set 5 points from our entry price

We just defined a set of conditions for the management of a 5 contract long position, or in
other words, we just defined an ATM Strategy. The ATM Strategy is the foundation for how
positions (or partial positions) can be managed within NinjaTrader. ATM Strategies can be
defined on the fly or you can pre-define them using templates that can be recalled for later
use in a split second.

The Value of an ATM Strategy
Now that we understand what an ATM Strategy is, what exactly is the value of it? When
trading, one develops ideas and methods for entry and further management of their position.
The management of this position can be simple to complex and everything in between. The
ATM Strategy allows the trader to define the rules and conditions that govern the
management of the position. How many profit targets should there be and at what prices?
What auto trail stop loss setting should be used? When should a stop loss be moved to
breakeven? Should profit target orders chase the market if not filled? Should the stop loss
order trigger immediately on trade through or should NinjaTrader's leading edge simulated
stop order be used? An ATM Strategy also provides a layer of discretionary automation and
intelligence that takes responsibility of mundane order modifications which can be inefficient,
time consuming and error prone. When scaling into a position for example, all of the stop loss
and profit target orders will be automatically updated to reflect the new position size.
Changing order contract sizes will update the distribution of contracts on other orders.
Decrease your 1st profit target order by one contract and your 2nd profit target will
automatically be increased by 1 contract. The bottom line is that a position strategy thinks
the way a trader thinks about managing their trade only 100x faster. It performs a lot of the
routine tasks for you allowing you to concentrate on what matters; the trade itself.

be used? A position strategy also provides a layer of discretionary automation and intelligence
that takes responsibility of mundane order modifications which can be inefficient, time
consuming and error prone. When scaling into a position for example, all of the stop loss and
profit target orders will be automatically updated to reflect the new position size. Changing
order contract sizes will udpate the distribution of contracts on other orders. Decrease your
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1st profit target order by one contract and your 2nd profit target will automatically be
increased by 1 contract. The bottom line is that a position strategy thinks the way a trader
thinks about managing their trade only 100x faster. It performs a lot of the routine taskes for
you allowing you to concentrate on what matters; the trade itself.

-o-

ATM Strategy Parameters
All of our order entry screens house the same control for defining an ATM Strategy.

The Strategy Control List
Icon(1) in the image above references the ATM Strategy control drop down list. This drop
down list is very important to understand as it defines how your orders will be handled once
submitted. There are three main categories of options that will be displayed in this drop down
list;  <None>, <Custom> and strategy template names, and active ATM Strategies.

<None>
When this option is selected, any orders placed in the entry window will not be applied to an
active ATM Strategy nor will it initiate a new ATM strategy.

<Custom> or ATM Strategy Template Names
When an ATM Strategy template name is selected, all of the parameters will update to reflect
your pre-defined ATM Strategy or, when <Custom> is selected, you have the ability to define
a new ATM Strategy on the fly. Once an order is submitted, the ATM Strategy parameters
specified will be initiated when the order is partially or completely filled.

* Active ATM Strategy Names
All active (live and working) ATM Strategies will be displayed. If one is selected, any order
submitted will be applied to the selected active ATM Strategy. For example, if you have an
active ATM Strategy with a stop and target bracket for 1 contract, if you are filled on another
contract, the fill is applied to this ATM Strategy and the stop and target bracket is
automatically updated from 1 contract to 2 contracts.

When it comes to the automatic submission of stop loss and profit targets and how
subsequent order fills are handled, there are two approaches.

1. Scaling into a position or out of a position should automatically update the order sizes of
existing stop and target brackets
2. Scaling into a position should create a new set of stop and target brackets based on the
new order fill price
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If you always want to operate with approach number 1, then you will always want to have the
ATM Strategy control list set to your active ATM Strategy when one exists. This is
accomplished by setting the ATM Strategy Selection Mode to
"SelectActiveATMStrategyOnOrderSubmission". If you would rather have new stop and target
brackets submitted on a new fill, then set the ATM Strategy Selection Mode to
"KeepSelectedATMStrategyTemplateOnOrderSubmission" and the strategy control list will not
automatically set to an active strategy when one is created.

The behavior of the strategy control list can be controlled automatically by selecting a ATM
Strategy Selection Mode.

Stop and Target Parameters
Icon (2) in the image above are parameters that define how many stop loss and target orders
are automatically submitted, what prices they will be submitted at and any stop loss
automation strategies that will be applied such as Auto Trail, Auto Breakeven etc...

Qty Sets the quanity for the stop loss and profit target orders
Stop Loss Sets the value that determines the stop loss price. If the value is set

to 4 (ticks) and your average entry for the initiating order is 1000 and
you are long, your stop loss would be submitted at AvgEntry - Stop
Loss = 1000 - 4 ticks = stop price of 999. This assumes each tick is
valued at 0.25.

Profit Target Sets the value that determines the profit target price. If the value is
set to 4 (ticks) and your average entry for initiating the order is 1000
and you are long, your profit target would be submitted at AvgEntry +
Profit Target = 1000 + 4 ticks = 1001 profit target. This assumes that
each tick is valued at 0.25.

Stop Strategy Sets the stop strategy

Parameters can be entered as ticks, percent or absolute price. To change what parameter
type is used, access the entry window's properties via the right mouse click context menu and
change the "Parameter type" property.

For further reference, please look at the Strategy Examples located within the "ATM Strategy"
section of this help guide.

Advanced Options
Via the right mouse click context menu you can enable the advanced options section of the
ATM Strategy parameters to become visible.

From the advanced section, you can enable a shadow strategy, reverse at target or stop and
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enable auto chase features.

-o-

ATM Strategy Selection Mode
Most of the NinjaTrader order entry screens have three modes that you can set that
determines the behavior of the ATM Strategy selection control list upon submission of an
order that enters the market/initiates an ATM Strategy. You can set this mode via the order
entry screen's Properties dialog window that is accessible via the right mouse click context
menu.

Before reviewing this section you should have a thorough understanding of how the strategy
control list determines what actions (if any) to take when a submitted order is filled. Please
review the video and content in the preceeding page ATM Strategy Parameters.

As a quick reminder, when the strategy control list is selected to:

<None> - Orders submitted take no action once filled or part filled (no stops or targets are
placed)
<Custom> - Orders submitted will initiate the custom defined ATM Strategy (submission of
stops and targets) once filled or part filled
<My Strategy Template> - Orders submitted will initiate your user defined ATM Strategy
(submission of stops and targets) once filled or part filled
<* Active ATM Strategy X - My Strategy Template> - Existing ATM Strategy stop and target
orders will be ammended once the submitted order is filled or part filled

Let's review the three available modes using the SuperDOM for demonstration purposes:

Select Active ATM Strategy on Order Submission
This mode will automatically select the newly created active ATM Strategy on entry order
submission in the ATM Strategy control list. This is the default setting upon initial NinjaTrader
installation.

Who is this mode designed for?
This mode is designed for traders who by default, want existing strategy stop loss and profit
targets to be automatically ammended when they scale into or out of a position being
managed by an ATM Strategy.
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1. A user defined ATM Strategy is selected.
2. Once the entry order is submitted, the ATM Strategy selection control automatically selects
the active ATM Strategy that you just created.

Keep Selected ATM Strategy Template on Order Submission
This mode will keep the currently selected ATM Strategy template selected in the strategy
control list upon order submission.

Who is this mode designed for?
This mode is designed for traders who by default, want to always create a new set of stop loss
and profit target brackets (new ATM Strategy) with each new order placed. An example of this
would be a trader who wanted a single bracket placed with a stop loss of four ticks and a
profit target of eight ticks. The trader wants to place two entry limit orders, the first at a price
of X and the second at a price of X - 2 ticks. The purpose is to scale into an overall position
but have the brackets be submitted and calculated from each individual fill price of the two
orders.

1. Using the images above, a user defined ATM Strategy is selected.
2. Once the entry order is submitted, there will be change in selection in the ATM Strategy
control list. It will continue to look like image #1.

Display Selected ATM Strategy Only
This mode is an advanced mode and should only be used once you have become very familiar
with the NinjaTrader application.

Who is this mode designed for?
This mode is designed for traders who want to run concurrent ATM Strategies (trades) in the
same market. This mode will visually separate all concurrent running ATM Strategies thereby
allowing you to have multiple SuperDOMs open, tracking the same market but displaying
different trade strategies. A practical example might be that you have taken a day long
intraday swing trade against a fifteen minute chart for five contracts. Throughout the day,
you scalp the same market on a one minute time frame. This mode allows you to have two
SuperDOMs open, one allocated to manage and only display your day long intraday swing
trade, the other used to manage and only display your scalp trades.

In the image below, you can see two separate SuperDOM's monitoring the same ES 12-05
market. In the ATM Strategy control list, there are two different ATM Strategies running each
which is displayed separately in each individual SuperDOM. Orders, positions, average entry
and unrealized profit are displayed individually for each separate running ATM Strategy.
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 When running multiple concurrent ATM Strategies by changing the selected active strategy
in the strategy control list you can change which strategy will be displayed

 When you select <None> in the strategy list, all working orders and ATM Strategies will be
displayed

 The position display will display the number of contracts being managed by the ATM
Strategy and then your net position size. The box is color coded to the ATM Strategy's
market position. So if your ATM Strategy is long, the box will be colored green. Using the
above left image as an example, it shows "3 - 4L" in a green box. Green indicates the ATM
Strategy is long, the number 3 indicates that there are 3 contracts being managed by that
ATM Strategy and 4L indicates the account actually holds 4 contracts long. What it is
saying is; that we are running a long ATM Strategy that is managing 3 of 4 contracts that
are held long in my account. The image on the right is managing 1 of the 4 long contracts.

 When you do not have any active ATM Strategies selected, the SuperDOM position display
will display your net account position

 Pressing the "CLOSE" button while an active ATM Strategy is selected will close only that
ATM Strategy. If anything else is selected, it will close the entire account position including
all other working ATM Strategies.

***** Risk *****
When a SuperDOM is set to this mode, it will only display orders associated to the
active selected ATM Strategy in the ATM Strategy control list. This means that if
there are other orders working in the selected market that are not associated to the
ATM Strategy, you will not see them displayed. The risk is that you could have
orders working, you forget about them or did not even know they were still working,
they are filled and you could damage your trading account. Please fully understand
how to use this powerful feature.
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Stop Strategy
A stop strategy is just an extension of an ATM Strategy. It allows you to combine auto
breakeven, auto trail and simulated stop strategies for the management and automatic
adjustment of your stop loss orders.

When setting up an ATM Strategy, you can select either <Custom>, <None> or any
pre-defined stop strategy template from the stop strategy control list.

If <Custom> or any template is selected ("Basic Stop" in the above image is a template) a
Stop Strategy Dialog window will appear.

You can enter the appropriate values to enable any of the stop loss automation strategies.
You can also save commonly used parameters as a stop strategy template.

-o-

Manage ATM Strategy Templates
An ATM Strategy is defined by the parameters you enter into the ATM Strategy parameters
section on any of the order entry screens. The collection of parameters that make up a
strategy can be saved as a template that you can recall at a later date to automatically
populate all of the ATM Strategy parameters.
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Via the right mouse click context menu in the Basic Entry or SuperDOM window and the stop
strategy dialog window, you can access menu's for saving and removing strategy templates.

See Strategy Example #1 and Strategy Example #2 for further reference on how to create
and save a strategy template.

-o-

Tutorial: ATM Strategy Example #1
Following is an example of how to create a simple 1 stop/ 1 target ATM Strategy and save the
strategy as a template. You can do this via any NinjaTrader order entry screen.

1. Set the order quantity to 1 contract
2. From the strategy control list select <Custom> and ensure that "1 Target" option is
selected
3. Set the stop loss value to 4 ticks
4. Set the profit target value to 8 ticks

This simple ATM Strategy will automatically submit a stop loss order 4 ticks from entry and a
profit target order 8 ticks from entry.
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Via the right mouse click context menu, select the menu "Manage ATM Strategy Templates..."

5. Enter the name "8 Tick 1 Target"
6. Press the "Save" button

Once you press the save button, a template is created for this strategy and will become
available in the strategy control list. You can now place an order which once filled will
automatically trigger the strategy to submit the stop loss and profit target. In the image
below, an order was submitted and filled at 1246 as depicted by the brown colored cell.

7. A profit target was submitted at 1248 which is 8 ticks from our entry price of 1246
8. A stop loss was submitted at 1245 which is 4 ticks from our entry price of 1246
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An active strategy named "* Active Strategy 1" is created and listed under the strategy
control list.

9. If under SuperDOM properties you have "ATM Strategy selection mode" set to
"SelectActiveATMStrategyOnOrderSubmission", NinjaTrader will automatically set the ATM
Strategy control list to the newly created ATM Strategy. The importance of this is if you place
another order, any fills resulting from the order will be applied to the existing stop loss and
profit target orders. As an example, if we were filled on an additional contract, our stop loss
and profit target would automatically be modified from 1 contract to 2 contracts. Both stop
loss and profit target orders are tied via OCO which means if one of the orders is filled, the
other will automatically be cancelled. If the option in the first sentence was not checked, the
strategy control list would be set to the "8 Tick 1 Target" ATM Strategy template we just
created. Any subsequent orders would create an additional strategy that would submit
another set of stop loss and profit target orders.

-o-

Tutorial: ATM Strategy Example #2
Following is an example of an ATM Strategy that will automatically submit 2 stop loss and
profit target brackets once the originating entry order is filled. This ATM Strategy includes a
stop strategy that will automatically adjust the stop loss orders using auto breakeven and
auto trail strategies.

1. Set the order quantity to 2 contracts
2. From the ATM Strategy control list select <Custom>
3. Select  "2 Targets"
4. Set "Qty" fields to 1 contract each (that represents 1 contract for the first stop loss/profit
target bracket and 1 for the 2nd)
5. Set the stop loss values to 5 ticks (you can set the 2nd stop loss to a wider value)
6. Set the first profit target to 8 ticks and the 2nd profit target to 12 ticks

7. Select <Custom> from the stop strategy control list
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A Stop Strategy parameters dialog window will appear. This is where you will define the
automation strategies for automatic stop loss adjustment.

8. Set the auto breakeven "Profit trigger" value to 6 ticks. This will automatically adjust our
stop loss order to breakeven once the ATM Strategy has 6 ticks in profit.
9. Set the auto trail "Profit trigger" to 8 ticks
10. Set the auto trail "Stop loss" to 4 ticks
11. Set the auto trail "Frequency" to 1 tick

The auto trail parameters will automatically start adjusting our stop loss order once we have
8 ticks in profit (9) to 4 ticks back (10) and adjust it for every 1 tick (11) in profit gain.

Via the right mouse click context menu, select "Manage Stop Strategy Templates..."

12. Enter the name "Basic Stop"
13. Press the "Save" button

Once you press the save button, a template is created for this stop strategy and will become
available in all stop strategy control lists.  Press the "OK" button on the stop strategy
parameters dialog window. 

14. Select the stop strategy we just created "Basic Stop" in the 2nd stop strategy list. This
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sets the 2nd stop loss order to the same strategy so that stop loss 1 and stop loss 2 will
adjust in unison.

Via the right mouse click context menu, select "Manage ATM Strategy Templates..." and
repeat steps 12 & 13 changing the name in step 12 to "2 Targets" We now have a 2 target
strategy template that can be selected from the strategy control list at any time. Doing so will
update all of the parameter fields automatically based on the information we have entered in
this example.

You can now place an order which once filled will automatically trigger the strategy to submit
the stop loss and profit target brackets. In the image below, an order was submitted and filled
at 1624 as depicted by the brown colored cell.

15. The first profit target order was submitted at 1628 which is 8 ticks from our entry, the
2nd profit target was submitted at 1630 which is 12 ticks from our entry and finally, our 2
stop loss orders were submitted at 1621.50 which is 5 ticks from our entry. You can tell we
have 2 orders at the stop loss level since the size marker has the "s" suffix indicating that we
have multiple orders consolidate at the price 1621.50.

An active ATM strategy named "* Active Strategy 29" is created and listed under the strategy
control list. The significance of 29 is that we had 28 active ATM strategies created before.

16. If under SuperDOM properties you have "ATM Strategy selection mode" set to
"SelectActiveATMStrategyOnOrderSubmission", NinjaTrader will automatically set the ATM
Strategy control list to the newly created ATM Strategy. The importance of this is if you place
another order, any fills resulting from the order will be applied to the existing stop loss and
profit target orders. As an example, if we were filled on an additional contract, our stop loss
and profit target would automatically be modified from 1 contract to 2 contracts. Both stop
loss and profit target orders are tied via OCO which means if one of the orders is filled, the
other will automatically be cancelled. If the option in the first sentence was not checked, the
strategy control list would be set to the "8 Tick 1 Target" ATM Strategy template we just
created. Any subsequent orders would create an additional strategy that would submit
another set of stop loss and profit target orders.
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Auto Breakeven
Auto Breakeven will adjust your stop loss order to breakeven (average entry price for the ATM
Strategy) once a user defined profit trigger has been reached.

Auto Breakeven Parameters
Profit trigger Sets the amount of profit required to move the stop loss to a

breakeven value
Plus Sets the amount added to the breakeven value

Auto Breakeven can be set before entering a position as part of a stop strategy. You can also
enable or disable it on a working stop loss order.

If you move your mouse over an active stop loss order in the buy cell for a buy order or sell
cell for a sell order and press down on your right mouse button, you will see a menu of all
working orders. Each working order menu has a sub menu that displays any applicable
strategies that can be enabled or disabled. In the above image, you can see that Auto
Breakeven is currently enabled. By selecting the "Auto Breakeven" menu, you can enable to
disable it. You can change the parameters by selecting the "Auto Breakeven Properties" menu
when Auto Breakeven is disabled.

Auto Breakeven Example #1:

Profit Trigger - 8 ticks
Plus - 0 ticks
Average Entry - 1000 Long (SP Emini contract)

As soon as the market trades at 1002 (Average Entry + Profit Trigger = 1000 + 8 ticks =
1002) NinjaTrader will move the stop loss order to 1000 (Average Entry + Plus = 1000 + 0
= 1000) and enter a log event in the Log tab.
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Auto Breakeven Example #2:

Profit Trigger - 10 ticks
Plus - 2 ticks
Average Entry - 10200 Short (DOW Emini contract)

As soon as the market trades at 10190 (Average Entry - Profit Trigger = 10200 - 10 ticks =
10190) NinjaTrader will move the stop loss order to 10,198 (Average Entry - Plus = 10200 -
2 ticks = 10198) and enter a log event in the Log tab.

-o-

Auto Chase
Auto Chase will automatically adjust the price of a limit order as the market moves away from
it.

Auto Chase Parameters
Chase Limit The maximum amount that auto chase will adjust your limit order

price
Chase Enables auto chase on your entry orders
Chase if touched Enables auto chase if touched on your entry orders
Target chase Enables auto chase if touched on your profit target orders

How does chase work?
NinjaTrader will automatically adjust the price of your limit order with each tick the market
moves away from your order up until the chase limit amount.

How does chase if touched work?
The difference between chase and chase if touched is that chase if touched does not start
chasing until your limit price as been touched. This works well for profit target orders. Your
profit targets will rest at their respective limit price, if the market moves to the target and
backs off but the target order does not fill, NinjaTrader would then start adjusting the target
order to chase the market up until the chase limit amount.

Auto Chase can be set as part of a ATM Strategy. You can also enable or disable it on working
limit orders.
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If you move your mouse over an active limit or profit target order in the buy cell for a buy
order or sell cell for a sell order and press down on your right mouse button, you will see a
menu of all working orders. Each working order menu has a sub menu that displays any
applicable strategies that can be enabled or disabled. In the above image, you can see that
Auto  Chase is currently disabled. By selecting the "Auto Chase" menu, you can enable or
disable it. You can change the parameters by selecting the "Auto Chase Properties" menu
when Auto Chase is disabled.

Auto Chase Example #1:

Chase Limit - 5
Buy Limit Price - 1000 (SP Emini contract)
Chase - Enabled
Current Bid - 1000.25

In this example, if the bid moves up to 1000.50, auto chase will adjust the buy limit price to
1000.25, subsequently each additional tick rise in price on the bid will adjust the buy limit
price accordingly to a maximum price of 1001.25 which is Buy Limit Price + Chase Limit =
1000 + 5 ticks = 1001.25.

Auto Chase Example #2:

Chase Limit - 5
Buy Limit Price - 1000 (SP Emini contract)
Chase if touched - Enabled
Current Bid - 1000.25

This example works in the same manner as example #1 with the exception that chasing
does not start until the bid has touched the limit price of 1000. 

-o-

Auto Reverse
Auto Reverse simply reverses your position at either your stop loss or profit target. You can
optionally enable "Reverse at stop" or  "Reverse at target" with any ATM Strategy. The
reverse strategy used will be the same as the position strategy you are reversing from.

When auto reverse is enabled, entry orders for the reverse strategy will be placed at either
your stop loss or profit target orders. The image below shows a 1 stop and target strategy
with auto reverse for both stop and target enabled.
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Modifying the price of either your stop loss or profit target will result in the modification of the
reverse order as well. You can also enable or disable auto reverse of an active strategy at any
time by selecting the "Reverse At Stop" or "Reverse At Target" menus via the right mouse
click context menu in either the SuperDOM or Basic Entry windows.

-o-

Auto Trail
Auto Trail is a powerful strategy that allows you to be more liberal with your stop loss at the
early stage of your trade and tighten your stop loss as your profits in your trade increase.

Auto Trail Parameters
Stop Loss Sets the value of the stop loss order as an offset
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Frequency Sets the value of how frequent the stop loss order is adjusted
Profit Trigger Sets the amount of profit required to trigger the initial stop loss

adjustment for the step

There are 3 available steps for auto trail parameters. Each step can have unique parameters
providing you with the flexibility to tighten your stop loss automatically as your profits
increase. Auto Trail can be set before entering a position as part of a stop strategy. You can
also enable or disable it on a working stop loss order.

If you move your mouse over an active stop loss order in the buy cell for a buy order or sell
cell for a sell order and press down on your right mouse button, you will see a menu of all
working orders. Each working order menu has a sub menu that displays any applicable
strategies that can be enabled or disabled. In the above image, you can see that Auto Trail is
currently enabled. By selecting the "Auto Trail" menu, you can enable or disable it. You can
change the parameters by selecting the "Auto Trail Properties" menu when Auto Breakeven is
disabled.

Auto Trail Example #1:

The image is saying:
"Once our trade has 4 ticks in profit, move our stop loss back 6 ticks and move it up
for every additional 2 ticks in profit."
Average Entry - 1000 Long (SP Emini contract)

The market moves up to 1001 and the auto trail is triggered (Average Entry + Profit Trigger
= 1000 + 4 ticks = 1001) and the stop loss is adjusted to 999.50 (1001 - Stop Loss = 1001
- 6 ticks = 999.50). For every additional 2 ticks (Frequency of 2 ticks) the stop loss will be
adjusted by 2 ticks.
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Auto Trail Example #2 building on top of Example #1:

The image is saying:
"Once our trade has 4 ticks in profit, move our stop loss back 6 ticks and move it up
for every additional 2 ticks in profit then;
once our trade has 10 ticks in profit, tighten and move our stop loss back 3 ticks
and increase the rate at which the stop loss is adjusted
and move it up for every additional 1 tick in profit"
Average Entry - 1000 Long (SP Emini contract)

The market moves up to 1001 and the auto trail is triggered (Average Entry + Profit Trigger
= 1000 + 4 ticks = 1001) and the stop loss is adjusted to 999.50 (1001 - Stop Loss = 1001
- 6 ticks = 999.50). For every additional 2 ticks (Frequency of 2 ticks) the stop loss will be
adjusted by 2 ticks. The market moves to 1002.50 and the 2nd step of the auto trail
strategy is triggered and the stop loss is adjusted to 1001.75 and moves up by 1 ticks for
every additional tick in profit.

-o-

Close at Time
Close at Time is a strategy that will automatically close your position at a user defined time. A
position will be closed using NinjaTrader close algorithm. The user defined close time can be
set via the "Time to flatten" property located in the Misc tab. You can enable or disable this
strategy via any NinjaTrader order  entry screen's right mouse click context menu.

-o-

Shadow Strategy
What is a Shadow Strategy?
Initiating a shadow strategy is a method for forward testing alternate trade management
ideas. As an example, you may have a method that is profitable, but you have some ideas on
how to increase its profitability. Maybe hold on to a few contracts for a higher target? With a
shadow strategy, you can set up an alternate ATM Strategy and link that to an ATM Strategy
that will be used for live trading. Every time you enter a position using your live strategy,
NinjaTrader opens a simulated position (Sim101 account) managed by your shadow strategy.
This allows you to forward test your concepts using the same entry signals that trigger your
live trades. Over time, a historical database of actual (live) and shadow (simulated) strategies
are compiled. You can then compare the live trades to the shadow trades under the 
Performance Tab. The end result is that you will be shown what  ATMStrategy (over time) is
more profitable. Changing your trade management logic without truly understanding the
impact of the changes is a risky shot in the dark. Shadow strategies give you proof of concept
needed to feel confident that your ATM Strategy changes make sense.

Tips
 Intelligently name shadow strategies by including a prefix such as "Shadow - My Strategy"
 When using the Performance Tab, you can filter your reports to include or exclude shadow

strategies 
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-o-

Backup and Restore

Backup and Restore Overview
The Backup and Restore utility provides an easy way to save and recover critical user
generated data files such as but not limited to, user preferences, historical trade data and
historical chart data. Backing up your data ensures that you are protected in case of software
or hardware failure.

-o-

Creating a backup archive
1. Disconnect from all connectivity providers (if connected) and from within the Control
Center window select the menu File > Utilities > Backup...

2. The "Backup NinjaTrader" dialog window will appear
3. Select the items you wish to back up
4. Press the "Run Backup" button
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-o-

Restoring a backup archive
To restore a backup archive:

1. From within the Control Center window select the menu File > Utilities > Restore...
2. Select the backup archive to restore from the "Restore" file dialog window
3. Press the "Open" button

-o-

Charts

Charts Overview
NinjaTrader charts support Tick, Range, Volume, Seconds, Minute, Day, Weekly, Monthly and
Yearly intervals of any user defined compression with a wide range of user definable options. 

Below is a general overview of what you can expect to see on a NinjaTrader chart.
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1. Chart options accessible via the right mouse click context menu
2. Chart display area
3. Indicator panels
4. Link button (various NinjaTrader windows have link buttons)
5. Indicator labels
6. Chart tool bar
7. Price markers (displays indicator and current price values)
8. Caption (Instrument, date and chart interval)

-o-

Creating a Chart
To create a new chart select the File-->New-->Chart... menu from the Control Center
window. A "Format Data Series" window will appear.
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1. Select the instrument you wish to chart
2. Select your interval settings
3. Optionally select a predefined chart template
3. Select range settings

Once you press "OK", NinjaTrader will load the appropriate  data into a new chart based on
your default template.

*NOTE ON HISTORICAL DATA: Historical data is a function of your connectivity provider.
Not all connectivity providers support historical data. Please see this matrix to determine if
your connectivity provider supports historical data. If your connectivity provider does not
support historical data, ensure that the option "Store real-time bar data" is enabled under
Tools-->Options-->Data tab. If this option is enabled, NinjaTrader will store real-time bar
data on your local PC providing a repository of self managed historical data.

-o-

Changing Instruments and Bar Intervals
There are several ways to change the instrument and bar interval of a chart.

Changing Instruments
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Option 1 - Click on the instrument button of the chart toolbar and selecting an instrument
from the default list that is shown.
Option 2 - Start typing the instrument name and a "Change Instrument" dialog window will
appear.
Option 3- Click on the instrument button of the chart tool bar, click on the "Instrument" sub
menu and entering the name of an instrument and pressing the "Enter" key. For exampe,
type in "MSFT" and press the "Enter" key to load a chart for Microsoft.
Option 4 - Right mouse click to bring up the context menu and select the "Instruments" sub
menu and select an instrument from the default list that is shown.

Changing Intervals

Option 1 - Click on the interval button of the chart toolbar and selecting a predefined interval.
Option 2 - Click on the interval button of the chart toolbar, click on either the "Tick",
"Volume" or "Seconds" sub menu and enter the desired interval value and press the "Enter"
key.
Option 3 - Right mouse click to bring up the context menu and select the "Intervals" sub
menu and select a predefined interval.

Format Data Series
You can change the instrument and interval using custom values via the "Format Data Series"
window. You can access this window by clicking on the "Format Data Series..." sub menu
from the instrument/interval buttons on the chart toolbar or the "Instruments" and "Intervals"
sub menu of the right click context menu. Alternatively you use the shortcut keys CTRL-F.
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1. Select the instrument you wish to chart
2. Select your interval settings
3. Select range settings

-o-

Navigating a Chart
There are several ways to navigate a chart.

Horizontal Scrolling (panning chart left or right)
You can pan the chart left or right via the following controls:

 Horizontal chart scroll bar at bottom of chart
 Left click and hold on chart canvas and drag left or right
 Mouse scroll wheel will scroll the chart back and forth through time (left to right) 3 bars at

a time
 Mouse scroll wheel + CTRL key held down will scroll the chart back and forth 9 bars at a

time
 Left arrow key will scroll the chart backwards one bar at a time
 Right arrow key will scroll the chart forwards one bar at a time
 Page Up scrolls back 1 page at a time
 Page down scroll forward 1 page at a time
 Home key will display the chart from the 1st bar of the loaded bar series
 End key will display the chart ending with the last loaded bar (most current in real-time) of

the loaded bar series

If the current bar (last bar on the chart) is outside the visible range of the chart, an "Out of
range" icon (a solid arrow head pointing at a bar) will appear in the top right hand corner of
the chart (as illustrated below) and can be clicked on with the left mouse button to reset the
current bar as the last visible bar on the chart. If the current bar is to the left of the right
most edge, a hollow "Out of range" icon will appear.
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Shrink/Grow Chart Panel Draw Objects (vertical scaling)
 Left click and hold your mouse button down in the y-axis margin while moving the mouse

cursor up or down

Compress/Decompress Bar Spacing and Width (horizontal scaling)
 Right click and hold your mouse button down in the x-axis margin while moving the mouse

cursor left or right
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Incremental Bar Width and Spacing
 Up arrow key + CTRL key held down decreases bar spacing
 Down arrow key + CTRL key held down increases bar spacing
 Up arrow key + ALT key held down decreases bar width
 Down arrow key + ALT key held down increases bar width
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 Click on the "Bar stye" chart toolbar icon to access bar width and spacing functions

Zooming
Zoom In - You can create a zoom frame around a chart area you want to focus in on
1. Click on the Zoom In icon on the tool bar or select the "Zoom In" menu within the right

mouse button click context menu
2. Click and hold down your left mouse button and draw a zoom frame region and release the

left mouse button
 
Zoom Out - Each zoom in is remembered and you can undo (zoom out) each of them. Either
click on the Zoom Out icon in the chart tool bar or select the "Zoom Out" menu within the
right mouse button click context menu.

Cursor Type
You can have either standard windows pointer, cross hair or global cross hair for chart
navigation. You can toggle between cursor modes via the right mouse click context menu
cursor sub menu, the "Cursor" chart toolbar icon or shortcut keys.

Shortcut Keys
Pointer - CTRL-R
Cross Hair - CTRL-Q
Global Cross Hair - CTRL-G

-o-

Data Box and Mini Data Box
Mini Data Box
The Mini Data Box displays the Date/Time, Price, Open, High, Low, Close and Volume
information of the selected bar on the chart. This view is excellent for quick access to
information.
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Press the middle mouse button (scroll wheel of your mouse) to display the Mini Data Box.

Data Box
The Data Box displays all chart data and indicator values based on your mouse cursor
position. You can enable or disable this window via the right mouse click context menu,
"Show data box" chart toolbar icon or by using the shortcut keys CTRL-D. If you have multiple
charts open, the chart data box will display values of the chart that your mouse is currently
hovering over.

-o-

Adding/Removing Indicators
NinjaTrader installs with over 100 prebuilt indicators. Indicators are added/removed and
edited via the Indicators window. To access the Indicators window, from within a chart select
the "Indicators" sub menu via the right mouse click context menu, the "Indicators" chart
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toolbar icon or use the shortcut keys CTRL-I.

Indicators Window

1. Available indicators
2. Current indicators applied to chart
3. Selected indicator's properties

Add Indicator
1. From the Indicators window, select an indicator and press the "Add" button or simply
double click.

2. Once added to the list of applied indicators, you can now edit the indicators properties.
Different indicators will have different editable properties. For the simple moving average
indicator, we have the following properties:



p135

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Auto scale If true, the indicator is part of the chart auto scaling
Calculate on bar close If true, will only calculate the indicator's value on the close of a bar

else its calculated with each incoming tick
Displacement Displaces the plot back by this value (value of 2 would plot the current

bar value -2 bars)
Display in Data Box If true, will display the indicator values in the chart Data Box
Label The label displayed on the chart (leaving blank will remove the label

display in the chart)
Panel Which panel the indicator is plotted on
Price marker(s) If true, the indicator value is plotted in the Y-axis
Period The number of periods used to calculate indicator values
Price type Data point used as input for calculating indicator values
Color The color of the indicator plot
Dash style The style of the plot (solid, dash, dot etc...)
Line width Width of the plot
Plot style The type of plot used (line, bar etc...)

3. Once you have set the indicator properties, press the "OK" button to apply and close the
Indicators window or, press the "Apply" button to keep the Indicators window open and apply
your new indicator.

Remove Indicator
1. From the Indicators window, select an indicator from the applied indicators list
2. Press the "Remove" button
3. Press "OK" or "Apply"

-o-

Chart Templates
Chart templates are a way to save user defined customized settings for future recall.

Saving a Default Template
A default template is the chart settings used each time you create a new chart. Once you
have a chart set up to your liking, select the menu Templates-->Save As Default from the
right mouse click context menu within a chart.

Saving a Template
1. Once you have a chart set up to your liking, select the menu Templates-->Save As... from
the right mouse click context menu within a chart
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2. The Save as Template dialog window will appear. Give your template a name and press the
"OK" button.

Removing a Template
1. Select the menu Templates-->Save As... from the right mouse click context menu within a
chart
2. The Save as Template dialog window will appear, select the template for removal from the
list of templates and press the "Remove" button

Loading a Template
1. Select the menu Templates-->Load... from the right mouse click context menu within a
chart
2. Select the template you wish to load from the list of templates and press the "OK" button

-o-

Drawing Tools
There are several drawing tools available to mark up your charts. These tools are available via
the "Tools" sub menu of the right mouse click context menu, the "Tools" chart toolbar icon (as
per image below) or via predefined shortcut keys.
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Drawing Features
1. Snap To OHLC - When this option is enabled, drawing object anchor points will
automatically snap to the closest open, high, low or close value otherwise it will snap to any
valid price point
2. Stay In Draw Mode - When this option is enabled, the current drawing mode selected will
remain active after the a drawing object has been drawn otherwise, the drawing mode is
exited
3. Remove All Draw Objects - Removes draw objects from the chart canvas

Drawing Tips
 Pressing the escape key disables the draw tool you have selected
 Select a drawn object and pressing the delete key or right click, selecting the "Remove

(Object)" menu will remove the object from the chart
 Double click on a drawn object or selecting it and from the right mouse click menu,

selecting the "(Object) Properties" will allow you to edit the drawing properties of an object
 Selecting a drawn object via your left mouse button and dragging it and letting go of the

object allows you to move an object around the chart canvas

Drawing Shortcuts
F2 - Line
F3 - Ray
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F4 - Extended Line
Ctrl+F2 - Arrow Line
F6 - Horizontal Line
F7 - Vertical Line
F8 - Fibonacci Retracements
F9 - Fibonacci Extensions
F10 - Fibonacci Time Extensions
F11 - Fibonacci Circle
F12 - Text
Ctrl+F8 - Andrew's Pitchfork
Ctrl+F9 - Gann Fan
Ctrl+F10 - Regression Channel
Ctrl+F11 - Ellipse
Ctrl +F12 - Rectangle
Alt+F2 - Arrow Up
Alt+F3 - Arrow Down
Alt+F4 - Diamond
Alt+F5 - Dot
Alt+F6 - Square
Alt+F7 - Triangle Up
Alt+F8 - Triangle Down

-o-

Miscellaneous
Chart Printing
To print a chart, select the menu "Print..." from the right mouse click context menu from
within a chart or, use the shortcut keys CTRL-P.

Email Image
To send a chart image via email, select the menu "Email Image..." from the right click context
menu from withing a chart.

Save As Image
To save the chart as an image, select the menu "Save As Image..." from the right click
context menu from within a chart. Formats supported are .JPG, .BMP, .GIF and .PNG.

Updating Custom Indicators and Strategies in a Chart
To reload indicators and strategies that have been changed and compiled, select the menu
"Reload NinjaScript" from the right click context menu from within a chart. Alternatively, you
can press the F5 key. Prior settings of a reloaded NinjaScript object will be maintained on a
refresh. You would need to remove and re-add a NinjaScript object if you need parameter
settings changed.

-o-

Properties
Chart properties are accessible via:

 Right mouse click context menu within a chart window
 Double click on any part of the chart canvas
 Chart Toolbar icon
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Property Definitions
Color of axis Sets the color for both vertical and horizontal chart axis
Color of inactive price
markers

Price markers display the current price of bars and indicators on the
Y-axis. When looking at the current bar, the price markers will take
the color of the data series. When scrolling back through historical bar
data, the markers are inactive (not real-time) and will be displayed by
the color set on this property.

Date label format for
daily bars

Sets the format for displaying the date in the X-axis for daily bars

Date label format for
monthly bars

Sets the format for displaying the date in the X-axis for monthly bars



p140

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Date label format for
yearly bars

Sets the format for displaying the date in the X-axis for yearly bars

Bar width Width of chart bars
Candle outline Sets the drawing properties for candle stick chart style outline
Chart style The plot style for the chart
Color for down bars Sets the color for bars where the close is lower than the open
Color for last trade Sets the color for the last trade price marker
Color for up bars Sets the color for bars where the close is higher than the open
Exclude weekend Enables or disables weekend data to be included in the chart
Session begins Starting time range you want the chart to plot (set the value to the

time you want the session start. If the first market bar comes in at
8:30 AM, set it to 8:30 AM)

Session ends Ending time range you want the chart to plot
Show unstable period
for indicators

A 200 SMA requires at least 200 bars of data to calculate it's true
value. If this property is set to true, the 200 SMA will be plotted even
if it does not have enough bar data to calculate accurately

Day break line Sets the drawing properties for the day break (session) line
Horizontal grid line
interval

Sets the interval between grid lines in ticks for intraday charts. A
value of zero will use automatic horizontal grid line generation.

Horizontal grid lines Sets the drawing properties for horizontal grid lines
Plot day break lines Enables or disables plotting of the day break line
Plot horizontal grid
lines

Enables or disables the plotting of horizontal grid lines

Plot vertical grid lines Enables or disables the plotting of vertical grid lines
Vertical grid lines Sets the drawing properties of vertical grid lines
Color for executions -
buy

Sets the color for plotting buy executions

Color for executions -
sell

Sets the color for plotting sell executions

NinjaScript strategy
position line profitable
trade

Sets the drawing properties of strategy position lines for a profitable
trade

NinjaScript strategy
position line
unprofitable trade

Sets the drawing properties of strategy position lines for a unprofitable
trade

Plot executions Sets the plotting style of trade executions
Color for background Sets the chart background color
Color for crosshair
label

Sets the color for the crosshair label

Display update
interval (sec)

Sets the frequency the chart display is updated (setting of zero will
update every tick but can be CPU intensive on some PC's)

Label Font Sets the font display properties for the chart
Right side margin Sets the spacing between the Y-axis and the current bar
Show chart trader Enables or disables the chart trader control for direct trading from

within a chart
Show scrollbar Enables or disables showing the horizontal chart scroll bar
Show toolbar Enables or disabled showing the chart tool bar

-o-

Power Volume Indicators
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NinjaTrader includes several powerful real-time volume based indicators that give traders a
profile where trades are executing relative to the bid or ask.

BuySellPressure Indicator
The BuySellPressure indicator displays both the current bar's buying and selling pressure as
percentage values based on the categorization of trades as buy or sell trades. Trades are
categorized in real-time as a buy (at the ask or above) or as a sell (at the bid or below)....
Trades in between the market are ignored. This is a real-time indicator only. It functions only
on real-time data and therefore does not plot any values on historical data. If you change any
property, interval or instrument on a chart, this indicator will restart and any accumulated
real-time data plots will be lost.

BuySellVolume Indicator
The BuySellVolume indicator displays a real-time horizontal histogram of volume categorized
as buy or sell trades. Trades are categorized in real-time as a buy (at the ask or above) or as
a sell (at the bid or below) and then color coded .... Trades in between the market are
ignored. This is a real-time indicator only. It functions only on real-time data and therefore
does not plot any values on historical data. If you change any property, interval or instrument
on a chart, this indicator will restart and any accumulated real-time data plots will be lost.

Volume Profile Indicator
The Volume by Price indicator plots a real-time volume profile as a vertical histogram on a
chart. Each bar represents the volume (number of trades) that accumulate at each bar from
the time the indicator is started or re-started on the chart. Bars are color coded to represent
number of buys (trades at the ask or higher), sells (at the bid or lower) and neutrals
(between the market). This power volume indicator provides you with instant feedback to
guage where support and resistance levels are and if their is  accumulation or distribution
taking place at those levels. This is a real-time indicator only. It functions only on real-time
data and therefore does not plot any values on historical data. If you change any property,
interval or instrument on a chart, this indicator will restart and any accumulated real-time
data plots will be lost.

Volume Zones Indicator
The Volume Zones indicator plots a horizontal histogram on the left side of a chart that
indicates volume levels on historical and real-time data. The length of each bar represents the
cumulative total of all volume bars for the periods during which the closing price (user defined
price type) fell within the vertical price range of the histogram bar. Each bar is color coded to
differentiate up (Close > Open) and down (Close < Open) volume. This indicator is designed
for use against historical data only and NOT intended to be used on real-time data. Use the
"Volume Profile Indicator" for real-time data.

-o-

Custom Indicator Development
NinjaTrader supports development of custom Quote Board Columns, Indicators and
automated trading systems using NinjaScript. Please see the "Custom Indicator Development"
sub-section of the NinjaScript section.

-o-

Reload Historical Data
While you are connected to a market data provider that supports historical data, right click
within a chart to bring up the context menu and select "Reload Historical Data". Historical
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data for the base interval unit (minute bars for a 5 minute chart for example) will be reloaded
for the instrument and chart date range.

-o-

Trading from a Chart
Please see the "Chart Trader" section under "Order Entry Windows".

-o-

Real-time Tick Filtering
What is tick filtering?
Tick filtering is a function where each incoming tick is evaluated in relation to the last known
price and if it is outside of a user defined percentage value, the tick is thrown away and not
distributed to any NinjaTrader object that requires market data such as advanced charts or
strategies. This prevents data spikes from showing on your charts and can also prevent
unwanted actions taken by automated strategies due to a data spike.

How does it work?
A bad tick is detected if the tick price is less than the last valid traded price - (last traded
Price * (1 - bad tick offset as %))
A bad tick detected if the tick price is greater than the last valid traded price + (last traded
Price * (1 + bad tick offset as %))
If a bad tick is detected but the prior two ticks were also bad ticks, then the tick being
processed is now a valid last traded price and is NOT filtered out

How do I enable tick filtering?
You can enable real-time tick filtering by selecting the menu Tools > Options from the Control
Center window which will bring up the "Options" dialog window. Within the "Options" dialog
window click on the "Data" tab.  Under the "General" sub tab you can place a check mark
next to "Enabled" under the "Real-time tick filter and set the "Bad tick offset as %" value.

When should I used tick filtering?
 If you are using a market data vendor where you often see data spikes coming in
 If you trade primarily equities
 If you are running automated strategies where a data spikes have implications

-o-

Window Linking
See the "Window Linking" section.

-o-

Split and Dividend Adjusted Data
NinjaTrader will split and dividend adjust historical data. This is primarily relevant for
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backtesting. You can enable this data adjusting via the "Data" tab accessible via the Control
Center menu Tools-->Options.

You must set split and dividend dates per instrument in the Instrument Manager.

 NinjaTrader stores historical data in it's local database in an unadjusted state
 If the data provider provides adjusted data, NinjaTrader will convert the data into it's

unadjusted state prior to local storage

-o-

Custom NinjaScript Automated Strategies
When running a backtest through the Strategy Analyzer or running a live NinjaScript Strategy
unique entries and exits are plotted  on the chart. In the image below you will see an example
of a profitable short trade with the entry and exit clearly marked and connected by a trade
line.

1. Connecting lines can be customized via the Properties dialog window
2. You must have "Plot executions" enabled via the Properties dialog window

-o-
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How does NinjaTrader build Chart Bars?
There are many variables that are used to build a bar chart.

Bar Time Stamp
NinjaTrader stamps a bar with the closing time of the bar. For example, a minute bar with a
time of 9:31:00 AM has data from 9:30:00 AM through 9:30:59 AM.

Different Data Feeds
Different data feeds produce different charts especially when using tick based intervals vs
time based intervals. Market data vendors each employ various methods for tick filtering,
throttling and time stamping. As a result, no data stream is 100% identical and thus can
cause subtle differences in charts. Since NinjaTrader supports many of the leading brokerage
and data feed technologies, its guaranteed that two traders using NinjaTrader on different
data feeds will have minor differences when plotting the same market and time interval.

Time Settings
Different session start and end time values as well as look back period can affect the chart
display and indicator values.

Real-Time Tick Filter
If you have the real-time tick filter enabled, it is possible that your offset percent (the percent
away a tick is in value from the last traded price to be considered a bad tick) may be too tight
and thus a good tick (gap up/down on session open for example) could be excluded from the
bar.

Base Data used to Build Bars
A chart bar (interval type) requires a base data value as its source for bar construction.
Following are NinjaTrader supported interval types and their required base data values.

Tick - tick data
Volume - tick data
Range - tick data
Second - tick data
Minute - minute bar data
Day - daily bar data
Week - daily bar data
Month - daily bar data
Year - daily bar data

This is important to understand since if you are connected to a market data vendor that does
not support "daily data" you will not be able to build chart bars that use "daily data" as its
base data. A matrix of support vendors and their varying levels of service is located here.

Why can my chart look different after reloading historical data from the server?
As ticks come into NinjaTrader in real-time, they are time stamped based on your local PC
time if they do not already have an associated time stamp that is provided from the real-time
data source. The majority of our supported brokerage feeds DO NOT time stamp ticks where
most of our supported market data vendor feeds do provide time stamped ticks. NinjaTrader
then builds bars based on the time stamp of the incoming tick and displays these bars in your
chart in real-time.

Let's say you have a tick (tick "A") with a time stamp of 10:31:00 AM which gets packaged
into the 10:32:00 AM bar and happens to be the high of that bar. An hour later, you reload
historical data from your historical data provider into NinjaTrader. This process will overwrite
the existing data. The 10:32:00 AM bar now looks different since the high made by TICK "A"
is now part  of the prior bar, 10:31:00 AM. How is this possible?

 Your PC clock could have been off so the time stamp is delayed
 Your internet may have been lagging so the tick came in slightly delayed and therefore the
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time stamp is delayed
 Due to standard latency, even 50ms delay (which is normal) could be the difference

between a 10:30:59 and 10:31:00 time stamp
 There is no way of knowing how the historical data provider packages their bars

The only way to ensure that data always looks the same is if every connectivity provider sent
ticks with time stamps AND that all vendors synchronized on time stamps. Unfortunately, this
is just not a reality nor plausible.

Loading Historical Data
More information can be found here.

-o-

Control Center

Control Center Overview
The NinjaTrader Control Center provides a centralized view of account, execution, order,
historical log and position information. It also provides access to all of the various NinjaTrader
function windows and enables/disables global application features and commands.

The NinjaTrader Control Center can be broken down into three sections. The menu system,
the information tabs and the status bar.

Using the menu system, you can access various functions:

File Menu
New Creates new function windows such as charts and order entry

windows
Workspaces Creates and manages workspaces
Connect Establish a connection to a connectivity provider
Disconnect Disconnects an established connection
Flatten Everything* Flattens all open positions and cancels all working orders across all

connected accounts
AT Interface Enables or disables the automated trading interface
Global Simulation Mode Enables or disables global simulation mode
Utilities Utility functions such as import and export of NinjaScript files
Exit Exits the application

*The "Flatten Everything" function is not guaranteed. Refer to the risks section for further
explanation.
* The "Flatten Everything" function is also accessible via the right mouse click context menu
of all order entry windows

Tools Menu
Instrument Manager Opens the Instrument Manager
Historical Data Manages historical data (Import, Export, Merge and Reload)
New NinjaScript Creates a new NinjaScript indicator, Market Analyzer column or

strategy
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Edit NinjaScript Edits NinjaScript indicators, Market Analyzer columns and
strategies

Output Window Opens the NinjaScript output window
Automated Trading OIF
Builder

Opens the Automated Trading OIF Builder

Account Connections Opens a wizard to create and manage account connections
Options Opens a window for managing application options

Help Menu
Help Opens the application help guide
Search Opens the application help guide in search mode
Support Center Links to the NinjaTrader customer support center
Mail To Support Sends email support request
Download Site Download the latest version of NinjaTrader
License Key Setting appliction license key
About About NinjaTrader

Using the information tabs, you can view various account information.

The status bar provides current connection status information and indicates if the Automated
Trading Interface (ATI) is enabled.

-o-

Orders Tab
The orders tab is broken down into three sections.

Order Grid Section
The order grid displays detailed information regarding the current day's orders. The grid is
also active in that you can modify an order directly in it. All active order's "State" cells will be
color coded for ease of use.
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1. You can modify the size and/or price of an order by directly clicking in either the Qty, Limit
or Stop value fields of an active order and either pressing the "Enter" key or clicking in
another cell.
2. You can increase the price of an order by one tick by pressing the "+' button. Holding the
CTRL key down will modify the order by 5 ticks, ALT key by 10 ticks.
3. You can decrease the price of an order by one tick pressing on the "-" button. Holding the
CTRL key down will modify the order by 5 ticks, ALT key by 10 ticks.
4. You can cancel an order by pressing on the "X" button.

Via the right mouse click context menu, there are several order grid specific features.

Cancel Order Cancels the selected order
Cancel All Orders Cancels all working orders
Filter Only Active
Orders

Displays only active orders

Filter By Account Sets which orders to display by account

Order Entry Section
The order entry section allows you to submit orders.

Select an instrument, enter parameters and either press the "BUY" or "SELL" button.

Order Type Sets the order type
Qty Sets the order quantity
Limit Price Sets the limit price



p148

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Stop Price Sets the stop price
TIF Sets the time in force
OCO *Sets an OCO (One cancels other) id
Account Sets the account the order will be submitted to

* OCO is an order property that groups orders together by a common user defined id. If one
order in the group is either filled, canceled or rejected, all orders in the group with the same
OCO id will be canceled.

Market Display Section
The market display section display market data for the currently selected instrument.

-o-

Strategies Tab
The strategies tab displays running and terminated strategies for the current session.

Green highlighted cells indicating a currently running strategy.

Via the right mouse click context menu, there are several order grid specific features.

New Strategy... Run a new automated NinjaScript strategy
Stop Strategy Stops the highlighted running strategy
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Stop All Strategies Stops all running strategies
Remove Strategy Removes the selected strategy from the grid
Strategy Performance Generates a performance report for the selected strategy (see more

info below)
Filter Only Active
Strategies

Displays only active strategies

Filter By Account Sets which strategies to display by account

Strategy Performance
While the Account Performance tab will generate performance report against your account's
trade history, the Strategy Performance menu allows you to generate a performance report
against the trades generated by the selected strategy.

Real-time - Selecting this menu will generate performance data for your real-time trades only
(since the strategy started running) and will exclude historical trades. If your strategy held a
virtual position (calculated against historical data) upon starting, a virtual execution
representing the average price of this position will be injected into the real-time results to
ensure that a trade pair can be created with the executions resulting from the closing of this
position.

Historical & Real-time - Selecting this menu will generate performance data for both historical
and real-time trade data.

-o-

Executions Tab
The executions tab displays all executions for the current day in a data grid.

Via the right mouse click context menu, you can gain access to several execution grid specific
features.
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Filter By Account Sets which executions to display by account
Add... Add an execution to the database
Remove... Remove an execution from the database

Adding Executions
There may be situations where you will want to manually add an historical execution to the
database. Historical executions are used to generate performance data in the Performance tab
. If an execution is missing, the performance data will be incorrect. Why can executions be
missing? Not all brokers provide historical execution for past days. Let's say you placed a GTC
order on Monday, did not connect on Tuesday at which time your order filled, then connected
NinjaTrader on Wednesday, NinjaTrader would never receive the execution report for
Tuesday's order fill. You would then have to add this historical execution to the database if
you want your performance reporting to be accurate. By selecting the "Add..." menu from the
right mouse click context menu (as per the image above) you will be presented with the "Add
Execution" dialog window as per the image below.

-o-

Positions Tab
The positions tab displays the current open positions in a data grid.

Via the right mouse click context menu, there are several position grid specific features.
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Close Position* Flattens the currently selected position in the grid and cancels any
working orders associated to the position's instrument

Flatten Everything* Flattens all open positions and cancels all working orders
Filter By Account Sets which positions to display by account

*The "Close Position" and "Flatten Everything" functions are not guaranteed. Refer to the risks
section for further explanation.

-o-

Accounts Tab
The accounts tab displays current account information in a data grid. The account values that
are displayed or not displayed is dependant on your connectivity provider. Not all connectivity
providers transmit complete account data. Some transmit partial account data while others do
not transmit anything.

-o-

Account Performance Tab

Account Performance Tab Overview
The Account Performance tab allows you to generate customized performance data against
your trade history for a selected account. Performance data is displayed in the Performance
Data tabs.

You can generate a basic report by selecting a date range and report "Mode" which displays
the performance data in either currency, percent or point based values and pressing the
"Generate" button. The basic report will be generated against all historical trade data for all
accounts including the Sim101 account.

Group trade by ATM strategy - When this option is selected, trades are reported based on 
ATM Strategies. For example, if you have an ATM Strategy that had multiple entries and exits,
all executions are grouped and reported as one trade record under the "Trades" tab with
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single average entry and exit prices.

Pressing the "Advanced" button will expand the performance tab to include advanced
parameters that you can filter your performance reports by.

1. Accounts - Select the accounts you want to include in your performance report
2. Instruments - Select the instruments you want to include in your performance report
3. Templates - Select the strategies that you want to include in your performance report
4. Providers - Select the connectivity providers that you want to include in your performance
report
5. Selects the instrument(s) used to filter historical trade data for your performance report
6. Pressing the "Compare" button will open a new performance window. You can then
generate two different sets of performance data for comparison. Some examples of
comparisons you can make are:

 Time frame based (current week compared to last week)
 Account based (simulation account compared to live account)
 Instrument based (S&P Emini compared to Dow Mini)
 Instrument type based (equities compared to futures)
 Template based (strategy x compared to strategy y)

-o-

Performance Data Tabs
The Performance Data Tabs display historical trade performance data. This performance data
can be access from the following locations -

 Account Performance tab
 Strategies tab "Strategy Performance" menu
 Strategy Analyzer

Summary Tab
The summary tab displays performance statistics.
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Chart Tab
The Chart tab is only visible in the Strategy Analyzer. It is used to display historical back
tested trade data. Strategy trades are connected by lines that can be configured via Chart 
properties. You can quickly jump to the next trade in time by pressing the CTRL + Arrow
Right key combination. CTRL + Arrow Left key combination will jump in the other direction.
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Graphs Tab
The graphs tab displays a graph of either cumulated profit or draw down.

Executions Tab
Displays all historical executions. You can go to the exact chart location of an execution by
selecting the execution, right mouse click and select "Chart". This will only work if you have
access to historical data via a connection or in your local database.

Trades Tab
Displays all historical trades. You can go to the exact chart location of a trade by selecting the
trade, right mouse click and select "Chart". This will only work if you have access to historical
data via a connection or in your local database.

Periods Tab
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Displays performance data based on time periods.

Orders Tab
Displays all historical orders.

Settings Tab
The Settings tab is only visible in the Strategy Analyzer. Displays the backtest settings used.

Journal Tab
The Journal tab is only visible in the Performance Tab of the Control Center window. The
journal tab allows you to keep journal entries on your trading activities. Enter your comments
in the text area (highlighted green) and press the "OK" button. The data grid will display your
journal entries.

-o-

Effciency Graphs
Following are the formulas for the calculation of some of the efficiency performance graphs.

Assume the following:

- Enter long at price of 100
- Market moves down to a price of 90
- Market moves up to a price of 130
- Exit at a price of 110

Entry efficiency is calculated as:

(maximum price seen -  entry price) / (maximum price seen - minimum price seen)
= (130 - 100) / (130 - 90)
= 75%
= The entry took 75% of the trade range

Exit efficiency is calculated as:

(exit price -  minimum price seen) / (maximum price seen - minimum price seen)
= (110 - 90) / (130 - 90)
= 50%
= The exit took 50% of the available trade range

Total efficiency is calculated as:

(exit price -  entry price) / (maximum price seen - minimum price seen)
= (110 - 100) / (130 - 90)
= 25%



p156

© NinjaTrader, LLC, 2005

www.ninjatrader.com

= The trade represented only 25% of the trade range

 The formulas are reversed for short
 The blue line on any efficiency graph represents the average

-o-

Statistics Definitions

Average Time In Market
SUM(exit date – entry date) of all trades / # of trades

This statistic returns a value that gives you an idea of how long you can expect your positions
to be open. You can use this by manually closing out a position if you feel it has been in the
market for too long.

-o-

Average ETD
Currency: Average MFE – Average Trade 

Percent: Average MFE – Average Trade 

Points: Average MFE – Average Trade 

This statistic returns a value that is useful in giving you a measure of how effective your exit
conditions capture the price movements after your strategy enters a position. It shows you
how much you give back from the best price reached before you exit the trade. A small
number here is generally desirable since it would imply highly optimized exit conditions that
capture most of the price movement you were after. 

Example:
Enter long at $100
Market price rises to $110 so your MFE is now $110 - $100 = $10 or 10%
Market price declines to $107 and you exit your trade. ETD is now $10 - $7 = $3 or 3%
We know from the ETD that we gave back $3 in potential profit in this particular trade.

-o-

Average Losing Trade
Currency: SUM(loss * quantity * point value) of all losing trades / # of losing trades  

Percent: SUM(profit * quantity / entry price) of all losing trades  / # of losing traded
lots

Points: SUM(profit * quantity) of all losing trades / # of losing trades

where loss is defined as (exit price – entry price) for long trades and as (entry price – exit
price) for short trades, and point value  is defined as the monetary conversion of each point
(e.g. 100 for currency pairs).

This statistic returns a value representing the average loss you experience from all of your
losing trades. It is useful for getting an idea of how much you could expect to lose on losing
trades.

-o-
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Average MAE
Currency: SUM(MAE * quantity * point value) of all trades / # of trades

Percent: SUM(MAE * quantity / entry price) of all trades / # of traded lots

Points: SUM(MAE * quantity) of all trades / # of trades

where MAE  (max. adverse excursion) is defined as |worst price trade reached – entry price|,
 quantity is defined as the number of contracts traded, and point value  is defined as the
monetary conversion of each point (e.g. 100 for currency pairs).

This statistic returns a value representing the average maximum run-down your strategy
experiences. This information helps you gauge how poorly your strategy’s entry conditions
predict upcoming price movement directions. A low percentage here is desirable since it
would imply that the price movement after you enter a position follows the direction of your
intended trade.

-o-

Average MFE
Currency: SUM(MFE * quantity * point value) of all trades / # of trades

Percent: SUM(MFE * quantity / entry price) of all trades / # of traded lots

Points: SUM(MFE * quantity) of all trades / # of trades

where MFE  (max. favorable excursion) is defined as (best price trade reached – entry price),
 quantity is defined as the number of contracts traded, and point value is defined as the
monetary conversion of each point (e.g. 100 for currency pairs).

This statistic returns a value representing the average maximum run-up your strategy
experiences. This information helps you gauge how well your strategy’s entry conditions
predict upcoming price movements. A high percentage here is desirable since it would imply
high profitability opportunities.

-o-

Average Trade
Currency: SUM(profit * quantity * point value) of all trades / # of trades

Percent: SUM(profit * quantity / entry price) of all trades  / # of traded lots

Points: SUM(profit * quantity) of all trades / # of trades

Where profit is defined as (exit price – entry price) for long trades and as (entry price – exit
price) for short trades, quantity is defined as the number of contracts traded, and point value
is defined as the monetary conversion of each point (e.g. 100 for currency pairs).

This statistic returns a value representing the average profit you experience from all of your
trades. It is useful for getting an idea of how much you could expect to earn on future trades.

-o-

Average Winning Trade
Currency: SUM(profit * quantity * point value) of all winning trades / # of winning
trades

Percent: SUM(profit * quantity / entry price) of all winning trades  / # of winning
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traded lots

Points: SUM(profit * quantity) of all winning trades / # of winning trades

where profit  is defined as (exit price – entry price) for long trades and as (entry price – exit
price) for short trades, quantity is defined as the number of contracts traded, and point value
is defined as the monetary conversion of each point (e.g. 100 for currency pairs).

This statistic returns a value representing the average profit you experience from all of your
winning trades. It is useful for getting an idea of how much you could expect to earn on
winning trades.

-o-

Commission
SUM(commission of all traded executions)

This statistic returns a value that is the sum of all the commission fees associated with the
trades executed by the strategy.

-o-

Cumulated Profit
Currency: SUM(profit * quantity * point value) of all trades

Percent: PRODUCT(1 + profit / entry price) of all trades - 1

Points: SUM(profit * quantity) of all trades

where profit is defined as (exit price – entry price) for long trades and as (entry price – exit
price) for short trades, quantity is defined as the number of contracts traded, and point value
is defined as the monetary conversion of each point (e.g. 100 for currency pairs).

This statistic returns a value representing a summation of all the profits earned by all your
trades. It can be interpreted as a performance measure for your strategy.

-o-

Gross Loss
SUM(loss * quantity) of all losing trades

where loss is defined as (exit price – entry price) for long trades and as (entry price – exit
price) for short trades and quantity  is defined as the number of contracts traded.

This statistic returns a monetary value representing a summation of all the money lost across
all your trades with your strategy.

-o-

Gross Profit
SUM(profit * quantity) of all winning trades

where profit is defined as (exit price – entry price) for long trades and as (entry price – exit
price) for short trades and quantity is defined as the number of contracts traded.

This statistic returns a monetary value representing a summation of all the money earned
across all your trades with your strategy.
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-o-

Max. Drawdown
Drawdown = local maximum account size – local minimum account size
Max Drawdown = single largest Drawdown

The maximum drawdown statistic provides you with information regarding the biggest
decrease (drawdown) in account size experienced by your strategy. Drawdown is often used
as an indicator of risk.

As an example, your account rises from $25,000 to $50,000. It then subsequently drops to
$40,000 but rises again to $60,000. The drawdown in this case would be $10,000 or -20%.
Take note that drawdown does not necessarily have to correspond with a loss in your original
account principal.

-o-

Profit Factor
Gross Profit / Gross Loss

This statistic returns a ratio that can be used as a performance measure for your strategy. It
gives you an idea of how much more money your strategy earns then it loses. A higher ratio
can be considered characteristic of a high performing strategy. A ratio less than one indicates
your strategy loses more money than it earns.

-o-

Profit Per Month
Currency: Cumulated Profit / # of months 

Percent: (1 + Cumulated Profit)(1 / # of months) - 1 

Points: Cumulated Profit / # of months 

See the Cumulated Profit statistic for its definition.

This statistic returns a value that can be used as a performance measure for your strategy. It
gives you an idea of how much profit you can expect to make per month. 

-o-

Ratio Avg Win / Avg Loss
Average Winning Trade / Average Losing Trade

This statistic returns a ratio that can be used as a performance measure for your strategy. A
value greater than 1 signifies you win more than you lose. A value less than 1 signifies you
lose more than you win.

-o-

Sharpe Ratio
(Profit per Month – risk free Rate of Return) / standard deviation of monthly profits

See Profit Per Month for its definition.

This statistic returns a ratio that measures the risk premium per unit of risk of your strategy.
It can help you make decisions based on the excess risk of your strategies. You may have a
high-return strategy, but the high returns may come at a cost of excess risk. The Sharpe ratio
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will help you determine if it is an appropriate increase in risk for the higher return or not.
Generally, a ratio of 1 or greater is good, 2 or greater is very good, and 3 and up is great.

Note: 

 NinjaTrader presets "risk free Rate of Return" to a value of zero
 In the event that there is only 1 month of trade history or less, there is insufficient data to

calculate the monthly standard deviation of profits in which event, the Sharpe Ratio is set
to a value of 1

-o-

Log Tab
The log tab displays historical application and trading events for the current day in a data grid
. There are various options for displaying log information that can be set via the
Tools-->Options menu of the Control Center window. Log events are categorized and color
coded based on four distinct alert levels; Information, Warning, Error and Alert.

Each log event is displayed by date, category and message. In some cases, the length of the
message may be larger than the width of the "Message" column. In this situation, you can
hover your mouse above the message in order to have it display in a pop-up type window.

You can filter out different categories of log events via the right click context menu.

-o-

Diagnostics Tab
The diagnostics tab is a feature that should only be used with the direction of a NinjaTrader
technical support or your connectivity providers' customer support representative. This
feature records low level tracing of the NinjaTrader application operations and events. Trace
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information is displayed in the window and written to files located in the <NinjaTrader
Installation Folder>\trace folder. By default, this tab should be invisible. You can enable or
disable visibility via the Tools-->Options menu, General Tab of the Control Center window.

-o-

Data Grids

Data Grids Overview
You will find the use of data grids throughout the NinjaTrader application.

With a data grid you can:

 Size and hide columns
 Export data to Excel
 Save data as a file
 Print data

You may want to export your execution history to Excel for further analysis as an example.
Simply go to any grid displaying execution history, right click and select the "Export to
Excel..." menu.
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Each data grid's right click context menu will display the menu options in the above image.
Depending on which data grid you are working with  (Orders, Executions, Positions etc...) you
will potentially see additional menu options relevant to the data you are viewing. For
example, in the orders data grid, you will also see menu options for "Cancel Order" and
"Cancel All Orders".

Grid Properties
Selecting the "Grid Properties..." menu option will open a grid properties window. In this
window, you can choose which columns you wish to show (make visible) and modify the
display order of columns.

-o-

Historical Data

Overview
NinjaTrader, LLC is not a market data provider. Historical data is provided by our connectivity
providers that offer historical data as part of their service.

Connectivit
y Provider

Real-Time
Data

Historical
Tick Data

Historical
Minute
Data

Historical
Daily Data

Instrument
s

Supported

Real-Time
News

BarChart (
view pricing
)

YES YES YES YES E, F, FX, I NO

eSignal YES YES YES YES E, F, FX, I YES

https://www.barchart.com/register/realtime/?ID=NJA
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FuturesBetti
ng

YES NO NO NO F NO

GAIN
Capital/FOR
EX.COM

YES YES (24
hours back)

YES (24
hours back)

NO FX NO

Interactive
Brokers

YES NO YES (live
account
only)

YES (live
account
only)

E, F, FX, I NO

IQFeed YES YES YES YES E, F, FX, I YES

MB Trading YES NO NO NO E, F, FX NO

Patsystems YES NO NO NO F NO

PFGBEST.co
m

YES YES YES YES F, FX NO

TD
AMERITRAD
E

YES NO YES YES E, I YES

TrackData YES YES YES YES E, I NO

TradeStatio
n

YES NO YES NO E, F, FX, I NO

Trading
Technologie
s

YES YES YES NO F NO

Vision
Financial
Markets

YES YES YES NO F NO

YAHOO NO NO NO YES E NO

Zen-Fire YES YES YES NO F NO

E = Equities
F = Futures
FX = Forex
I = Indexes

NinjaTrader Converts Real-Time Data into Historical Data
NinjaTrader stores real-time incoming tick data to your local PC if you have a Chart or Market
Analyzer (must have an indicator column added) window open. This data can then be used as
historical data. For example, if you open a chart and let it run all day long, the data collected
today, will be available as historical data when you open the same chart tomorrow.

Connecting to your Broker and a Market Data Provider Simultaneously
If your broker technology does not support historical data, you can connect to a service like
eSignal at the same time as connecting to your broker so that you can receive historical data.
Please see the topic on "Multiple Connections" for additional information.

Create a Connection to Yahoo for Free Historical Daily Data
You can create a connection to Yahoo Finance via the Tools-->Account Connections menu.
This connection provides access to free historical daily data that can be used for system
development and backtesting.

-o-
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Export
You can export historical data in ".txt" format via the Tools-->Historical Data-->Export menu.

Export Folder
Exports files are written to the folder "My Documents\<NinjaTrader Folder>\db\export"

Where User is the name of the Windows user account such as "Admin" or any user account
you created and are logged into.

Tick Format
Each tick written on its own line and fields are separated by semicolon (;).

The format is:
yyyyMMdd HHmmss;price;volume

Sample data:
20061107 000431;1383.00;1
20061107 000456;1383.25;25
20061107 000456;1383.25;36
20061107 000537;1383.25;14

Minute Bars Format
Each bar is written on its own line and fields are separated by semicolon (;).

The format is:
yyyyMMdd HHmmss;open price;high price;low price;close price;volume

Sample data:
20061023 004400;1377.25;1377.25;1377.25;1377.25;86
20061023 004500;1377.25;1377.25;1377.25;1377.25;27
20061023 004600;1377.25;1377.25;1377.25;1377.25;24
20061023 004700;1377.50;1377.50;1377.25;1377.25;82

Daily Bars Format
Each bar is written on its own line and fields are separated by semicolon (;).

The format is:
yyyyMMdd;open price;high price;low price;close price;volume

Sample data:
20061023;1377.25;1377.25;1377.25;1377.25;86
20061024;1377.25;1377.25;1377.25;1377.25;27
20061025;1377.25;1377.25;1377.25;1377.25;24
20061026;1377.50;1377.50;1377.25;1377.25;82

-o-

Import
You can import historical data using a text file in ".txt" format via the Tools-->Historical
Data-->Import menu. Tick data is used to build tick and volume bars of all intervals, minute
bars are used to create minute bars of all intervals and daily bars are used to create day bars
of all intervals.

A few tips:
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 If you are importing historical data for a futures or forex instrument, the instrument MUST
exist in the Instrument Manager and if it does not, you must add it first

 Any data imported where the instrument does not exist in the Instrument Manager will
automatically be imported as a "Stock" instrument type

 NinjaTrader bar time stamps are end of bar. This means that a 9:31 bar consists of data
from 9:30:00 through 9:30:59. Please ensure that your source data time stamps are inline
with this.

 Data points will be rounded to the instruments tick size as it is imported if the price is no
evenly divisible by the instruments ticksize

File Name
The name of the file must be the instrument name within NinjaTrader. For example:

MSFT.txt for Microsoft
ES 12-06.txt for the S&P Emini December contract

Tick Format
Each tick must be on its own line and fields must be separated by semicolon (;).

The format is:
yyyyMMdd HHmmss;price;volume

Sample data:
20061107 000431;1383.00;1
20061107 000456;1383.25;25
20061107 000456;1383.25;36
20061107 000537;1383.25;14

Minute Bars Format
Each bar must be on its own line and fields must be separated by semicolon (;). Only 1
minute bars can be imported.

The format is:
yyyyMMdd HHmmss;open price;high price;low price;close price;volume

Sample data:
20061023 004400;1377.25;1377.25;1377.25;1377.25;86
20061023 004500;1377.25;1377.25;1377.25;1377.25;27
20061023 004600;1377.25;1377.25;1377.25;1377.25;24
20061023 004700;1377.50;1377.50;1377.25;1377.25;82

Daily Bars Format
Each bar must be on its own line and fields must be separated by semicolon (;). Only 1 day
bars can be imported.

The format is:
yyyyMMdd;open price;high price;low price;close price;volume

Sample data:
20061023;1377.25;1377.25;1377.25;1377.25;86
20061024;1377.25;1377.25;1377.25;1377.25;27
20061025;1377.25;1377.25;1377.25;1377.25;24
20061026;1377.50;1377.50;1377.25;1377.25;82
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Import Historical Data from TradeStation
Make sure you have imported the NinjaTrader.ELD. If not, instructions are found here.

To download historical data from TradeStation for import into NinjaTrader, open a chart in
TradeStation and open the Format Symbol window.

Futures Note: If  you want to download historical futures data, use the TradeStation
continuous contract such as "@ES". Once imported into NinjaTrader, it will be
mapped to the closest individual contract. If the current month is November, 2006,
data would be mapped to the December contract which is "ES 12-06".

This import procedure will allow you to construct charts in NinjaTrader that use minute bars.
Tick or daily bars can not be constructed from this procedure.

1. Set the symbol
2. Set the interval to 1 Minute bars (do not set to any other interval)
3. Last date should be today's date
4. First date should be set to the first data you wish to download historical data for
5. Set the time zone to "Local"
6. Press the "OK" button

7. Right mouse button click in your TradeStation chart and select "Insert Strategies"
8. Select the "NTDataDownload" strategy
9. Press the "OK" button
10. Press the "CLOSE" button
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11. The NTDataDownload strategy is now creating a file that contains historical data that can
be imported into NinjaTrader
12. Start NinjaTrader
13. Select the menu Tools-->Historical Data-->Import to import the downloaded historical
data which will be visible in the File Dialog window

-o-

Merge
Merge
You can merge data between individual futures contracts. NinjaTrader will automatically price
*adjust historical data to provide one continuous contract.

1. Select the menu Tools-->Historical Data-->Merge...
2. In the "Merge the following data" box, select the instrument whose historical data you wish
to merge
3. Select the "From" date and "To" date which represents the start and end time of the
historical data set to merge 
3. In the "Into" box, select the target instrument you will be merging the historical data into
4. Press "OK" button

In the example image below, a historical data set starting from September 8th, 2006 through
December 6, 2006 of the ES December contract will be merged into the ES March 2007
contract. 

* Prior contract data is adjusted since there is always a price difference between the expiring
contract and the current front month contract. This is called the "premium" and includes the
cost of interest and the dividends of the underlying index.

The formula used to back adjust historical data is as follows:

New price = Old price + (Open price of front month of merge date - Close price of expiring
month on the day prior to the merge date)
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Reload
There are two ways to reload historical data into NinjaTrader.

Reloading from a chart
While you are connected to a market data provider that supports historical data, right click
within a chart to bring up the context menu and select "Reload Historical Data". Historical
data for the base interval unit (minute bars for a 5 minute chart for example) will be reloaded
for the instrument and chart date range.

Reloading from a dialog window
You can load/reload historical data from a broker or market data provider that supports
historical data. Common reasons you would want to reload historical data are:

 You have data gaps in your charts
 You want to refresh charts or any other function in NT that requires historical data due to

inaccurate data

You must first be connected to a broker or market data provider that supports historical
data.

1. Select an instrument to reload historical data for
2. Select the date range to reload data for
3. Select the data interval type
4. Press the "OK" button

-o-

Delete
You can delete historical data from your database.
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1. From within the Control Center window select the menu Tools > Historical Data > Delete to
open the "Delete Historical Data" dialog window as seen in the image above
2. Select an instrument for whose historical data you wish to delete
3. Select the date range of the historical data set you wish to delete
4. Select the type of data you wish to delete
5. Press the "OK" button

-o-

When does NinjaTrader Load Historical Data
NinjaTrader loads data from your data provider whenever it determines it could potentially
not have all the data pertaining to the requested time period. 

NinjaTrader will load data when:

1.“Format Data Series” contains the current day

2.“Format Data Series” contains the last day of data available in your database

3.The database contains no data within 3 days of the “From” date

Examples of when NinjaTrader will fetch data if the database contains data from 1/3/08 to
1/6/08:

1.Chart of 1/3/08 to 1/7/08 -> load data

2.Chart of 1/3/08 to 1/6/08 -> load data

3.Chart of 1/3/08 to 1/5/08 -> use database data

4.Chart of 12/28/07 to 1/5/08 -> load data

To minimize the need to load data and to speed up chart load times, NinjaTrader maintains
an internal cache of your prior accessed data. When data is in this cache, NinjaTrader will use
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it to populate your charts instead of loading from your data provider. There are two ways to
ensure that the internal cache contains data for your instrument of interest.

1.Open and maintain a chart of any time frame containing the instrument

2.Load the instrument into a Market Analyzer window along with an indicator column

The Market Analyzer option is not as viable since it only maintains a 100 bar cache as a
default setting that can be changed. Since 99% of all charting requests consist of much more
than 100 bars, they will most likely incur a data load.

Note: The internal cache is managed by the .NET framework so it is unpredictable when the
.NET runtime will clear it. In most cases, as long as you have at least one chart of your
instrument open, the instrument’s data cache will persist.

-o-

Instrument Manager

Instrument Manager Overview
NinjaTrader supports multiple connectivity providers and therefore manages a single
instrument instance (master instrument) and maintains the parameters required to establish
market data and order permissions through the various connectivity sources. The Instrument
Manager manages the instrument lists , edits instrument data and can add or remove
instruments from the database. A default database of commonly traded instruments is
installed with NinjaTrader.

The Instrument Manager can be accessed via the Control Center window Tools-->Instrument
Manager menu.

-o-

Searching for Instruments
NinjaTrader is installed with a database of the most commonly supported instruments that
you can search through.

1. From the Instrument Manager, first select an available instrument type:

2. Enter any search parameters. You can use wildcards such as "*".
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3. Press the Search button. Below is an image of a completed search for all instruments of
type "Future" with the name beginning with the letter "E". The search returned three
matches.

You can double click any selected instrument (blue highlight) or press the "Edit" button to see
the detailed information on the selected instrument.

-o-

Adding Splits and Dividends
Automatic Update
You can automatically update an instrument with historical split and dividend adjustment data
from within the Instrument Editor. You can skip step 1 if you already have create a Yahoo
connection.

1. Create a connection to Yahoo via the menu Tools-->Account Connections from within the
NinjaTrader Control Center window
2. Connect to Yahoo via the menu File-->Connect
3. Open the Instrument Manager via the menu Tools-->Instrument Manager
4. Select the stock that you wish to update with historical split and dividend data
5. Press the "Edit" button to bring up the Instrument Editor window
6. Select the "Misc" tab and scroll down to the bottom section "Splits & Dividends"
7. Press the "Update splits & dividends" button

NinjaTrader will now request historical splits and dividend information from Yahoo Finance
and populate the information in your local database.

NOTE: The "Update splits & dividends" button only appears when connected to a provider that
supports historical splits and dividend data.

-o-

Editing Instruments
The Instrument Editor displays all parameters that define an instrument including symbol
mappings to your connectivity provider and symbol level commission values. The editor
allows you to change or add parameters to an instrument's profile. In general, instruments
that are installed with NinjaTrader do not require any parameter modification. However, you
may want to override your global commission settings if a particular symbol has a unique
commission structure.
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In the Instrument Manager, once an instrument is selected in the instrument grid, you can
double click or press the "Edit" button to open the Instrument Editor.

Definition Tab
The definition tab displays parameters that uniquely define an instrument.

Definition Tab Parameters
Master instrument The NinjaTrader master name of the instrument
Instrument type The instrument type (asset class)
Tick size The increment value the instrument trades in
Currency The currency the instrument trades in
Point value The currency value of 1 point of movement for the instrument
Rollover period The number of months between contracts (futures and options)
Sim feed start price The starting price for internally generated data feed (Simulated data

feed connection)
Margin value The margin required for backtesting this instrument
Description Description of the instrument
URL The website address of the instrument definition
Exchanges Sets the exchange that the instrument is traded on

Misc Parameters
The misc tab allows you to set instrument level commission settings, symbol mapping, split
and dividend information.

Commission Section
Instrument level commission values override global commission settings. An example would
be if you have a standard commission rate from your broker for most instruments but there
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may be an exception where your rate is different for the DOW Emini contract. You would then
set the custom DOW Emini contract commission rate at the instrument level. Please review
the following help section to understand how to manipulate commission values.

Symbol Mapping
If you add a new instrument that is not already in the NinjaTrader instrument database you
will need to map the new instrument to the symbol used for the connectivity provider (broker
or data feed) that you will be requesting data from. Most instruments in the database are
already mapped.
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Splits & Dividends
NinjaTrader will split and dividend adjust historical chart data based on the information
defined per instrument and if options are enabled to do so. Some market data providers
provide already adjusted data while others do not. Please see the following help instructions
for adding split and dividend data to an instrument. 
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Adding Commission Rates
You can add instrument level commission rates that override global commission settings. You
may set up a global commission rate for trading futures of $4.00 per side however you may
have a reduced rate for trading the DOW Mini futures contract of $3.00 per side in which case
you need to add this rate the DOW Mini contract in the Instrument Manager.

1. Open up the Instrument Editor window for the instrument you wish to add a commission
rate for.
2. Expand the Commission parameter for your connectivity provider.

3. Click the "..." button to open the Collection Editor - Commission Item window
4. Press the "New" button and you will see a commission item object added in the window like
below.

Commission Per side commission rate
Units The number of contracts/shares that the associated commission rate is

valid for (a value of zero represents an infinite limit)

5. Enter a commission rate value and unit limit that the rate is affective for.
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Example: If we had a commission rate of $3.00 per side for an unlimited number of contracts,
the set up would look like the image below.

6. Press the "OK" button.

-o-

Instrument Lists
There are several uses for an instrument list:

 Backtesting in the Strategy Analyzer
 The "Default" instrument list is used for quick access to commonly used instruments within

most NinjaTrader windows such as Charts or SuperDOM

1. Press the "New" button to create a new list
2. Press the "Delete" button to delete a list
3. Display all instrument lists

NOTE: The "Default" instrument list can not be deleted
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Add/Remove from a list
The collection of instruments that comprise a list is displayed in the left pane of the
Instrument Manager.

ADD
1. Select the list you wish to add an instrument to 
2. Select a master instrument in the instrument grid
3. Depending on the instrument type, parameter drop down lists will become enabled. In the
above example, the ES futures contract is selected which prompts you to enter the Exchange
and Expiry parameters.
4. Press the left arrow button.
5. The instrument ES 12-06 (S&P Emini Futures December 2006 contract) is added to the
instrument list and will now be available throughout the NinjaTrader application.

Remove
1. Select an instrument in the instrument list in the left pane of the Instrument Manager
2. Press the right arrow button.

http://www.ninjatrader.com/V5_Videos/InstrumentManager2.html
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Manage Database
NinjaTrader installs with a predefined database of commonly traded instruments. There will
be rare occasions where you may need to add a new instrument to the database.

Add
1. Press the "New" button which opens the Instrument Editor
2. Add instrument parameters including the symbol mapping for your connectivity provider(s)
3. Press the "OK" button.

Delete
1. Select a master instrument in the instrument grid
2. Press the "Delete" button

-o-

TradeStation Symbol Mapping
The following section outlines the requirements  for proper TradeStation to NinjaTrader
symbol mapping when using the Automated Trading Interface (both DLL or Email interface)
and/or using the TradeStation's market data through the External Data Feed Connection for
simulation.

Stocks and Forex Symbols
Mapping is NOT required for stocks or Forex symbols.

I Want to Map an Individual Futures Contract
To send either market data via the NTExternalFeed strategy or orders through the ATI to
NinjaTrader from an individual futures contract such as the Emini S&P March contract
"ESH06" in TradeStation or the Euro FX March Contract "ECH06", you have to correctly set up
mapping within NinjaTrader.

For this example, let's map the "ECH06" contract.

1. From the Control Center window select the menu Tools-->Instrument Manager
2. Highlight the 6E contract from the main grid which is the NinjaTrader Euro FX contract
3. Press the "Edit" button to bring up the "Instrument Editor" window
4. Select the "Misc" tab
5. Next to "Symbol map - External" set the value to "EC"
6. Press "OK"

* The symbol map name "EC" in the image below needs to be the TradeStation symbol base
name.
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This procedure would be repeated for any other symbols you wish to map between
TradeStation and NinjaTrader.

*Most popular futures contracts already have mapping set up

I Want to Map a Continuous Contract
NinjaTrader can map continuous contracts in one of two ways:

 Automatically map to the next closest expiration date
 User defined contract mapping

For automatic mapping, follow the instructions above for "I Want to Map an Individual Futures
Contract" otherwise follow the instructions below.

If you run the TradeStation Automated Trading Interface through the email protocol or want
to use the NTExternalFeed strategy to drive NinjaTrader Simulation Edition with a
TradeStation continuous contract follow the instructions below. We will use the "@ES"
continuous contract symbol and front month of March 2006 for example purposes.

1. From the Control Center window select the menu Tools-->Instrument Manager
2. Highlight the ES contract from the main grid
3. Press the "Edit" button to bring up the "Instrument Editor" window
4. Select the "Misc" tab
5. Next to "Symbol map - External" set the value to "ES|03-06"
6. Press "OK"

* The symbol map name "EC" in the image below needs to be the TradeStation symbol base
name.

Automated Trading Interface - Orders generated for "@ES" will now be routed to the
NinjaTrader "ES 03-06" contract. 
NTExternalFeed strategy - Data from your "@ES" chart will be sent to the NinjaTrader "ES
03-06" contract.

Please remember to change this when the contract rolls over. If your system is trading on the
"ESH06" symbol you could just leave the symbol mapping in NinjaTrader to "ES" instead of
the "ES|03-06" as shown above.

-o-

Importing a list of stock symbols
Importing a list of stock symbols is an efficient way to add instruments to the Instrument
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Manager in bulk.

1. Within the Control Center window select the menu File > Utilities > Import Stock Symbol
List
2. Press the "Load" button to open a text file that contains your symbol list or type each
symbol into the editor manually

The text file must contain valid symbols separated by either -

 User defined character such as a semicolon or comma
 White space
 Carriage return

3. The symbols for import are listed in the editor
4. Select the exchange the instruments are traded on
5. Select the currency the instruments are traded in
6. Optionally add the instruments to an Instrument List (optionally create a new one)
7. Enter any user defined separator characters
8. Press the "OK" button to import

-o-

Level II

Overview
The Level II window displays bid and ask data color coded by price. It is used to gauge
strength and depth on either side of the market. Each price row in the Details section shows a
Market Maker or ECN for that price level. For non-Nasdaq stocks, market depth is displayed
for the regional exchange the market is traded.
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Changing Instruments
You can change an instrument via the right mouse button click menu "Instruments" sub
menu.

1. Details Section
The Details section displays bid data on the left and ask data on the right.

ID - The Market Maker or ECN identification
Price - The bid or ask price
Size - The number of shares/contracts at that price level available for buy or sell by the
specific Market Maker or ECN
Time - The last time the bid/ask was refreshed by the Market Market or ECN

You can disable the Detail section via the right mouse button click menu "Show Details" sub
menu.

2. Summary Section
The Summary Depth section shows totals per price level.

Price - The bid price by ask price
Depth - Number of market participants on the bid by ask price
Size - The total number of shares/contracts on the bid by ask price
Spread - The spread between the bid and ask price
Graph - Visual display of either Size or Depth (number of market participants)

You can change the graph type via the Level II Properties dialog window. You can disable the
Summary section via the right mouse button click menu "Show Summary" sub menu.
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3. Quotes Section
The Quotes section displays various market data items. You can add/remove items in this
display via the right click mouse menu within the Quotes section. You can disable the Quotes
section via the right mouse button click menu "Show Quotes" sub menu.

-o-

Tracking Market Makers
You can track a Market Maker by double clicking on the Market Maker in the Details section of
the Level II window. The Market Maker will change color based on the color setting in the 
Properties dialog window.

Below you can see that the Market Maker UBSS is being tracked.

You can also see the list of tracked Market Makers via  the right mouse button click menu
"Tracked Market Makers" sub menu.

-o-

Properties
Level II properties are accessible via the right mouse click menu.



p183

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Property Definitions
# of price levels
(Details)

Sets the number of visible price levels in the details section of the
Level II window

# of price levels
(Summary)

Sets the number of visible price levels in the summary section of the
Level II window

Graph Graphs the total size at a price level or depth which is number of
market participants

Size divided by 100 Displays the the size column values divided by 100
Time refresh When true, updates every 250ms otherwise every tick
Color for price level
XXX

Sets the back ground color for a specific price level

Back color for tracked
market makers

Sets the back color for tracked market makers

Fore color for tracked 
market makers

Sets the fore color for tracked market makers

-o-

Market Analyzer

Market Analyzer Overview
The Market Analyzer window is a high powered quote sheet that enables real-time market
scanning of multiple instruments based on your own custom criteria.

The Market Analyzer allows you to:
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 Monitor indicator columns using user defined bar intervals
 Monitor market data columns
 Monitor trade data columns 
 Define custom cell color conditions
 Define custom row filters
 Define custom dynamic ranking and sorting criteria
 Define custom alerts

-o-

Creating a Market Analyzer Window
From the NinjaTrader Control Center window, select the menu File-->New-->Market
Analyzer...

-o-

Adding/Removing Columns
Columns are added/removed and edited via the Columns dialog window. To access the
Columns dialog window, from within a Market Analyzer window right mouse click and  select
the menu "Columns...".

Columns Dialog Window
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1. Available columns
2. Current columns applied to the Market Analyzer window
3. Selected column's properties

Add Column
1. From the Columns dialog window, select a column and press the "Add" button or simply
double click.

2. Once added to the list of applied columns, you can now edit the column's properties.
Different columns will have different editable properties.
3. You can modify the order that the column(s) are displayed in the Market Analyzer window 
4. Once you have set the column's properties, press the "OK" button to apply and close the
Columns dialog window or, press the "Apply" button to keep the Columns  dialog window
open and apply your new column.
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Adding Indicators
When adding a column, select "Indicator" from the list of available columns. You can then
select the desired indicator from the column properties.

Remove Column
1. From the Columns dialog window, select a column from the applied columns list
2. Press the "Remove" button
3. Press "OK" or "Apply"

-o-

Regular vs Bar Graph Column
Market Analyzer window data columns can be formatted to display their data as values or as
bar graph's.

A data column "Type" property is set to "Regular" by default which formats the column to
display it's data as a value. You can toggle the column type between "Regular" and
"BarGraph" via the Columns dialog window. When "BarGraph" is selected, the follow
additional properties are available.

Bar graph growth type
Sets the style of growth for the bar graph.

LeftToRight - Will grow from left to right where the left most value is equal to the "Bar graph
reference value"
RightToLeft - Will grow from right to left where the right most value is equal to the "Bar graph
reference value"
Center - Will grow from the center out where the center line is equal to the "Bar graph
reference value"

Bar graph reference value
Sets the value for the starting point of growing a bar graph. If  you have a LeftToRight bar
graph with a reference value of zero, the bar graph will be displayed in a column cell once the
cell's value is greater than zero.

Color for values < reference value
Sets the color of the bar graph when the cell value is greater than the reference value.

Color for values > reference value
Sets the color of the bar graph when the cell value is less than the reference value.

Max. bar graph display
Sets the maximum value of the bar graph. For example, if you have a LeftToRight bar graph
with a reference value of zero, the left most value is zero (start of the cell) and the right most
value (end of the cell) would be set to the maximum value.

The the following example will demonstrate a use case for a bar graph column to display the
value of a 14 period ADX indicator.

After adding an ADX indicator data column:

1. Change the column type to "BarGraph"
2. Set the "Bar graph growth type" to "LeftToRight"
3. Set the "Bar graph reference value" to a value of "0"
4. Set the "Color for values > reference value" to "Lime"
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5. Set the "Max. bar graph display" to a value of "100" since ADX indicator only returns a
value from 0 to 100.
6. Press "OK"

The image below is the result. Since the ADX indicator is an indication of strength of trend,
we can easily determine that the ZB 12-06 indicator has the strongest trend in relation to the
other instruments in the Market Analyzer  window.

-o-

Adding/Removing Instruments
Adding Instruments
You can add a single instrument or an instrument list via the right mouse button click context
menu.

NOTE: It is more efficient to add instruments after defining the columns of your Market
Analyzer window. This will minimize NinjaTrader re-loading historical data into the Market
Analyzer window.

Removing Instruments
Select a row that represents the instrument you want to remove and via the right mouse
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button click context menu, select the sub menu "Remove Instrument".
 

-o-

Dynamic Ranking and Sorting
You can have the Market Analyzer window automatically rank and sort the data rows.

1. Set the column you wish to sort on by clicking in the column header to either descending
(down arrow) or ascending (up arrow)

2. Enable dynamic sorting via the right mouse button click context menu, sub menu "Auto
Sort"

You can set the auto sort interval within the Properties dialog window.

-o-

Creating Alert Conditions
Alert conditions allow you to define a custom alert based on the cell's value. Alert conditions
are defined per column. Alert notifications are displayed in the Alert Window. You can
enable/disable alert conditions within the Market Analyzer window via the right mouse button
click context menu sub menu "Alerts".

To create an alert condition, right mouse button click inside the Market Analyzer window and
select the sub menu "Columns...".

1. Select a column to create an alert condition for and press the "..." button under the
property "Alert conditions"
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2. Press the "New" button to add a new alert condition to the list of alert conditions displayed
in the left window
3. Set the alert condition properties

The example alert condition above will:

 Trigger the alert once the cell value is greater than 30
 Display a lime green background with white text
 Display "Trending" as the alert text



p190

© NinjaTrader, LLC, 2005

www.ninjatrader.com

 Re-arm the alert after 60 seconds has passed
 Display a "Low" priority
 Play an alert sound

Don't Confuse Multiple Alert Conditions as Multiple Alerts
You can have one alert per Market Analyzer column and each alert can have multiple
conditions. Conditions are evaluated from top to bottom.

Assume you have an alert with the following conditions defined:

Alert if value is greater than 30
Alert if value is greater than 100

In this example, if the value of the cell was greater than 100, the first condition of "greater
than 30" would trigger the alert since its first in the list of conditions to be evaluated. The
"greater than 100" condition would never trigger in this example since "greater than 30" will
always trigger the alert first. To ensure that both conditions trigger an alert so that you get
the desired alerting behavior you want, you have to list the conditions in this order:

Alert if value is greater than 100
Alert if value is greater than 30

This will guarantee that a cell value over 100 will fall in the "greater than 100" condition and
cell values between 30 and 100 will be triggered by the "greater than 30" condition.

-o-

Creating Color Conditions
Color conditions allow you to define the display behavior of a cell based on the cell's value.
Color conditions are defined per column. To create a color condition, right mouse button click
inside the Market Analyzer window and select the sub menu "Columns...".

1. Select a column to create a color condition for and press the "..." button under the property
"Color conditions"
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2. Press the "New" button to add a new color condition to the list of color conditions displayed
in the left window
3. Set the color condition properties

You can remove a condition by pressing the "Remove" button.

Multiple Color Conditions
Conditions are evaluated from top to bottom.
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Assume you have the following conditions defined:

Change color if value is greater than 30
Change color if value is greater than 100

In this example, if the value of the cell was greater than 100, the first condition of "greater
than 30" would change the cell's color since its first in the list of conditions to be evaluated.
The "greater than 100" condition would never trigger in this example since "greater than 30"
will always trigger the color change first. To ensure that both conditions trigger a color
change so that you get the desired alerting behavior you want, you have to list the conditions
in this order:

Alert if value is greater than 100
Alert if value is greater than 30

This will guarantee that a cell value over 100 will fall in the "greater than 100" condition and
cell values between 30 and 100 will be triggered by the "greater than 30" condition.

-o-

Creating Filter Conditions
Filter conditions allow you to define conditions that filter out rows from the Market Analyzer
grid display based on the cell's value. Filter conditions are defined per column. To create a
filter condition, right mouse button click inside the Market Analyzer window and select the sub
menu "Columns...".

1. Select a column to create a filter condition for and press the "..." button under the property
"Filter conditions"

2. Press the "New" button to add a new filter condition to the list of filter conditions displayed
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in the left window
3. Set the filter condition properties

You can enable/disable filtering via the Market Analyzer right mouse button click context
menu "Row Filter". When enabled, the Market Analyzer will filter out rows from the grid based
on the filter conditinos of the columns. 

-o-

Performance Tips
Create Columns Before Adding Instruments
It is more efficient to add columns and set any alert, color and filter conditions before adding
instruments to the Market Analyzer. The Market Analyzer reloads and re-calculates cell values
each time you make any change to a column. Defining your columns first when there are no
instruments loaded will save a lot time due to constant re-loading of data.

"# bars to look back" Property
Set this number to the minimum number of bars required to properly initialize any indicator
columns. The higher the number, the longer it will take to load data and the more memory
(RAM) NinjaTrader will use to hold the data in memory. 

Start and Connect Before the Market Opens
The number of instrument rows, the number of indicator columns and the interval type and
bar look back period determines how much historical data needs to be loaded into memory. If
your Market Analyzer window requires a lot of historical data to load, it is suggested that you
start NinjaTrader and connect prior to market open so that NinjaTrader does not have to
process historical data loading during trading time.

Refresh on Changing of Column Properties
The Market Analyzer  will reload current day historical data and re-calculate indicator columns
on any change to any column property. Try to minimize changing properties during trading
hours if your Market Analyzer window has a lot of instruments and indicator columns
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-o-

Market Analyzer Templates
Market Analyzer templates are a way to save user defined customized settings for future
recall.

Saving a Default Template
A default template is the Market Analyzer settings used each time you create a new Market
Analyzer. Once you have a Market Analyzer set up to your liking, select the menu
Templates-->Save As Default from the right mouse click context menu within a Market
Analyzer.

Saving a Template
1. Once you have a Market Analyzer set up to your liking, select the menu Templates-->Save
As... from the right mouse click context menu within a Market Analyzer

2. The Save as Template dialog window will appear. Give your template a name and press the
"OK" button.

Removing a Template
1. Select the menu Templates-->Save As... from the right mouse click context menu within a
Market Analyzer
2. The Save as Template dialog window will appear, select the template for removal from the
list of templates and press the "Remove" button

Loading a Template
1. Select the menu Templates-->Load... from the right mouse click context menu within a
Market Analyzer
2. Select the template you wish to load from the list of templates and press the "OK" button

-o-

Reloading Indicators and Columns
When compiling custom NinjaScript indicators and columns, the Market Analyzer window will
not automatically reload the changes. To force a reload of any changed indicators or columns
you must select the menu "Reload NinjaScript" via the right mouse button context menu or
alternatively, press the "F5" key.

-o-

Properties
Market Analyzer properties are accessible via the right mouse click menu.
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Property Definitions
# of bars to look back Sets the number of bars of historical data to use for indicator column

calculations
Auto sort seconds Sets the interval time in seconds between automatic resorting of rows
Color for background Sets the default color for the row background
Color for foreground Sets the default color for the text in a cell
Color for grid lines Sets the color of grid lines
Exclude weekend Enables or disables weekend historical data for use in indicator column

calculations
Font Sets the font
Session begins Starting session time for historical data required for indicator column

calculations
Session ends Ending session time for historical data required for indicator column

calculations
Back color Sets the color of for the background of the 'Total' row
Enabled Enables or disables the display for the 'Total' row. The 'Total' row is

the first row of the Market Analyzer grid and displays the total (sum)
value for each column.

-o-

Market Replay

Market Replay Overview
Market replay is the ability to record market data and replay it at another time. It is the same
as recording your favorite TV show during the day and watching it at some other more
convenient time. Unlike most products that only allow you to replay one market at a time,
NinjaTrader provides synchronous replay of any and all recorded markets and delivers this
market data to all NinjaTrader windows as if it was happening real-time. Therefore, you can
have multiple SuperDOMs and charts replaying different markets all at the same time. You
can trade in simulation against this data at varying levels of replay speed.



p196

© NinjaTrader, LLC, 2005

www.ninjatrader.com

On occasion, NinjaTrader, LLC will provide pre-recorded market data for use with the market
replay function. If new data exists, NinjaTrader will detect and inform you upon application
start up and ask you if you wish to download this data.

NOTE: Market Replay is not supported in the NinjaTrader Direct Edition.

-o-

Set Up
In order to run market replay you must have recorded data to replay. Via the Control Center
window, Tools-->Options, Data tab :

1. Enable "Run market replay recorder"

-o-

Replay
To initiate replay you must first connect to the "Market Replay Connection" via the Control
Center window, File-->Connect-->Market replay connection and select the date that you want
to replay.

Once connected, a replay control will appear.
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The replay control looks like a standard VCR control.

1. Play button - starts the market replay
2. Pause button - pauses market replay
3. Speed control button - each successive click will increase the speed of replay (current
speed displayed in the caption bar of the replay control)
4. Slide control - selects the point time where you want to be in replay (can slide this during
replay)

The current time stamp is displayed in the caption bar of the replay control.

Chart Settings
You should always use a brand new chart for market replay if possible. From the Contol
Center window select "File-->New-->Chart..." and select the instrument and interval for your
chart. Close this chart after finished with market replay.

If you decide to use the same chart windows that you use for live trading, you must reset the
chart "Last date" property to today's date by clicking on your right mouse button in the chart
and selecting the menu "Format Data Series..." after you have reconnected to your live
account. If you do not do this, your chart will not update with current market data.

Fast Forward to a Specific Time
You can fast forward to a specific time by moving your mouse cursor into the replay control
and via the right mouse button click context menu select the sub menu "Go To..." as per the
image below.

Available Instruments
As in the above image, there is also an "Available Instruments" menu that will display a list of
instruments that have recorded data for the selected date.
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-o-

Data Files
Market replay data is recorded and stored in compressed files located in the <Installation
Folder>\db\data folder. These files can be shared by copying the contents of this folder to
another NinjaTrader installation.

-o-

News

Overview
The News window allows you to display, filter and create alerts for real-time news. You will
receive real-time news if are subscribed to a news service through a market data vendor or
your broker.

1. Selects user defined filters
2. Enables user defined alerts
3. List of real-time news headlines
4. Displays the news story for the selected news headline
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-o-

Working with Alerts and Filters
You can create news alerts and filters.

Alerts
An alert will visually and audibly notify you when your user defined conditions have been met.
You can define an alert by:

 Keyword
 Filtering on a specified instrument list
 Filtering on a specified set of news providers

To add an alert, click on your right mouse button in the upper left hand portion of the News
window and select the "Add Alert..." menu. To remove an alert, highlight an alert in the upper
left hand portion of the News window, click on your right mouse button and select the
"Remove Alert" menu. You can enable/disable an alert by checking/unchecking the checkbox
next to the alert in the upper left hand portion of the News window

Filters
A filter will only display news items if they meet your user defined conditions. You can define
a filter by:

 Keyword
 Filtering on a specified instrument list
 Filtering on a specified set of news providers
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To add a filter, click on your right mouse button in the upper left hand portion of the News
window and select the "Add Filter..." menu. To remove a filter, select the filter to remove from
the filter drop down list in the upper left hand portion of the News window, click on your right
mouse button and select the "Remove Filter" menu. You can enable a filter by selecting it
from the filter drop down list in the upper left hand portion of the News window.

-o-

NinjaScript

NinjaScript Overview
NinjaScript is NinjaTrader's extension to the powerful Microsoft C# language. In addition to
the core functionality of C# and the Microsoft .NET framework we have added features
designed for the rapid implementation of custom indicators, automated trading systems and
custom drawing. 

 NinjaScript runs compiled NOT interpreted code providing you with the highest level of
performance and security

 Modern programming language with infinite number of  help resources available online and
in print

 All NinjaTrader installed chart indicators and sample strategies come with full source code

The NinjaScript section is broken into sub sections designed to get you up to speed if you are
brand new to programming or let you dive right in if you understand programming basics.

-o-

Developing Custom Indicators

Overview
The building blocks of any automated trading system are indicators. NinjaScript allows you to
develop custom indicators in rapid time. A few key points are:

- Custom indicators are compiled and run natively within the NinjaTrader application
providing the highest performance possible
- Indicator values are calculated at the current bar which ensures that you do not accidentally
include future data in your calculations
- You can retain calculations between bar updates
- You can retain and share calculation values between bar updates across indicators

Custom indicator development follows a logical progression.

Wizard
The wizard allows you to define your overall indicator parameters which include name,
properties, inputs, plots and oscillator lines. The wizard will then generate the necessary
NinjaScript code and open up the NinjaScript Editor.

Initialize() Method
The Initialize() method is called once before any initial calculation triggered by an update bar
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event. This method is used to configure the indicators plots, lines and properties. The wizard
will generate the required NinjaScript code for this method for most cases.

OnBarUpdate() Method
The OnBarUpdate() method is called with either with each incoming tick or on the close of
each bar depending on how you deploy the indicator at run time. Your core indicator
calculation logic is contained within this method.

Debug
The NinjaScript Editor will perform both syntax and semantic checks and list any errors at the
bottom of the NinjaScript Editor. If there are logic problems with your indicator, they will be
listed in the Log tab of the NinjaTrader control center during run time. You can use the Print()
method within your script to help debug your code. Output will be sent to the NinjaTrader
Output window.

Compilation
Once the coding effort is completed, you must then compile the indicator (several second
process) directly from the NinjaScript Editor.

Usage
The completed indicator is now available through any window that can use an indicator such
as a Chart window.

Tutorial Descriptions
All internal NinjaTrader indicators come with full source code and can be viewed within the
NinjaScript Editor. Please review the tutorials within this section for detailed walk throughs of
custom indicator development.

Level 1 - Demonstrating the use of price variables
Level 2 - Demonstrating the use of indicator on indicator
Level 3 - Demonstrating the use of a "for" loop to build a simple moving average indicator
Level 4 - Demonstrating the use of IndicatorSeries objects to retain historical custom
calculations data series
Level 5 - Demonstrating the use of custom plot coloring based on threshold values
Level 6 - Demonstrating the use of custom of drawing using bar color, back color and line
colors
Level 7 - Demonstrating the use of custom draw objects such as bar markers

-o-

Developing Outside of the NinjaScript Editor
The NinjaScript Editor automatically generates required program code on saving and/or
compiling a custom indicator. If you choose to develop custom indicators outside of the
NinjaScript Editor environment, please ensure that you use the NinjaScript Editor to compile.

Please see the additional information on this subject.

-o-

Best Practices for 3rd Party Developers
Please see the section "Best Practices".

-o-

See the section Developing Strategies > "Using 3rd Party Indicators".

-o-
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Tips and Reference Samples
There is a growing repository of NinjaScript tips and reference samples in the NinjaTrader
Support Forum.

-o-

Tutorial: Using price variables (Level 1)

Overview
In this level 1 tutorial we are going to build a custom indicator that searches for a bar pattern
where the closing price is equal to the opening price. This indicator will show you how to
access price variables and use a conditional operator.

-o-

Set Up
The first step in creating a custom indicator is to use the custom indicator wizard. The wizard
will generate the required NinjaScript code that will serve as the foundation for your custom
indicator.

1. Within the NinjaTrader Control Center window select the Tools-->New
NinjaScript-->Indicator... menu
2. Press the "Next >" button

Defining Indicator Properties and Name
Below you will define your indicators name and several indicator properties.

3. Enter the information as shown above
4. Press the "Next >" button

http://www.ninjatrader-support.com/vb/forumdisplay.php?f=29
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Defining Input Parameters
Below you will define your indicators input parameters. These are any parameters that can be
changed by the user and used in the calculation of the indicators value(s). If your indicator
does not require any parameters leave the "Name" fields blank.

5. This indicator does not require any input parameters
6. Press the "Next >" button

Defining Plots
Below you will define how your indicator is plotted on a chart.
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7. Enter the information as shown above. Note that we changed the "Color" to "Black" and the
"Type" to "Bar".
8. Press the "Next >" button

Defining Oscillator Lines
Below you will define any required oscillator lines. This would be the "Zero" line in the CCI
indicator for example. If your indicator does not require any oscillator lines leave the "Name"
fields blank.
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9. Enter the information as shown above (make sure the "Name" fields are blank since we do
not need an oscillator line for a simple moving average indicator)
10. Press the "Next >" button
11. We are now finished entering in our indicator set up information. Press "Finish" button.

* At any time, you can press the "Generate" button in the wizard if you do not need to go
through each of the wizard steps

You will now see the NinjaScript Editor preloaded with NinjaScript code generated by the
wizard. It should look something like the image below.

Your primary area of concern will be sections "2" and "3".

1. This section provides the indicator with the chart display name and description used in the 
Indicator Dialog window.
2. The Initialize() section is processed only once when the indicator is initially loaded (added
to a chart for example) and can be used to set up any indicator configuration requirements.
You can see that this wizard generated code that added the plot color and style that we
defined.
3. This is the section that is called on each bar update (incoming tick) and is where you will
enter your indicator logic

-o-

Entering Calculation Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations and is called on each bar of a data series
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when re-calculating the indicator. For example, an indicator would be re-calculated when
adding it to an existing chart that has existing price data displayed. Therefore, this is the
main method called for indicator calculation and we will use this method to enter the script
that will check if the open price is equal to the close price.

The Comparison
Replace the wizard generated code with the following code into the OnBarUpdate() method in
the NinjaScript Editor:

// Set the value

Plot0.Set(Open[0] == Close[0] ? 1 : 0);

Here we are doing a comparison of the current open price Open[0] and the current close
price Close[0] using a conditional operator "?" and setting a value to the "Plot0" property via
the Set() method. It might look a little intimidating but it is actually quite simple. 

The syntax for a conditional operator is the following:

Expression ? value 1 : value2

Translated to English it is saying:

if the expression is true ? use value 1 : otherwise use value 2

translated one last time to our indicator logic:

if the current open price is equal to the current close price ? use a value of 1 : other wise use
a value of 0

Our indicator then plots a value of 1 when we have a bar with the open price equal to the
close price or a value of 0 otherwise. The OnBarUpdate() method in your editor should look
identical to the image below.

-o-

Compiling
The indicator code is now complete and needs to be compiled. You can compile this indicator
from within the NinjaScript Editor right mouse button menu "Compile" menu or simply press
the F5 key. It is important to understand that this process makes the indicator ready for
real-time use and will run natively within NinjaTrader directly. It does not run interpreted as
many other applications do. This provides you with the highest performance possible. If there
are any errors reported during compiling, the error messages will be displayed at the bottom
of the NinjaScript Editor.

-o-
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Using
Your strategy is now ready to be used. You can run it in real-time right away or backtest it.

Congratulations, you just completed building a custom strategy!

-o-

Tutorial: Indicator on Indicator (Level 2)

Overview
In this level 2 tutorial we are going to build a custom indicator that calculates a moving
average of volume. This indicator will show you how to use the built in indicators of Moving
Average (SMA) and Volume.

-o-

Set Up
The first step in creating a custom indicator is to use the custom indicator wizard. The wizard
will generate the required NinjaScript code that will serve as the foundation for your custom
indicator.

1. Within the NinjaTrader Control Center window select the Tools-->New
NinjaScript-->Indicator... menu
2. Press the "Next >" button

Defining Indicator Properties and Name
Below you will define your indicators name and several indicator properties.

3. Enter the information as shown above
4. Press the "Next >" button
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Defining Input Parameters
Below you will define your indicators input parameters. These are any parameters that can be
changed by the user and used in the calculation of the indicators value(s). If your indicator
does not require any parameters leave the "Name" fields blank.

5. Enter the information as shown above
6. Press the "Next >" button

Defining Plots
Below you will define how your indicator is plotted on a chart.



p209

© NinjaTrader, LLC, 2005

www.ninjatrader.com

7. Enter the information as shown above.
8. Press the "Next >" button

Defining Oscillator Lines
Below you will define any required oscillator lines. This would be the "Zero" line in the CCI
indicator for example. If your indicator does not require any oscillator lines leave the "Name"
fields blank.
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9. Enter the information as shown above (make sure the "Name" fields are blank since we do
not need an oscillator line for a simple moving average indicator)
10. Press the "Next >" button
11. We are now finished entering in our indicator set up information. Press "Finish" button.

* At any time, you can press the "Generate" button in the wizard if you do not need to go
through each of the wizard steps

You will now see the NinjaScript Editor preloaded with NinjaScript code generated by the
wizard. It should look something like the image below.

Your primary area of concern will be sections "2" and "3".

1. This section provides the indicator with the chart display name and description used in the 
Indicator Dialog window.
2. The Initialize() section is processed only once when the indicator is initially loaded (added
to a chart for example) and can be used to set up any indicator configuration requirements.
You can see that this wizard generated code that added the plot color and style and set the
default "Period" parameter that we define to 10.
3. This is the section that is called on each bar update (incoming tick) and is where you will
enter your indicator logic

-o-

Entering Calculation Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations and is called on each bar of a data series
when re-calculating the indicator. For example, an indicator would be re-calculated when
adding it to an existing chart that has existing price data displayed. Therefore, this is the
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main method called for indicator calculation and we will use this method to enter the script
that will calculate a simple moving average of volume.

Calculating the Average
NinjaTrader has built in indicators that you can reference in your calculations. Since we are
calculating a simple moving average of volume it would make sense for us to use the built in 
SMA indicator and Volume indicators.

Replace the wizard generated code with the following code into the OnBarUpdate() method in
the NinjaScript Editor:

// Calculate the volume average

double average = SMA(VOL(), Period)[0];

Here we declared the variable "average" which is of type double. This serves as the temporary
storage for the current value of the simple moving average of volume. We then use the
simple moving average indicator and pass in the volume indicator as its input, pass in our
indicator "Period" property (a parameter we defined in the wizard) and access the current
value "[0]" that we will assign to our variable "average". If we wanted to assign the value one
bar ago, we could have used  "[1]".

Final Assignment
Enter the following code into the OnBarUpdate() method and below the code snippet you
entered above:

// Set the calculated value to the plot

Plot0.Set(average);

Here we assign the  "average" value to the property that represents the plot data using its
"Set()" method. We have just finished coding our simple moving average of volume. The
OnBarUpdate() method in your editor should look identical to the image below.

-o-

Compiling
The indicator code is now complete and needs to be compiled. You can compile this indicator
from within the NinjaScript Editor right mouse button menu "Compile" menu or simply press
the F5 key. It is important to understand that this process makes the indicator ready for
real-time use and will run natively within NinjaTrader directly. It does not run interpreted as
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many other applications do. This provides you with the highest performance possible. If there
are any errors reported during compiling, the error messages will be displayed at the bottom
of the NinjaScript Editor.

-o-

Using
Your indicator is now ready for use and will be listed in the Indicator Dialog window.

Once applied to a chart, it can look something like the image below.
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Congratulations, you just completed building a custom indicator!

-o-

Tutorial: Your own SMA (Level 3)

Overview
In this level 3 tutorial we are going to build a simple moving average indicator. This indicator
will show you how to use the "for" loop and a single case "if" statement.

-o-

Set Up
The first step in creating a custom indicator is to use the custom indicator wizard. The wizard
will generate the required NinjaScript code that will serve as the foundation for your custom
indicator.

1. Within the NinjaTrader Control Center window select the Tools-->New
NinjaScript-->Indicator... menu
2. Press the "Next >" button

Defining Indicator Properties and Name
Below you will define your indicators name and several indicator properties.
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3. Enter the information as shown above
4. We have checked the option "Plot on chart" which means that this will be price overlay
indicator (will plot on top of the price data instead of in its own indicator panel)
5. We have checked the option "Price type selectable" which means that this indicator has the
option of using any price type (Open, High, Low, Close etc...)
6. Press the "Next >" button

Defining Input Parameters
Below you will define your indicators input parameters. These are any parameters that can be
changed by the user and used in the calculation of the indicators value(s). If your indicator
does not require any parameters leave the "Name" fields blank.
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7. Enter the information as shown above
8. Press the "Next >" button

Defining Plots
Below you will define how your indicator is plotted on a chart.

9. Enter the information as shown above.
10. Press the "Next >" button
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Defining Oscillator Lines
Below you will define any required oscillator lines. This would be the "Zero" line in the CCI
indicator for example. If your indicator does not require any oscillator lines leave the "Name"
fields blank.

11. Enter the information as shown above (make sure the "Name" fields are blank since we do
not need an oscillator line for a simple moving average indicator)
12. Press the "Next >" button
13. We are now finished entering in our indicator set up information. Press "Finish" button.

* At any time, you can press the "Generate" button in the wizard if you do not need to go
through each of the wizard steps

You will now see the NinjaScript Editor preloaded with NinjaScript code generated by the
wizard. It should look something like the image below.
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Your primary area of concern will be sections "2" and "3".

1. This section provides the indicator with the chart display name and description used in the 
Indicator Dialog window.
2. The Initialize() section is processed only once when the indicator is initially loaded (added
to a chart for example) and can be used to set up any indicator configuration requirements.
You can see that this wizard generated code that added the plot color and style, set the
default "Period" parameter that we define to 20 and set the "Overlay" and
"PriceTypeSupported" properties which we configured in the wizard in steps 4 and 5 above.
3. This is the section that is called on each bar update (incoming tick) and is where you will
enter your indicator logic

-o-

Entering Calculation Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations and is called on each bar of a data series
when re-calculating the indicator. For example, an indicator would be re-calculated when
adding it to an existing chart that has existing price data displayed. Therefore, this is the
main method called for indicator calculation and we will use this method to enter the script
that will calculate a simple moving average.

Are there enough bars?
Replace the wizard generated code with the following code into the OnBarUpdate() method in
the NinjaScript Editor:



p218

© NinjaTrader, LLC, 2005

www.ninjatrader.com

// Do not calculate if we don't have enough bars

if (CurrentBar < Period) return;

To calculate a 20 period moving average you will need a minimum of 20 bars of data. The
first statement in our OnBarUpdate() method checks to see if there are enough bars of data to
perform the moving average calculation. "CurrentBar" returns the index number of the
current bar and this is checked against the user defined parameter "Period". If the current bar
number is less than the user defined period we "return" which skips calculating the moving
average.

Getting a sum of closing prices
Enter the following code into the OnBarUpdate() method and below the code snippet you
entered above:

// Get a sum of prices over the specified period

double sum = 0;

for (int barsAgo = 0; barsAgo < Period; barsAgo++)

{

    sum = sum + Input[barsAgo];

}

First we must declare a variable that will store our sum total.

        double sum = 0;

The variable "sum" whose value is of type "double" will serve as temporary storage.

        for (int barsAgo = 0; barsAgo < Period; barsAgo++)
        {
                sum = sum + Input[barsAgo];
        }

Next we must calculate the sum. We use a standard "for" loop to skip through prices and add
them to the "sum" variable. Although the command that represents the loop may look
intimidating, its really quite simple. Let's look at it in English....

What the loop is saying is:

1. the number of bars ago is now zero
2. as long as the number of bars ago is less than the moving average period, then go to line 3
otherwise this loop is finished
3. get the price Input[number of bars ago] and add it to the running sum total
4. add one to the number of bars ago (if number of bars ago was zero it will now be one)
5. go to to line 2

You can find more information on how loops work here. Once the loop has finished, it will
have calculated the total sum of closing prices for the period of our moving average.

* We use the value of Input[barsAgo] to get a price to use for our calculation. We could
have substituted Close[barsAgo] to use closing prices or High[barsAgo] to use high prices.
The reason we use Input[barsAgo] is since we set "PriceTypeSupported" property to true.
Remember? This allows the user of the indicator to select a price type (High, Open, Close
etc...) and therefore will pass in the correct price type value to Input[barsAgo].

The final calculation
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Enter the following code into the OnBarUpdate() method and below the code snippet you
entered above:

// Calculate and set the 'average' value to the 'Plot0' property

Plot0.Set(sum / Period);

We can now calculate the final moving average value and assign it's value to the property
that represents the plot data. We have just finished coding our simple moving average. The
OnBarUpdate() method in your editor should look identical to the image below.

Alternate Implementation
In this tutorial we are using a "for" loop to iterate through a collection of prices and
accumulate a sum value. We chose this approach to demonstrate the use of a loop. A simple
moving average can actually be expressed in a more efficient manner using the built in SUM
indicator as show below.

// Do not calculate if we don't have enough bars

if (CurrentBar < Period) return;

// Calculate and set the 'average' value to the 'Plot0' property

Plot0.Set(SUM(Input, Period)[0] / Period);

-o-

Compiling
The indicator code is now complete and needs to be compiled. You can compile this indicator
from within the NinjaScript Editor right mouse button menu "Compile" menu or simply press
the F5 key. It is important to understand that this process makes the indicator ready for
real-time use and will run natively within NinjaTrader directly. It does not run interpreted as
many other applications do. This provides you with the highest performance possible. If there
are any errors reported during compiling, the error messages will be displayed at the bottom
of the NinjaScript Editor.

-o-
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Using
Your indicator is now ready for use and will be listed in the Indicator Dialog window.

-o-

Tutorial: Historical Custom Data Series (Level
4)

Overview
In this level 4 tutorial we are going to build a custom indicator that stores intermediary
calculations without the use of plots. This indicator will show you how to use a DataSeries
object.

-o-

Set Up
The first step in creating a custom indicator is to use the custom indicator wizard. The wizard
will generate the required NinjaScript code that will serve as the foundation for your custom
indicator.

1. Within the NinjaTrader Control Center window select the Tools-->New
NinjaScript-->Indicator... menu
2. Press the "Next >" button

Defining Indicator Properties and Name
Below you will define your indicators name and several indicator properties.
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3. Enter the information as shown above
4. Press the "Next >" button
5. Press the "Next >" button again

Defining Input Parameters
Below you will define your indicators input parameters. These are any parameters that can be
changed by the user and used in the calculation of the indicators value(s). If your indicator
does not require any parameters leave the "Name" fields blank.
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6. Enter the information as shown above
7. Press the "Next >" button

Defining Plots
Below you will define how your indicator is plotted on a chart.

8. Enter the information as shown above
9. Press the "Next >" button

Defining Oscillator Lines
Below you will define any required oscillator lines. This would be the "Zero" line in the CCI
indicator for example. If your indicator does not require any oscillator lines leave the "Name"
fields blank.
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10. Enter the information as shown above (make sure the "Name" fields are blank since we do
not need an oscillator line for a simple moving average indicator)
11. Press the "Next >" button
12. We are now finished entering in our indicator set up information. Press "Finish" button.

* At any time, you can press the "Generate" button in the wizard if you do not need to go
through each of the wizard steps

You will now see the NinjaScript Editor preloaded with NinjaScript code generated by the
wizard. It should look something like the image below.
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Your primary area of concern will be sections "2" and "3".

1. This section provides the indicator with the chart display name and description used in the
Indicator Dialog window.
2. The Initialize() section is processed only once when the indicator is initially loaded (added
to a chart for example) and can be used to set up any indicator configuration requirements.
You can see that this wizard generated code that added the plot color and style that we
defined.
3. This is the section that is called on each bar update (incoming tick) and is where you will
enter your indicator logic

-o-

Entering Calculation Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations and is called on each bar of a data series
when re-calculating the indicator. For example, an indicator would be re-calculated when
adding it to an existing chart that has existing price data displayed. Therefore, this is the
main method called for indicator calculation and we will use this method to enter the script
that will do our calculations.

Creating DataSeries Object
1. Declare a variable ("myDataSeries" used in this example) of type DataSeries that will hold
a DataSeries object within the region "Variables"
2. Create a new DataSeries object and assing it to the DataSeries variable within the
Initialize() method 
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# region Variables

    private DataSeries myDataSeries; // Declare a DataSeries variable

# endregion

protected override void Initialize()

{

    myDataSeries = new DataSeries(this); // this refers to the

indicator/strategy itself

                                         // and syncs the DataSeries object to

historical

                                         // data bars

}

Storing calculations in the DataSeries object
Now that we have our DataSeries object we can store double values into it. For this example
we will store a simple Close minus Open calculation.

Enter the following code into the OnBarUpdate() method:

// Calculate the range of the current bar and set the value

myDataSeries.Set(Close[0] - Open[0]);

The value of a DataSeries object will be aligned with the current bar. This means that all
DataSeries objects will be synced with the CurrentBar index. It allows you to store a double
value that corresponds with every bar.

Using DataSeries values
With our new DataSeries object we can continue with further calculations easily. We can now
use our DataSeries object as input to an indicator method such as SMA or instead of always
writing Close[0] - Open[0] we can subsitute our DataSeries object instead as per the example
below.

To plot our final calculation we will store the calculation in our Plot0.
1. Remove the wizard generated code in the OnBarUpdate() of “Plot0.Set(Close[0]);”
2. In the OnBarUpdate() method add the following code snippet

// Calculate the range of the current bar and set the value

Plot0.Set(SMA(SMAPeriod)[0] + myDataSeries[0]);

Here we assign the SMA + DataSeries value to the property that represents the plot data
using its "Set()" method. We have just finished coding our DataSeries example. 

-o-

Compile
The indicator code is now complete and needs to be compiled. You can compile this indicator
from within the NinjaScript Editor right mouse button menu "Compile" menu or simply press
the F5 key. It is important to understand that this process makes the indicator ready for
real-time use and will run natively within NinjaTrader directly. It does not run interpreted as
many other applications do. This provides you with the highest performance possible. If there
are any errors reported during compiling, the error messages will be displayed at the bottom
of the NinjaScript Editor.
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-o-

Using
Your indicator is now ready for use and will be listed in the Indicator Dialog window.

Once applied to a chart, it can look something like the image below.



p227

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Congratulations, you just completed building a custom indicator!

-o-

Tutorial: Custom Plot Colors via Thresholds
(Level 5)

Overview
In this level 5 tutorial we are going to build a custom indicator which is a ROC variation and
paints one color above the zero band and another below. This indicator will show you how to
use the concept of plot thresholds.

-o-

Set Up
The first step in creating a custom indicator is to use the custom indicator wizard. The wizard
will generate the required NinjaScript code that will serve as the foundation for your custom
indicator.

1. Within the NinjaTrader Control Center window select the Tools-->New
NinjaScript-->Indicator... menu
2. Press the "Next >" button

Defining Indicator Properties and Name
Below you will define your indicators name and several indicator properties.

3. Enter the information as shown above
4. Press the "Next >" button
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5. This indicator requires two parameters "Period" and "Smooth", enter the information as
shown above
6. Press the "Next >" button

Defining Plots
Below you will define how your indicator is plotted on a chart.
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7. Enter the information as shown above. Notice that we have added two plots. The
"AboveZero" plot will be plotted if the indicator value is above zero and the "BelowZero" plot
will be plotted if the indicator is below zero. We still have to add the NinjaScript code to make
this possible which is coming later in the tutorial.
8. Press the "Next >" button

Defining Oscillator Lines
Below you will define any required oscillator lines. This would be the "Zero" line in the CCI
indicator for example. If your indicator does not require any oscillator lines leave the "Name"
fields blank.

9. Enter the information as shown above. We are adding one oscillator line that will be plotted
at a value of zero.
10. Press the "Next >" button
11. We are now finished entering in our indicator set up information. Press "Finish" button.

* At any time, you can press the "Generate" button in the wizard if you do not need to go
through each of the wizard steps

You will now see the NinjaScript Editor preloaded with NinjaScript code generated by the
wizard. It should look something like the image below.
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Your primary area of concern will be sections "2" and "3".

1. This section provides the indicator with the chart display name and description used in the 
Indicator Dialog window.
2. The Initialize() section is processed only once when the indicator is initially loaded (added
to a chart for example) and can be used to set up any indicator configuration requirements.
You can see that this wizard generated code that added the plot color and style that we
defined.
3. This is the section that is called on each bar update (incoming tick) and is where you will
enter your indicator logic

-o-

Entering Calculation Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations and is called on each bar of a data series
when re-calculating the indicator. For example, an indicator would be re-calculated when
adding it to an existing chart that has existing price data displayed. Therefore, this is the
main method called for indicator calculation and we will use this method to enter the script
that will calculate the ROC value.

Setting Plot Thresholds
The Initialize() method is called once before any bar data is loaded and is used to configure
the indicator. The code below is automatically generated by the wizard and added to the
Initialize() method. It configures the indicator for two plots and one line and sets the
parameters.
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Plots.Add(new Plot(Color.Green, PlotStyle.Line, "AboveZero"));

Plots.Add(new Plot(Color.OrangeRed, PlotStyle.Line, "BelowZero"));

Lines.Add(new Line(Color.Black, 0, "ZeroLine"));

Period = 14;

Smooth = 3;

Enter the following code in the Initialize() method and below the wizard generated code:

// Set the threshold values for each plot

Plots[0].Min = 0;

Plots[1].Max = 0;

The concept of setting threshold values is to set when and when not to paint a plot on the
chart. In this indicator, we have an "AboveZero" plot with a default color of green which we
only want to see when the value of ROC is above zero and a "BelowZero" plot with a default
color of orangeRed which we only want to see when the value of ROC is below zero. In order
to make that happen we have to set the threshold values of each plot.

Plots[0].Min = 0;

This statement says, in the collection of Plot objects, take the first one (Plots[0]) and set its
minimum value to zero. This means any value below zero will not display.

Plots[1].Max = 0;

This statement says, in the collection of Plot objects, take the second one (Plots[1]) and set
its maximum value to zero. This means any value above zero will not display.

We now have a simple plot switching mechanism that displays the correct colored line
depending on if the value of ROC is above or below zero. In fact, you can take this concept a
little bit farther. You can even set different plots style (bar, dot etc..) depending on threshold
values.

A quick word about collections. Collections are objects that store a collection of objects, kind
of like a container. In this case we are working with a collection of plots. In the above wizard
generated code you will notice that we are adding new plots to the "Plots" collection.
"AboveZero" was added first and then "BelowZero". This means that we can reference the
"AboveZero" plot object through Plots[0]. The reason we don't pass in a value of 1 is because
collections are zero based indexes. This means the first item has an index of 0, the second
time an index of 1 and so forth.

Completing the Indicator
This indicator is actually quite simple in its implementation. The last thing we need to do is
add the calculation code and set the value of ROC to both our plot lines.
Replace the wizard generated code with the following code into the OnBarUpdate() method in
the NinjaScript Editor:

// Are there enough bars

if (CurrentBar < Period) return;

// Set the plot values

AboveZero.Set(ROC(Period)[0]);

BelowZero.Set(ROC(Period)[0]);

The calculation first checks to ensure there are enough bars to complete the calculation and
then sets both plot lines to the ROC value.

The OnBarUpdate() method in your editor should look identical to the image below.
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-o-

Compile
The indicator code is now complete and needs to be compiled. You can compile this indicator
from within the NinjaScript Editor right mouse button menu "Compile" menu or simply press
the F5 key. It is important to understand that this process makes the indicator ready for
real-time use and will run natively within NinjaTrader directly. It does not run interpreted as
many other applications do. This provides you with the highest performance possible. If there
are any errors reported during compiling, the error messages will be displayed at the bottom
of the NinjaScript Editor.

-o-

Using
Your indicator is now ready for use and will be listed in the Indicator Dialog window.
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Once applied to a chart, it can look something like the image below.

Congratulations, you just completed building a custom indicator!

-o-

Tutorial: Custom Drawing (Level 6)
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Overview
In this level 6 tutorial we are going to build a custom indicator which is a CCI variation to
show different drawing options for bar color, line color and background color.

-o-

Set Up
The first step in creating a custom indicator is to use the custom indicator wizard. The wizard
will generate the required NinjaScript code that will serve as the foundation for your custom
indicator.

1. Within the NinjaTrader Control Center window select the Tools-->New
NinjaScript-->Indicator... menu
2. Press the "Next >" button

Defining Indicator Properties and Name
Below you will define your indicators name and several indicator properties.

3. Enter the information as shown above
4. Press the "Next >" button
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5. This indicator requires one parameter, Period, enter the information as shown above
6. Press the "Next >" button

Defining Plots
Below you will define how your indicator is plotted on a chart.

7. Enter the information as shown above. Although the CCI indicator only has one plot, we
have defined three plots above. This is because we are going to turn on/off the display of
each plot depending on the actual CCI value. This will give the illusion that the CCI indicator
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line has three different colors.
8. Press the "Next >" button

Defining Oscillator Lines
Below you will define any required oscillator lines. 

9. Enter the information as shown above. We are adding two refererence lines, one at +70
and the other at -70.
10. Press the "Next >" button
11. We are now finished entering in our indicator set up information. Press "Finish" button.

* At any time, you can press the "Generate" button in the wizard if you do not need to go
through each of the wizard steps

You will now see the NinjaScript Editor preloaded with NinjaScript code generated by the
wizard. It should look something like the image below.



p237

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Your primary area of concern will be sections "2" and "3".

1. This section provides the indicator with the chart display name and description used in the 
Indicator Dialog window.
2. The Initialize() section is processed only once when the indicator is initially loaded (added
to a chart for example) and can be used to set up any indicator configuration requirements.
You can see that this wizard generated code that added the plot color and style that we
defined.
3. This is the section that is called on each bar update (incoming tick) and is where you will
enter your indicator logic

-o-

Entering Calculation Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations and is called on each bar of a data series
when re-calculating the indicator. For example, an indicator would be re-calculated when
adding it to an existing chart that has existing price data displayed. Therefore, this is the
main method called for indicator calculation and we will use this method to enter the script
that will calculate the CCI value and set the conditions used to set custom drawing.

Initializing the Indicator
The Initialize() method is called once before any bar data is loaded and is used to configure
the indicator. The code below is automatically generated by the wizard and added to the
Initialize() method. It configures the indicator for three plots and two lines and sets the
parameters.
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Plots.Add(new Plot(Color.Magenta, PlotStyle.Line, "Above"));

Plots.Add(new Plot(Color.Black, PlotStyle.Line, "Neutral"));

Plots.Add(new Plot(Color.OrangeRed, PlotStyle.Line, "Below"));

Lines.Add(new Line(Color.Black, 70, "+70"));

Lines.Add(new Line(Color.Black, -70, "-70"));

Period = 14;

Enter the following code in the Initialize() method and below the wizard generated code:

// Set the pen used to draw the plot as a dashed line

Plots[2].Pen.DashStyle = DashStyle.Dash;

The third plot named "Below" is of color OrangeRed and has a PlotStyle of line. The code
above changes the DashStyle property of this line from a solid line to a dashed line. This is
accomplished by accessing the plot via Plots[2] syntax. New plots are always added to the
collection Plots in sequence. Based on the wizard generated code above, we can see that the
plot named "Below" was the third added plot. Since collections are always zero based we pass
in the value of 2 (plot 1 = 0, plot 2 = 1, plot 3 = 2 etc...) to then access the Pen used to draw
the plot and change the DashStyle property. This is an advanced topic. Changing this
property can be done by the user of the indicator directly within the Indicator Dialog window.
You can read more about the Pen class here.

Enter the following code in the Initialize() method and below the code entered above:

// Set line drawing thresholds which give the visual effect of

// multi colored lines based on indicator values

Plots[0].Min = 70;

Plots[1].Max = 70;

Plots[1].Min = -70;

Plots[2].Max = -70;

The code above sets the plot threshold values. The concept of setting threshold values is to
set when and when not to paint a plot on the chart. This topic is covered in greater detail in
the Level 5 Tutorial.

Custom Drawing
Replace the wizard generated code with the following code into the OnBarUpdate() method in
the NinjaScript Editor:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingpenmemberstopic.asp
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// Do not calculate if we don't have enough bars

if (CurrentBar < Period) return;

// Calculate CCI value

double value = CCI(Period)[0];

// Use an if branch to set an indicator panel back ground color and bar color

if (value > 200)

{

    BackColor = Color.PaleGreen;

    BarColor  = Color.Yellow;

}

else if (value > 150)

{

    BackColor = Color.PaleGreen;

}

else if (value < -200)

{

    BackColor = Color.Pink;

    BarColor  = Color.Yellow;

}

else if (value < -150)

{

    BackColor = Color.Pink;

}

The method first checks to ensure that there are enough bars to perform the calculation and
then assigns the CCI value to the variable value. A multi case if statement is used to
determine when to draw custom graphics.

        if (value > 200)
        {
                BackColor = Color.PaleGreen;
                BarColor   = Color.Yellow;
        }

The first branch checks if the value is greater than 200 and if true, sets the BackColor
property to PaleGreen and also sets the BarColor property to yellow.

BackColor sets the background color of the chart for the current bar.
BarColor sets the color of the current price bar.

A list of available colors can be found here.

Each successive else if branch checks the value of value and sets custom drawing properties.

Setting the plot values
Enter the following code in the OnBarUpdate() method and below the code entered above:

// Set the plot value

Above.Set(value);

Neutral.Set(value);

Below.Set(value);

To complete the indicator you must set the indicator value to each plot.

The Initialize() method in your editor should look identical to the image below:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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The OnBarUpdate() method in your editor should look identical to the image below:

-o-



p241

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Compile
The indicator code is now complete and needs to be compiled. You can compile this indicator
from within the NinjaScript Editor right mouse button menu "Compile" menu or simply press
the F5 key. It is important to understand that this process makes the indicator ready for
real-time use and will run natively within NinjaTrader directly. It does not run interpreted as
many other applications do. This provides you with the highest performance possible. If there
are any errors reported during compiling, the error messages will be displayed at the bottom
of the NinjaScript Editor.

-o-

Using
Your indicator is now ready for use and will be listed in the Indicator Dialog window.

Once applied to a chart, it can look something like the image below.
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Congratulations, you just completed building a custom indicator!

-o-

Developing Custom Strategies

Overview
NinjaScript allows you to develop custom strategies in rapid time by using over 100 built-in
system indicators, 3rd party indicators or custom indicators. NinjaScript strategies are
compiled and run natively within the NinjaTrader application providing the highest
performance possible.

Please take the time to review this section including the Strategy Development Process.

Tutorial Descriptions
All internal NinjaTrader indicators and sample strategies come with full source code and can
be viewed within the NinjaScript Editor. Please review the tutorials within this section for
detailed walk throughs of custom strategy development.

Level 1 - Simple MA Cross Over (Demonstrates strategy construction by wizard and scripting)
Level 2 - RSI with Stop Loss & Profit Target (scripting only)

-o-

The Strategy Development Process
Describe your Strategy
Describing your strategy means creating a set of objective rules that define the conditions
used to enter and exit a market. Describing your strategy always starts with the Strategy
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Wizard and then provides the following choices:

 Strategy Wizard with Condition Builder - This is a point and click approach for strategy
description which is ideal for everyone from the non-programmer, novice programmer and
advanced programmer.

 NinjaScript Editor - This is a modern scripting editor with full inline syntax checking and
intellisense. This is a great approach for those who want to manually code their strategy
logic. If you are going to self code your strategy, please be familiar with the Initialize()
and OnBarUpdate() methods.

Backtest and Optimize your Strategy
Once you have completed describing your strategy you can then test it against historical data
to objectively determine how the strategy performed on a specific market(s) in the past.

 Strategy Analyzer - You can backtest, optimize, and analyze your historical results

At this point in the process you will likely go through an iterative cycle by where you change
your strategy description, backtest, change description and backtest until you have a strategy
that meets your requirements.

See special instructions on running FX strategies.

Real-Time Test your Strategy
It is critical that before you deploy your strategy against your live trading account that you
test it in real-time operation to ensure that the mechanics (operation) of your strategy
behaves as you would expect it to. In addition, you can also forward test your strategy using
real-time market data against the NinjaTrader trade simulation engine. NinjaTrader provides
several options for real-time testing:

 Simulated Data Feed Connection - This is an random internally generated market with user
controlled trend and is great for force testing operation of a strategy

 Market Replay Connection - Record, replay at user defined speeds multiple markets
simultaneously and run your strategies

 Real-time Simulation - Connect to your broker or market data vendor in real-time and run
your strategies through our state of the art simulation engine

You can run your strategy from either a chart or the Strategies tab of the Control Center
window. You can generate real-time strategy performance data from the Strategies tab.

Running on your Live Trading Account
Now that you have described, backtested and real-time tested your strategy, you are ready
to automate your strategy against your live trading account. A few tips you should know:

 Please make sure you fully understand the live run-time options
 Live strategy performance will vary from your backtested results
 Please make sure you fully understand Strategy Position vs Account Position...your

strategy position is not a one to one relationship with your brokerage account
position...you may need to synchronize if they should be synchronized

 Strategies are automatically terminated (stop running) on NinjaTrader shut down
 Automated trading does not mean go fishing while your computer trades for you, we highly

recommend that you are within close proximity to your computer while it is running and
automated trading strategy, you never know what can go wrong

 You can run multiple trading strategies at the same time in the same market
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Strategy Position Vs Account Position
An important concept to understand prior to using NinjaScript strategies in a real-time trading
environment (live brokerage account for example) is the difference between a Strategy
Position and an Account Position. A Strategy Position is a virtual position that is created by
the entry and exit executions generated by a strategy and is independent from any other
running strategy’s position or an account position. An Account Position is the position you
actually hold in a real-time trading account, whether it is a NinjaTrader internal simulation
account (Sim101) or your live real-money brokerage account. In most cases, a trader would
want their Strategy Position’s size and market direction to be equal (in sync) to their Account
Position but there are situations when this may not be the case. 

For example:

 You want to run multiple strategies in the same market simultaneously where strategy A
holds a LONG 1 position, strategy B holds a LONG 2 position resulting in an account that
should hold a LONG 3 position in order to be in sync with both strategies

 You want to run a strategy and at the same time trade the same market the strategy is
running on using discretionary tactics through one of NinjaTrader’s advanced order entry
window such as the SuperDOM or Chart Trader

An extremely common scenario…

An extremely common scenario is starting a NinjaScript strategy in the middle of a trading
session, such as one hour after the session has begun.. The NinjaScript strategy is run on
each historical bar for the 1st hour of the session (it will actually run on all historical data
loaded in a chart) to determine the current position state it would be in if it had been running
live since the start of the session. This position state then becomes the Strategy Position for
your strategy. Let us assume that during the historical hour your strategy would have entered
a LONG 1 position and the position is still open. This would mean the Strategy Position is
LONG 1 and since this trade was not actually executed on an account your Account Position is
FLAT.

What can you do in this case?

If you want your Account Position to match your Strategy Position, you will need to place a
manual order into the account the strategy is running on. Continuing from the above
example, you would need to place a 1-lot market order for the market being traded into the
account the strategy is running on.

What if I do not submit a manual order to sync my account?

The resulting behavior when the Strategy Position and Account Position are out of sync is
when your strategy (continuing with the example above) closes the long position with a sell
order it would bring the Strategy Position to flat and your Account Position to SHORT 1. 

-o-

Multi-Time Frame & Instruments
A NinjaScript strategy supports multi-time frame and instruments in a single strategy. This is
possible since you can add additional Bars objects to a strategy. A Bars object represents all
of the bars of data on a chart. If you had a MSFT 1 minute chart with 200 minute  bars on it,
the 200 minute bars represents a Bars object. You can even execute trades across all the
different instruments in a strategy. There is extreme flexibility in the strategy model that
NinjaTrader uses for multiple-bars strategies so it is very important that before you
incorporate additional Bars objects in a strategy, you understand how it all works. An
important fact to understand is that a NinjaScript strategy is truly event driven; every Bars
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object in a strategy will call the OnBarUpdate() method. What does this mean? It will become
evident as you read further.

It is also important that you understand the following method and properties:

 Add()
 BarsArray
 BarsInProgress

Understanding this Section (MUST READ)
As we move through this section, the term "primary Bars" will be used and for the purpose of
clarification, this will always refer to the first Bars object loaded into a strategy. For example,
if you apply a strategy on MSFT 1 minute chart, the primary Bars would be MSFT 1 minute
data set.

This section is written in sequential fashion. Example code is re-used and built upon from sub
section to sub section.

Adding Additional Bars Object to a Strategy
Additional Bars are added to a strategy via the Add() method in the Initialize() method. When
a Bars object is added to a strategy, it is also added to the BarsArray array. What is that you
ask? Think of it like a container in the strategy that holds all Bars objects added to the
strategy. It's no different than a bucket of golf balls in your garage. As a Bars object is added
to the strategy, it's added to this container, BarsArray, and given an index number so we can
retrieve this Bars object later. Don't sweat this if it sounds complex, its quite easy once you
see it in practical use. Its explained in greater detail later in this section.

For the purpose of demonstration, let's assume that a MSFT 1 minute bar is our primary Bars
(set when the strategy is applied to a 1 minute MSFT chart) and that the Initialize() method is
adding a 3 minute Bars object of MSFT and then adding a 1 minute Bars object of AAPL for a
total of 3 unique Bars objects.

protected override void Initialize()

{

    Add(PeriodType.Minute, 3);

    Add("AAPL", PeriodType.Minute, 1);                                    

}

How Bar Data is Referenced
Understanding how multi-time frame bars are processed and what OHLCV data is referenced
is critical.

The "Figure 1" image below demonstrates the concept of bar processing on historical data or
in real-time when CalculateOnBarClose property is set to true. The 1 minute bars in yellow
will only know the OHLCV of the 3 minute bar in yellow.  The 1 minute bars in cyan will only
know the OHLCV data of the 3 minute bar in cyan. Take a look at "Bar 5" which is the 5th one
minute bar, if you wanted to know the current high value for on the 3 minute time frame, you
would get the value of the 1st 3 minute bar since this is the last "closed" bar. The 2nd 3
minute bar (cyan) is not known at this time.
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Contrast the above image and concept with the image below which demonstrates bar
processing in real-time when CalculateOnBarClose property is set to false (tick by tick
processing) . The 1 minute bars in yellow will know the current OHLCV of the 3 minute bar in
yellow (2nd 3 minute bar) which is still in formation...not yet closed.

The point is if you have a multi-time frame strategy in real-time and it is processing tick by
tick instead of on the close of each bar, understand that the OHLCV data you access in
real-time is different than on historical data.

A quick example to illustrate the point:

Your strategy has complex logic that changes the bar color on the chart. You are running tick
by tick, as per the above "Figure  2" image, the 5th 1 minute bar is looking at OHLCV data
from the 2nd 3 minute bar. Your strategy changes the 5th 1 minute bar color to green. In the
future you reload your strategy into the chart (for whatever reason) and the 5th 1 minute bar
is now a historical bar. As per "Figure 1" image, the 5th 1 minute bar now references the
OHLCV data of the 1st 3 minute bar (instead of the 2nd 3 minute bar as per Figure 2) and as
a result, your strategy logic condition for coloring the bar green is no longer valid. Now your
chart looks different.

Using Bars Objects as Input to Indicator Methods
In the sub section above, the concept of index values was introduced. This is a critical concept
to understand since it is used consistently when working with multi-Bars strategies.

Let's demonstrate this concept:

Carrying on from the example above, our primary Bars is set from a MSFT 1 minute chart

MSFT 1 minute Bars is given an index value of 0

In the Initialize() method we added a MSFT 3 minute Bars object and an AAPL 1 minute Bars
object to the strategy

MSFT 3 minute Bars is given an index value of 1
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AAPL 1 minute Bars is given an index value of 2

Index values are given to each Bars object as they are added to a strategy in an incremental
fashion. If there are 10 Bars objects in a strategy, then you will have index values ranging
from 0 through 9.

Our strategy now has 3 Bars objects in the container BarsArray. From this point forward, we
can ask this container to give us the Bars object we want to work with by providing the index
value. The syntax for this is:

BarsArray[index]

This allows us to get the correct Bars object and use it as input for an indicator method. For
example:

ADX(14)[0] > 30 && ADX(BarsArray[2], 14)[0] > 30

The above expression in English would translate to:

If the 14 period ADX of MSFT 1 minute is greater than 30 and the 14 period ADX of APPL 1
minute is greater than 30

The following example checks if the current CCI value for all Bars objects is above 200. You
will notice that BarsInProgress is used. This is to check which Bars object is calling the
OnBarUpdate() method. More on this later in this section.

protected override void OnBarUpdate()

{

    if (BarsInProgress == 0)

    {

        if (CCI(20)[0] > 200 && CCI(BarsArray[1], 20)[0] > 200 

          && CCI(BarsArray[2], 20)[0] > 200)

        {

            // Do something

        }                                 

    }

}

True Event Driven OnBarUpdate() Method
Since a NinjaScript is truly event driven, the OnBarUpdate() method is called for every bar
update event for each Bars object added to a strategy. This model provides the utmost
flexibility. For example, you could have multiple trading systems combined into one strategy
dependent on one another. Specifically, you could have a 1 minute MSFT Bars object and a 1
minute AAPL Bars object, process different trading rules on each Bars object and check to see
if MSFT is long when APPL trading logic is being processed.

The BarsInProgress property is used to identify which Bars object is calling the OnBarUpdate()
method. This allows you to filter out the events that you want to or don't want to process.

Continuing our example above, let's take a look at some code to better understand what is
happening. Remember, we have three Bars objects working in our strategy, a primary Bars
MSFT 1 minute, MSFT 3 minute and AAPL 1 minute.
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protected override void OnBarUpdate()

{

    // Checks if OnBarUpdate() is called from an update on the primary Bars

    if (BarsInProgress == 0)

    {

        if (Close[0] > Open[0])

            // Do something                   

    }

    // Checks if OnBarUpdate() is called from an update on MSFT 3 minute Bars

    if (BarsInProgress == 1)

    {

        if (Close[0] > Open[0])

            // Do something   

    }

    // Checks if OnBarUpdate() is called from an update on AAPL 1 minute Bars

    if (BarsInProgress == 2)

    {

        if (Close[0] > Open[0])

            // Do something   

    }

}

What is important to understand in the above sample code is that we have "if" branches that
check to see what Bars object is calling the OnBarUpdate() method in order to process
relevant trading logic. If we only wanted to process the events from the primary Bars we
could write our first statement as follows:

if (BarsInProgress != 0)
            return;

What is also important to understand is the concept of context. When the OnBarUpdate()
method is called, it will be called within the context of the calling Bars object. This means that
if the primary Bars triggers the OnBarUpdate() method, all indicator methods and price data
will point to that Bars object's data. Looking at the above example, see how the statement "if
(Close[0] > Open[0]" exists under each "if" branch? The values returned by Close[0] and
Open[0] will be the close and open price values for the calling Bars object. So when the
BarsInProgress == 0 (primary Bars) the close value returned is the close price of the MSFT 1
minute bar. When the BarsInProgress == 1 the close value returned is the close price of the
MSFT 3 minute Bars object.

Accessing the Price Data in a Multi-Bars Strategy
As you probably know already, you can access the current bar's closing price with the
following statement:

Close[0];

You can also access price data such as the close price of other Bars objects at any time. This
is accomplished by accessing the Opens, Highs, Lows, Closes, Volumes, Medians, Typicals
and Times series by index value. These properties hold collections (containers) that hold their
named values for all Bars objects in a strategy.

Continuing with our example code above, if you wanted to access the high price of the MSFT
3 min Bars object which is at index 1 you would write:

Highs[1][0];

This is just saying give me the series of high prices for the Bars object at index 1 "Highs[1]"
and return to me the current high value "[0]". Now, if the BarsInProgress index was equal to
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1, the current context is of the MSFT 3 min Bars object so you could just write:

High[0];

The following example demonstrates various ways to access price data.

protected override void OnBarUpdate()

{

    // Checks if OnBarUpdate() is called from an update on the primary Bars

    if (BarsInProgress == 0)

    {

        double primaryClose  = Close[0];

        double msft3minClose = Closes[1][0];

        double aapl1minClose = Closes[2][0];

        // primaryClose could also be expressed as

        // primaryClose = Closes[0][0];                  

    }

    // Checks if OnBarUpdate() is called from an update on MSFT 3 minute Bars

object

    if (BarsInProgress == 1)

    {

        double primaryClose  = Closes[0][0];

        double msft3minClose = Close[0];

        double aapl1minClose = Closes[2][0];                  

    }

}

Entering and Exiting and Retrieving Position Information
Entry and Exit methods are executed within the BarsInProgress context. Let's demonstrate
with an example:
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protected override void OnBarUpdate()

{

    // Checks if OnBarUpdate() is called from an update on the primary Bars

    if (BarsInProgress == 0)

    {

        // Submits a buy market order for MSFT

        EnterLong();              

    }

    // Checks if OnBarUpdate() is called from an update on MSFT 3 minute Bars

object

    if (BarsInProgress == 1)

    {

        // Submits a buy market order for MSFT

        EnterLong();

    }

    // Checks if OnBarUpdate() is called from an update on AAPL 1 minute Bars

object

    if (BarsInProgress == 2)

    {

        // Submits a buy market order for APPL

        EnterLong();

        // Submits a buy market for MSFT when OnBarUpdate() is called for AAPL

        EnterLong(0, 100, "BUY MSFT");    

    }

}

As you can see above, orders are submitted  for MSFT when BarsInProgress is equal to 0 and
for AAPL when BarsInProgress is equal to 2. The orders submitted are within the context of
the Bars object calling the OnBarUpdate() method and the instrument associated to the
calling Bars object. There is one exception which is the order placed for MSFT within the
context of the OnBarUpdate() call for APPL. Each order method has a variation that allows you
to specify the BarsInProgress index value which enables submission of orders for any
instrument within the context of another instrument.

The property Position always references the position of the instrument of the current context.
If the BarsInProgress is equal to 2 (APPL 1 minute Bars), Position would refer to the position
being held for APPL. The property Positions holds a collection of Position objects for each
instrument in a strategy. Note that there is a critical difference here. Throughout this entire
section we have been dealing with Bars objects. Although in our sample we have three Bars
objects (MSFT 1 and 3 min and APPL 1 min) we only have two instruments in the strategy.

MSFT position is given an index value of 0
AAPL position is given an index value of 1

In the example below, when the OnBarUpdate() method is called for the primary Bars we also
check if the position held for AAPL is NOT flat and then enter a long position in MSFT. The net
result of this strategy is that a long position is entered for APPL, and then once APPL is long,
we go long MSFT.
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protected override void OnBarUpdate()

{

    // Checks if OnBarUpdate() is called from an update on the primary Bars

    if (BarsInProgress == 0 && Positions[1].MarketPosition !=

MarketPosition.Flat)

    {

        // Submits a buy market order for MSFT

        EnterLong();              

    }

    // Checks if OnBarUpdate() is called from an update on AAPL 1 minute Bars

    if (BarsInProgress == 2)

    {

        // Submits a buy market order for APPL

        EnterLong();   

    }

}

-o-

Using ATM Strategies
You can create an automated strategy that generates a trade signal that executes a
NinjaTrader ATM Strategy. 

 ATM Strategies operate in real-time only and will not execute on historical data thus they
can't be back tested

 Executions resulting from an ATM Strategy that is created from within a NinjaScript
automated strategy will not plot on a chart during real-time operation

 Strategy set up parameters such as EntriesPerDirection, EntryHandling, ExitOnClose do not
apply when calling the AtmStrategyCreate() method

There is a Clear Line...
There is a clear line between a NinjaScript Strategy and an ATM Strategy. The use model for
creating an ATM Strategy within a NinjaScript Strategy is when you want to programatically
monitor and generate an entry signal and then manualy manage the resulting open position
via an ATM Strategy in one of NinjaTrader's order entry windows.

!!! IMPORTANT: Manually Closing an ATM Strategy from an Order Entry Window such
as the SuperDOM 
It is crucial that when running ATM Strategies created by a NinjaScript strategy that you
understand how to properly manually close the ATM Strategy from any of the order entry
windows.

 If the order entry window ATM Strategy Selection Mode is NOT in
"DisplaySelectedATMStrategyOnly" click on the "CLOSE" button via your middle mouse
button (scroll wheel)

 If the order entry window ATM Strategy Selection Mode is in
"DisplaySelectedATMStrategyOnly" you can click on the "CLOSE" button with your left
mouse button to close the selected active ATM strategy

Following the approaches above will internallly close the ATM Strategy. Not following the
approach will close the account/instrument position, terminate all strategies and cancel all
orders. The result is that your NinjaScript strategy will be terminated.

-o-
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Tips and Reference Samples
There is a growing repository of NinjaScript tips and reference samples in the NinjaTrader
Support Forum.

-o-

Best Practices for 3rd Party Developers
Please see the section "Best Practices".

-o-

Using 3rd Party Indicators
You can use 3rd party indicators within your strategies or custom indicators. A 3rd party
indicator is an indicator that was not developed by NinjaTrader. It is important to understand
from the 3rd party developer, the functionality provided or NOT provided in their proprietary
indicators. Just because they provide an indicator that displays a bullish or bearish trend on a
chart does NOT mean that you can access this trend state from their indicator.

3rd party indicators can be provided to you in one of the following ways:

 NinjaScript archive file that can be directly imported into NinjaTrader
 A custom installer
 A set of files and instructions for saving them in the correct folders

If you were provided with a NinjaScript archive file that you have successfully imported via
the Control Center window "File > Utilities > Import NinjaScript" menu you are can skip over
the information below since NinjaTrader automatically configures the indicators ready for use.

If you were provided with a custom installer or a compiled assembly (.DLL) file that you had
to manually save in the folder My Documents\<NinjaTrader Folder>\bin\Custom then you
must follow the instructions below.

Vendor File
The 3rd party developer should have either installed a "Vendor" file or provided you with one.
Its likely in the format "NinjaTrader.VendorName.cs" where VendorName is the name of the
3rd party vendor. This file allows you to conveniently access their indicators.

 If you were provided an installer, you can check with the vendor if this file was included or;
 If they provided you this file, save it to "My Documents\<NinjaTrader Folder>\bin\Custom"

and restart NinjaTrader

Adding a Reference
1. From within any NinjaScript indicator or strategy (Tools > Edit NinjaScript > Indicator and
open any indicator in the NinjaScript Editor) , right click on your mouse to bring up the
context menu and select the sub-menu "References..." as per the image below

http://www.ninjatrader-support.com/vb/forumdisplay.php?f=29
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2. A "References" window will appear
3. Press the "Add" button and select the 3rd party vendor DLL file

4. You will see a reference to the 3rd party vendor DLL in the "References" window
5. Press the "OK" button

You will now be able to access the indicator methods provided by the 3rd party vendor.

-o-

Tutorial: Simple MA Cross Over (Level 1)

Overview
In this level 1 tutorial we are going to build a custom automated strategy that goes long
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when the fast moving average crosses above the slow moving average and goes short when
the fast moving average crosses below the slow moving average.

-o-

Set Up
The first step in creating a custom strategy is to use the custom strategy wizard. The wizard
provides two options:

 Allow you to create a functional strategy without any programming
 Generate the required NinjaScript code that will serve as the foundation for your custom

strategy for further coding

1. Within the NinjaTrader Control Center window select the Tools > New NinjaScript >
Strategy... menu
2. Press the "Next >" button

3. Enter the information as shown above
4. Press the "Next >" button

Defining Input Parameters
Below you will define your strategies input parameters. These are any input parameters that
can be changed by the user when running or backtesting a strategy. If your strategy does not
require any parameters leave the "Name" fields blank.
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5. Add the inputs as per the image above
6. Press the "Next >" button

Defining Conditions and Actions
Below you can define conditions that trigger user defined actions such as placing orders,
drawing on a chart or creating an alert.

Notice how there are two buttons on the screen below:

View Code... - Pressing this button loads the strategy code in the NinjaScript Editor for
viewing purposes only. This is a great approach if you are new to programming or you want
to see how the strategy wizard dynamically generates the correct script code on the fly.

Unlock Code - Pressing this button loads the strategy code in the NinjaScript editor for further
manual editing. Once this button is pressed, you can NOT go back to the Wizard for strategy
construction and editing.



p256

© NinjaTrader, LLC, 2005

www.ninjatrader.com

If you want to proceed with this tutorial through self programming continue here after
pressing the "Unlock Code" button.

-o-

Creating the Srategy via the Wizard
1. Press the "Add" button to display the "Condition Builder" window as per the image below

2. Expand the "Indicators" section by clicking on the "+" button and highlight the "SMA"
indicator
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3. Select the "Period" property on the lower left window and press the "..." button to open the
"Value" window

4. From the "Value" window, expand the "User defined inputs" section and select the "Fast"
input

5. Press "OK" to assign the user define input "Fast" to the SMA "Period" property
6. Enable this indicator to be plotted on a chart
7. Select "CrossAbove" and set the look back period to a value of "1"
8. Select "SMA" indicator in the right window
9. Set the "Slow" period (just like you did for Fast in step 4)
10. Enable this indicator to be plotted on a chart
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If you look at the image above, you just created an initial condition. The condition is "if the
fast simple moving average crosses above the slow simple moving average".

11. Press the "OK" button and you will see the following image

12. Press the "Add" button in the lower right section of the Wizard to bring up the "Strategy
Action" dialog window
13. Expand the "Order management" section by clicking on the "+" button and highlight the
"Enter Long position" action and then press the "OK" button
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14. Select the condition as per the image below, right click and select "Copy" from the menu
15. Click on the "Set 2" tab and move your cursor into the conditions area, right click and
select "Paste" from the menu

16. Press the "..." button for the copied condition which will bring up the Condition Builder
17. In the Condition Builder, change the "CrossAbove" function to "CrossBelow"
18. We also want to set to "false" the "Plot on chart" parameters (Step #6) since we already
set them to true on "Set 1" tab
19. Press the "OK" button
20. Repeat steps #12 and #13 exception subsituting "Enter short position" for "Enter long
position"
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21. Complete the remainder of the wizard by pressing the "Next >" buttton

-o-

Creating the Strategy via Self Programming
If you have not done so already, press the "Unlock Code" button within the wizard to launch
the NinjaScript Editor.

The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations. Therefore, this is the main method called for
strategy calculation and we will use this method to enter the script that check for entry and
exit conditions.

The Entry and Exit Condition
Enter the code contained within the OnBarUpdate() method in the image below into the
OnBarUpdate() method in the NinjaScript Editor:

Translated into english, the code contained within the OnBarUpdate() method above reads:

if the fast simple moving average crosses above the slow simple moving average within the
last bar, go long

if the fast simple moving average crosses below the slow simple moving average within the
last bar, go short

To accomplish this we used the following methods:

CrossAbove() - Checks for a cross above condition and returns true or false
CrossBelow() - Checks for a cross below condition and returns true or false
SMA() - Returns the value of a simple moving average
EnterLong() - Enters a market order long
EnterShort() - Enters a market order short

-o-

Compiling
The strategy code is now complete and needs to be compiled. 
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 If you completed this tutorial via the Strategy Wizard, simply follow the wizard instructions
to the end at which time the strategy will compile.

 If you self coded this tutorial you can compile this strategy from within the NinjaScript
Editor right mouse button menu "Compile" menu or simply press the F5 key. 

It is important to understand that this process makes the strategy ready for real-time use and
will run natively within NinjaTrader directly. It does not run interpreted as many other
applications do. This provides you with the highest performance possible. If there are any
errors reported during compiling, the error messages will be displayed at the bottom of the
NinjaScript Editor.

-o-

Tutorial: RSI with Stop loss & Profit Target
(Level 2)

Overview
In this level 2 tutorial we are going to build a custom automated strategy that goes long
when RSI crosses above 20 and exits at a predefined stop loss or profit target, whichever is
hit first. This tutorial is demonstrates the use of the NinjaScript Editor.

-o-

Set Up
The first step in creating a custom strategy is to use the custom strategy wizard. The wizard
provides two options:

 Allow you to create a functional strategy without any programming
 Generate the required NinjaScript code that will serve as the foundation for your custom

strategy for further coding

This tutorial will cover the latter, conscructing a strategy via direct coding in the NinjaScript
editor.

1. Within the NinjaTrader Control Center window select the Tools > New NinjaScript >
Strategy... menu
2. Press the "Next >" button
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3. Enter the information as shown above
4. Press the "Next >" button

Defining Input Parameters
Below you will define your strategies input parameters. These are any input parameters that
can be changed by the user when running or backtesting a strategy. If your strategy does not
require any parameters leave the "Name" fields blank.
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5. Add the inputs as per the image above
6. Press the "Unlock Code" button to launch the NinjaScript Editor.

-o-

Entering Strategy Logic
Using the Initialize() Method to Configure the Strategy
The Initialize() method is called once prior to running a strategy and can be used to set
properties or call methods in preparation for running a strategy.

Enter the code contained within the Initialize() method in the image below into the Initialize()
method in the NinjaScript Editor.

CalculateOnBarClose is set to true and sets the strategy to call the OnBarUpdate() method
below on the close of each bar instead of each incoming tick.
Add() method is called and the RSI() indicator method is passed in which will automatically
plot this indicator on a chart when the strategy runs.

The method signature for the RSI() indicator is: 

RSI(int period, int smooth)

It is valid to have used called the Add() method in the following manner:

Add(RSI(14, 3))

However, instead of hard coding the period value to 14 and the smooth value to 3, we
subsituted the values for the user defined inputs we defined in the wizard. Calling the Add()
method in the following manner:

Add(RSI(RSIPeriod, RSISmooth))

Allows us to change the period and smooth parameters of the embedded RSI indicator in the
strategy at run time. This gives us a higher level of flexibility when working with our strategy.

SetStopLoss() and SetProfitTarget() are called with CalculationMode.Ticks. This means that
when a position is opened, the strategy will immediately submit a stop and target order with
a price that is calculated based on the StopLoss and ProfitTarget parameters passed in offset
from the positions average entry price.

Using the OnBarUpdate() Method for the Core Strategy Logic
The OnBarUpdate() method is called for each incoming tick or on the close of a bar (user
defined) when performing real-time calculations. Therefore, this is the main method called for
strategy calculation and we will use this method to enter the script that check for entry and
exit conditions.
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Enter the code contained within the OnBarUpdate() method in the image below into the
OnBarUpdate() method in the NinjaScript Editor:

Since our strategy exit logic has already been set up in the Initialize() method above, we only
need to focus on expressing our entry logic. The strategy entry logic is very straight forward
and can be translated to English:

if we have not seen the number of bars specified by the user defined input "RSIPeriod" then
do not go any further

if RSI crosses above a value of 20 within the last bar, go long

To accomplish this we used the following methods and properties:

CurrentBar -  A value representing the current bar being processed (think of a chart where
the left most bar would be equal to one)
CrossAbove() - Checks for a cross above condition and returns true or false
RSI() - Returns the value of the RSI indicator
EnterLong() - Enters a market order long

-o-

Compiling
The strategy code is now complete and needs to be compiled. 

 If you completed this tutorial via the Strategy Wizard, simply follow the wizard instructions
to the end at which time the strategy will compile.

 If you self coded this tutorial you can compile this strategy from within the NinjaScript
Editor right mouse button menu "Compile" menu or simply press the F5 key. 

It is important to understand that this process makes the strategy ready for real-time use and
will run natively within NinjaTrader directly. It does not run interpreted as many other
applications do. This provides you with the highest performance possible. If there are any
errors reported during compiling, the error messages will be displayed at the bottom of the
NinjaScript Editor.

-o-

NinjaScript Language Reference

Reference Samples & Tips
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You can find numerous NinjaScript Reference Samples and Tips in the NinjaTrader Support
Forum.

Click here for Reference Samples

Click here for Tips

-o-

Basic Programming Concepts

Getting started with NinjaScript
NinjaScript is an extension of the Microsoft C# programming language. There is a wealth of
resources available online for learning the C# language. If you have limited programming
experience, do not let C# scare you. NinjaScript provides a layer of convenience allowing you
to focus on your trading ideas and not programming. Spend some time and go through some
of our own tutorials for developing custom indicators and strategies.

The following is an excellent set of online C# tutorials Soft Steel C# Tutorials.

-o-

Basic Syntax
NinjaScript is an extension to the powerful Microsoft C# language. The following syntax guide
is a subset of the capabilities of the C# language. For tutorials and an online reference to the
C# language visit the overview page.

Statements
A statement is analogous to a complete sentence in the English language.

Example:

I like trading.

This is clear and easy to understand. If you only wrote:

I like.

Anyone reading this would not know what you like. This is not a complete sentence. The same
logic applies to a C# statement, it forms a complete instruction that can be interpreted by the
compiler.

sum = 10 + 10;

The above statement is complete since we are saying that the variable sum is equal to 10
plus 10. Notice that the statement ends with a semicolon ";" and not a period. In English
sentences end in periods, in C#, statements end with a semicolon.

Building Blocks
Building blocks are analogous to paragraphs in the English language in that they group
statements together. In the programming world we call this a "Block of code". These blocks

http://www.ninjatrader-support.com/vb/showthread.php?t=3220
http://www.ninjatrader-support.com/vb/showthread.php?t=3229
http://www.softsteel.co.uk/tutorials/cSharp/contents.html


p266

© NinjaTrader, LLC, 2005

www.ninjatrader.com

are delimited with curly braces "{}" like the following example:

if (x == 5)

{

    Print("NinjaTrader");

    Print("NinjaScript");

}

The above code block encloses two statements in curly braces.

User Defined Comments
You can add your own comments to your code.

Use the "//" characters for single line comments.

Example:

// The following code encloses two statements with curly braces

if (x == 5)

{

    Print("NinjaTrader");

    Print("NinjaScript");

}

You can enclose several comment lines using the "/*" characters to start the comment block
and then using the "*/" characters to end the comment block.

Example:

/* These are comments to illustrate a multi line comment

block within NinjaScript */

Case Sensitivity
C# is a case-sensitive language which means that "NinjaTrader" with a capital "N" is not the
same as "ninjaTrader" with a lower-case "n".

Variables and Value Types
A variable is a place holder that stores information into computer memory. A variable is
unique analogous to your mailing address. Use variables to store and access data. There are
many variable types that you can use in the C# language. The following are a few of the
basics:

string
Stores textual data

double
Stores floating point values

integer
Stores whole number values

bool
Stores either true or false
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object
Stores objects such as NinjaTrader indicators (in these cases, you would declare the variable
type as the object type itself)

Declaring Variables
To declare a variable in C# you must first declare its data type and then provide a unique
name and optionally assign a value.

// Declaring a string variable

string myString = "NinjaTrader";

// Declaring a double variable

double myDouble = 2.5;

// Declaring an integer variable

int myInteger = 1;

// Declaring a bool variable

bool learningIsFun = true;

// Declaring an object type variable using a Simple Moving Average indicator

SMA mySMA = new SMA(Close, 20);

In each of the above examples you will notice that the equals character "=" is used to assign
a value to the declared variable.

Operators
C# provides a large set of operators, which are symbols that specify which operations to
perform in a statement. The following is a subset of common operators.

Arithmetic

+ addition

- subtraction
* multiplication
/ division

// Example of using arithmetic operators

int myInteger = 0;

myInteger = 5 + (3 * 4);

Print(myInteger.ToString());

The above example would print a value of 17 to the NinjaTrader output window. The 
System.Math class provides additional math functions.

For example:

// Example of using the ABS method of the System.Math class

double myDouble = Math.Abs(5 - 6);

Print(myDouble.ToString());

Would print a value of 1 to the NinjaTrader output window. See a complete list of the 
Sytem.Math methods.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemmathmemberstopic.asp
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Logical

&& and also
|| or else

// Example of using logical operators

int myInteger = 3;

string myString = "NinjaTrader";

if (myInteger == 3 && myString == "NinjaTrader")

{

    Print("true");

}

The above example will print true to the NinjaTrader output window if the variable myString
is equal to 3 and also (&& operator used) the variable myString is equal to NinjaTrader.

Relational

== is equal to
!= does not equal
< less than
> greater than
<= less than or equal to
>= greater than or equal to

// Example of using relational operator

string myString = "NinjaTrader";

if (myString != "trading")

{

    Print("Variable myString does not equal trading");

}

// Second example of using a relational operator in conjunction with logical

operator

double myDouble = 1000.25;

if (myDouble < 1000 || myDouble > 1001)

{

    Print("Variable myDouble is between 1000 and 1001");

}

Assignment

= equals
+= x += y is equivalent to x = x  + y
-= x -= y is equivalent to x = x - y
*= x *= y is equivalent to x = x * y
/= x /= y is equivalent to x = x / y

Conditional

?:
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// Example of a conditional operator

int myInteger = (10 > 12 ? 3 : 4);

Print(MyInteger.ToString());

The above conditional statement says assign the value 3 to the variable myInt if 10 is greater
than 12 else assign the value 4 to the variable myInt. The example will then print the value of
4 to the NinjaTrader output window since 10 is not greater than 12.

String Concatenation
To append one string to another string use the "+" character.

// Example of string concatenation

string wordOne = "Ninja";

string wordTwo = "Trader";

Print(MyInteger.ToString());

The above example would print out NinjaTrader to the NinjaTrader output window.

-o-

Branching Commands
Branching controls execution flow of your script. It allows you to branch into separate logical
sequences based on decisions you make.

The if Statement

An if statement allows you to take execute different paths of logic depending on a given
condition.

// Single case condition

int x = 0;

if (x == 0)

{

    Print("NinjaTrader");

}

The above example will print NinjaTrader to the NinjaTrader output window since x does
equal 0.

// Either/Or decision

int x = 1;

if (x == 0)

{

    Print("NinjaTrader");

}

else

{

    Print("NinjaScript");

}
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The above example will print NinjaScript to the NinjaTrader output window.

// Multiple case decision

int x = 2;

if (x == 0)

{

    Print("NinjaTrader");

}

else if (x == 1)

{

    Print("NinjaScript");

}

else

{

    Print("NinjaTrader Rules!");

}

The above example will print NinjaTrader Rules! to the NinjaTrader output window.

The switch Statement

The switch statement executes a set of logic depending on the value of a given parameter.

// Switch example

int x = 2;

switch (x)

{

    case 0:

         Print("x is equal to zero");

         break;

    case 1:

         Print("x is equal to one");

         break;

    case 2:

         Print("x is equal to two");

         break;

}

The above example will print out x is equal to two to the NinjaTrader output window.

-o-

Looping Commands
Looping commands control execution flow of your script. If you wanted to print the word
NinjaTrader 100 times the you could use 100 lines of code or you could do the same using a
looping command in only a few lines of code.

While Loop

while (Boolean expression)
{
        //Do something here
}

Example:
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// Print NinjaTrader 100 times to the output window

int x = 0;

while (x < 100)

{

    Print("NinjaTrader");

    x = x + 1;

}

Do Loop

do
{
        //Do something here
}
while (Boolean expression)

Example:

// Print NinjaTrader 100 times to the output window

int x = 0;

do

{

    Print("NinjaTrader");

    x = x + 1;

}

while (x < 100)

For Loop

for (initializer; boolean expression; iterator)
{
        //Do something here
}

Example:

// Print NinjaTrader 100 times to the output window

for (int x = 0; x < 100; x++)

{

    Print("NinjaTrader");

}

Foreach Loop

foreach (type identifier in boolean expression)
{
        // Do something here
}

Example:

Lets say you wanted to count the number of oatmeal cookies in a cookie jar.
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// Count the number of oatmeal cookies in the cookie jar

int oatmealCookies = 0;

foreach (cookie in cookieJar)

{

    if (cookie.Type == Oatmeal)

    {

        oatmealCookies = oatmealCookies + 1;

    }

}

Print("There are " + numberOatmeal.ToString() + "oatmeal cookies in the cookie

jar.");

Break and Continue

You can use the break command to exit a loop at any time.  The following example is an
infinite loop but we will break after the first print statement.

// Exit the infinite loop after the first iteration

while (0 == 0)

{

    Print("NinjaTrader");

    break;

}

The continue command will jump ahead to the next iteration of the loop. The following
example will not print NinjaTrader because the continue command sends control back to the
top of the loop each time.

// Never prints NinjaTrader

for (int x = 0; x < 100; x++)

{

    continue;

    Print("NinjaTrader");

}

-o-

Functions and Methods Explained
Functions and methods are used to encapsulate a set of statements. They are given a name
and optionally a set of input parameters. They can be called from any point in your
NinjaScript. Once written, we need only be concerned what the function or method does. In
general, the difference between a function and method is that a function returns a value to
the calling routine. C# has done away with the term function and only uses the term method.
A method can return a value (a function) or return nothing.

Declaring a Method
A method must first be declared before you can use it in your script.

[Method Access] [Return Data Type] [Name] (Optional parameters)

Method Access - Sets the access to the method. This topic can be a little complex so lets just
use the access level "private" which is all you will ever likely need.
Return Data Type - Sets the value type that the method return. If it returns nothing, you will
set the return type to "void".
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Name - A user defined name for the method
Optional Parameters - Any optional parameters that you may want to pass into the method

Method With No Return Type

// This method prints out the data and time

private void PrintDateTime()

{

    Print(DateTime.Now.ToString());

}

The above method has no return type so we use the keyword "void", we provide a user
defined method name PrintDateTime and since there are no parameters we complete the
declaration with "()".  The method code itself is then enclosed within curly braces.

Method With a Return Type

// This method performs a calculation and returns a double value

private double Multiply(double input)

{

    return input * 10;

}

The above method returns a value of type double so we use the keyword "double", we provide
a user defined method name "Multiply" and we declare that this method takes a parameter
named "input" which is of value type double. Since this method returns a value, we use the
"return" keyword to return the value of (input * 10) back to the calling routine.

Calling a Method within a Method

// This method performs a calculation and returns a double value

private double Multiply(double input)

{

    PrintDateTime();

    return input * 10;

}

Building on our examples from above, we added a call to the PrintDateTime() method within
our Multiply method.

When to use Methods
Using methods is a great way to logically organize blocks of code. If you find that you are
performing the same calculations in different parts of your script it also makes sense to
encapsulate the repetitive code into a method.

For example:

Lets say you had a script that needed to calculate the average range of the past three bars in
multiple locations. This is where encapsulating the logic to that calculates the range into one
method comes in handy.

First we declare our method using a return type of double and name it AverageRange. There
is no requirement to pass in any parameters. We then write a statement the calculates and
returns the average range of the past three bars. We end up with the method below.
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// Calculates the average range of the past three bars

private double AverageRange()

{

    return ((High[1] - Low[1]) + (High[2] - Low[2]) + (High[3] - Low[3])) / 3

;

}

We can then reference the AverageRange method anywhere else in our script like the
example below shows.

// Example method that calls the AverageRange() method twice

private void ExampleMethod()

{

    if (High[0] - Low[0] > AverageRange())

    {

        Print("The current bar range is greater than the 3 bar average range

of " +

           AverageRange().ToString());

    }

}

Declaring Variables within a Method
You can declare variables within a method. These variables are local in scope which means
they can only be accessed within the method and not outside of it such as your main script.

// Example method using a variable

private double MyMethod()

{

    double myDouble = 100.25

    return myDouble * 10;

}

        

-o-

Custom Strategy Methods and Properties

Advanced Event Driven Programming

Advanced Event Driven Strategy Programming
Overview
Advanced event-driven strategy programming is reserved for EXPERIENCED programmers.

NinjaTrader is unlike traditional strategy development platforms in that it is not limited to
processing your strategy logic on a bar by bar basis. NinjaTrader is a true real-time trading
platform and thus can be driven by real-time events.

In addition to the OnBarUpdate() and Initialize() methods, NinjaScript exposes the following
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advanced event-driven methods:

 OnConnectionStatus() - Called when a connection state changes
 OnExecution() - Called when a strategy generated order is filled
 OnMarketData() - Called on any change in a level 1 market data stream
 OnMarketDepth() - Called on any change in a level 2 market data stream
 OnOrderUpdate() - Called when a strategy generated order changes state
 OnPositionUpdate() -  Called when a strategy generated position changes

-o-

IExecution
Definition
Represents a read only interface that exposes information regarding an execution (fill)
resulting from an order and is passed as a parameter in the OnExecution() method.

* The "Price" property may return a value that is not aligned to the underlying instruments
tick size. This can happen if the original order price was submitted not aligned to tick size or if
the period in time being backtested contains split/dividend back adjusted data that is also not
aligned to tick size. However, most if not all execution grid displays will display a rounded to
tick size value. You can also use the method Round2Ticksize().

Methods and Properties
Commission A double value representing the commission of an execution
ExecutionId A string value representing the exchange generated execution id
Instrument An Instrument value representing the instrument of an order
MarketPosition Possible values are:

MarketPosition.Long
MarketPosition.Short

Name
Order An IOrder value representing an order associated to the execution
Price A double value representing the price of an execution
Quantity An int value representing quantity of an execution
Time A DateTime structure representing the time the execution occured
Token A string representing the unique id of an execution
ToString() A string representation of an execution

Examples

private IOrder entryOrder = null;

protected override void OnBarUpdate()

{

    if (entryOrder == null && Close[0] > Open[0])

        entryOrder = EnterLong();

}

protected override void OnExecution(IExecution execution)

{

    if (entryOrder != null && entryOrder.Token == execution.Order.Token)

        Print(execution.ToString());

}

-o-

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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IOrder
Definition
Represents a read only interface that exposes information regarding an order.

 An IOrder object returned from calling an order method is dynamic in that its' properties
will always reflect the current state of an order

 An IOrder object passed in from the OnOrderUpdate() method is volatile in that its'
properties remain static and do not change. DO NOT hold on to these references  for the
purpose of checking its' properties outside of the OnOrderUpdate() method. Check the
IOrder object returned from the original call to the order method.

 IOrder objects are NOT unique per order and therefore do not compare IOrder objects to
each other to determine equality

 To check for equality check the <IOrder>.Token property which is a guaranteed unique
identifier for an order

 The property <IOrder>.OrderId is NOT a unique value since it can change throughout an
order's lifetime

Methods and Properties
Action Possible values are:

Action.Buy
Action.BuyToCover
Action.Sell
Action.SellShort

AvgFillPrice A double value representing the average fill price of an order
Filled An int value representing the filled amount of an order
FromEntrySignal A string representing the user defined fromEntrySignal parameter on an

order
Instrument An Instrument value representing the instrument of an order
LimitPrice A double value representing the limit price of an order
LiveUntilCancelled *A bool value representing if the order is live until cancelled by the user
Name A string representing the name of an order which can be provided by the

entry or exit signal name
Oco A string representing the OCO (one cancels other) id of an order
OrderId A string representing the broker issued order id value (this value can

change)
OrderState See table below
OrderType Possible values are:

OrderType.Limit
OrderType.Market
OrderType.Stop
OrderType.StopLimit

Quantity An int value representing the quantity of an order
StopPrice A double value representing the stop price of an order
Time A DateTime structure representing the last time the order changed state
TimeInForce Possible values are:

TimeInForce.Day
TimeInForce.Gtc

Token A string representing the unique id of an order
ToString() A string representation of an order

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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OrderState Values
OrderState.Accepted Order has been acknowledged by the broker
OrderState.Cancelled Order has been cancelled
OrderState.Filled Order has been filled
OrderState.PartFilled Order has been part filled
OrderState.PendingCance
l

An order cancellation request has been submitted

OrderState.PendingChan
ge

An order change request has been submitted

OrderState.PendingSubm
it

An order has been submitted

OrderState.Rejected An order has been rejected
OrderState.Working An order is working at the exchange
OrderState.Unknown An unknown order state

* In a historical backtest, orders will always reach a "Working" state.
** In real-time, some stop orders may only reach "Accepted" state if they are simulated/held
on a brokers server

Examples

private IOrder entryOrder = null;

protected override void OnBarUpdate()

{

    if (entryOrder == null && Close[0] > Open[0])

        entryOrder = EnterLong();

}

protected override void OnOrderUpdate(IOrder order)

{

    if (entryOrder != null && entryOrder.Token == order.Token)

    {

        Print(order.ToString());

        if (order.OrderState == OrderState.Filled)

            entryOrder = null;

     }

}

Tips
1. Not all connectivity providers support all MarketDataTypes.

-o-

IPosition
Definition
Represents a read only interface that exposes information regarding a position and is passed
as a parameter in the OnPositionUpdate() method.

Methods and Properties
AvgPrice A double value representing the average price of a position
Instrument An Instrument value representing the instrument of a position
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MarketPosition Possible values are:

MarketPosition.Flat
MarketPosition.Long
MarketPosition.Short

Quantity An int value representing quantity of a position
ToString() A string representation of a position

Examples

protected override void OnPositionUpdate(IPosition position)

{

    if (position.MarketPosition == MarketPosition.Flat)

    {

        // Do something like reset some variables here

    }

}

-o-

OnConnectionStatus()
Definition
The OnConnectionStatus() method is called on a change in connection status.

 Programming to this method is considered advanced programming and exposed for
experienced programmers

 You can not start a strategy without a "Connected" connection
 The connection event is for the connection where the traded account resides

Method Return Value
This method does not return a value.

Method Parameters
ConnectionStatus orderStatus and priceStatus

Possible values are:

ConnectionStatus.Connected
ConnectionStatus.Connecting
ConnectionStatus.ConnectionLost
ConnectionStatus.Disconnected

A NinjaTrader connection may have two internally may have two separate connections, one
for the price server and the other for the order server.

orderStatus - Status of the broker's order server
priceStatus - Status of the price server

Syntax
You must override the method in your strategy with the following syntax.

protected override void OnConnectionStatus(ConnectionStatus orderStatus,
ConnectionStatus priceStatus)
{

}



p279

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Examples

private ConnectionStatus dataFeed = ConnectionStatus.Connected;

protected override void OnOrderUpdate(IOrder order)

{

    if (dataFeed != ConnectionStatus.Connected)

    {

        // Do something

    }

}

protected override void OnConnectionStatus(ConnectionStatus orderStatus,

ConnectionStatus priceStatus)

{

    dataFeed = priceStatus;

}

Additional Reference Samples
Additional reference code samples are available the NinjaScript Educational Resources section
of our support forum.

-o-

OnExecution()
Definition
The OnExecution() method is called on an incoming execution. An execution is another name
for a fill of an order.

 Programming to this method is considered advanced programming and exposed for
experienced programmers

 An order can generate multiple executions (partial fills)
 OnExecution is always called after OnOrderUpdate() is called

If you are relying on the OnExecution() method to trigger actions such as the submission of a
stop loss order when your entry order is filled ALWAYS reference the properties on the IOrder
object property attached to the IExecution object passed into the OnExecution() method.

Method Return Value
This method does not return a value.

Method Parameters
IExecution execution

Syntax
You must override the method in your strategy with the following syntax.

protected override void OnExecution(IExecution execution)
{

}

Examples
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private IOrder entryOrder = null;

protected override void OnBarUpdate()

{

    if (entryOrder == null && Close[0] > Open[0])

        entryOrder = EnterLong();

}

protected override void OnExecution(IExecution execution)

{

    if (entryOrder != null && entryOrder.Token == execution.Order.Token)

        Print(execution.ToString());

}

Additional Reference Samples
Additional reference code samples are available the NinjaScript Educational Resources section
of our support forum.

-o-

OnMarketData()
See OnMarketData()

-o-

OnMarketDepth()
See OnMarketDepth()

-o-

OnOrderUpdate()
Definition
The OnOrderUpdate() method is called everytime an order managed by a strategy changes
state. An order will change state when a change in order quantity, price or state (working to
filled) occurs.

 Programming to this method is considered advanced programming and exposed for
experienced programmers

 You can program your own order rejection handling

NinjaTrader is a multi-threaded application and therefore it is extremely important to
understand 

 This method guarantees that you will see each order state change in sequence
 This method does not provide an update for the most current state of an order but instead

provides you an event notifying you of each state change in sequence and the relevant
information on the order at the time the state changed

 CRITICAL: If you want to drive your strategy logic based on order fills you must use
OnExecution() instead of OnOrderUpdate(). OnExecution() is always triggered after
OnOrderUpdate(). There is internal strategy logic that is triggered after OnOrderUpdate() is
called but before OnExecution() that can adversely affect your strategy if you are relying
on tracking fills within OnOrderUpdate().

 As an example, the NinjaTrader core may have received "Working" and then "PartFilled"
order state change events back from the broker API on thread "B" and at some point in
time (milliseconds later) the NinjaTrader core will take these events and trigger the
OnOrderUpdate() method in the strategy on thread "A". Thus, when the strategy receives
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the first "Working" state for an order, the IOrder object passed in will reflect the "Working"
state although the actual order is really in a state of "Part Filled" which is truly reflected in
the original IOrder object returned in any of the order methods such as EnterLong(). Of
course, the OnOrderUpdate() method will subsequently receive the event for "PartFilled"
state.

 When connected to the Market Replay Connection, calling market order based methods
such as EnterLong() and EnterShort() will result in order state events being fired prior to
the order method return an IOrder object. This is done to ensure that all events are in sync
at high speed market replays.

If you are relying on the OnOrderUpdate() method to trigger actions such as the submission
of a stop loss order when your entry order is filled ALWAYS reference the properties on the
IOrder object passed into the OnOrderUpdate() method.

Method Return Value
This method does not return a value.

Method Parameters
IOrder order

Syntax
You must override the method in your strategy with the following syntax.

protected override void OnOrderUpdate(IOrder order)
{

}

Examples

private IOrder entryOrder = null;

protected override void OnBarUpdate()

{

    if (entryOrder == null && Close[0] > Open[0])

        entryOrder = EnterLong();

}

protected override void OnOrderUpdate(IOrder order)

{

    if (entryOrder != null && entryOrder.Token == order.Token)

    {

        Print(order.ToString());

        if (order.OrderState == OrderState.Cancelled)

        {

            // Do something here

            entryOrder = null;

        }

    }

}

Additional Reference Samples
Additional reference code samples are available the NinjaScript Educational Resources section
of our support forum.

-o-

OnPositionUpdate()
Definition
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The OnPositionUpdate() method is called everytime a position managed by a strategy
changes state.

 Programming to this method is considered advanced programming and exposed for
experienced programmers

Method Return Value
This method does not return a value.

Method Parameters
IPosition position

Syntax
You must override the method in your strategy with the following syntax.

protected override void OnPositionUpdate(IPosition position)
{

}

Examples

protected override void OnPositionUpdate(IPosition position)

{

    if (position.MarketPosition == MarketPosition.Flat)

    {

        // Do something like reset some variables here

    }

}

Additional Reference Samples
Additional reference code samples are available the NinjaScript Educational Resources section
of our support forum.

-o-

AtmStrategy Methods

AtmStrategyCancelEntryOrder()
Definition
Cancels the specified entry order.

Method Return Value
Returns true if the specified order was found; otherwise false.

Syntax
AtmStrategyCancelEntryOrder(string orderId)

Parameters
limitPrice Order limit price
stopPrice Order stop price
orderId The unique identifier for the entry order

Examples
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protected override void OnBarUpdate()

{   

    AtmStrategyCancelEntryOrder("orderIdValue");     

}

-o-

AtmStrategyChangeEntryOrder()
Definition
Changes the price of the specified entry order.

Method Return Value
Returns true if the specified order was found; otherwise false.

Syntax
AtmStrategyChangeEntryOrder(double limitPrice, double stopPrice, string orderId)

Parameters
limitPrice Order limit price
stopPrice Order stop price
orderId The unique identifier for the entry order

Examples

protected override void OnBarUpdate()

{   

    AtmStrategyChangeEntryOrder(GetCurrentBid(), 0, "orderIdValue");     

}

-o-

AtmStrategyChangeStopTarget()
Definition
Changes the price of the specified order of the specified ATM strategy.

Method Return Value
Returns true if the specified order was found; otherwise false.

Syntax
AtmStrategyChangeStopTarget(double limitPrice, double stopPrice, string orderName, string
AtmStrategyId)

Parameters
limitPrice Order limit price
stopPrice Order stop price
orderName The order name such as "STOP1" or "TARGET2"
AtmStrategyId The unique identifier for the ATM strategy

Examples
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protected override void OnBarUpdate()

{   

    AtmStrategyChangeStopTarget(0, SMA(10)[0], "STOP1", "AtmIdValue");     

}

-o-

AtmStrategyClose()
Definition
Cancels any working orders and closes any open position of a strategy by first modifying any
existing target orders so they are filled or submitting a market order if no target orders exist. 

Method Return Value
Returns true if the specified ATM strategy was found; otherwise false. True in NO WAY
indicates that the strategy in fact has been closed. It indicates that the specified  ATMstrategy
was found and the internal close routine was triggered.

Syntax
AtmStrategyClose(string AtmStrategyId)

Parameters
AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{

    if (Historical)

        return;

    

    // Check for valid condition and create an ATM Strategy

    if (GetAtmStrategyUnrealizedProfitLoss("idValue") > 500)

        AtmStrategyClose("idValue");

}

-o-

AtmStrategyCreate()
Definition
Submits an entry order that will execute the specified ATM Strategy that can then be
managed manually by any order entry window such as the SuperDOM or within your
NinjaScript strategy. 

 Please review the section on using ATM Strategies
 This method is not back testable and will not execute on historical data
 Executions resulting from the ATM Strategy will not be plotted on the chart
 See the AtmStrategyCancelEntryOrder() to cancel an entry order
 See the AtmStrategyChangeEntryOrder() to change the price of the entry order

Method Return Value
Returns true if the specified ATM strategy was created and no errors were generated.

Syntax
AtmStrategyCreate(Action action, OrderType orderType, double limitPrice, double  stopPrice,
TimeInForce timeInForce, string orderId, string strategyTemplateName, string AtmStrategyId)
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Parameters
action Sets if the entry order is a buy or sell order. Possible values are:

Action.Buy
Action.Sell

orderType Sets the order type of the entry order. Possible values are:
OrderType.Limit
OrderType.Market
OrderType.Stop
OrderType.StopLimit

limitPrice The limit price of the order
stopPrice The stop price of the order
timeInForce Sets the time in force of the entry order. Possible values are:

TimeInForce.Day
TimeInForce.Gtc

orderId The unique identifier for the entry order
strategyTemplateN
ame

Specifies which strategy template will be used

AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{

    if (Historical)

        return;

    

    // Check for valid condition and create an ATM Strategy

    if (Close[0] > SMA(20)[0])

        AtmStrategyCreate(Action.Buy, OrderType.Market, 0, 0,

          TimeInForce.Day, GetAtmStrategyUniqueId(), "MyTemplate",

          GetAtmStrategyUniqueId());

}

-o-

GetAtmStrategyEntryOrderStatus()
Definition
Gets the current state of the specified entry order. If the method can't find the specified
order, an empty array is returned.

Method Return Value
A string[] array holding three elements that represent average fill price, filled amount and
order state.

Syntax
GetAsmStrategyEntryOrderStatus(string orderId)

Parameters
orderId The unique identifier for the entry order

Examples
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protected override void OnBarUpdate()

{   

    string[] entryOrder = GetAtmStrategyEntryOrderStatus("orderId");

    // Check length to ensure that returned array holds order information

    if (entryOrder.Length > 0)

    {

        Print("Average fill price is " + entryOrder[0].ToString());

        Print("Filled amount is " + entryOrder[1].ToString());

        Print("Current state is " + entryOrder[2].ToString());

    }

}

-o-

GetAtmStrategyMarketPosition()
Definition
Gets the current market position of the specified ATM Strategy.

Method Return Value
MarketPosition.Flat
MarketPosition.Long
MarketPosition.Short

Syntax
GetAtmStrategyMarketPosition(string AtmStrategyId)

Parameters
AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{   

    // Check if flat

    if (GetAtmStrategyMarketPosition("id") == MarketPosition.Flat)

        Print("ATM Strategy position is currently flat");

}

-o-

GetAtmStrategyPositionAveragePrice()
Definition
Gets the current position's average price of the specified ATM Strategy.

Method Return Value
A double value representing the average price.

Syntax
GetAtmStrategyPositionAveragePrice(string AtmStrategyId)

Parameters
AtmStrategyId The unique identifier for the ATM strategy
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Examples

protected override void OnBarUpdate()

{   

    // Check if flat

    if (GetAtmStrategyMarketPosition("id") != MarketPosition.Flat)

        Print("Average price is " +

GetAtmStrategyPositionAveragePrice("id").ToString());

}

-o-

GetAtmStrategyPositionQuantity()
Definition
Gets the current position quantity of the specified ATM Strategy.

Method Return Value
An int value representing the quantity.

Syntax
GetAtmStrategyPositionQuantity(string AtmStrategyId)

Parameters
AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{   

    // Check if flat

    if (GetAtmStrategyMarketPosition("idValue") != MarketPosition.Flat)

        Print("Position size is " +

GetAtmStrategyPositionQuantity("id").ToString());

}

-o-

GetAtmStrategyRealizedProfitLoss()
Definition
Gets the realized profit and loss value of the specified ATM Strategy.

Method Return Value
A double value representing the realized profit and loss.

Syntax
GetAtmStrategyRealizedProfitLoss(string AtmStrategyId)

Parameters
AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{   

    Print("PnL is " + GetAtmStrategyRealizedProfitLoss("id").ToString());

}
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-o-

GetAtmStrategyStopTargetOrderStatus()
Definition
Gets the current state(s) of the specified stop or target order. If the method can't find the
specified order(s), an empty array is returned.

!!! A specified stop or target within an ATM strategy can actually hold multiple orders. For
example, if your ATM strategy submits a stop and target and you receive multiple partial fills
on entry with a delay of a few seconds or more between entry fills, the ATM strategy will
submit stop and target orders for each partial fill all with the same price and order type.

Method Return Value
A string[,] multi-dimensional array holding three dimensions that represent average fill price,
filled amount and order state. The length (number of elements) represents the number of
orders that represent the specified name.

Syntax
GetAtmStrategyStopTargetOrderStatus(string orderName, string AtmStrategyId)

Parameters
orderName The order name such as "STOP1" or "TARGET2"
AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{   

    string[,] orders = GetAtmStrategyStopTargetOrderStatus("TARGET1",

"idValue");

    // Check length to ensure that returned array holds order information

    if (orders.Length > 0)

    {

        for (int i = 0; i < orders.GetLength(0) - 1; i++)

        {

            Print("Average fill price is " + orders[i, 0].ToString());

            Print("Filled amount is " + orders[i, 1].ToString());

            Print("Current state is " + orders[i, 2].ToString());

        }

    }

}

-o-

GetAtmStrategyUnrealizedProfitLoss()
Definition
Gets the unrealized profit and loss value of the specified ATM Strategy.

Method Return Value
A double value representing the unrealized profit and loss.

Syntax
GetAtmStrategyUnrealizedProfitLoss(string AtmStrategyId)

Parameters
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AtmStrategyId The unique identifier for the ATM strategy

Examples

protected override void OnBarUpdate()

{   

    Print("Unrealized PnL is " +

GetAtmStrategyUnrealizedProfitLoss("id").ToString());

}

-o-

GetAtmStrategyUniqueId()
Definition
Generates a unique id value.

Method Return Value
A string value representing a unique id value.

Syntax
GetAtmStrategyUniqueId()

Examples

protected override void OnBarUpdate()

{   

    string orderId = GetAtmStrategyUniqueId();

}

-o-

Order Methods

Overview
Order methods are wrapped with an invisible convenience layer that allows you to focus on
your system's trading rules leaving the underlying mechanics of order management and the
relationships between entry and exit orders and positions to NinjaTrader. This will become
more evident as you review this section.

A few key points:

 Orders are submitted as live working orders when a strategy is running in real-time
 *Profit targets, stop loss and trail stop orders are submitted immediately as entry orders

are filled and are also OCO tied
 Order changes and cancellations are queued in the event that the order is in a state where

it can't be cancelled or modified
 By default, orders submitted via Entry() and Exit() methods automatically cancel at the

end of a bar if not re-submitted 
 Experienced programmers can submit orders that are live until cancelled

* Via the SetProfitTarget(), SetStopLoss() and SetTrailStop() methods

Order Submission for Entry and Exit Methods - Basic Operation
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You can submit and manage orders in one of two ways:

 Orders that automatically expire (cancel) at the end of a bar unless re-submitted
 Orders that are live until you purposely cancel them

The first and most common approach is the quickest and easiest approach and is suitable for
programmers of all levels. The second approach, what we call live until cancelled, is reserved
for experienced programmers only.

The Common Approach
Orders are primarily submitted from within the OnBarUpdate() method when a specific order
method is called. By default, orders are kept alive provided that they are re-submitted on
each call of the OnBarUpdate() method. If the order is not re-submitted, the order is then
cancelled. If the order is re-submitted with changed parameters (new limit price for example)
the order is modified.

In the example below, a buy limit order to enter a long position is working at the bid price
provided that the close price of the current bar is greater than the current value of the 20
period simple moving average. If the entry condition is no longer true and the order is still
active it will be immediately cancelled.

protected override void OnBarUpdate()

{

    // Entry condition

    if (Close[0] > SMA(20)[0])

        EnterLongLimit(Bars.CurrentBid);

}

The Advanced Approach
The advanced approach providers a more granular approach to order submission and
management which can be useful if you decide to distribute your strategy logic outside of the
traditional OnBarUpdate() approach to other strategy event driven methods such as 
OnOrderUpdate() and OnMarketData() just to name a few. After reviewing this overview
section on Order Methods please review the Advanced Order Handling section for further
information on the advanced approach to order submission.

Entry Methods
Entry methods are used to submit orders that create a market position if none exists or to
reverse an existing position. An example of an entry method that submitted  a buy market
order would look like the following:

EnterLong();

Signal Names on Entry Methods
You can optionally tag an entry order with a signal name. Signal names are used to identify
executions resulting from the order on a chart and in performance reports. Market positions
created from a tagged entry method are marked with the signal name which serves two
purposes:

 Used to tie an exit method to a specific position
 Used to identify unique entries in a strategy

An example of an entry method that submitted a sell short market order with a tagged signal
name would look like the following:
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EnterShort("My Signal Name");

to the Strategies tab of the Control Center window.
  
 EntriesPerDirection property - Sets the maximum number of entries in a single direction
Defining how Entry Methods are Processed in a Strategy
You can limit how many entry methods are processed by determining the maximum number
of entries in a single direction across all entry methods, or across unique entry methods,
defined by providing signal names. The following properties can be set in the Strategy Dialog
window when adding a strategy to a chart or 
 EntryHandling property - Limits EntriesPerDirection property across all entries on per

unique entries (tagged with a signal name)

To illustrate how the above properties control the processing of entry methods let's look at
the example code below. The code contains two entry conditions and two EnterLong methods
each tagged with unique signal names.

protected override void OnBarUpdate()

{

    // Entry condition 1

    if (CrossAbove(SMA(10), SMA(20), 1))

        EnterLong("Condition 1 Entry");

    // Entry condition 2

    if (CrossAbove(RSI(14, 3), 30, 1))

        EnterLong("Condition 2 Entry");

}

If you wanted your strategy to enter only once per direction on either condition 1 or
condition 2, whichever condition evaluated to true first, you would set the EntriesPerDirection
to a value of "1" and the EntryHandling to a value "AllEntries".

If you wanted your strategy to enter only once per direction for both conditions, you would
set EntriesPerDirection to a value of "1" and the EntryHandling to the value "UniqueEntries".
This is possible since the entry methods have been tagged with unique signal names. 

Entry Methods on Multi-Instrument Strategies
When running strategies that submit orders to multiple instruments, entry methods will
submit orders to the instrument referenced by the BarsInProgress. The following example
assumes that the strategy is running on a 1 minute ES chart. It adds an ER2 data series and
enters a position on both the ES and ER2. 

protected override void Initialize()

{

    Add(GetInstrument("ER2 12-06", PeriodType.Minute, 1);

}

protected override void OnBarUpdate()

{

    if (BarsInProgress == 0)

        EnterLong("ES Trade");

    else if (BarsInProgress == 1)

        EnterLong("ER2 Trade");

}
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Quantity Type and TIF
You can also set the entry order quantity and order type which is generally set via the UI at
run time.

 QuantityType property - Sets if the order quantity is taken from the entry method quantity
property or the default strategy quantity size

 TimeInForce propery - Sets the time in force of the order

Closing a Position using a Stop Loss, Trailing Stop and/or Profit Target
You can predefine a stop loss, trailing stop and/or profit target in a strategy by calling the 
SetStopLoss(), SetTrailStop() or SetProfitTarget() methods from inside the Initialize()
method. When these methods are called, they submit live working orders in real-time
operation as executions are reported as a result of calling an entry method. Stop and target
orders are submitted to the market as soon as fills come in from an entry order. Trailing stop
orders are modified in real-time and NOT on the close of a bar. A stop and target order are
also tied via OCO (one cancels the other) so if one is filled, the other is automatically
canceled.

Stops and targets are generated either per fill or per position. This is determined by the "Stop
& target submission" property which is set running a strategy live via the UI. Property values
are:

ByStrategyPosition - When this is selected, only one stop loss, trail stop and/or profit target
order is submitted. As entry executions come in, the order size is amended. The downside of
this approach is that if you have partial fills, the orders are re-inserted into the exchange
order queue. The upside is that if you broker charges you a per order commission (not per
lot), you will not incur additional commission expenses.

PerEntryExecution - When this is selected, a stop loss, trail stop and/or profit target order is
submitted for each partial fill received. The downside is if your broker charges commission per
order, you can incur very expensive commission costs if you receive partial fills. The upside is
that orders are submitted as soon as possible giving you the advantage of getting into the
order queue immediately.

Closing a Position using an Exit Method
Exit methods submit orders to close out a position in whole or in part. An example of an exit
method that submitted a sell market order to close the entire strategy position would look like
the following:

ExitLong();

Closing a Partial Position using an Exit Method
You can close out a partial position by specifying the exit quantity. The following example
goes long 3 contracts. Each subsequent bar update will submit a market order to exit one
contract until the position is completely closed. ExitLong(1) will be ignored if a long market
position does not exist.

protected override void OnBarUpdate()

{

    if (CrossAbove(SMA(10), SMA(20), 1))

        EnterLong(3);

    ExitLong(1);

}
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Tying an Exit to an Entry: How to Close a Position Tagged with a Signal Name
Identifying entries with a signal name allows you to have multiple unique entries within a
single strategy and call exit methods with specified signal names so that only a position
created with the tagged signal name is closed. In the example below, there are two entry
conditions which create positions. There are two exit conditions that specify which position to
close based on the signal name.

protected override void OnBarUpdate()

{

    // Entry condition 1

    if (CrossAbove(SMA(10), SMA(20), 1))

        EnterLong("Condition 1 Entry");

    // Entry condition 2

    if (CrossAbove(RSI(14, 3), 30, 1))

        EnterLong("Condition 2 Entry");

    // Closes the position created by entry condition 1

    if (CrossBelow(SMA(10), SMA(20), 1)

        ExitLong("Condition 1 Entry");

    // Closes the position created by entry condition 2

    if (CrossBelow(RSI(14, 3), 70, 1))

        ExitLong("Condition 2 Entry");

}

Interal Order Handling Rules that Reduce Unwanted Positions
NinjaTrader is a real-time live trading platform and thus we need to ensure that we prevent
situations in real-time where you may have multiple orders working accomplishing the same
task. An example of this would be if your strategy had a target limit order for 1 contract
working and then your strategy issued a market order to close the position. This is dangerous
since it could result in both orders getting filled and instead of having a flat position you are
now short! To prevent these types of situations, there are some "under the hood" rules that a
NinjaScript strategy follows when order methods are called.

For the most part, you do not need to be intimately familiar with these rules as you develop
your strategies, its all taken care of for you internal within a strategy. If a rule is violated, you
will be notified through an error log in the Control Center log tab when running a strategy in
real-time or in a backtest. 

The following rules are true per unique signal name excluding market orders:

Methods that generate orders (excluding market orders) to enter a position will be ignored if:
 A position is open and an order submitted by an exit method (ExitLongLimit() for example)

is active and the order is used to open a position in the opposite direction
 A position is open and an order submitted by a set method (SetStopLoss() for example) is

active and the order is used to open a position in the opposite direction
 The strategy position is flat and an order submitted by an enter method (EnterLongLimit()

for example) is active and the order is used to open a position in the opposite direction

Methods that generate orders to exit a position will be ignored if a strategy position is open
and:
 An order submitted by an enter method (EnterLongLimit() for example) is active and this

entry order is used to open a position in the opposite direction
 An order submitted by a set method (SetStopLoss() for example) is active

Set() methods that generate orders to exit a position will be ignored if a strategy position is
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open and:
 An order submitted by an enter method (EnterLongLimit() for example) is active and this

entry order is used to open a position in the opposite direction
 An order submitted by an exit method (ExitLongLimit() for example)  is active

-o-

Advanced Order Handling
Advanced order handling is reserved for EXPERIENCED programmers. Through advanced
order handling you can submit, change and cancel orders at your discretion through any 
event-driven method within a strategy. Each order method within the "Order Methods" section
has a method overload designed for advanced handling.

Live Until Cancelled Orders
Orders can be submitted that are live until you call the CancelOrder() method or the order's
time in force has expired, which ever comes first. This flexibility allows you to control exactly
when an order should be cancelled instead of relying on the close of a bar. Each order method
such as EnterLongLimit() has a method variation (overload) designed to submit a live until
cancelled order.

The IOrder Class
All order methods return an IOrder object. Several things you need to be aware of:

 An IOrder object returned from calling an order method is dynamic in that its' properties
will always reflect the current state of an order

 An IOrder object passed in from the OnOrderUpdate() method is volatile in that its'
properties remain static and do not change. DO NOT hold on to these references  for the
purpose of checking its' properties outside of the OnOrderUpdate() method. Check the
IOrder object returned from the original call to the order method.

 IOrder objects are NOT unique per order and therefore do not compare IOrder objects to
each other to determine equality

 To check for equality check the <IOrder>.Token property which is a guaranteed unique
identifier for an order

 The property <IOrder>.OrderId is NOT a unique value since it can change throughout an
order's lifetime

The following example code demonstrates the submission of an order and assigning the
IOrder return object to the variable "entryOrder" and then checking the "Token" property in
the OnOrderUpdate() method for equality and then checking if the order was filled.
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private IOrder entryOrder = null;

protected override void OnBarUpdate()

{

    if (entryOrder == null && Close[0] > Open[0])

        entryOrder = EnterLong();

}

protected override void OnOrderUpdate(IOrder order)

{

    if (entryOrder != null && entryOrder.Token == order.Token)

    {

        Print(order.ToString());

        if (order.OrderState == OrderState.Filled)

            entryOrder = null;

     }

}

Working with a Multi-Instrument Strategy
With advanced order handling you can submit an orders in the context of any bars object by
designating the "BarsInProgress" index. What this means is that if your primary bar series is
"MSFT" and your secondary series added to the strategy through the Add() method is "AAPL",
you can submit an order for either "MSFT" or "AAPL" anywhere from within the strategy.
There is detailed information on working with multi-time frame and instrument strategies
however, this sub-section strictly deals with the concept of order submission.

Let's take as an example the EnterLongLimit() method and one of its method variations
(below) designed for advanced order handling:

EnterLongLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, string signalName)

Let's also continue with the example above where a "MSFT" 1 minute chart is the primary bar
series the strategy is running on. We add a secondary bar series, an "AAPL" 1 min series to
our strategy by calling the Add() method in the Initialize() method as follows:

Add("AAPL", PeriodType.Minute, 1);

In NinjaScript, "MSFT" has a bars index value of "0" and "AAPL" would have bars index value
of "1". More information on this concept can be found in the multi-time frame and instrument
strategies section as well as the property BarsInProgress. In a multi-instrument strategy,
using the EnterLongLimit() method above will generate an order for the instrument that is
associated to the value of the "barsInProgressIndex" parameter you pass in.

The following example code demonstrates how you can monitor for bar update events on
"MSFT" but submit an order to "AAPL". The key is in passing in a value of "1" (bold red below)
into for the "BarsInProgressIndex". A value of 1 represents the "AAPL" bar series and thus the
order is submitted for "AAPL".
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private IOrder entryOrder = null;

protected override void OnBarUpdate()

{

    // Check if the MSFT series triggered an bar update event

    if (BarsInProgress == 0)

    {

        // Submit an order for APPL in the context of MSFT bar update event

        if (entryOrder == null)

            entryOrder = EnterLongLimit(1, true, 1, Low[1][0], "AAPL Order");

    }

}

-o-

CancelOrder()
Definition
Cancels the specified order.

 This method is made available for experienced programmers that fully understanding the
concepts of advanced order handling

 This method sends a cancel request to the broker and does not guarantee that an order is
completely cancelled. Most of the time you can expect your order to come back 100%
cancelled. An order can be completely filled or part filled in the time that you send the
cancel request and the time the exchange receives the request. Check the 
OnOrderUpdate() method for the state of an order you attempted to cancelled.

Syntax
CancelOrder(IOrder order)

Parameters
order An IOrder object representing the order you wish to cancel.

Examples

private IOrder myEntryOrder = null;

private int barNumberOfOrder = 0;

protected override void OnBarUpdate()

{   

    // Submit an entry order at the low of a bar

    if (myEntryOrder == null)

    {        

        myEntryOrder = EnterLongLimit(0, true, 1, Low[0], "Long Entry");

        barNumberOfOrder = CurrentBar;

    }

    // If more than 5 bars has elapsed, cancel the entry order

    if (myEntryOrder != null && CurrentBar > barNumberOfOrder + 5)

        CancelOrder(myEntryOrder);

}

-o-

EnterLong()
Definition
Generates a buy market order to enter a long position.
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Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterLong()
EnterLong(string signalName)
EnterLong(int quantity)
EnterLong(int quantity, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterLong(int barsInProgressIndex, int quantity, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
quantity Entry order quantity.
barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLong("SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterLongLimit()
Definition
Generates a buy limit order to enter a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterLongLimit(double limitPrice)
EnterLongLimit(double limitPrice, string signalName)
EnterLongLimit(int quantity, double limitPrice)
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EnterLongLimit(int quantity, double limitPrice, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterLongLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
limitPrice The limit price of the order.
quantity Entry order quantity. 
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLongLimit(GetCurrentBid(), "SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterLongStop()
Definition
Generates a buy stop order to enter a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterLongStop(double stopPrice)
EnterLongStop(double stopPrice, string signalName)
EnterLongStop(int quantity, double stopPrice)
EnterLongStop(int quantity, double stopPrice, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterLongStop(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double stopPrice
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, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
stopPrice The stop price of the order.
quantity Entry order quantity. 
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLongStop(GetCurrentAsk() + TickSize, "SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterLongStopLimt()
Definition
Generates a buy stop limit order to enter a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterLongStopLimit(double limitPrice, double stopPrice)
EnterLongStopLimit(double limitPrice, double stopPrice, string signalName)
EnterLongStopLimit(int quantity, double limitPrice, double stopPrice)
EnterLongStopLimit(int quantity, double limitPrice, double stopPrice, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterLongStopLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, double stopPrice, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
limitPrice The limit price of the order.
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stopPrice The limit price of the order.
quantity Entry order quantity. 
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLongStop(High[0] + 2 * TickSize, High[0], "SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterShort()
Definition
Generates a sell short market order to enter a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterShort()
EnterShort(string signalName)
EnterShort(int quantity)
EnterShort(int quantity, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterShort(int barsInProgressIndex, int quantity, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
quantity Entry order quantity.
barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples
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protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

        EnterShort("SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterShortLimit()
Definition
Generates a sell short limit order to enter a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterShortLimit(double limitPrice)
EnterShortLimit(double limitPrice, string signalName)
EnterShortLimit(int quantity, double limitPrice)
EnterShortLimit(int quantity, double limitPrice, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterShortLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
limitPrice The limit price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples
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protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

        EnterShortLimit(GetCurrentAsk(), "SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterShortStop()
Definition
Generates a sell short stop order to enter a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterShortStop(double stopPrice)
EnterShortStop(double stopPrice, string signalName)
EnterShortStop(int quantity, double stopPrice)
EnterShortStop(int quantity, double stopPrice, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterShortStop(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
stopPrice, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
stopPrice The stop price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples
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protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

        EnterShortStop(GetCurrentBid() + TickSize, "SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

EnterShortStopLimit()
Definition
Generates a sell short stop limit order to enter a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
EnterShortStopLimit(double limitPrice, double stopPrice)
EnterShortStopLimit(double limitPrice, double stopPrice, string signalName)
EnterShortStopLimit(int quantity, double limitPrice, double stopPrice)
EnterShortStopLimit(int quantity, double limitPrice, double stopPrice, string signalName)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

EnterShortStopLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, double stopPrice, string signalName)

Parameters
signalName User defined signal name identifying the order generated.
limitPrice The limit price of the order.
stopPrice The limit price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples
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protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

        EnterShortStop(Low[0] + 2 * TickSize, Low[0], "SMA Cross Entry");

}

Tips (also see Overview)
 If using a method signature  that does not have the parameter quantity, the order quantity

will be taken from the quantity value set in the strategy dialog window when running or
backtesting a strategy

-o-

ExitLong()
Definition
Generates a sell market order to exit a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitLong()
ExitLong(int quantity)
ExitLong(string fromEntrySignal)
ExitLong(string signalName, string fromEntrySignal)
ExitLong(int quantity, string signalName, string fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitLong(int barsInProgressIndex, int quantity, string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
quantity Entry order quantity.
barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples



p305

© NinjaTrader, LLC, 2005

www.ninjatrader.com

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLong("SMA Cross Entry");

    // Exits position

    if (CrossBelow(SMA(10), SMA(20), 1))

        ExitLong();

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-

ExitLongLimit()
Definition
Generates a sell limit order to exit a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitLongLimit(double limitPrice)
ExitLongLimit(int quantity, double limitPrice)
ExitLongLimit(double limitPrice, string fromEntrySignal)
ExitLongLimit(double limitPrice, string signalName, string fromEntrySignal)
ExitLongLimit(int quantity, double limitPrice, string signalName, string fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitLongLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double limitPrice,
string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
limitPrice The limit price of the order.
quantity Entry order quantity.
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liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live
until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLong("SMA Cross Entry");

    // Exits position

    if (CrossBelow(SMA(10), SMA(20), 1))

        ExitLongLimit(GetCurrentBid());

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-

ExitLongStop()
Definition
Generates a sell stop order to exit a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitLongStop(double stopPrice)
ExitLongStop(int quantity, double stopPrice)
ExitLongStop(double stopPrice, string fromEntrySignal)
ExitLongStop(double stopPrice, string signalName, string fromEntrySignal)
ExitLongStop(int quantity, double stopPrice, string signalName, string fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitLongStop(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double stopPrice,
string signalName, string fromEntrySignal)
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Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
stopPrice The stop price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

private double stopPrice = 0;

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

    {

        EnterLong("SMA Cross Entry");

        stopPrice = Low[0];

    }

    // Exits position

    ExitLongStop(stopPrice);

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-

ExitLongStopLimit()
Definition
Generates a sell stop limit order to exit a long position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitLongStopLimit(double limitPrice, double stopPrice)
ExitLongStopLimit(int quantity, double limitPrice, double stopPrice)
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ExitLongStopLimit(double limitPrice, double stopPrice, string fromEntrySignal)
ExitLongStopLimit(double limitPrice, double stopPrice, string signalName, string
fromEntrySignal)
ExitLongStopLimit(int quantity, double limitPrice, double stopPrice, string signalName, string
fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitLongStopLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, double stopPrice, string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
limitPrice The limit price of the order
stopPrice The stop price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

private double stopPrice = 0;

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

    {

        EnterLong("SMA Cross Entry");

        stopPrice = Low[0];

    }

    // Exits position

    ExitLongStopLimit(stopPrice - (10 * TickSize), stopPrice);

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-
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ExitShort()
Definition
Generates a buy to cover market order to exit a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitShort()
ExitShort(int quantity)
ExitShort(string fromEntrySignal)
ExitShort(string signalName, string fromEntrySignal)
ExitShort(int quantity, string signalName, string fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitShort(int barsInProgressIndex, int quantity, string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
quantity Entry order quantity.
barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

        EnterShort("SMA Cross Entry");

    // Exits position

    if (CrossAbove(SMA(10), SMA(20), 1))

        ExitShort();

}

Tips (also see Overview)
 This method is ignored if a short position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat
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-o-

ExitShortLimit()
Definition
Generates a buy to cover limit order to exit a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitShortLimit(double limitPrice)
ExitShortLimit(int quantity, double limitPrice)
ExitShortLimit(double limitPrice, string fromEntrySignal)
ExitShortLimit(double limitPrice, string signalName, string fromEntrySignal)
ExitShortLimit(int quantity, double limitPrice, string signalName, string fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitShortLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double limitPrice,
 string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
limitPrice The limit price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

        EnterShort("SMA Cross Entry");

    // Exits position

    if (CrossAbove(SMA(10), SMA(20), 1))

        ExitShortLimit(GetCurrentAsk());

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
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 You can tie an exit to an entry by providing the entry signal name in the parameter
"fromEntrySignal"

 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-

ExitShortStop()
Definition
Generates a buy to cover stop order to exit a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitShortStop(double stopPrice)
ExitShortStop(int quantity, double stopPrice)
ExitShortStop(double stopPrice, string fromEntrySignal)
ExitShortStop(double stopPrice, string signalName, string fromEntrySignal)
ExitShortStop(int quantity, double stopPrice, string signalName, string fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitShortStop(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double stopPrice,
 string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
fromEntrySignal The entry signal name. This ties the exit to the entry and exits the

position quantity represented by the actual entry.
stopPrice The stop price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples



p312

© NinjaTrader, LLC, 2005

www.ninjatrader.com

private double stopPrice = 0;

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

    {

        EnterShort("SMA Cross Entry");

        stopPrice = High[0];

    }

    // Exits position

    ExitShortStop(stopPrice);

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-

ExitShortStopLimit()
Definition
Generates a buy to cover stop limit order to exit a short position.

Method Return Value
An IOrder read-only object that represents the order. Reserved for experienced programmers,
additional information can be found within the Advanced Order Handling section.

Syntax
ExitShortStopLimit(double limitPrice, double stopPrice)
ExitShortStopLimit(int quantity, double limitPrice, double stopPrice)
ExitShortStopLimit(double limitPrice, double stopPrice, string fromEntrySignal)
ExitShortStopLimit(double limitPrice, double stopPrice, string signalName, string
fromEntrySignal)
ExitShortStopLimit(int quantity, double limitPrice, double stopPrice, string signalName, string
fromEntrySignal)

The following method variation is for experienced programmers who fully understand 
Advanced Order Handling concepts.

ExitShortStopLimit(int barsInProgressIndex, bool liveUntilCancelled, int quantity, double
limitPrice, double stopPrice, string signalName, string fromEntrySignal)

Parameters
signalName User defined signal name identifying the order generated.
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fromEntrySignal The entry signal name. This ties the exit to the entry and exits the
position quantity represented by the actual entry.

limitPrice The limit price of the order
stopPrice The stop price of the order.
quantity Entry order quantity.
liveUntilCancelled The order will NOT expire at the end of a bar but instead remain live

until the CancelOrder() method is called or its time in force has been
reached.

barsInProgressInd
ex

The index of the Bars object the order is to be submitted against. See
the BarsInProgress property. This determines what instrument the order
is submitted for.

Examples

private double stopPrice = 0;

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossBelow(SMA(10), SMA(20), 1))

    {

        EnterShort("SMA Cross Entry");

        stopPrice = High[0];

    }

    // Exits position

    ExitShortStopLimit(stopPrice + (10 * TickSize), stopPrice);

}

Tips (also see Overview)
 This method is ignored if a long position does not exist
 It is helpful to provide a signal name if your strategy has multiple exit points to help

identify your exits on a chart
 You can tie an exit to an entry by providing the entry signal name in the parameter

"fromEntrySignal"
 If you do not specify a quantity the entire position is exited rendering your strategy flat
 If you do not specify a "fromEntrySignal" parameter the entire position is exited rendering

your strategy flat

-o-

SetProfitTarget()
Definition
Generates a limit profit target order to exit a position. Profit target orders are real working
orders submitted immediately to the market upon receiving an execution from an entry order.

 It is suggested to call this method from within the strategy Initialize() method if your profit
target price/offset is static

 You may call this method from within the strategy OnBarUpdate() method should you wish
to dynamically change the target price while in an open position

 Should you call this method to dynamically change the target price in the strategy
OnBarUpdate() method, you should always reset the target price/offset value when your
strategy is flat otherwise, the last price/offset value set will be used to generate your profit
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target order on your next open position

Syntax
SetProfitTarget(double currency)
SetProfitTarget(CalculationMode mode, double value)
SetProfitTarget(string fromEntrySignal, CalculationMode mode, double value)

Parameters
currency Sets the profit target amount in currency ($500 profit for example)
mode CalculationMode.Percent (0.01 = 1%)

CalculationMode.Price
CalculationMode.Ticks

value The value the profit target order is offset from the position entry price
(exception is using .Price mode where 'value' will represent the actual
price)

fromEntrySignal The entry signal name. This ties the profit target exit to the entry and
exits the position quantity represented by the actual entry.

Examples

protected override void Initialize()

{

    // Submits a profit target order 10 ticks away from the avg entry price

    SetProfitTarget(CalculationMode.Ticks, 10);

}

Tips (also see Overview)

 Profit target orders are submitted in real-time on incoming executions from entry orders
 A strategy will either generate a target order for each partial fill of an entry order or one

order for all fills. See additional information under the Strategies tab of the Options
dialogwindow.

 If a stop loss or trail stop order is generated in addition to a profit target order, they are
submitted as OCO (one cancels other)

 A profit target order is automatically cancelled if the managing position is closed by
another strategy generated exit order

-o-

SetStopLoss()
Definition
Generates a stop loss order to exit a position. Stop loss orders are real working orders (unless
simulated is specified in which case the stop order is locally simulated and submitted as
market once triggered) submitted immediately to the market upon receiving an execution
from an entry order.

 It is suggested to call this method from within the strategy Initialize() method if your stop
loss price/offset is static

 You may call this method from within the strategy OnBarUpdate() method should you wish
to dynamically change the stop loss price while in an open position

 Should you call this method to dynamically change the stop loss price in the strategy
OnBarUpdate() method, you should always reset the stop loss price/offset value when your
strategy is flat otherwise, the last price/offset value set will be used to generate your stop
loss order on your next open position
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Syntax
SetStopLoss(double currency)
SetStopLoss(double currency, bool simulated)
SetStopLoss(CalculationMode mode, double value)
SetStopLoss(string fromEntrySignal, CalculationMode mode, double value, bool simulated)

Parameters
currency Sets the stop loss amount in currency ($500 loss for example)
simulated If true, will simulate the stop order and submit as market once triggered
mode CalculationMode.Percent (0.01 = 1%)

CalculationMode.Price
CalculationMode.Ticks

value The value the stop loss order is offset from the position entry price
(exception is using .Price mode where 'value' will represent the actual
price)

fromEntrySignal The entry signal name. This ties the stop loss exit to the entry and exits
the position quantity represented by the actual entry.

Examples

protected override void Initialize()

{

    // Submits a stop loss of $500

    SetStopLoss(500);

}

Tips (also see Overview)

 The SetStopLoss() method can NOT be used concurrently with the SetTrailStop() method
for the same position, if both methods are called for the same position (fromEntrySignal)
the SetStopLoss() will always take precedence. You can however, use both methods in the
same strategy if they reference different signal names.

 Stop loss orders are submitted in real-time on incoming executions from entry orders
 A strategy will either generate a stop loss order for each partial fill of an entry order or one

order for all fills. See additional information under the Strategies tab of the Options
dialogwindow.

 If a profit target order is generated in addition to a stop loss order, they are submitted as
OCO (one cancels other)

 Stop loss orders are submitted as stop market orders
 A stop loss order is automatically cancelled if the managing position is closed by another

strategy generated exit order

-o-

SetTrailStop()
Definition
Generates a trail stop order to exit a position. Trail stops are ammended on a tick by tick
basis. Trail stop orders are real working orders (unless simulated is specified in which case
the stop order is locally simulated and submitted as market once triggered) submitted
immediately to the market upon receiving an execution from an entry order.

 It is suggested to call this method from within the strategy Initialize() method if your trail
stop price/offset is static

 You may call this method from within the strategy OnBarUpdate() method should you wish
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to dynamically change the trail stop price while in an open position
 Should you call this method to dynamically change the trail stop price in the strategy

OnBarUpdate() method, you should always reset the trail stop price/offset value when your
strategy is flat otherwise, the last price/offset value set will be used to generate your trail
stop order on your next open position

Syntax
SetTrailStop(double currency)
SetTrailStop(double currency, bool simulated)
SetTrailStop(CalculationMode mode, double value)
SetTrailStop(string fromEntrySignal, CalculationMode mode, double value, bool simulated)

Parameters
currency Sets the trail stop amount in currency ($500 profit for example)
simulated If true, will simulate the trail stop order and submit as market once

triggered
mode CalculationMode.Percent (0.01 = 1%)

CalculationMode.Price
CalculationMode.Ticks

value The trail stop value
fromEntrySignal The entry signal name. This ties the trail stop exit to the entry and exits

the position quantity represented by the actual entry.

Examples

protected override void Initialize()

{

    // Sets a trail stop of 12 ticks

    SetTrailStop(CalculationMode.Ticks, 12);

}

Tips (also see Overview)

 The SetTrailStop() method can NOT be used concurrently with the SetStopLoss() method
for the same position, if both methods are called for the same position (fromEntrySignal)
the SetStopLoss() will always take precedence. You can however, use both methods in the
same strategy if they reference different signal names.

 Trail stop orders are submitted in real-time on incoming executions from entry orders
 A strategy will either generate a trail stop order for each partial fill of an entry order or one

order for all fills. See additional information under the Strategies tab of the Options
dialogwindow.

 If a profit target order is generated in addition to a trail stop order, they are submitted as
OCO (one cancels other)

 Trail stop orders are submitted  as stop market orders
 A trail stop order is automatically cancelled if the managing position is closed by another

strategy generated exit order

-o-

Strategy Performance Methods and Properties

Performance
Definition
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Performance is the parent object that holds all trades and trade performance data generated
by a strategy.

 A NinjaScript strategy can generate both synthetic trades (historical backtest trades) and
real-time trades executed on a real-time data stream. If you wish to access only real-time
trades, access the "RealtimeTrades" collection

 The first trade of the "RealtimeTrades" collection will contain a synthetic entry execution if
the strategy was NOT flat at the time you start the strategy.

Methods and Properties
AllTrades Gets a TradeCollection object of all trades generated by the

strategy
LongTrades Gets a TradeCollection object of long trades generated by

the strategy
RealtimeTrades Gets a TradeCollection object of real-time trades generated

by the strategy
ShortTrades Gets a TradeCollection object of short trades generated by

the strategy

Examples

protected override void OnBarUpdate()

{

    // Print out the number of long trades

    Print("The strategy has taken " + Performance.LongTrades.Count + " long

trades.");

}

-o-

Trade Class
Definition
A Trade is a completed buy/sell or sell/buy transaction. It consists of an entry and exit
execution.

Example 1:
Buy 1 contract at a price of 1000 and sell 1 contract at a price of 1001 is one complete trade.

Example 2:
Buy 2 contracts at a price of 1000 and sell the 1st contract at a price of 1001, then sell the
2nd contract at a price of 1002 are two completed trades.

In the second example above, two trade objects are created to represent each individual
trade. Each trade object will hold the same entry execution for two contracts since this single
execution was the opening execution for both individual trades.

Methods and Properties
Commission An int value representing the number of trades in the

collection
Entry Gets an IExecution object representing the entry
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Exit Gets an IExecution object representing the exit
ProfitCurrency A double value representing profit in currency for one

traded unit. Multiple this value by the trade Quantity to get
the total profit in currency for the trade.

ProfitPercent A double value representing profit as a percentage
ProfitPoints A double value representing profit in points for one traded

unit. Multiply this value by the trade Quantity to get the
total profit in points for the trade.

Quantity An int value representing the quantity of the trade
ToString() A string representation of the Trade object

Examples

protected override void OnBarUpdate()

{

    // Check to make sure there is at least one trade in the collection

    if (Performance.RealtimeTrades.Count > 0)

    {

        // Get the last completed real-time trade

        Trade lastTrade =

Performance.RealtimeTrades[Performance.RealtimeTrades.Count - 1];

        // Calculate the PnL for the last completed real-time trade

        double lastProfit = lastTrade.ProfitCurrency * lastTrade.Quantity;

        // Pring the PnL to the Output window

        Print("The last trade's profit is " + lastProfit);

    }

}

-o-

TradeCollection Class
Definition
A collection of Trade objects. You can access a trade object by providing an index value.
Index value are zero based meaning the most recent trade taken in a strategy will be at an
index value of zero. The least recent trade taken will be at an index value of the total trades
in the collection minus 1. 

Methods and Properties
Count An int value representing the number of trades in the

collection
GetTrades() Gets a TradeCollection object representing a specified

position
LosingTrades Gets a TradeCollection object of losing trades
TradesPerformance Gets a TradesPerformance object
WinningTrades Gets a TradeCollection object of winning trades

Examples
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EXAMPLE 1

protected override void OnBarUpdate()

{

    // Accesses the first/last trade in the strategy (the first trade is at

index 0)

    // and prints out the profit as a percentage to the output window

    Trade firstTrade  = Performance.AllTrades[0];

    Trade lastTrade = Performance.AllTrades[Performance.AllTrades.Count - 1];

    

    if (lastTrade != null)

        Print("The last trade profit is " + lastTrade.ProfitPercent);

    if (firstTrade != null)

        Print("The first trade profit is " + firstTrade.ProfitPercent);

}

EXAMPLE 2

protected override void OnBarUpdate()

{

    // Once the strategy has executed 20 trades loop through the losing trades

    // collection and print out the PnL on only long trades

    if (Performance.AllTrades.Count == 20)

    {

        Print(Performance.AllTrades.LosingTrades.Count.ToString() + " losing

trades.");

        foreach (Trade myTrade in Performance.AllTrades.LosingTrades)

        {

            if (myTrade.Entry.MarketPosition == MarketPosition.Long)

                Print(myTrade.ProfitCurrency * myTrade.Quantity);

        }

    }

}

GetTrades() Method

Definition
Returns a TradeCollection object representing all trades that make up the specified position.

Method Return Value
An TradeCollection object.

Syntax
<TradeCollection>.GetTrades(string instrument, string entrySignalName, int instance)

Parameters
instrument An instrument name such as "MSFT"
entrySignalName The name of your entry signal
instance The occurence to check for (1 is the most recent position, 2 is the 2nd

most recent position etc...)

Examples

TradeCollection myTrades = Performance.AllTrades("MSFT", "myEntrySignal", 1);

Print("The last position was comprised of " + myTrades.Count + " trades.");
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-o-

TradesPerformance Class
Definition
Performance profile of a collection of Trade objects.

Methods and Properties
AvgBarsInTrade A double value representing the avg number of bars per

trade
AvgTradeDuration A TimeSpan value representing quantity-weighted avg

duration of a trade
Commission A double value representing the total commission
Currency Gets a TradesPerformanceValues object in currency
GetSharpeRatio()
GrossLoss A double value representing the gross loss
GrossProfit A double value representing the gross profit
MaxConsecLoser An int value representing the maximum number of

consecutive losses seen
MaxConsecWinner An int value representing the maximum number of

consecutive  winners seen
MaxTime2Recover A TimeSpan value representing maximum time to recover

from a draw down
Percent Gets a TradesPerformanceValues object in percent
Points Gets a TradesPerformanceValues object in points
ProfitFactor A double value representing the profit factor
SharpeRatio A double value representing sharpe ratio using a zero risk

free return
TradesPerDay An int value representing the avg trades per day

Examples

protected override void OnBarUpdate()

{

    // Only trade if you have less than 5 consecutive losers in a row

    if (Performance.RealtimeTrades.TradesPerformance.MaxConsecLoser < 5)

    {

        // Trade logic here

    }

}

GetSharpeRatio() Method

Definition
Returns a TradeCollection object representing all trades that make up the specified position.

Method Return Value
An TradeCollection object.

Syntax

http://msdn2.microsoft.com/en-us/library/system.timespan.aspx
http://msdn2.microsoft.com/en-us/library/system.timespan.aspx
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<TradeCollection>.GetTrades(string instrument, string entrySignalName, int instance)

Parameters
instrument An instrument name such as "MSFT"
entrySignalName The name of your entry signal
instance The occurence to check for (1 is the most recent position, 2 is the 2nd

most recent position etc...)

Examples

TradeCollection myTrades = Performance.AllTrades("MSFT", "myEntrySignal", 1);

Print("The last position was comprised of " + myTrades.Count + " trades.");

-o-

TradesPerformanceValues Class
Definition
Performance values of a collection of Trade objects.

 Currency and Point based calculations are per trade
 Percent based calculations are per traded unit

Methods and Properties
AvgEtd A double value representing avg end trade draw down
AvgMae A double value representing avg maximum adverse

excursion
AvgMfe A double value representing avg maximum favorable

excursion
AvgProfit A double value representing avg profit
CumProfit A double value representing cumulated profit (percent is

compounded)
DrawDown A double value representing end of trade draw down
LargestLoser A double value representing largest loss
LargestWinner A double value representing largest gain
ProfitPerMonth A double value representing profit per month always as a

percent

Examples

protected override void OnBarUpdate()

{

    // If the profit on real-time trades is > $1000 stop trading

    if (Performance.RealtimeTrades.TradesPerformance.Currency.CumProfit >

1000)

        return;

}

-o-
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Position Methods and Properties

AvgPrice
Definition
Gets the average price of a strategy position.

Property Value
A double value representing the position's average price per unit.

Syntax
Position.AvgPrice

-o-

GetProfitLoss()
Definition
Calculates the unrealized PnL for the position.

Method Return Value
A double value representing the unrealized PnL.

Syntax
Position.GetProfitLoss(double marketPrice, PerformanceUnit performanceUnit)

Parameters
marketPrice Price used to calculate the PnL such as Close[0]
performanceUnit PerformanceUnit.Currency

PerformanceUnit.Percent
PerformanceUnit.Points

Examples

protected override void OnBarUpdate()

{   

    // If not flat print our unrealized PnL

    if (Position.MarketPosition != MarketPosition.Flat)

        Print("Open PnL: " + Position.GetProfitLoss(Close[0],

PerformanceUnit.Points));

}

-o-

MarketPosition
Definition
Gets the current market position.

Property Value
MarketPosition.Flat
MarketPosition.Long
MarketPosition.Short

Syntax
Position.MarketPosition

Examples
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protected override void OnBarUpdate()

{   

    // If not flat print our open PnL

    if (Position.MarketPosition != MarketPosition.Flat)

        Print("Open PnL: " + Position.GetProfitLoss(Close[0],

PerformanceUnit.Points));

}

-o-

Quantity
Definition
Gets the current position size.

Property Value
An int value representing the position size.

Syntax
Position.Quantity

Examples

protected override void OnBarUpdate()

{   

    // Prints out the current market position

    Print(Position.MarketPosition.ToString() + " " +

Position.Quantity.ToString());

}

-o-

Positions
Definition
Holds an array of Position objects that represent positions managed by the strategy. This
property should only be used when your strategy is executing orders against multiple
instruments.

Index value is based on the the array of Bars objects added via the Add() method. For
example:

Primary Bars is ES 1 Minute
Secondary Bars is ES 3 Minute
Third Bars is ER2 1 Minute

Positions[0] == ES position
Positions[1] == Always a flat position, ES position will always be Positions[0]
Positions[2] == ER2 position

Property Value
An array of Position objects.

Syntax
Positions[int index]

Property Of
Custom Strategy

Examples
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protected override void Initialize()

{

    Add(Instrument, PeriodType.Minute, 5);

    Add("ER2 06-07, PeriodType.Minute, 5);                                   

      

}

protected override void OnBarUpdate()

{

    Print("Primary position is " + Positions[0].MarketPosition);

    Print("ER2 positions is " + Positions[2].MarketPosition);

    // Alternative approach. By checking what Bars object is calling the

OnBarUpdate()

    // method, we can just use the Position property since its pointing to the

correct

    // position.

    if (BarsInProgress == 0)

        Print("Primary position is " + Position.MarketPosition);

    else if (BarsInProgress = 2)

        Print("Er2 position is " + Position.MarketPosition);

}

-o-

AccountSize
Definition
A cash value used to calculate order size of strategy entry orders. Order size is dynamically
calculated based on this property only when setting the "New Strategy" dialog window during
backtest or on a real-time chart "Set order quantity" property to "by account size".

 Equities - Order share size is calculated based on AccountSize / Current Close Price
 Futures and Forex - Order contract/lot size is calculated based on AccountSize / Margin

Requirement (margin set per instrument in the Instrument Manager)

Property Value
An int value representing the account size.

Syntax
AccountSize

Examples

protected override void Initialize()

{

    AccountSize = 10000;

}

-o-

Add()
Definition
This is method provides two functions:

1. Adds a Bars object to a strategy for developing a multi-time frame or multi-instrument
strategy. When running a strategy, the NinjaTrader UI will prompt you to select the primary
instrument and bar interval to run on. This primary Bars object will carry a BarsInProgress
index of 0. In a multi-time frame and multi-instrument strategy, supplementary Bars objects
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are added via this method in the Initialize() method and given an incremented BarsInProgress
index value. See additional information on running multi-bars strategies.

2. Adds an indicator to the strategy only for the purpose of displaying it on a chart.

Note: The Add() method should only be called within the strategy Initialize() method.

Syntax
Add(Indicator indicator)

The following syntax will add another Bars object to the strategy for the primary instrument of
the strategy.
Add(PeriodType periodType, int period)

The following syntax allows you to add another Bars object for a different instrument to the
strategy.
Add(string instrument, PeriodType periodType, int period)

NOTE: You can optionally add the exchange name as a suffix to the symbol name. This is only
advised if the instrument has multiple possible exchanges that it can trade on and it is
configured within the Instrument Manager. For example: Add("MSFT Arca",
PeriodType.Minute, 5).

Parameters
indicator An indicator object
instrument An instrument name such as "MSFT"
periodType The period type of the bar such as:

PeriodType.Day
PeriodType.Minute
PeriodType.Tick
PeriodType.Volume

period The period interval such as "3" for 3 minute bars

Examples
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protected override void Initialize()

{

    // Add a 5 minute Bars object - BarsInProgress index = 1

    Add(PeriodType.Minute, 5);

    // Add a 100 tick Bars object for the ES 12-06 contract - BarsInProgress

index = 2

    Add("ES 12-06", PeriodType.Tick, 100);

                                     

    // Charts a 20 period simple moving average to the chart

    Add(SMA(20));  

}

protected override void OnBarUpdate()

{

    // Ignore bar update events for the supplementary Bars object added above

    if (BarsInProgress == 1 || BarsInProgress == 2)

        return;

    // Go long if we have three up bars on all bars objects

    if (Close[0] > Open[0] && Closes[1][0] > Opens[1][0] && Closes[2][0] >

Opens[2][0])

        EnterLong();

}

-o-

BarsArray
Definition
BarsArray is an array holding Bars objects that are added to a strategy via the Add() method.
Bars objects can be used as input for indicator methods. This property is of primary value
when working with multi-time frame or multi-instrument strategies.

Property Value
An array of Bars objects.

Syntax
BarsArray[int index]

Examples

protected override void Initialize()

{

    // Add a 5 minute Bars object which is added to the BarArray

    // which will take index 1 since the primary Bars object of the strategy

    // will be index 0

    Add(PeriodType.Minute, 5);

}

protected override void OnBarUpdate()

{

    // Ignore bar update events for the supplementary Bars object added above

    if (BarsInProgress == 1)

        return;

    // Pass in a Bars object as input for the simple moving average method

    // Checks if the 20 SMA of the primary Bars is greater than

    // the 20 SMA of the secondary Bars added above

    if (SMA(20)[0] > SMA(BarsArray[1], 20)[0])

        EnterLong();

}
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-o-

BarsInProgress
Definition
An index value of the current Bars object that has called the OnBarUpdate() method. In a
multi-bars strategy, the OnBarUpdate() method is called for each Bars object of a strategy.
This flexibility allows you to separate trading logic from different bar events. In a single
Bars strategy this property will always return an index value of 0 representing the
primary Bars and instrument the strategy is running on. 

See additional information on running multi-bars strategies.

Property Value
An int value represents the Bars object that is calling the OnBarUpdate() method.

Syntax
BarsInProgress

Examples

// Lets assume this sample strategy was added to a ES 12-06 1 minute chart

protected override void Initialize()

{

    // Add a 5 minute Bars object: BarsInProgress index = 1

    Add(PeriodType.Minute, 5);

}

protected override void OnBarUpdate()

{

    // Check which Bars object is calling the OnBarUpdate() method

    if (BarsInProgress == 0)

    {

        // A value of zero represents the primary Bars which is the ES 12-06

        // 1 minute chart.

        // Do something within the context of the 1 minute Bars here

    }

    else if (BarsInProgress == 1)

    {

        // A value of 1 represents the secondary 5 minute bars added in the

Initaliaze()

        // Do something within the context of the 5 minute Bars

    }

}

-o-

BarsPeriods
Definition
Holds an array of Period objects synchronized to the number of unique Bars objects held
within the parent NinjaScript object. If a strategy holds two Bars series, then BarsPeriods will
hold two Period objects.

Property Value
An array of Periods objects.

Syntax
BarsPeriods[int barSeriesIndex]
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Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Print out 5, the value of the secondary bars object

    if (BarsInProgress == 1)

        Print(BarsPeriods[1].Value);

}

-o-

BarsPeriod
Definition
The primary Bars object period type and interval.

Property Value
A Period object.

Syntax
BarsPeriod.Id
BarsPeriod.Value

* Id can be of value PeriodType.Tick, PeriodType.Volume, PeriodType.Second,
PeriodType.Range, PeriodType.Minute, PeriodType.Day, PeriodType.Week, PeriodType.Month,
PeriodType.Year
* Value will return an integer value

Property Of
Custom Strategy

Examples

// Calculate only if there is a 100 tick chart or greater

protected override void OnBarUpdate()

{

    if (BarsPeriod.Id == PeriodType.Tick && BarsPeriod.Value >= 100)

    {

        // Indicator calculation logic here

    }

}

-o-

BarsRequired
Definition
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The number of historical bars required before the strategy starts processing calls to the 
OnBarUpdate() method. This property is generally set via the UI when starting a strategy.

The OnBarUpdate() method is not triggered until CurrentBar >=  BarsRequired.

Property Value
An int value representing the number of historical bars.

Syntax
BarsRequired

-o-

BarsSinceEntry()
Definition
Returns the number of bars that have elapsed since the last specified entry.

Method Return Value
An int value that represents a number of bars.

Syntax
BarsSinceEntry()
BarsSinceEntry(string signalName)

The following method signature should be used when working with multi-time frame and
instrument strategies:

BarsSinceEntry(int barsInProgressIndex, string signalName, int entriesAgo)

Parameters
signalName The signal name of an entry order specified in an order entry method.

Pass in empty string "" for default signal.
barsInProgressInd
ex

The index of the Bars object the entry order was submitted against. See
the BarsInProgress property.

entriesAgo Number of entries ago. Pass in 0 for the most recent entry.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last entry

    if (BarsSinceEntry() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLong();

}

-o-

BarsSinceExit()
Definition
Returns the number of bars that have elapsed since the last specified exit.

Method Return Value
An int value that represents a number of bars. A value of -1 will be returned if a previous exit
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does not exist.

Syntax
BarsSinceExit()
BarsSinceExit(string signalName)

The following method signature should be used when working with multi-time frame and
instrument strategies:

BarsSinceExit(int barsInProgressIndex, string signalName, int exitsAgo)

Parameters
signalName The signal name of an entry order specified in an order entry method.

Pass in empty string "" for default signal.
barsInProgressInd
ex

The index of the Bars object the entry order was submitted  against. See
the BarsInProgress property.

exitsAgo Number of exits ago. Pass in 0 for the the most recent exit.

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    

    // Only enter if at least 10 bars has passed since our last exit

    if (BarsSinceExit() > 10 && CrossAbove(SMA(10), SMA(20), 1))

        EnterLong();

}

-o-

DataSeriesConfigurable
Definition
Indicates if the strategy will allow the configuration of the main data series that will drive the
strategy via the Strategy dialog window when starting a strategy from either a chart or the
Strategies tab of the Control Center window. This property is only of value if a strategy should
only be run on a specific data series.

Property Value
This property returns true if the data series is configureable; otherwise, false.

Syntax
DataSeriesConfigurable

-o-

DefaultQuantity
Definition
An order size variable that can be set either programmatically or overriden via the Strategy
that determines the quantity of an entry order.

Property Value
An int value represents the number of contracts or shares to enter a position with.

Syntax
DefaultQuantity
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-o-

EntriesPerDirection
Definition
Indicates the maximum number of entries allowed per direction while a position is active
based on the EntryHandling property.

Property Value
An int value represents the maximum number of entries allowed.

Syntax
EntriesPerDirection

Examples

// Example #1

// If an open position already exists, subsequent EnterLong() calls are

ignored.

protected override void Initialize()

{

    EntriesPerDirection = 1;

    EntryHandling = EntryHandling.AllEntries;

}

protected override void OnBarUpdate()

{

    if (CrossAbove(SMA(10), SMA(20), 1)

        EnterLong("SMA Cross Entry");

    if (CrossAbove(RSI(14, 3), 30, 1)

        EnterLong("RSI Cross Entry);

}

// Example #2

// EnterLong() will be processed once for each uniquely named entry.

protected override void Initialize()

{

    EntriesPerDirection = 1;

    EntryHandling = EntryHandling.UniqueEntries;

}

protected override void OnBarUpdate()

{

    if (CrossAbove(SMA(10), SMA(20), 1)

        EnterLong("SMA Cross Entry");

    if (CrossAbove(RSI(14, 3), 30, 1)

        EnterLong("RSI Cross Entry);

}

-o-

EntryHandling
Definition
Sets the manner in how entry orders are handled. If set to "EntryHandling.AllEntries",
NinjaScript will process all order entry methods until the maximum allowable entries set by
the EntriesPerDirection property has been reached while in an open position. If set to
"EntryHandling.UniqueEntries", NinjaScript will process order entry methods until the
maximum allowable entries set by the EntriesPerDirection property per each uniquely named
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entry.

Property Value
EntryHandling.AllEntries
EntryHandling.UniqueEntries

Syntax
EntryHandling

Examples

// Example #1

// Will allow a maximum of two entries while a position is open

protected override void Initialize()

{

    EntriesPerDirection = 2;

    EntryHandling = EntryHandling.AllEntries;

}

protected override void OnBarUpdate()

{

    if (CrossAbove(SMA(10), SMA(20), 1)

        EnterLong("SMA Cross Entry");

}

// Example #2

// EnterLong() will be processed once for each uniquely named entry.

protected override void Initialize()

{

    EntriesPerDirection = 1;

    EntryHandling = EntryHandling.UniqueEntries;

}

protected override void OnBarUpdate()

{

    if (CrossAbove(SMA(10), SMA(20), 1)

        EnterLong("SMA Cross Entry");

    if (CrossAbove(RSI(14, 3), 30, 1)

        EnterLong("RSI Cross Entry);

}

-o-

ExitOnClose
Definition
Indicates if the strategy will cancel all strategy generated orders and close all open strategy
positions at the close of the session. This property can be set programatically in the 
Initialize() method or be driven by the UI at run time. See also "ExitOnCloseSeconds".

Property Value
This property returns true if the strategy will exit on close; otherwise, false.

Syntax
ExitOnClose

Examples
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protected override void Initialize()

{

    // Triggers the exit on close function 30 seconds prior to session end

    ExitOnClose        = true;

    ExitOnCloseSeconds = 30;

}

-o-

ExitOnCloseSeconds
Definition
The number of seconds before the actual session end time that the "ExitOnClose" function will
trigger. This property can be set programatically in the Initialize() method or be driven by the
UI at run time.

Property Value
An int value representing the number of seconds.

Syntax
ExitOnCloseSeconds

Examples

protected override void Initialize()

{

    // Triggers the exit on close function 30 seconds prior to session end

    ExitOnClose        = true;

    ExitOnCloseSeconds = 30;

}

-o-

IncludeCommission
Definition
Indicates if the strategy performance results will include commission on a historical backtest.

Property Value
This property returns true if the strategy includes commission on a historical backtest;
otherwise, false.

Syntax
IncludeCommission

Examples

protected override void Initialize()

{

    IncludeCommission = true;

}

-o-

RealtimeErrorHandling
Definition
Defines the behaviour of a strategy when a strategy generated order is returned from the
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broker's server in a "Rejected" state.

 Setting this property value to "TakeNoAction" can have *serious* adverse affects on a
running strategy unless you have programmed your own order rejection handling in the
OnOrderUpdate() method

 User defined rejection handling is advanced and should *only* be addressed by
experienced programmers

Property Value
RealtimeErrorHandling.TakeNoAction
RealtimeErrorHandling.StopStrategyCancelOrdersClosePositions (Default value of a strategy)

Syntax
RealtimeErrorHandling

Examples

protected override void Initialize()

{

    RealtimeErrorHandling = RealtimeErrorHandling.TakeNoAction;

}

private IOrder stopLossOrder = null;

protected override void OnBarUpdate()

{

    if (entryOrder == null && Close[0] > Open[0])

        EnterLong();

    if (stopLossOrder == null)

        stopLossOrder = ExitLongStop(Position.AvgPrice - 10 * TickSize);

}

protected override void OnOrderUpdate(IOrder order)

{

    if (stopLossOrder != null && stopLossOrder.Token == order.Token)

    {

        // Rejection handling

        if (order.OrderState == OrderState.Rejected)

        {    

            // Stop loss order was rejected !!!!

            // Do something about it here

        }

    }

}

-o-

Slippage
Definition
Sets the amount of slippage in ticks used in performance calculations during backtests.

Property Value
An int value representing the number ticks.

Syntax
Slippage



p335

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Examples

protected override void Initialize()

{

    Slippage = 2;

}

-o-

TimeInForce
Definition
Sets the time in force property for all orders generated by a strategy. This property is
dependant on what time in force your broker may or may not support.

Property Value
Cbi.TimeInForce.Day
Cbi.TimeInForce.Gtc

Syntax
TimeInForce

Examples

protected override void Initialize()

{

    TimeInForce = Cbi.TimeInForce.Day;

}

-o-

TraceOrders
Definition
When enabled, traces are generated and displayed in the NinjaScript Output window for each
call of an order method providing confirmation that the method is entered and providing
information if order methods are ignored and why. This is valuable for debugging if you are
not seeing expected behaviour when calling an order method. This property can be set
programatically in the Initialize() method.

The output will reference a method "PlaceOrder()" which is an internal method that all Enter()
and Exit() methods use.

Property Value
This property returns true if the strategy will output trace information; otherwise, false.

Syntax
TraceOrders

Examples

protected override void Initialize()

{

    TraceOrders        = true;

}

-o-
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WaitForOcoClosingBracket
Definition
There may be brokers who require that OCO orders are submitted simultaneously in a single
API call vs sending them in sequence with an include user defined OCO identifier. For brokers
that require OCO orders to be submitted in a single function call, a NinjaScript strategy must
wait until it has both legs of the OCO pair generated by SetStopLoss(), SetTrailStop() and
SetProfitTarget().

If you only wish to send a stop loss or profit target (but not both) via any of the Set...()
methods mentioned above, when WaitForOcoClosingBracket is enabled, your exit orders will
never be sent since NT needs to wait until it has both orders of the OCO bracket. If you
disable WaitForOcoClosingBracket, NinjaTrader will immediately submit a stop or profit target
order, whichever is submitted first.

Current affected brokers:

TD AMERITRADE

* For any other broker, this property has no affect.

Property Value
This property returns true if the strategy will wait for both legs of an OCO bracket to be
called in a strategy before submitting the order pair to the broker; otherwise, false.

Syntax
WaitForOcoClosingBracket

Examples

protected override void Initialize()

{

    WaitForClosingOcoBracket        = false;

}

-o-

Custom Indicator Methods and Properties

Overview
The methods and properties covered in this section are unique to custom indicator
development.
Indicator configuration properties globally define various behaviors of indicators. All
properties have default values and can be overridden by setting them in the Initialize()
method of the indicator.

-o-

Add()
Definition
Adds plot and line objects that define how an indicator data series is visualized on a chart.
When this method is called to add a plot, an associated DataSeries object is created that is
held in the Values collection.

Syntax
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Add(Plot plot)
Add(Line line)

* The Add() method should only be called within the indicator Initialize() method.

Parameters
plot A Plot object
line A Line object

Examples

// Adds a blue line style plot

Add(new Plot(Color.Blue, "myPlot"));

// Adds a blue historgram style plot

Add(new Plot(Color.Blue, PlotStyle.Bar, "myPlot"));

// Adds a blue line style plot with a thickness of 3

Add(new Plot(new Pen(Color.Blue, 3), "myPlot"));

// Adds an oscillator line at a value of 30

Add(new Line(Color.Gray, 30, "Lower"));

Tips
1. There are many variations of defined plot and line objects that are not documented. We
suggest using the NinjaScript indicator wizard to generate your indicator plot and oscillator
lines.

2. Plot objects DO NOT hold the actual indicator values. They simply define how the
indicator's values  are plotted on a chart.

3. An indicator may calculate multiple values and therefore hold multiple plots to determine
the display of each calculated value. Indicator values are held in the indicator's Values
collection.

4. If your indicator calculates and stores three values then plots are assigned as per the
example below.

Protected override void Initialize()

{

    // Add three plots and associated DataSeries objects

    Add(new Plot(Color.Blue, "PlotA"));  // Defines the plot for Values[0]

    Add(new Plot(Color.Red, "PlotB"));   // Defines the plot for Values[1]

    Add(new Plot(Color.Green, "PlotC")); // Defines the plot for Values[2]

}

-o-

AutoScale
Definition
If true, the indicator plot(s) are included to determine the y scaling of the chart.

Property Value
This property returns true if the indicator plot(s) is included in the y scale; otherwise, false.
Default set to true.
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Syntax
AutoScale

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    AutoScale = false;

}

-o-

BackColorAll
Definition
Sets the back color for all chart panels for the current bar.

Property Value
A color structure that represents the color of  this price bar.

Syntax
BackColorAll

Examples

// Sets the back color to pale green

BackColorAll = Color.PaleGreen;

// Sets the back color to the default color set in the chart properties dialog

window

BackColorAll = Color.Empty;

// Sets the back color to pink when the closing price is less than the 20

period SMA 

// and to lime green when above (see image below)

BackColorAll = SMA(20)[0] >= Close[0] ? Color.Pink : Color.PaleGreen;

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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-o-

BarsRequired
Definition
The number of bars on a chart required before the indicator plots. This is NOT the same as a
minimum number of bars required to calculate the indicators values.

Property Value
A int value that represents the minimum number of bars required.

Syntax
BarsRequired

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    BarsRequired = 10; // Do not plot until the 11th bar on the chart

}

-o-

DayBreakLines
Definition
Plots day break lines on the indicator panel.

Property Value
This property returns true if day break lines are plotted on the indicator panel; otherwise,
false. Default set to true.

Syntax
DayBreakLines
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Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    DayBreakLines = false; // Day break lines will not plot on the indicator

panel

}

Tips
1. The indicator panel's parent chart has a similar property 'DayBreakLines' which if set to 
false, will override the indicator's local setting if true.

-o-

Displacement
Definition
An offset value that shifts the plotted value of an indicator.

Property Value
A int value that represents the number of bars ago

Syntax
Displacement

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    Displacement = 2; // Plots the indicator value from 2 bars ago on the

current bar

}

-o-

DisplayInDataBox
Definition
If true, the indicator plot(s) values are displayed in the chart data box.

Property Value
This property returns true if the indicator plot(s) values are displayed in the chart data box;
otherwise, false. Default set to true.

Syntax
DisplayInDataBox

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    DisplayInDataBox = false;

}
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-o-

DrawOnPricePanel
Definition
If true, all draw objects are painted on the price panel which is the panel that displays the
price bar data. If false, draw objects are painted on the actual indicator panel itself.

Property Value
This property returns true if the indicator paints draw objects on the price panel; otherwise,
false. Default set to true.

Syntax
DrawOnPricePanel

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    DrawOnPricePanel = false; // Draw objects now paint on the indicator panel

itself

}

-o-

HorizontalGridLines
Definition
Plots horizontal grid lines on the indicator panel.

Property Value
This property returns true if horizontal grid lines are plotted on the indicator panel;
otherwise, false. Default set to true.

Syntax
HorizontalGridLines

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    HorizontalGridLines = false; // Will not plot on the indicator panel
}

Tips

1. The indicator panel's parent chart has a similar property 'HorizontalGridLines' which if set
to false, will override the indicator's local setting if true.

-o-

Line Class
Definition
Objects derrived from the Line class are used to characterize how an oscillator line is visually
displayed (plotted) on a chart.

Syntax
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Line(Color color, double value, string name)
Line(Pen pen, double value, string name)

Parameters
color The line color (reference)
value The value use to define where the line is plotted
pen The pen used to draw the plot (reference)

Examples
See the Add() method for examples.

-o-

Lines
Definition
A collection holding all of the Line objects that define the visualization characterstics oscillator
lines of the indicator.

Property Value
A collection of Line objects.

Syntax
Lines[int index]

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    // Lines are added to the Lines collection in order

    Add(new Line(Color.Gray, 30, "Lower"));   // Stored in Lines[0]

    Add(new Line(Color.Gray, 70, "Upper"));   // Stored in Lines[1]

}

// Dynamically change the upper line's color and thickness based on the

indicator value

protected override void OnBarUpdate()

{

    if (Values[0] > 70)

        Lines[1].Pen = new Pen(Color.Blue, 3);

    else

        Plots[1].Pen = new Pen(Color.Gray, 1);

}

-o-

LinesConfigurable
Definition
If true, any indicator line(s) are configurable within the indicator dialog window

Property Value
This property returns true if any indicator line(s) are configurable; otherwise, false. Default
set to true.

Syntax
LinesConfigurable

Examples

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/en-us/cpref/html/frlrfSystemDrawingPenClassTopic.asp?frame=true
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// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    LinesConfigurable = false; // Indicator lines are not configurable

}

-o-

Overlay
Definition
If true, the indicator plot(s) are drawn on the chart panel over top of price.

Property Value
This property returns true if the indicator plot(s) are drawn on the chart panel; otherwise,
false. Default set to false.

Syntax
Overlay

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    Overlay = true; // Indicator plots are drawn on the chart panel on top of

price

}

-o-

PaintPriceMarkers
Definition
If true, the indicator plot values are displayed by price markers in the y axis.

Property Value
This property returns true if the indicator plot values are displayed in the y axis; otherwise,
false. Default set to true.

Syntax
PaintPriceMarkers

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    PaintPriceMarkers = true; // Indicator plot values are displayed in the y

axis

}

-o-

Plot Class
Definition
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Objects derrived from the Plot class are used to characterize how indicator values are visually
displayed (plotted) on a chart.

Syntax
Plot(Color color, string name)
Plot(Pen pen, string name)
Plot(Color color, PlotStyle plotStyle, string name)
Plot(Pen pen, PlotStyle plotStyle, string name)

Properties
Plot.Min - Sets the minimum value required for the plot to display
Plot.Max - Sets the maximum value the plot will display

* See tutorial "Custom Plot Color via Thresholds" for example of Plot.Min and Plot.Max
properties.

Parameters
color The plot color (reference)
name The plot name
pen The pen used to draw the plot (reference)
plotStyle The plot's PlotStyle:

PlotStyle.Bar
PlotStyle.Dot
PlotStyle.Hash
PlotStyle.Line
PlotStyle.Square

Examples
See the Add() method for examples.

-o-

Plots
Definition
A collection holding all of the Plot objects that define the visualization characterstics of the
indicator.

Property Value
A collection of Plot objects.

Syntax
Plots[int index]

Examples

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/en-us/cpref/html/frlrfSystemDrawingPenClassTopic.asp?frame=true
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// Initialize method of a custom indicator

protected override void Initialize()

{

    // Plots are added to the Plots collection in order

    Add(new Plot(Color.Orange, "Plot1")); // Stored in Plots[0]

    Add(new Plot(Color.Blue, "Plot2"));   // Stored in Plots[1]

}

// Dynamically change the primary plot's color based on the indicator value

protected override void OnBarUpdate()

{

    if (Value[0] > 100)

        Plots[0].Pen = new Pen(Color.Blue);

    else

        Plots[0].Pen = new Pen(Color.Red);

}

-o-

PlotsConfigurable
Definition
If true, any indicator plot(s) are configurable within the indicator dialog window

Property Value
This property returns true if any indicator plot(s) are configurable; otherwise, false. Default
set to true.

Syntax
PlotsConfigurable

Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    PlotsConfigurable = false; // Plots are not configurable in the indicator

dialog

}

-o-

PriceType
Definition
Type of price data such as open, high, low etc...

Property Value
This property returns a PriceType value of either:

PriceType.Close
PriceType.High
PriceType.Low
PriceType.Median
PriceType.Open
PriceType.Typical

Syntax
PriceType
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Examples

// Initialize method of a custom indicator

protected override void Initialize()

{

    Add(new Plot(Color.Orange, "SMA"));

    PriceType = PriceType.High; // Indicator will use high prices for

calculations

}

-o-

Update()
Definition
This method will force the OnBarUpdate() method to be called so that indicator values are
updated. This method is only relevant in specific use cases and likely only used by advanced
programmers.

When indicators are embedded (called) within a NinjaScript strategy, they are optimized to
calculate only when they are called upon in a historical backtest. Since the NinjaTrader
indicator model is very flexible, it is possible to create public properties on a custom indicator
that return values of internal user defined variables. If these properties require that the
OnBarUpdate() method is called before returning a value, include a call to this Update()
method in the property getter.

Syntax
Update()

Examples

private double tripleValue = 0;

protected override void OnBarUpdate()

{

    if (CurrentBar < 20)

        return;

    tripleValue = SMA(20)[0] * 3;

    Values[0].Set(SMA(20)[0]);

}

public double TripleValue

{

    get

    {

        Update();

        return tripleValue;

    }

}                              

-o-

Value
Definition
Value references the 1st DataSeries object Values[0] in the indicator. This is the primary
indicator value.

Property Value
A DataSeries object.
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Syntax
Value

Examples

// OnBarUpdate method of a custom indicator

protected override void OnBarUpdate()

{

    // Checks the indicator primary value 1 bar agao and sets the value of the

indicator

    // for the current bar being evaluated

    if (Value[1] < High[0] - Low[0])

        Value.Set(High[0] - Low[0]);

    else

        Value.Set(High[0] - Close[0]);

}

Tips
1. The DataSeries object referenced by this property is created by calling the Add() method. 

-o-

Values
Definition
Values is a collection holding DataSeries objects that hold the indicator's underlying
calculated values.
DataSeries objects held by this collection are added by calling the Add() method.

Property Value
A collection of DataSeries objects.

Syntax
Values[int index]

-o-

VerticalGridLines
Definition
Plots vertical grid lines on the indicator panel.

Property Value
This property returns true if vertical grid lines are plotted on the indicator panel; otherwise,
false. Default set to true.

Syntax
VerticalGridLines

Examples

// Vertical grid lines will not plot on the indicator panel

VerticalGridLines = false;

Tips
1. The indicator panel's parent chart has a similar property 'VerticalGridLines' which if set to 
false, will override the indicator's local setting if true.
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-o-

Custom Fill and Optimizer Types

Fill Types
Custom Fill Algorithms
In addition to the two system fill types (Default and Liberal) you can also script a custom fill
algorithms using any code/text editor.

Copy the file "My Documents\<NinjaTrader Folder>\bin\Custom\Type\@LiberalFillType.cs"
and provide a name new exluding the "@" sign such as "My Documents\<NinjaTrader
Folder>\bin\Custom\Type\MyFillType.cs".

Then within your code editor:

1. Provide a new display name for example rename "Liberal" to "MyFill"
2. Provide a new class name for example rename "LiberalFillType" to "MyFillType"
3. Code your fill algorithm within the Fill() method
4. Once complete, open any indicator or strategy within the NinjaTrader's NinjaScript Editor
and compile. This will compile the new fill algorithm and make it available  within any
backtest dialog window.

-o-

Optimizer Type
This section is under construction however, if you are an advanced C# programmer you can
see the file My Documents\<NinjaTrader
Folder>\bin\Custom\Type\@DefaultOptimizationMethod.cs.

-o-

Shared Alert and Debug Methods

Alert()
Definition
Generates a visual/audible alert for the Alerts window.

 Calls to this method are ignored on historical data, it will only work in real-time.
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Syntax
Alert(string id, Priority priority, string message, string soundLocation, int rearmSeconds, Color
 backColor, Color foreColor)

Method Of
Custom Indicator, Custom Strategy

Parameters
id A unique id for this alert
priority Any one of the following values:

NinjaTrader.Cbi.Priority.High
NinjaTrader.Cbi.Priority.Low
NinjaTrader.Cbi.Priority.Medium

message Alert message
soundLocation File name of .wav file to play. Provide either the absolute file path or just 

the name if the file is located in C:\Program Files\NinjaTrader Installation
Folder\sounds folder

rearmSeconds Sets the number of seconds an alert will rearm. If the same alert
(identified by the id parameter) is called within a time window of the
time of last alert + rearmSeconds, the alert will be ignored.

backColor The alert row back color (reference)
foreColor The alert row fore color (reference)

Examples

// Generates an alert

Alert("myAlert", NinjaTrader.Cbi.Priority.High, "Reached threshold",

"Alert1.wav", 10, Color.Black, Color.Yellow);

-o-

ClearOutputWindow()
Definition
Clears all data from the NinjaTrader output window

Syntax
ClearOutputWindow()

Method Of
Custom Indicator, Custom Strategy

-o-

Log()
Definition
Generates log output to the NinjaTrader Control Center window Log tab.  

Syntax

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Log(string message, LogLevel logLevel)

Method Of
Custom Indicator, Custom Strategy

Parameters
message User defined log message
LogLevel Sets the message level for the log event. Different levels are colored

coded in the NinjaTrader log.

NinjaTrader.Cbi.LogLevel.Alert (will also generate a pop up message
window with log text)
NinjaTrader.Cbi.LogLevel.Error
NinjaTrader.Cbi.LogLevel.Information
NinjaTrader.Cbi.LogLevel.Warning

Examples

// Generates a log message

Log("This is a log message", NinjaTrader.Cbi.LogLevel.Information);

// Generates a log message with a notification window 

Log("This will energate a notification window as well",

NinjaTrader.Cbi.LogLevel.Alert);

-o-

PlaySound()
Definition
Plays a .wav file.

 Calls to this method are ignored on historical data, it will only work in real-time.

Syntax
PlaySound(string fileName)

Method Of
Custom Indicator, Custom Strategy

Parameters
fileName File name of .wav file to play

Examples

// Plays the wav file mySound.wav

PlaySound(@"C:\mySound.wav");

-o-



p351

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Print()
Definition
Prints data to the NinjaTrader output window

Syntax
Print(string message)
Print(bool value)
Print(double value)
Print(int value)
Print(DateTime value)

Method Of
Custom Indicator, Custom Strategy

Parameters
message User defined message

Examples

// Generates a message

Print("This is a message");

// Prints the current bar SMA value to the output window

Print(SMA(Close, 20)[0]);

Tips
1. You can align prices to be formatted for easier debugging such as Low[0].ToString("0.00").
So if you have

12.5
12.75

you would get

12.50
12.75

-o-

ResetAlert()
Definition
Resets the rearm time of an alert created via the Alert() method.

Syntax
ResetAlert(string id)

Method Of
Custom Indicator, Custom Strategy
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Parameters
id The unique id value identifying the alert

-o-

ResetAlerts()
Definition
Resets the rearm time of all triggered alerts across NinjaTrader regardless of where the alerts
were created.

Syntax
ResetAlerts()

Method Of
Custom Indicator, Custom Strategy

-o-

SendMail()
Definition
Sends an email message.

 Calls to this method are ignored on historical data, it will only work in real-time.

Syntax
SendMail(string from, string to, string subject, string text)

Method Of
Custom Indicator, Custom Strategy

Parameters
from From email address
to To email address
subject Subject line of email
text Message body of email

Examples

// Generates an email message

SendMail("support@ninjatrader.com", "customer@winners.com", "Trade Alert",

"Buy ES");

Tips
1. If mails are not sent, check the Control Center Log tab for any error information. You can
also try changing the SMTP outgoing mail server to use your own ISP's mail server. You can
set this information via the Control Center window Tools > Options > Misc.

-o-
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Shared Data Methods and Properties

Overview
The following section documents methods and properties that access various forms of data
including bar data, price data and statistical forms of data.

-o-

Working with Price Data

The core objective of developing custom Indicators and Strategies with NinjaScript is to
evaluate price data. NinjaScript allows you to reference current and historical price data.
There are several categories of price data which include Price Types, Indicator and Custom
Historical Series.

Definitions
Price Type - Standard bar based price types such as closing, opening, high, low prices and
volume
Indicator - Calculated values based on price type values such as a simple moving average
Custom Historical DataSeries - Custom calculated values that you wish to store and associate
to each historical bar

Referencing Price Type Data

Price Type Syntax Editor Shortcut Definition
Close Close[int

barsAgo]
"c" + Tab Key Last traded price of a bar

Open Open[int
barsAgo]

"o" + Tab Key Opening price of a bar

High High[int
barsAgo]

"h" + Tab Key Highest traded price of a bar

Low Low[int
barsAgo]

"l" + Tab Key Lowest traded price of a bar

Volume Volume[int
barsAgo]

"v" + Tab Key Number of shares/contracts traded of
a bar

Input Input[int
barsAgo]

"i" + Tab Key *Default price type of a bar

You will notice that to reference any price data you need to include a value for [int barsAgo].
This is a very simple concept; barsAgo represents the number of bars ago to reference and int
indicates that barsAgo is an integer value. As an example, we could write a statement to
check if the the high price of 1 bar ago is less than the high price of the current bar like this:

        High[1] < High[0];

You could write a statement to calculate the average closing price of the last three bars like
this:

        ( Close[2] + Close[1] + Close[0] ) / 3;

As you may have already figured out, referencing the current bar data is accomplished by
passing in a value of 0 (zero) to the barsAgo parameter. Basically, we are saying show me the
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price data of zero bars ago, which means the current bar.

* Input is a special property that can be accessed and always points to the default price type.
If you have an indicator that supports using different price type as its source data, if you
reference the Input[in barsAgo] property it will automatically reference the correct price type
object. This is an advanced topic.

Referencing Indicator Data
NinjaScript includes a library of built in indicators that you can access. Please see the 
Indicator Methods reference section for clear defintions for how to access each indicator.

All indicator values can be accessed in the following way:

        indicator(parameters)[int barsAgo]

where indicator is the name of the indicator you want to access, parameters is any associated
parameters the indicator requires and barsAgo is the number of bars we wish to offset from
the current bar. 

As an example, we could write a statement to check if the current closing price is greater than
the 20 period simple moving average like this:

        Close[0] > SMA(20)[0];

If you wanted to perform the same check but only check against a 20 period simple moving
average of high prices you would write it like this:

        Close[0] > SMA(High, 20)[0];

You could write a statement to see if a 14 period CCI indicator is rising like this:

        CCI(14)[0] > CCI(14)[1];

Value of a 10 period CCI 1 bar ago = CCI(10)[1]

Please review the Indicator Methods reference for proper syntax for accessing different
indicator values.

-o-

BarsSinceSession
Definition
The number of bars that have elapsed since the session started.

Property Value
An int value representing the number of bars elapsed.

Property Of
Custom Indicator, Custom Strategy

Syntax
Bars.BarsSinceSession

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be a Bar object which
holds the CurrentBid property. Should you wish to access this property elsewhere, check for
null reference first. e.g. if (Bars != null)
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-o-

BoolSeries Class
Definition
A BoolSeries is a special type of data structure that holds a series of bool values and always
contains the same number of elements as bars in a chart. See the DataSeries Class for
related information.

Creating BoolSeries Objects
To create a BoolSeries object:

1. Define a variable ("myBoolSeries" used in this example) of type BoolSeries that will hold a
BoolSeries object
2. In the Initialize() method, create a new BoolSeries object and assign it to the
"myBoolSeries" variable

#region Variables

    private BoolSeries myBoolSeries; // Define a BoolSeries variable

#endregion

// Create a BoolSeries object and assign it to the variable

protected override void Initialize()

{

    myBoolSeries = new BoolSeries(this); // "this" refers to the indicator, or

strategy

                                         // itself. This syncs the BoolSeries

object

                                         // to historical data bars

}

* BoolSeries objects can be used on supplementary series in a multi-time frame and
instrument strategy. Please see our support forum NinjaScript reference samples section for
further information.

Setting Values -  BoolSeries.Set() & BoolSeries.Reset()
You can set value (plug in a value) into a BoolSeries object by calling the Set() method. 

BoolSeries.Set(bool value)
Setting a value on a BoolSeries object is automatically aligned to the current bar being
evaluated. This ensures values across all BoolSeries objects are always in sync by the 
CurrentBar index. The following code samples demonstrates calculating the range of each bar
and storing the value in a BoolSeries object.

protected override void OnBarUpdate()

{

    // Is the close > than the open

    myBoolSeries.Set(Close[0] > Open[0] ? true : false);

}

BoolSeries.Set(int barsAgo, bool value)
You can also set the value for historical bars by including a "barsAgo" value that represents
the number of bars ago that you want the bool value to be stored at.

Calling the Reset() method is unique and can be very powerful for custom indicator
development. BoolSeries objects can hold null values which simply means that you do not
want to store a value for the current bar. Reset() will reset the current index value to null.
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Checking for Valid Values
It is possible that you may use a BoolSeries object but decide not to set a value for a specific
bar. Internally, a dummy value does exist however, if you wanted to check to see if it was a
valid value that you set, you can check the following method.

BoolSeries.ContainsValue(int barsAgo)
Returns a true or false value.

Getting Values
You can access BoolSeries object values using the syntax BoolSeries[int barsAgo] where
barsAgo represents the data value n number of bars ago.

protected override void OnBarUpdate()

{

    // Prints the current and last bar value

    Print("The values are " + myBoolSeries[0] + " " + myBoolSeries[1]);

}

-o-

CalculateOnBarClose
Definition
If true, OnBarUpdate() is called on the close of each bar otherwise it is called on each
incoming tick. This property should ONLY be set in an Initialize() method and be the last
statement within that method.

 When indicators or strategies are running on historical data, OnBarUpdate() is only called
on the close of each historical bar even if this property is set to false. This is due to the fact
that with a historical data set, only the OHLCVT of the bar is known and not each tick that
made up the bar.

 The CalculateOnBarClose property of indicators embedded within a strategy are overriden
by the CalculateOnBarClose property of the strategy

Property Value
This property returns true if the value is calculated on the close of each bar; otherwise, false
. Default set to false.

Syntax
CalculateOnBarClose

Property Of
Custom Indicator, Custom Strategy

Examples

// Calculate on the close of each bar

CalculateOnBarClose = true;

Tips
1. Calculating indicators or systems for each incoming tick can be CPU intensive. Only
calculate indicators on each incoming tick if you have a requirement to calculate it intra bar.

-o-

Close
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Definition
A collection of historical bar close prices.

Property Value
A DataSeries type object. Accessing this property via an index value [int barsAgo] returns a
double value representing the price of the referenced bar.

Syntax
Close
Close[int barsAgo]

Property Of
Custom Indicator, Custom Strategy

Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Checks if the current close is greater than the prior bar close

    if (Close[0] > Close[1])

        Print("We had an up day");

}

-o-

Closes
Definition
Holds an array of DataSeries objects holding historical bar close prices. A DataSeries object is
added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the closing prices of all Bars objects in a multi-instrument or multi-time
frame strategy. 

Property Value
An array of DataSeries objects.

Syntax
Closes[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples
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protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's close price to the 5-minute bar's close

price

    if (Closes[0][0] > Closes[1][0])

        Print("The current bar's close price is greater");

}

-o-

Count
Definition
The total number of bars or data points.

Property Value
An int value representing the the total number of bars.

Syntax
Count

Property Of
Custom Indicator, Custom Strategy

Tips
1. CurrentBar value is guaranteed to be <= Count - 1. This is because of the NinjaTrader
multi-threaded architecture, the Count value can have additional bars as inflight ticks come in
to the system.

-o-

CountIf()
Definition
Counts the number of occurrences of the test condition over the look back period expressed in
bars. This method will NOT work on multi-instrument or multi-time frame strategies.

Method Return Value
An int value representing the number of occurrences found

Syntax
CountIf(Condition condition, int lookBackPeriod)

The syntax for condition must written in the following manner:

delegate { return your true/false condition;}

Method Of
Custom Indicator, Custom Strategy
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Parameters
condition A true/false expression
lookBackPeriod Number of bars to look back to check for the test condition

Examples

// If in the last 10 bars we have had 8 up bars then go long

if (CountIf(delegate {return Close[0] > Open[0];}, 10) > 8)

    EnterLong();

-o-

CrossAbove()
Definition
Checks for a cross above condition over the specified bar look back period.

Method Return Value
This method returns true if a cross above condition occured; otherwise, false.

Syntax
CrossAbove(IDataSeries series1, double value, int lookBackPeriod)
CrossAbove(IDataSeries series1, IDataSeries series2, int lookBackPeriod)

Method Of
Custom Indicator, Custom Strategy

Parameters
value Any double value
series1 & series2 Any DataSeries type object such as an indicator, Close, High, Low etc..
lookBackPeriod Number of bars back to check for the cross above condition

Examples

// Go short if CCI crossed above 250 within the last bar

if (CrossAbove(CCI(14), 250, 1))

    EnterShort();

// Go long if 10 EMA crosses above 20 EMA within the last bar

if (CrossAbove(EMA(10), EMA(20), 1))

    EnterLong();

// Go long we have an up bar and the 10 EMA crosses above 20 EMA within the

last 5 bars

if (Close[0] > Open[0] && CrossAbove(EMA(10), EMA(20), 5))

    EnterLong();

-o-

CrossBelow()
Definition
Checks for a cross below condition over the specified bar look back period.

Method Return Value
This method returns true if a cross above condition occured; otherwise, false.
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Syntax
CrossBelow(IDataSeries series1, double value, int lookBackPeriod)
CrossBelow(IDataSeries series1, IDataSeries series2, int lookBackPeriod)

Method Of
Custom Indicator, Custom Strategy

Parameters
value Any double value
series1 & series2 Any DataSeries type object such as an indicator, Close, High, Low etc..
lookBackPeriod Number of bars back to check for the cross above condition

Examples

// Go long if CCI crossed below -250 within the last bar

if (CrossBelow(CCI(14), -250, 1))

    EnterLong();

// Go short if 10 EMA crosses below 20 EMA within the last bar

if (CrossBelow(EMA(10), EMA(20), 1))

    EnterShort();

// Go short we have a down bar and the 10 EMA crosses below 20 EMA within the

last 5 bars

if (Close[0] < Open[0] && CrossBelow(EMA(10), EMA(20), 5))

    EnterShort();

-o-

CurrentBar
Definition
A number representing the current bar in a Bars object that the OnBarUpdate() method in an
indicator or strategy is currently processing. For example, if a chart has 100 bars of data, the
very first bar of the chart (left most bar) will be number 0 (zero) and each subsequent bar
from left to right is incremented by 1.

Property Value
An int value that represents the current bar.

Syntax
CurrentBar

Property Of
Custom Indicator, Custom Strategy

Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Checks to make sure we have at least 20 or more bars

    if (CurrentBar < 20) 

        return;

    

    // Indicator logic calculation code...

}

-o-
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DataSeries Class
Definition
A DataSeries is a special type of data structure that holds a series of double values and
always contains the same number of elements as bars in a chart. If you have 200 bars loaded
in your chart with a moving average plotted, the moving average itself holds a DataSeries
object with 200 historical values of data, one for each bar. DataSeries objects can be used as
input data for all indicator methods. The DataSeries class implements the IDataSeries
interface.

Creating DataSeries Objects
When creating custom indicators, DataSeries objects are automatically created for you by
calling the Add() method and can be subsequently referenced by the Value and/or Values
property. However, you may have a requirement to create a DataSeries object to store values
that are part of an overall indicator value calculation. This can be done within a custom
indicator or strategy. 

To create a DataSeries object:

1. Define a variable ("myDataSeries" used in this example) of type DataSeries that will hold a
DataSeries object
2. In the Initialize() method, create a new DataSeries object and assign it to the
"myDataSeries" variable

#region Variables

    private DataSeries myDataSeries; // Define a DataSeries variable

#endregion

// Create a DataSeries object and assign it to the variable

protected override void Initialize()

{

    myDataSeries = new DataSeries(this); // "this" refers to the indicator, or

strategy

                                         // itself. This syncs the DataSeries

object

                                         // to historical data bars

}

* DataSeries objects can be used on supplementary series in a multi-time frame and
instrument strategy. Please see our support forum NinjaScript reference samples section for
further information.

Setting Values -  DataSeries.Set() & DataSeries.Reset()
You can set value (plug in a value) into a DataSeries object by calling the Set() method. 

DataSeries.Set(double value)
Setting a value on a DataSeries object is automatically aligned to the current bar being
evaluated. This ensures values across all DataSeries objects are always in sync by the 
CurrentBar index. The following code samples demonstrates calculating the range of each bar
and storing the value in a DataSeries object.

protected override void OnBarUpdate()

{

    // Calculate the range of the current bar and set the value

    myDataSeries.Set(High[0] - Low[0]);

}

DataSeries.Set(int barsAgo, double value)
You can also set the value for historical bars by including a "barsAgo" value that represents
the number of bars ago that you want the double value to be stored at.



p362

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Calling the Reset() method is unique and can be very powerful for custom indicator
development. DataSeries objects can hold null values which simply means that you do not
want to store a value for the current bar. Mathematically, you can correctly assign a value of
zero however if the DataSeries was the primary DataSeries of an indicator whose values
would be used for plotting, you may NOT want a zero value plotted. Meaning, you want a zero
value for proper calculations but not a zero value for chart visualization. The Reset() method
allows you to reset the current bar's DataSeries value to a zero for calculation purposes but
NinjaScript would ignore this value when it plotted it on a chart.

Checking for Valid Values
It is possible that you may use a DataSeries object but decide not to set a value for a specific
bar. Internally, a dummy value does exist which is the current bar close however, if you
wanted to check to see if it was a valid value that you set, you can check the following
method.

DataSeries.ContainsValue(int barsAgo)
Returns a true or false value.

Getting Values
You can access DataSeries object values using the syntax DataSeries[int barsAgo] where
barsAgo represents the data value n number of bars ago.

protected override void OnBarUpdate()

{

    // Prints the current and last bar value

    if (CurrentBar > 0)

        Print("The values are " + myDataSeries[0] + " " + myDataSeries[1]);

}

Methods that Accept DataSeries as Arguments
All indicator methods accept DataSeries objects as arguments. Carrying from the prior
examples, let's print out the 10 period simple moving average of range.

protected override void OnBarUpdate()

{

    // Calculate the range of the current bar and set the value

    myDataSeries.Set(High[0] - Low[0]);

    // Print the current 10 period SMA of range

    Print("Value is " + SMA(myDataSeries, 10)[0]);

}

-o-

DateTimeSeries Class
Definition
A DateTimeSeries is a special type of data structure that holds a series of DateTime values
and always contains the same number of elements as bars in a chart. See the DataSeries
Class for related information.

Creating DateTimeSeries Objects
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To create a DateTimeSeries object:

1. Define a variable ("myDateTimeSeries" used in this example) of type DateTimeSeries that
will hold a DateTimeSeries object
2. In the Initialize() method, create a new DateTimeSeries object and assign it to the
"myDateTimeSeries" variable

#region Variables

    private DateTimeSeries myDateTimeSeries; // Define a DateTimeSeries

variable

#endregion

// Create a DateTimeSeries object and assign it to the variable

protected override void Initialize()

{

    myDateTimeSeries = new DateTimeSeries(this); // "this" refers to the

indicator, or strategy

                                         // itself. This syncs the

DateTimeSeries object

                                         // to historical data bars

}

* DateTimeSeries objects can be used on supplementary series in a multi-time frame and
instrument strategy. Please see our support forum NinjaScript reference samples section for
further information.

Setting Values -  DateTimeSeries.Set() & DateTimeSeries.Reset()
You can set value (plug in a value) into a DateTimeSeries object by calling the Set() method. 

DateTimeSeries.Set(DateTime value)
Setting a value on a DateTimeSeries object is automatically aligned to the current bar being
evaluated. This ensures values across all DateTimeSeries objects are always in sync by the 
CurrentBar index. The following code samples demonstrates calculating the range of each bar
and storing the value in a DateTimeSeries object.

protected override void OnBarUpdate()

{

    // Store the current time

    myDateTimeSeries.Set(DateTime.Now);

}

DateTimeSeries.Set(int barsAgo, DateTime value)
You can also set the value for historical bars by including a "barsAgo" value that represents
the number of bars ago that you want the DateTime value to be stored at.

Calling the Reset() method is unique and can be very powerful for custom indicator
development. DateTimeSeries objects can hold null values which simply means that you do
not want to store a value for the current bar. Reset() will reset the current index value to null.

Checking for Valid Values
It is possible that you may use a DateTimeSeries object but decide not to set a value for a
specific bar. Internally, a dummy value does exist however, if you wanted to check to see if it
was a valid value that you set, you can check the following method.

DateTimeSeries.ContainsValue(int barsAgo)
Returns a true or false value.
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Getting Values
You can access DateTimeSeries object values using the syntax DateTimeSeries[int barsAgo]
where barsAgo represents the data value n number of bars ago.

protected override void OnBarUpdate()

{

    // Prints the current and last bar value

    Print("The values are " + myDateTimeSeries[0] + " " +

myDateTimeSeries[1]);

}

-o-

DayOfWeek
Definition
The day of the week of the current bar accessed through the Time property.

Property Value
A DayOfWeek type such as:
DayOfWeek.Monday
DayOfWeek.Tuesday
DayOfWeek.Wednesday
DayOfWeek.Thursday
DayOfWeek.Friday
DayOfWeek.Saturday
DayOfWeek.Sunday

Syntax
Time[int barsAgo].DayOfWeek

Property Of
Custom Indicator, Custom Strategy

Examples

protected override void OnBarUpdate()

{

    // If its Monday...do not trade

    if (Time[0].DayOfWeek == DayOfWeek.Monday)

        return;

}

-o-

Dispose()
Definition
For advanced programmers: You can override the Dispose() method to clean up all resources
owned by the custom indicator or strategy. It is critical that you call the base.Dispose()
method when overriding the Dispose() method.

Method Of
Custom Indicator, Custom Strategy

Examples
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public override void Dispose()

{

    // Clean up your resources here

    base.Dispose();

}

-o-

Falling()
Definition
Checks for a falling condition which is true when the current value is less than the value of 1
bar ago.

Method Return Value
This method returns true if a falling condition is present; otherwise, false.

Syntax
Falling(IDataSeries series)

Method Of
Custom Indicator, Custom Strategy

Parameters
series Any DataSeries type object such as an indicator, Close, High, Low etc..

Examples

// If the 20 period SMA is falling (in downtrend) go short

if (Falling(SMA(20))

    EnterShort();

-o-

FirstBarOfSession
Definition
Gets a value indicating if the bar is the first bar of a session.

Property Value
This property returns true if the bar is the first bar of a session; otherwise, false.

Syntax
Bars.FirstBarOfSession

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be a Bar object which
holds the FirstBarOfSession property. Should you wish to access this property elsewhere,
check for null reference first. e.g. if (Bars != null)

-o-

FirstTickOfBar
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Definition
Indicates if the incoming tick is the first tick of a new bar. This property is only of value in
strategies that run tick by tick which is when the CalculateOnBarClose property is set to false
.

Property Value
This property returns true if the incoming tick is the first tick of a new bar; otherwise, false.

Syntax
FirstTickOfBar

Property Of
Custom Indicator, Custom Strategy

Examples

// On a tick by tick strategy the only way you know when a bar is closed is

when

// the FirsTickOfBar is true. 

protected override void OnBarUpdate()

{

    // Only process entry signals on a bar by bar basis (not tick by tick)

    if (FirstTickOfBar)

    {

        if (CCI(20)[1] < -250)

            EnterLong();

        

        return;

    }

    // Process exit signals tick by tick

    if (CCI(20)[0] > 250)

        ExitLong();

}

-o-

FloatSeries Class
Definition
A FloatSeries is a special type of data structure that holds a series of float values and always
contains the same number of elements as bars in a chart. See the DataSeries Class for
related information.

Creating FloatSeries Objects
To create a FloatSeries object:

1. Define a variable ("myFloatSeries" used in this example) of type FloatSeries that will hold a
FloatSeries object
2. In the Initialize() method, create a new FloatSeries object and assign it to the
"myFloatSeries" variable
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#region Variables

    private FloatSeries myFloatSeries; // Define a FloatSeries variable

#endregion

// Create a FloatSeries object and assign it to the variable

protected override void Initialize()

{

    myFloatSeries = new FloatSeries(this);  // "this" refers to the indicator,

or strategy

                                         // itself. This syncs the IntSeries

object

                                         // to historical data bars

}

* FloatSeries objects can be used on supplementary series in a multi-time frame and
instrument strategy. Please see our support forum NinjaScript reference samples section for
further information.

Setting Values -  FloatSeries.Set() & FloatSeries.Reset()
You can set value (plug in a value) into a FloatSeries object by calling the Set() method. 

FloatSeries.Set(float value)
Setting a value on a FloatSeries object is automatically aligned to the current bar being
evaluated. This ensures values across all FloatSeries objects are always in sync by the 
CurrentBar index. The following code samples demonstrates calculating the range of each bar
and storing the value in a FloatSeries object.

protected override void OnBarUpdate()

{

    float range = (float) High[0] - Low[0];

    myFloatSeries.Set(range);

}

FloatSeries.Set(int barsAgo, bool value)
You can also set the value for historical bars by including a "barsAgo" value that represents
the number of bars ago that you want the bool value to be stored at.

Calling the Reset() method is unique and can be very powerful for custom indicator
development. FloatSeries objects can hold null values which simply means that you do not
want to store a value for the current bar. Reset() will reset the current index value to null.

Checking for Valid Values
It is possible that you may use an FloatSeries object but decide not to set a value for a
specific bar. Internally, a dummy value does exist however, if you wanted to check to see if it
was a valid value that you set, you can check the following method.

FloatSeries.ContainsValue(int barsAgo)
Returns a true or false value.

Getting Values
You can access IntSeries object values using the syntax IntSeries[int barsAgo] where barsAgo
represents the data value n number of bars ago.
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protected override void OnBarUpdate()

{

    // Prints the current and last bar value

    Print("The values are " + myFloatSeries[0] + " " + myFloatSeries[1]);

}

-o-

GetBar()
Definition
Returns the number of bars ago starting with the 1st bar from oldest to newest that matches
the time stamp based on the DateTime parameter passed in. If the time stamp passed in is
older than the 1st bar, the value returned reflects the number of bars ago for the 1st bar of
the series. If  the time stamp is newer than the last bar, a value of zero is returned.

Method Return Value
An int value that represents the number of bars ago.

Syntax
GetBar(DateTime time)
GetBar(int barSeriesIndex, DateTime time)

Method Of
Custom Indicator, Custom Strategy

Parameters
time An instance of time.
barSeriesIndex Index value of bars object in a multiseries strategy

Examples

// Check that its past 9:45 AM

if (ToTime(Time[0]) >= ToTime(9, 45, 00))

{

    // Calculate the bars ago value for the 9 AM bar for the current day

    int barsAgo = GetBar(new DateTime(2006, 12, 18, 9, 0, 0));

    // Print out the 9 AM bar closing price

    Print("The close price on the 9 AM bar was: " +

Close[barsAgo].ToString());

}

-o-

GetCurrentAsk()
Definition
Returns the current ask price.

Method Return Value
A double value representing the current ask price. Note: When accessed during a historical
backtest, the close price of the evaluated bar is subsituted.

Syntax
GetCurrentAsk()
GetCurrentAsk(int barSeriesIndex)

Method Of

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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Custom Indicator, Custom Strategy

-o-

GetCurrentAskVolume()
Definition
Returns the current ask volume.

Method Return Value
An int value representing the current ask volume. Note: When accessed during a historical
backtest, the volume of the evaluated bar is subsituted.

Syntax
GetCurrentAskVolume()
GetCurrentAskVolume(int barSeriesIndex)

Method Of
Custom Indicator, Custom Strategy

-o-

GetCurrentBid()
Definition
Returns the current bid price.

Method Return Value
A double value representing the current bid price. Note: When accessed during a historical
backtest, the close price of the evaluated bar is subsituted.

Syntax
GetCurrentBid()
GetCurrentBid(int barSeriesIndex)

Method Of
Custom Indicator, Custom Strategy

-o-

GetCurrentBidVolume()
Definition
Returns the current bid volume.

Method Return Value
An int value representing the current bid volume. Note: When accessed during a historical
backtest, the volume of the evaluated bar is subsituted.

Syntax
GetCurrentBidVolume()
GetCurrentBidVolume(int barSeriesIndex)

Method Of
Custom Indicator, Custom Strategy

-o-

GetMedian()
Definition
Returns the median value of the specified series over the specified look back period. This



p370

© NinjaTrader, LLC, 2005

www.ninjatrader.com

method will sort the values of the specified look back period in ascending order and return the
middle value. If an even number is passed in, the average of the two middle values in the
sorted values will be returned. 

Method Return Value
A double value representing the median price.

Syntax
GetMedian(IDataSeries series, int lookBackPeriod)

Method Of
Custom Indicator, Custom Strategy

Parameters
series Any DataSeries type object such as an indicator, Close, High, Low etc..
lookBackPeriod Number of bars back to include in the calculation

Examples

// Print the median price of the last 10 open prices

if (GetMedian(Open, 10))

    Print("The median of the last 10 open prices is: " + GetMedian(Open,

10).ToString());

-o-

GetSessionBar()
Definition
Returns a Bar object that represents a session whose properties for open, high, low, close,
time and volume can be accessed. This bar is a virtual bar built off of the underlying data
series. In some cases, the session bar can be used to represent a daily bar. Since this bar is
virtual, its property values are calculated for the session time only and not represent the
actual day. You must check for a null reference since null is returned if there is not sufficient
intraday data to build a session bar.

!!! This method should ONLY be used for accessing prior session data. To access
current session data, use the CurrentDayOHL() method. 

Method Return Value
See below.

Syntax
The properties below return double values:
Bars.GetSessionBar(int sessionsAgo).Open
Bars.GetSessionBar(int sessionsAgo).High
Bars.GetSessionBar(int sessionsAgo).Low
Bars.GetSessionBar(int sessionsAgo).Close

The property below returns a DateTime structure:
Bars.GetSessionBar(int sessionsAgo).Time

The property below returns an int value:
Bars.GetSessionBar(int sessionsAgo).Volume

Method Of
Custom Indicator, Custom Strategy

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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Parameters
sessionsAgo Number of sessions ago

Examples

// Print the prior session close

if (Bars.GetSessionBar(1) != null)

    Print("The prior session's close is: " +

Bars.GetSessionBar(1).Close.ToString());

-o-

HighestBar()
Definition
Returns the number of bars ago the highest price value occured for the lookback period. If
there are several occurences within the lookback period where the bar was the highest bar
the more recent occurence is returned.

Method Return Value
An int value that represents number of bars ago.

Syntax
HighestBar(IDataSeries series, int lookBackPeriod)

Method Of
Custom Indicator, Custom Strategy

Parameters
series Any DataSeries type object such as an indicator, Close, High, Low etc..
lookBackPeriod The number of bars to include in the calculation

Examples

// Prints out the number of bars ago for the highest close of the current

session

Print(HighestBar(Close, Bars.BarsSinceSession - 1).ToString());

-o-

High
Definition
A collection of historical bar high prices.

Property Value
A DataSeries type object. Accessing this property via an index value [int barsAgo] returns a
double value representing the price of the referenced bar.

Syntax
High
High[int barsAgo]

Property Of
Custom Indicator, Custom Strategy
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Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Make sure we have at least 20 bars

    if (CurrentBar < 20) 

        return;

    // Checks for higher highs

    if (High[0] > High[1] && High[1] > High[2])

        Print("Two successive higher highs");

    // Gets the current value of a 20 period SMA of high prices

    double value = SMA(High, 20)[0];

    Print("The value is " + value.ToString());

}

-o-

Highs
Definition
Holds an array of DataSeries objects holding historical bar high prices. A DataSeries object is
added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the high prices of all Bars objects in a multi-instrument or multi-time frame
strategy. 

Property Value
An array of DataSeries objects.

Syntax
Highs[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's high price to the 5-minute bar's high price

    if (Highs[0][0] > Highs[1][0])

        Print("The current bar's high price is greater");

}

-o-

Historical
Definition
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Indicates if the NinjaScript object is running on historical data. With a strategy, when running
a backtest, this property will always return true. When running a live strategy, this property
will be true until the strategy starts processing real-time data. The property can be of value
for many different applications.

1. Filtering out historical data for real-time strategies that does not require any historical data
to initialize.

Property Value
This property returns true if the strategy is running on historical data; otherwise, false.

Syntax
Historical

Property Of
Custom Indicator, Custom Strategy

Examples

protected override void OnBarUpdate()

{

    // Only run on real-time data

    if (Historical)

       return;

}

-o-

IDataSeries
Definition
IDataSeries is an interface that is implemented by all NinjaScript classes that manage
historical data such as DataSeries, Indicators and other classes. The relevance of this boils
down to one practical use which is providing you with the means to write a method that has
flexibility in the types of price data arrays it can accept. By specifying a parameter of  type
IDataSeries, you can then pass in an array of closing prices, an indicator or a user defined
data series.

The sample code below demonstrates a method named DoubleTheValue that accepts any
object that implements the IDataSeries interface as a parameter. This method is then used
twice, the first time passing in an array of closing prices and the second time passing in a 20
period simple moving average.

private double DoubleTheValue(IDataSeries priceData)

{

    return priceData[0] * 2;      

}

protected override void OnBarUpdate()

{

    Print(DoubleTheValue(Close));

    Print(DoubleTheValue(SMA(20)));

}

-o-
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Initialize()
Definition
The Initialize() method is called once when starting a strategy. This method can be used to
configure indicator and strategy properties.

For example:

 Strategies - Call the Add() method to add indicators to charts and to add additional Bars
objects to the strategy

 Indicators - Set configuration properties such as Overlay and PaintPriceMarkers
 Although this method is called once on the start of an indicator or strategy, there are times

that this method is also called (Opening an indicator dialog) when you may not expect it
to. FOR ADVANCED PROGRAMMERS, DO NOT USE THIS METHOD TO RUN CUSTOM
ROUTINES SUCH AS OPENING FORMS, MAKING EXTERNAL CALLS SUCH AS A
LICENSE CHECK.

Method Return Value
This method does not return a value.

Syntax
See example below. The NinjaScript indicator and strategy wizards automatically generate the
method syntax for you.

Method Of
Custom Indicator, Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

-o-

Input
Definition
The main data input.

Property Value
A data series type object that implements the IDataSeries interface. Accessing this property
via an index value [int barsAgo] returns a double value representing the price of the
referenced bar.

Syntax
Input
Input[int barsAgo]

Property Of
Custom Indicator, Custom Strategy
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Examples

// Prints the the current value of input

Print(Input[0].ToString());

Tips
1. Input represents the input data source of the indicator. If you implement an indicator
where PriceTypeSupported is set to true, then when referencing the input data source value,
you will want to reference Input[0] instead of Close[0]. This is because Input[0] will
return the data value of the seleced PriceType.

-o-

Instrument Class
Definition
An tradeable instrument.

Methods and Properties
Expiry See reference
FullName See reference
MasterInstrument.InstrumentTy
pe

See reference

MasterInstrument.Name See reference
MasterInstrument.PointValue See reference
MasterInstrument.Round2TickSi
ze

See reference

-o-

Instrument.Expiry
Definition
Returns the expiration date of a futures contract.

Property Value
A DateTime structure representing the expiration date of a futures contract.

Syntax
Instrument.Expiry

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be an Instrument
object. Should you wish to access this property elsewhere, check for null reference first. e.g. if
(Instrument != null)

-o-

Instrument.FullName
Definition
Returns the full NinjaTrader name of an instrument. For futures, this would include the

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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expiration date. The June S&P 500 Emini contract full name is "ES 06-07".

Property Value
A string representing the full name of the instrument.

Syntax
Instrument.FullName

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be an Instrument
object. Should you wish to access this property elsewhere, check for null reference first. e.g. if
(Instrument != null)

-o-

Instrument.MasterInstrument.Compare()
Definition
Compares two price values with respect to the Instrument TickSize. to ensure accuracy when
dealing with floating point math.

Method Return Value
An int value.

A value of "1" is returned if price1 is greater than price2
A value of "-1" is returned if price1 is less than price2
A value of "0" if price1 is equal to price2

Syntax
Instrument.MasterInstrument.Compare(double price1, double price2)

Method Of
Custom Indicator, Custom Strategy

Parameters
price1 A double value representing a price
price2 A double value representing a price

Examples

double newPrice = Close[0] + High[0] + Open[0];

if (Instrument.MasterInstrument.Compare(newPrice, Close[1]) == 1)

    // Do something since price1 is greater than price2

-o-

Instrument.MasterInstrument.InstrumentType
Definition
Returns the type of instrument.

Property Value
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An InstrumentType representing the type of an instrument.

Possible values are:
InstrumentType.Currency
InstrumentType.Future
InstrumentType.Index
InstrumentType.Option
InstrumentType.Stock

Syntax
Instrument.MasterInstrument.InstrumentType

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be an Instrument
object. Should you wish to access this property elsewhere, check for null reference first. e.g. if
(Instrument != null)

-o-

Instrument.MasterInstrument.Name
Definition
Returns the NinjaTrader database name of an instrument. For example, "MSFT", "ES", "ER2"
etc...

Property Value
A string representing the name of the instrument.

Syntax
Instrument.MasterInstrument.Name

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be an Instrument
object. Should you wish to access this property elsewhere, check for null reference first. e.g. if
(Instrument != null)

-o-

Instrument.MasterInstrument.PointValue
Definition
Returns the currency value of 1 full point of movement. For example, 1 point in the S&P 500
Emini futures contract (ES) is $50 USD which is equal to $12.50 USD per tick.

Property Value
A double value representing the currency value of 1 point of movement.

Syntax
Instrument.MasterInstrument.PointValue

Property Of
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Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be an Instrument
object. Should you wish to access this property elsewhere, check for null reference first. e.g. if
(Instrument != null)

-o-

Instrument.MasterInstrument.Round2TickSize()
Definition
Returns a value that is rounded to the nearest valid value evenly divisible by the instrument's
tick size.

Method Return Value
A double value.

Syntax
Instrument.MasterInstrument.Round2TickSize(double price)

Method Of
Custom Indicator, Custom Strategy

Parameters
price A double value representing a price

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be an Instrument
object. Should you wish to access this property elsewhere, check for null reference first. e.g. if
(Instrument != null)

-o-

IntSeries Class
Definition
An IntSeries is a special type of data structure that holds a series of int values and always
contains the same number of elements as bars in a chart. See the DataSeries Class for
related information.

Creating IntSeries Objects
To create a IntSeries object:

1. Define a variable ("myIntSeries" used in this example) of type IntSeries that will hold a
IntSeries object
2. In the Initialize() method, create a new IntSeries object and assign it to the "myIntSeries"
variable
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#region Variables

    private IntSeries myIntSeries; // Define a IntSeries variable

#endregion

// Create a IntSeries object and assign it to the variable

protected override void Initialize()

{

    myIntSeries = new IntSeries(this);  // "this" refers to the indicator, or

strategy

                                         // itself. This syncs the IntSeries

object

                                         // to historical data bars

}

* IntSeries objects can be used on supplementary series in a multi-time frame and
instrument strategy. Please see our support forum NinjaScript reference samples section for
further information.

Setting Values -  IntSeries.Set() & IntSeries.Reset()
You can set value (plug in a value) into a IntSeries object by calling the Set() method. 

IntSeries.Set(int value)
Setting a value on a IntSeries object is automatically aligned to the current bar being
evaluated. This ensures values across all IntSeries objects are always in sync by the 
CurrentBar index. The following code samples demonstrates calculating the range of each bar
and storing the value in an IntSeries object.

protected override void OnBarUpdate()

{

    int rangeInTicks = (int) ((High[0] - Low[0]) / TickSize);

    myIntSeries.Set(rangeInTicks);

}

IntSeries.Set(int barsAgo, bool value)
You can also set the value for historical bars by including a "barsAgo" value that represents
the number of bars ago that you want the bool value to be stored at.

Calling the Reset() method is unique and can be very powerful for custom indicator
development. IntSeries objects can hold null values which simply means that you do not want
to store a value for the current bar. Reset() will reset the current index value to null.

Checking for Valid Values
It is possible that you may use an IntSeries object but decide not to set a value for a specific
bar. Internally, a dummy value does exist however, if you wanted to check to see if it was a
valid value that you set, you can check the following method.

IntSeries.ContainsValue(int barsAgo)
Returns a true or false value.

Getting Values
You can access IntSeries object values using the syntax IntSeries[int barsAgo] where barsAgo
represents the data value n number of bars ago.
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protected override void OnBarUpdate()

{

    // Prints the current and last bar value

    Print("The values are " + myIntSeries[0] + " " + myIntSeries[1]);

}

-o-

Least Recent Occurence (LRO)
Definition
Returns the number of bars ago that the test condition evaluated to true within the specified
look back period expressed in bars. It checks from the furthest bar away and works toward
the current bar. This method will NOT work on multi-instrument or multi-time frame
strategies.

Method Return Value
An int value representing the number of bars ago. Returns a value of -1 if the specified test
condition did not evaluate to true within the look back period.

Syntax
LRO(Condition condition, int instance, int lookBackPeriod)

The syntax for condition must be written in the following manner:

delegate { return your true/false condition;}

Method Of
Custom Indicator, Custom Strategy

Parameters
condition A true/false expression
instance The occurence to check for (1 is the least recent, 2 is the 2nd least recent

etc...)
lookBackPeriod Number of bars to look back to check for the test condition

Examples

// Prints the high price of the least recent up bar over the last 10 bars

int barsAgo = LRO(delegate {return Close[0] > Open[0];}, 1, 10);

if (barsAgo > -1)

    Print("The bar high was " + High[barsAgo]);

See Also
Most Recent Occurence(MRO)

-o-

Low
Definition
A collection of historical bar low prices.

Property Value
A DataSeries type object. Accessing this property via an index value [int barsAgo] returns a
double value representing the price of the referenced bar.
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Syntax
Low
Low[int barsAgo]

Property Of
Custom Indicator, Custom Strategy

Examples

// Current bar low price

double barLowPrice = Low[0];

// Low price of 10 bars ago

double barLowPrice = Low[10];

// Current bar value of a 20 period exponential moving average of low prices

double value = EMA(Low, 20)[0];

-o-

Lows
Definition
Holds an array of DataSeries objects holding historical bar low prices. A DataSeries object is
added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the low prices of all Bars objects in a multi-instrument or multi-time frame
strategy. 

Property Value
An array of DataSeries objects.

Syntax
Lows[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's low price to the 5-minute bar's low price

    if (Lows[0][0] > Lows[1][0])

        Print("The current bar's low price is greater");

}

-o-

LowestBar()
Definition
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Returns the number of bars ago the lowest price value occured for the lookback period. If
there are several occurences within the lookback period where the bar was the lowest bar the
more recent occurence is returned.

Method Return Value
An int value that represents number of bars ago.

Syntax
LowestBar(IDataSeries series, int lookBackPeriod)

Method Of
Custom Indicator, Custom Strategy

Parameters
series Any DataSeries type object such as an indicator, Close, High, Low etc..
lookBackPeriod The number of bars to include in the calculation

Examples

// Prints out the number of bars ago for the lowest SMA(20) value of the

current session

Print(Lowest(SMA(20), Bars.BarsSinceSession - 1).ToString());

-o-

MarketDataEventArgs
Definition
Represents a change in level one market data and is passed as a parameter in the 
OnMarketData() method.

Methods and Properties
MarketDataType Possible values are:

MarketDataType.Ask
MarketDataType.Bid
MarketDataType.DailyHigh
MarketDataType.DailyLow
MarketDataType.DailyVolume
MarketDataType.Last
MarketDataType.LastClose (prior session close)

Price A double value representing the price
Time A DateTime structure representing the time
ToString() A string representation of the MarketDataEventArgs object
Volume An int value representing volume

Examples

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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protected override void OnMarketData(MarketDataEventArgs e)

{

    // Print some data to the Output window

    if (e.MarketDataType == MarketDataType.Last)

        Print("Last = " + e.Price + " " + e.Volume);

    else if (e.MarketDataType == MarketDataType.Ask)

        Print("Ask = " + e.Price + " " + e.Volume);

    else if (e.MarketDataType == MarketDataType.Bid)

        Print("Bid = " + e.Price + " " + e.Volume);

}

Tips
1. Not all connectivity providers support all MarketDataTypes.

-o-

MarketDepthEventArgs
Definition
Represents a change in level two market data also known as market depth and is passed as a
parameter in the OnMarketDepth() method.

Methods and Properties
MarketDataType Possible values are:

MarketDataType.Ask
MarketDataType.Bid

MarketMaker A string representing the market maker id
Position An int value representing the zero based position in the depth ladder.
Operation Represents the action you should take when building a level two book.

Possible values are:

Operation.Insert
Operation.Remove
Operation.Update

Price A double value representing the price
Time A DateTime structure representing the time
ToString() A string representation of the MarketDataEventArgs object
Volume An int value representing volume

Examples

protected override void OnMarketDepth(MarketDepthEventArgs e)

{

    // Print some data to the Output window

    if (e.MarketDataType == MarketDataType.Ask && e.Operation ==

Operation.Update)

        Print("The most recent ask change is " + e.Price + " " + e.Volume);

}

-o-

Most Recent Occurence (MRO)
Definition
Returns the number of bars ago that the test condition evaluated to true within the specified

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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look back period expressed in bars. It checks from the current bar works away (back) from it. 
This method will NOT work on multi-instrument or multi-time frame strategies.

Method Return Value
An int value representing the number of bars ago. Returns a value of -1 if the specified test
condition did not evaluate to true within the look back period.

Syntax
MRO(Condition condition, int instance, int lookBackPeriod)

The syntax for condition must be written in the following manner:

delegate { return your true/false condition;}

Method Of
Custom Indicator, Custom Strategy

Parameters
condition A true/false expression
instance The occurence to check for (1 is the most recent, 2 is the 2nd most

recent etc...)
lookBackPeriod Number of bars to look back to check for the test condition

Examples

// Prints the high price of the most recent up bar over the last 10 bars

int barsAgo = MRO(delegate {return Close[0] > Open[0];}, 1, 10);

if (barsAgo > -1)

    Print("The bar high was " + High[barsAgo]);

See Also
Least Recent Occurence(LRO)

-o-

Median
Definition
A collection of historical bar median prices. Median price = (High + Low) / 2.

Property Value
A DataSeries type object. Accessing this property via an index value [int barsAgo] returns a
double value representing the price of the referenced bar.

Syntax
Median
Median[int barsAgo]

Property Of
Custom Indicator, Custom Strategy

Examples
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// Current bar median price

double barMedianPrice = Median[0];

// Median price of 10 bars ago

double barMedianPrice = Median[10];

// Current bar value of a 20 period exponential moving average of median

prices

double value = EMA(Median, 20)[0];

-o-

Medians
Definition
Holds an array of DataSeries objects holding historical bar median prices. A DataSeries object
is added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the median prices of all Bars objects in a multi-instrument or multi-time
frame strategy. 

Property Value
An array of DataSeries objects.

Syntax
Medians[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's median price to the 5-minute bar's median

price

    if (Medians[0][0] > Medians[1][0])

        Print("The current bar's median price is greater");

}

-o-

PercentComplete
Definition
Gets a value indicating the completion percent of a bar.

 Will always return a value of zero (0) when working with range bars
 Will always return a value of one (1) which represents 100% during a strategy backtest or

running a strategy with CalculateOnBarClose set to a value of true
 Otherwise, will never return a value of 1 since a complete bar is not known until we receive
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the 1st tick of the next bar thus, you can also use the FirstTickOfBar property

Property Value
A double value representing a percent. e.g. 50% complete would return 0.5.

Syntax
Bars.PercentComplete

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be a Bar object which
holds the PercentComplete property. Should you wish to access this property elsewhere,
check for null reference first. e.g. if (Bars != null)

-o-

OnBarUpdate()
Definition
The OnBarUpdate() method is called whenever a bar is updated. If the "CalculateOnBarClose"
property is set to true, it is only called on the close of each bar, otherwise it is called on each
incoming tick. This is the method where all of your strategy or indicator core calculation logic
should be contained.

 For mult-timeframe and instrument strategies, this method is called for each Bars object of
a strategy and you MUST filter for the exact bar update events using the "BarsInProgress"
property you want your system logic to execute against.

Method Return Value
This method does not return a value.

Syntax
See example below. The NinjaScript indicator and strategy wizards automatically generate the
method syntax for you.

Method Of
Custom Indicator, Custom Strategy

Examples

protected override void OnBarUpdate()

{

    if (CurrentBar < 1)

        return;

    // Compares the current bar to the prior bar

    if (Low[0] > Low[1])

        Print("The current bar's low price is greater");

}

-o-
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OnMarketData()
Definition
The OnMarketData() method is called for every change in level one market data for the
underlying instrument. This can include but is not limited to the bid, ask, last price and
volume.

 Programming to this method is considered advanced programming and exposed for
experienced programmers

 This is a real-time data stream and can be CPU intensive if your program code is compute
intensive (not optimal)

 This method is not called on historical data (backtest)

Method Return Value
This method does not return a value.

Method Parameters
MarketDataEventArgs e

Syntax
You must override the method in your strategy or indicator with the following syntax.

protected override void OnMarketData(MarketDataEventArgs e)
{

}

Method Of
Custom Indicator, Custom Strategy

Examples

protected override void OnMarketData(MarketDataEventArgs e)

{

    // Print some data to the Output window

    if (e.MarketDataType == MarketDataType.Last)

        Print("Last = " + e.Price + " " + e.Volume);

    else if (e.MarketDataType == MarketDataType.Ask)

        Print("Ask = " + e.Price + " " + e.Volume);

    else if (e.MarketDataType == MarketDataType.Bid)

        Print("Bid = " + e.Price + " " + e.Volume);

}

Additional Reference Samples
Additional reference code samples are available the NinjaScript Educational Resources section
of our support forum.

Tips
1. With multi-time frame and instrument strategies, OnMarketData will be called for all
unique instruments in your strategy. Use the BarsInProgress to filter the OnMarketData()
method for a specific instrument.
2. Do not leave an unused OnMarketData() method declared in your NinjaScript object. This
will unnecessarily attached a data stream to your strategy which uses unnecessary CPU
cycles.

-o-

OnMarketDepth()

http://www.ninjatrader-support.com/vb/index.php
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Definition
The OnMarketDepth() method is called for every change in level two market data (market
depth) for the underlying instrument. This method can be used to build your own level two
book.

 Programming to this method is considered advanced programming and exposed for
experienced programmers

 This is a real-time data stream and can be CPU intensive if your program code is compute
intensive (not optimal)

 This method is not called on historical data (backtest)

Method Return Value
This method does not return a value.

Method Parameters
MarketDepthEventArgs e

Syntax
You must override the method in your strategy or indicator with the following syntax.

protected override void OnMarketDepth(MarketDepthEventArgs e)
{

}

Method Of
Custom Indicator, Custom Strategy

Examples

protected override void OnMarketDepth(MarketDepthEventArgs e)

{

    // Print some data to the Output window

    if (e.MarketDataType == MarketDataType.Ask && e.Operation ==

Operation.Update)

        Print("The most recent ask change is " + e.Price + " " + e.Volume);

}

Additional Reference Samples
Additional reference code samples are available the NinjaScript Educational Resources section
of our support forum.

Tips
1. With multi-time frame and instrument strategies, OnMarketDepth will be called for all
unique instruments in your strategy. Use the BarsInProgress to filter the OnMarketDepth()
method for a specific instrument.
2. Do not leave an unused OnMarketDepth() method declared in your NinjaScript object. This
will unnecessarily attached a data stream to your strategy which uses unnecessary CPU
cycles.

-o-

Open
Definition
A collection of historical bar opening prices.

Property Value
A DataSeries type object. Accessing this property via an index value [int barsAgo] returns a

http://www.ninjatrader-support.com/vb/index.php
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double value representing the price of the referenced bar.

Syntax
Open
Open[int barsAgo]

Property Of
Custom Indicator, Custom Strategy

Examples

// Current bar opening price

double barOpenPrice = Open[0];

// Opening price of 10 bars ago

double barOpenPrice = Open[10];

// Current bar value of a 20 period simple moving average of opening prices

double value = SMA(Open, 20)[0];

-o-

Opens
Definition
Holds an array of DataSeries objects holding historical bar open prices. A DataSeries object is
added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the open prices of all Bars objects in a multi-instrument or multi-time frame
strategy. 

Property Value
An array of DataSeries objects.

Syntax
Opens[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's open price to the 5-minute bar's open price

    if (Open[0][0] > Opens[1][0])

        Print("The current bar's open price is greater");

}

-o-
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Period
Definition
The Bars object period type and interval.

Property Value
A Period object.

Syntax
Bars.Period.Id
Bars.Period.Value

* Id can be of value PeriodType.Tick, PeriodType.Volume, PeriodType.Second,
PeriodType.Range, PeriodType.Minute, PeriodType.Day, PeriodType.Week, PeriodType.Month,
PeriodType.Year
* Value will return an integer value

NOTE: We suggest using BarsPeriod property for a Strategy.

Property Of
Custom Indicator, Custom Strategy

Examples

// Calculate only if there is a 100 tick chart or greater

protected override void OnBarUpdate()

{

    if (Bars.Period.Id == PeriodType.Tick && Bars.Period.Value >= 100)

    {

        // Indicator calculation logic here

    }

}

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be a Bar object which
holds the Period property. Should you wish to access this property elsewhere, check for null
reference first. e.g. if (Bars != null)

-o-

Rising()
Definition
Checks for a rising condition which is true when the current value is greater than the value of
1 bar ago.

Method Return Value
This method returns true if a rising condition is present; otherwise, false.

Syntax
Rising(IDataSeries series)

Method Of
Custom Indicator, Custom Strategy

Parameters
series Any DataSeries type object such as an indicator, Close, High, Low etc..
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Examples

// If the 20 period SMA is rising (in uptrend) go long

if (Rising(SMA(20))

    EnterLong();

-o-

SessionBreak
Definition
Gets a value indicating if the call to OnBarUpdate() method is the first call in a new session.

Property Value
This property returns true if the call to OnBarUpdate() is the first call of the session;
otherwise, false.

Syntax
Bars.SessionBreak

Property Of
Custom Indicator, Custom Strategy

Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    if (Bars.SessionBreak) 

        // Reset or store some values here

}

-o-

Slope()
Definition
The slope is a measure of the steepness of a line. This is the calculation of rise over run and
not to be confused with linear regression slope.

Method Return Value
This method returns a double value indicating the slope of a line

Syntax
Slope(IDataSeries series, int startBarsAgo, int endBarsAgo)

Method Of
Custom Indicator, Custom Strategy

Parameters
series Any DataSeries type object such as an indicator, Close, High, Low etc..
startBarsAgo Specifies the starting point of a line
endBar Specifies the ending point of aline

Examples

// Prints the slope of the 20 period simple moving average of the last 10 bars

Print(Slope(SMA(20), 9, 0));    
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-o-

StringSeries Class
Definition
A StringSeries is a special type of data structure that holds a series of string values and
always contains the same number of elements as bars in a chart. See the DataSeries Class for
related information.

Creating StringSeries Objects
To create a StringSeries object:

1. Define a variable ("myStringSeries" used in this example) of type StringSeries that will
hold a StringSeries object
2. In the Initialize() method, create a new StringSeries object and assign it to the
"myStringSeries" variable

#region Variables

    private StringSeries myStringSeries; // Define a StringSeries variable

#endregion

// Create a StringSeries object and assign it to the variable

protected override void Initialize()

{

    myStringSeries = new StringSeries(this); // "this" refers to the

indicator, or strategy

                                         // itself. This syncs the

StringSeries object

                                         // to historical data bars

}

* StringSeries objects can be used on supplementary series in a multi-time frame and
instrument strategy. Please see our support forum NinjaScript reference samples section for
further information.

Setting Values -  StringSeries.Set() & StringSeries.Reset()
You can set value (plug in a value) into a StringSeries object by calling the Set() method. 

StringSeries.Set(string value)
Setting a value on a StringSeries object is automatically aligned to the current bar being
evaluated. This ensures values across all StringSeries objects are always in sync by the 
CurrentBar index. The following code samples demonstrates calculating the range of each bar
and storing the value in a StringSeries object.

protected override void OnBarUpdate()

{

    // Just store some text

    myStringSeries.Set(CurrentBar.ToString());

}

StringSeries.Set(int barsAgo, string value)
You can also set the value for historical bars by including a "barsAgo" value that represents
the number of bars ago that you want the string value to be stored at.

Calling the Reset() method is unique and can be very powerful for custom indicator
development. StringSeries objects can hold null values which simply means that you do not
want to store a value for the current bar. Reset() will reset the current index value to null.



p393

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Checking for Valid Values
It is possible that you may use a StringSeries object but decide not to set a value for a
specific bar. Internally, a dummy value does exist however, if you wanted to check to see if it
was a valid value that you set, you can check the following method.

StringSeries.ContainsValue(int barsAgo)
Returns a true or false value.

Getting Values
You can access StringSeries object values using the syntax StringSeries[int barsAgo] where
barsAgo represents the data value n number of bars ago.

protected override void OnBarUpdate()

{

    // Prints the current and last bar value

    Print("The values are " + myStringSeries[0] + " " + myStringSeries[1]);

}

-o-

TickCount
Definition
The total number of ticks of the current bar.

Property Value
A int value that represents the total number of ticks of the current bar.

Syntax
Bars.TickCount

Property Of
Custom Indicator, Custom Strategy

Examples

// Prints the tick count to the output window

Print("The tick count of the current bar is " + Bars.TickCount.ToString());

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be a Bar object which
holds the TickCount property. Should you wish to access this property elsewhere, check for
null reference first. e.g. if (Bars != null)

-o-

TickSize
Definition
The minimum fluctuation value; the value of 1 tick for the corresponding instrument.

NOTE: This property should NOT be accessed within the Initialize() method.

Property Value
A double value that represents the minimum fluctuation of an instrument.

Syntax
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TickSize

Property Of
Custom Indicator, Custom Strategy

Examples

// Prints the ticksize to the output window

Print("The ticksize of this instrument is " + TickSize.ToString());

// Prints the value of the current bar low less one tick size

double value = Low[0] - TickSize;

Print(value.ToString());

-o-

Time
Definition
A collection of historical bar time stamp values.

Property Value
A TimeSeries type object.

Syntax
Time
Time[int barsAgo] (returns a DateTime structure)

Property Of
Custom Indicator, Custom Strategy

Examples

// Prints the current bar time stamp

Print(Time[0].ToString());

// Checks if current time is greater than the bar time stamp

if (DateTime.Now.Ticks > Time[0].Ticks)

    Print("Do something");

-o-

Times
Definition
Holds an array of TimeSeries objects holding historical bar times. A TimeSeries object is
added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the times of all Bars objects in a multi-instrument or multi-time frame
strategy. 

Property Value
An array of TimeSeries objects.

Syntax
Times[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's time to the 5-minute bar's time

    if (Times[0][0].Ticks > Times[1][0].Ticks)

        Print("The current bar's time is greater");

}

-o-

ToDay()
Definition
Calculates an integer value representing day. NinjaScript uses the .NET DateTime structures
which can be complicated for novice programmers. If you are familiar with C# you can
directly use DateTime structure properties and methods for date and time comparisons
otherwise use this method and the ToTime() method.

Integer representation of day is in the following format yyyyMMdd where January 8, 2007
would be 20070108.

Method Return Value
An int value that represents the date.

Syntax
ToDay(DateTime time)

Method Of
Custom Indicator, Custom Strategy

Parameters
time A DateTime structure such as Time[0] - See Time property

Examples

// Compare the date of the current bar to September 15, 2006

if (ToDay(Time[0]) > 20060915)

    // Do something

-o-

TotalTicks
Definition
Gets a value for the cummulative total of all ticks for all sessions.

Property Value
An int value representing total number of ticks.

http://msdn2.microsoft.com/en-us/library/system.datetime.aspx
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Syntax
Bars.TotalTicks

Property Of
Custom Indicator, Custom Strategy

Additional Access Information
This property can be accessed without a null reference check in the OnBarUpdate() event
handler. When the OnBarUpdate() event is triggered, there will always be a Bar object which
holds the TotalTicks property. Should you wish to access this property elsewhere, check for
null reference first. e.g. if (Bars != null)

-o-

TriggerCustomEvent()
Definition
This method provides a way to use your own custom events (such as a Timer object) so that
internal NinjaScript indexes and pointers are correctly set prior to processing user code
triggered by your custom event. When calling this event, NinjaTrader will synchronize all
internal pointers and then call your custom event handler where your user code is located.

Method Return Value
This method does not have a return value.

Syntax
TriggerCustomEvent(CustomEvent customEvent, object state)
TriggerCustomEvent(CustomEvent customEvent, int barsIndex, object state)

Method Of
Custom Indicator, Custom Strategy

Parameters
CustomEvent Delegate of your custom event method
barsIndex Index of the bar series you want to synchronize to
state Any object you want passed into your custom event method

Examples

// Your timer object tick event handler

private void OnTimerTick()

{

    // Do not process your code here but instead call the TriggerCustomEvent()

    // method and process your code in the MyCustomHandler method

    TriggerCustomEvent(new CustomEvent(MyCustomHandler, 0, "myText"));

}

private void MyCustomHandler(object state)

{

    Print((string) state + " " + CurrentBar.ToString());

}

-o-

ToTime()
Definition
Calculates an integer value representing time.  NinjaScript uses the .NET DateTime structure



p397

© NinjaTrader, LLC, 2005

www.ninjatrader.com

which can be complicated for novice programmers. If you are familiar with C# you can
directly use DateTime structure properties and methods for date and time comparisons
otherwise use this method and the ToDay() method.

Integer representation of time is in the following format Hmmss where 7:30 AM would be
73000 and 2:15:12 PM would be 141512.

Method Return Value
An int value that represents the time.

Syntax
ToTime(DateTime time)

Method Of
Custom Indicator, Custom Strategy

Parameters
time A DateTime structure such as Time[0] - See Time property

Examples

// Only trade between 7:45 AM and 1:45 PM

if (ToTime(Time[0]) >= 74500 && ToTime(Time[0]) <= 134500)

{

    // Strategy logic goes here

}

-o-

Typical
Definition
A collection of historical bar typical prices. Typical price = (High + Low + Close) / 3.

Property Value
A DataSeries type object. Accessing this property via an index value [int barsAgo] returns a
double value representing the price of the referenced bar.

Syntax
Typical
Typical[int barsAgo]

Property Of
Custom Indicator, Custom Strategy

Examples

// Current bar typical price

double barTypicalPrice = Typical[0];

// Median price of 10 bars ago

double barTypicalPrice = Typical[10];

// Current bar value of a 20 period exponential moving average of typical

prices

double value = EMA(Typical, 20)[0];

-o-
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Typicals
Definition
Holds an array of DataSeries objects holding historical bar typical prices. A DataSeries object
is added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the typical prices of all Bars objects in a multi-instrument or multi-time
frame strategy. 

Property Value
An array of DataSeries objects.

Syntax
Typicals[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's typical price to the 5-minute bar's typical

price

    if (Typicals[0][0] > Typicals[1][0])

        Print("The current bar's typical price is greater");

}

-o-

Volume
Definition
A collection of historical bar volume values.

Property Value
A VolumeSeries type object. Accessing this property via an index value [int barsAgo] returns
an double value representing the volume of the referenced bar.

Syntax
Volume
Volume[int barsAgo]

Property Of
Custom Indicator, Custom Strategy

Examples
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// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Is current volume greater than twice the prior bar's volume

    if (Volume[0] > Volume[1] * 2) 

        Print("We have increased volume");

    

    // Is the current volume greater than the 20 period moving average of

volume

    if (Volume[0] > SMA(Volume, 20)[0]) 

        Print("Increasing volume");

}

-o-

Volumes
Definition
Holds an array of VolumeSeries objects holding historical bar volumes. A DataSeries object is
added to this array when calling the Add() method in a Custom Strategy. Its purpose is to
provide access to the volumes of all Bars objects in a multi-instrument or multi-time frame
strategy. 

Property Value
An array of VolumeSeries objects.

Syntax
Volumes[int barSeriesIndex][int barsAgo]

Property Of
Custom Strategy

Examples

protected override void Initialize()

{

    // Adds a 5-minute Bars object to the strategy and is automatically

assigned

    // a Bars object index of 1 since the primary data the strategy is run

against

    // set by the UI takes the index of 0.

    Add(Instrument, PeriodType.Minute, 5);                                   

  

}

protected override void OnBarUpdate()

{

    // Compares the primary bar's volume to the 5-minute bar's volume

    if (Volumes[0][0] > Volumes[1][0])

        Print("The current bar's volume price is greater");

}

-o-

Shared Draw Methods and Properties

Overview
You can use NinjaScript to draw custom shapes, lines, text and colors on your price and
indicator panels. 
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Tips

1. Custom graphics for custom indicators can be painted on either the price panel or indicator
panel. You could for example have a custom indicator displayed in an indicator panel yet
have associated custom graphics painted on the price panel. The "DrawOnPricePanel"
property is set to true as default which means that custom graphics will always be painted
on the price panel even if the indicator is plotted in a separate panel. If you want your
custom graphics to be plotted on the indicator panel, set this property to false in the
Initialize() method of your custom indicator.

2. Set unique tag values for each draw object. A common trick is to incorporate the bar
number as part of the unique tag identifier. For example, if you wanted to draw a dot that
indicated a buying condition above  a bar, you could express it: 

DrawDot(CurrentBar.ToString() + "Buy", 0, High[0] + TickSize,
Color.ForestGreen).
3. Draw methods will not work if they are called  from the Initialize() method.

-o-

BackColor
Definition
Sets the chart panel back color for the current bar.

Property Value
A color structure that represents the color of  this price bar.

Syntax
BackColor

Property Of
Custom Indicator, Custom Strategy

Examples

// Sets the chart panel back color to pale green

BackColor = Color.PaleGreen;

// Sets the back color to the default color set in the chart properties dialog

window

BackColor = Color.Empty;

// Sets the back color to maroon when the closing price is less than the 20

period SMA // and to lime green when above (see image below)

BackColor = SMA(20)[0] >= Close[0] ? Color.Maroon : Color.LimeGreen;

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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-o-

BarColor
Definition
Sets the color of a price bar.

Property Value
A color structure that represents the color of this price bar.

Syntax
BarColor

Property Of
Custom Indicator, Custom Strategy

Examples

// Sets the bar color to yellow

BarColor = Color.Yellow;

// Sets the bar color to its default color as defined in the chart properties

dialog

BarColor = Color.Empty;

// Sets the bar color to yellow if the 20 SMA is above the 50 SMA and the

closing

// price is above the 20 SMA (see image below)

if (SMA(20)[0] > SMA(50)[0] && Close[0] > SMA(20)[0])

    BarColor = Color.Yellow;

-o-

CandleOutlineColor
Definition
Sets the outline color of a candle stick.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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* If you set the BarColor property and the CandleOutlineColor property is not set, the outline
color will take the color set by the BarColor property.

Property Value
A color structure that represents the color of this price bar.

Syntax
CandleOutlineColor

Property Of
Custom Indicator, Custom Strategy

Examples

// Sets the candle outline color to black

CandleOutlineColor = Color.Black;

-o-

Custom Drawing
There are virtually no limits for custom drawing on a chart panel. Since NinjaScript is based
on Microsoft C#, the entire System.Drawing namespace is available for use. Custom drawing
is an advanced programming topic and should only be considered by programmers familiar
with Microsoft C# and the .NET Framework.

Please see the following indicators for reference samples of custom drawing by overriding the
Plot() method of the Indicator base class:

 CustomPlotSample
 TickCounter
 VolumeZones

-o-

DrawAndrewsPitchfork()
Definition
Draws an Andrew's Pitchfork.

Syntax
DrawAndrewsPitchfork(string tag, bool autoScale, int anchor1BarsAgo, double anchor1Y, int
anchor2BarsAgo, double anchor2Y, int anchor3BarsAgo, double anchor3Y)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
anchor1BarsAgo The number of bars ago (x value) of the 1st anchor point
anchor1Y The y value of the 1st anchor point
anchor2BarsAgo The number of bars ago (x value) of the 2nd anchor point

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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anchor2Y The y value of the 2nd anchor point
anchor3BarsAgo The number of bars ago (x value) of the 3rd anchor point
anchor3Y The y value of the 3rd anchor point

Examples

DrawAndrewsPitchfork("tag1", true, 4, Low[4], 3, High[3], 1, Low[1]);

-o-

DrawArrowDown()
Definition
Draws an arrow pointing down.

Syntax
DrawArrowDown(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

Examples

// Paints a red down arrow on the current bar 1 tick above the high

DrawArrowDown("tag1", true, 0, High[0] + TickSize, Color.Red);

// Paints a blue down arrown on a three bar reversal pattern (see image below)

if (High[2] > High[3] && High[1] > High[2] && Close[0] < Open[0])

    DrawArrowDown(CurrentBar.ToString(), true, 0, High[0] + TickSize,

Color.Blue);

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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-o-

DrawArrowLine()
Definition
Draws an arrow line.

Syntax
DrawArrowLine(string tag, int startBarsAgo, double startY, int endBarsAgo, double endY,
Color color)
DrawArrowLine(string tag, bool autoScale, int startBarsAgo, double startY, int endBarsAgo,
double endY, Color color, DashStyle dashStyle, int width)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be
drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate
color The draw object color (reference)

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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dashStyle DashStyle.Dash
DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

width The width of the draw object

Examples

// Draws a dotted lime green arrow line 

DrawArrowLine("tag1", false, 10, 1000, 0, 1001, Color.LimeGreen,

DashStyle.Dot, 2);

-o-

DrawArrowUp()
Definition
Draws an arrow pointing up.

Syntax
DrawArrowUp(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

Examples

// Paints a red down arrow on the current bar 1 tick below the low

DrawArrowUp("tag1", true, 0, Low[0] - TickSize, Color.Red);

-o-

DrawDiamond()
Definition
Draws a diamond.

Syntax
DrawDiamond(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

Examples

// Paints a red diamond on the current bar 1 tick below the low

DrawDiamond("tag1", true, 0, Low[0] - TickSize, Color.Red);

-o-

DrawDot()
Definition
Draws a dot.

Syntax
DrawDot(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

Examples

// Paints a red dot on the current bar 1 tick below the low

DrawDot("tag1", true, 0, Low[0] - TickSize, Color.Red);

-o-

DrawElipse()
Definition
Draws an ellipse.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Syntax
DrawEllipse(string tag, int startBarsAgo, double startY, int endBarsAgo, double endY, Color
color)
DrawEllipse(string tag, bool autoScale, int startBarsAgo, double startY, int endBarsAgo,
double endY, Color color, Color backColor, int opacity)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be
drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate
color The draw object color (reference)
backColor The fill color for the object (reference)
opacity Sets the level of transparency for the fill color. Valid values between 1 -

10.

Examples

// Draws a blue ellipse from the low 10 bars back to the high of 5 bars back

DrawEllipse("tag1", 10, Low[10] - TickSize, 5, High[5] + TickSize,

Color.Blue);

// Draws a blue ellipse from the low 10 bars back to the high of 5 bars back

with

// a fill color or pale green with a transparency level of 2

DrawEllipse("tag1", false, 10, Low[10] - TickSize, 5, High[5] + TickSize,

Color.PaleGreen, Color.PaleGreen, 2);

-o-

DrawExtendedLine()
Definition
Draws a line with infinite end points.

Syntax
DrawExtendedLine(string tag, int startBarsAgo, double startY, int endBarsAgo, double endY,
Color color)
DrawExtendedLine(string tag, bool autoScale, int startBarsAgo, double startY, int
endBarsAgo, double endY, Color color, DashStyle dashStyle, int width)

Method Of
Custom Indicator, Custom Strategy

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be
drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate
color The draw object color (reference)
dashStyle DashStyle.Dash

DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

width The width of the draw object

Examples

// Draws a dotted lime green 

DrawExtendedLine("tag1", false, 10, 1000, 0, 1001, Color.LimeGreen,

DashStyle.Dot, 2);

-o-

DrawFibonacciCircle()
Definition
Draws fibonacci circle.

Syntax
DrawFibonacciCircle(string tag, bool autoScale, int startBarsAgo, double startY, int
endBarsAgo, double endY)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be

drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
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endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate

Examples

// Draws a fibonnaci circle

DrawFibonacciCircle("tag1", true, 10, Low[10], 0, High[0]);

-o-

DrawFibonacciExtensions()
Definition
Draws fibonacci extensions.

Syntax
DrawFibonacciExtensions(string tag, bool autoScale, int anchor1BarsAgo, double
anchor1Value, int anchor2BarsAgo, double anchor2Value, int anchor3BarsAgo, double
anchor3Value,)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
anchor1BarsAgo The number of bars ago (x value) of the 1st anchor point
anchor1Y The y value of the 1st anchor point
anchor2BarsAgo The number of bars ago (x value) of the 2nd anchor point
anchor2Y The y value of the 2nd anchor point
anchor3BarsAgo The number of bars ago (x value) of the 3rd anchor point
anchor3Y The y value of the 3rd anchor point

Examples

DrawFibonacciExtensions("tag1", true, 4, Low[4], 3, High[3], 1, Low[1]);

-o-

DrawFibonacciRetracements()
Definition
Draws fibonacci retracements.

Syntax
DrawFibonacciRetracements(string tag, bool autoScale, int startBarsAgo, double startY, int
endBarsAgo, double endY)

Method Of
Custom Indicator, Custom Strategy
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Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be

drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate

Examples

// Draws a fibonacci retracement object

DrawFibonacciRetracements("tag1", true, 10, Low[10], 0, High[0]);

-o-

DrawFibonacciTimeExtensions()
Definition
Draws fibonacci time extensions.

Syntax
DrawFibonacciTimeExtensions(string tag, int startBarsAgo, double startY, int endBarsAgo,
double endY)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be

drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate

Examples

// Draws a fibonacci time extension object

DrawFibonacciTimeExtensions("tag1", true, 10, Low[10], 0, High[0]);
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-o-

DrawGannFan()
Definition
Draws a Gann Fan.

Syntax
DrawGannFan(string tag, bool autoScale, int barsAgo, double y)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value

Examples

// Draws a Gann Fan at the current bar low.

DrawGannFan("tag1", true, 0, Low[0]);

-o-

DrawHorizontalLine()
Definition
Draws a horizontal line.

Syntax
DrawHorizontalLine(string tag, double y, Color color)
DrawHorizontalLine(string tag, bool autoScale, double y, Color color, DashStyle dashStyle, int
width)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

y The y value
color The draw object color (reference)

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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dashStyle DashStyle.Dash
DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

width The width of the draw object

Examples

// Draws a horizontal line

DrawHorizontalLine("tag1", 1000, Color.Black);

-o-

DrawLine()
Definition
Draws a line between two points.

Syntax
DrawLine(string tag, int startBarsAgo, double startY, int endBarsAgo, double endY, Color color
)
DrawLine(string tag, bool autoScale, int startBarsAgo, double startY, int endBarsAgo, double
endY, Color color, DashStyle dashStyle, int width)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be
drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate
color The draw object color (reference)
dashStyle DashStyle.Dash

DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

width The width of the draw object

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
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Examples

// Draws a dotted lime green line from 10 bars back to the current bar 

// with a width of 2 pixels 

DrawLine("tag1", false, 10, 1000, 0, 1001, Color.LimeGreen, DashStyle.Dot, 2);

-o-

DrawRay()
Definition
Draws a line which has an infinite end point in one direction.

Syntax
DrawRay(string tag, int startBarsAgo, double startY, int endBarsAgo, double endY, Color color
)
DrawRay(string tag, bool autoScale, int startBarsAgo, double startY, int endBarsAgo, double
endY, Color color, DashStyle dashStyle, int width)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be
drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate
color The draw object color (reference)
dashStyle DashStyle.Dash

DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

width The width of the draw object

Examples

// Draws a lime green line from 10 bars back through the current bar 

DrawRay("tag1", 10, 1000, 0, 1001, Color.LimeGreen);

-o-

DrawRectangle()
Definition
Draws a rectangle.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
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Syntax
DrawRectangle(string tag, int startBarsAgo, double startY, int endBarsAgo, double endY, Color
color)
DrawRectangle(string tag, bool autoScale, int startBarsAgo, double startY, int endBarsAgo,
double endY, Color color, Color backColor, int opacity)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

startBarsAgo The starting bar (x axis co-ordinate) where the draw object will be
drawn. For example, a value of 10 would paint the draw object 10 bars
back.

startY The starting y value co-ordinate where the draw object will be drawn
endBarsAgo The end bar (x axis co-ordinate) where the draw object will terminate
endY The end y value co-ordinate where the draw object will terminate
color The draw object color (reference)
backColor The fill color for the object (reference)
opacity Sets the level of transparency for the fill color. Valid values between 1 -

10.

Examples

// Draws a blue rectangle from the low 10 bars back to the high of 5 bars back

DrawRectangle("tag1", 10, Low[10] - TickSize, 5, High[5] + TickSize,

Color.Blue);

// Draws a blue rectangle from the low 10 bars back to the high of 5 bars back

with

// a fill color or pale green with a transparency level of 2

DrawRectangle("tag1", false, 10, Low[10] - TickSize, 5, High[5] + TickSize,

Color.PaleGreen, Color.PaleGreen, 2);

-o-

DrawRegion()
Definition
Draws a region on a chart.

Syntax
DrawRegion(string tag, int startBarsAgo, int endBarsAgo, IDataSeries series, double y, Color
outlineColor, Color backColor, int opacity)
DrawRegion(string tag, int startBarsAgo, int endBarsAgo, IDataSeries series1, IDataSeries
series2, Color outlineColor, Color backColor, int opacity)

Method Of
Custom Indicator, Custom Strategy

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

startBarsAgo The bar (x axis co-ordinate) where the starting point of the region will be
drawn from. For example, a value of 10 would paint the start of the
region 10 bars back.

endBarsAgo The bar (x axis co-ordinate) where the ending point of the region will be
drawn to. For example, a value of 0 would paint the end on the current
bar (last bar) of the chart.

series, series1,
series2

Any DataSeries type object such as an indicator, Close, High, Low etc..
The value of the object will represent a y value.

y Any double value
outlineColor Region outline color (reference)
backColor Region back color (reference)
opacity Sets the level of transparency for the backColor. Valid values between 1 -

10.

Examples

// Fills in the region between the upper and lower bollinger bands

DrawRegion("tag1", CurrentBar, 0, Bollinger(2, 14).Upper, Bollinger(2,

14).Lower, Color.Empty, Color.Lime, 2);

Tips
1. Pass in Color.Empty to the "outlineColor" parameter if you do not want to have an outline
color.
2. If you wanted to fill a region between a value (20 period simple moving average) and the
upper edge of the chart, pass in an extreme value to the "y" parameter such as 1000000.

-o-

DrawRegressionChannel()
Definition
Draws a regression channel.

Syntax
DrawRegressionChannel(string tag, int startBarsAgo, int endBarsAgo, Color color)
DrawRegressionChannel(string tag, bool autoScale, int startBarsAgo, int endBarsAgo, Color
upperColor, DashStyle upperDashStyle, int upperWidth, Color middleColor, DashStyle
middleDashStyle, int middleWidth, Color lowerColor, DashStyle lowerDashStyle, int
lowerWidth)

Method Of
Custom Indicator, Custom Strategy

Parameters

http://msdn2.microsoft.com/en-us/library/system.drawing.color_members(vs.71).aspx
http://msdn2.microsoft.com/en-us/library/system.drawing.color_members(vs.71).aspx
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tag A user defined unique id used to reference the draw object. For example,
if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is true.

startBarsAgo The starting bar (x axis co-ordinate) where the regression channel will
start

endBarsAgo The end bar (x axis co-ordinate) used as the 2nd anchor point of the
regression channel

color The draw object color (reference)
upperDashStyle,
middleDashStyle,
lowerDashStyle

DashStyle.Dash
DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

upperColor,
middleColor,
lowerColor

The line colors (reference)

upperWidth,
middleWidth,
lowerWidth

The line width

Examples

// Draws a green regression channel starting 10 bars back

DrawRegressionChannel("myTag" + CurrentBar, 10, 0, Color.Green);

-o-

DrawSquare()
Definition
Draws a square.

Syntax
DrawSquare(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Examples

// Paints a red square on the current bar 1 tick below the low

DrawSquare("tag1", true, 0, Low[0] - TickSize, Color.Red);

-o-

DrawText()
Definition
Draws text.

Syntax
DrawText(string tag, string text, int barsAgo, double y, Color color)
DrawText(string tag, bool autoScale, string text, int barsAgo, double y, int yPixelOffset, Color
textColor, Font font, StringAlignment alignment, Color outlineColor, Color backColor, int
opacity)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale. Default
value is false.

text The text you wish to draw
barsAgo The bar (x axis co-ordinate) where the draw object will be drawn. For

example, a value of 10 would paint the draw object 10 bars back.
y The y co-ordinate location the object will be drawn
yPixelOffset The offset value in pixels from the specified y price value
textColor The draw object text color (reference)
font The type of font used (reference)

alignment StringAlignment.Center
StringAlignment.Far
StringAlignment.Near
(reference)

outlineColor Text box outline color (reference)
backColor Text box back color (reference)
opacity Sets the level of transparency for the fill color. Valid values between 1 -

10.

Examples

// Draws text

DrawText("tag1", "Text to draw", 10, 1000, Color.Black);

-o-

DrawTextFixed()

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingfontclasstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingstringalignmentclasstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Definition
Draws text in one of 5 available pre-defined fixed locations on panel 1 (price panel) of a
chart.

Syntax
DrawTextFixed(string tag, string text, TextPosition textPosition)
DrawTextFixed(string tag, string text, TextPosition textPosition, Color textColor, Font font,
Color outlineColor, Color backColor, int opacity)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

text The text you wish to draw
TextPosition TextPosition.BottomLeft

TextPosition.BottomRight
TextPosition.Center
TextPosition.TopLeft
TextPosition.TopRight

textColor The draw object text color (reference)
font The type of font used (reference)

outlineColor Text box outline color (reference)
backColor Text box back color (reference)
opacity Sets the level of transparency for the fill color. Valid values between 1 -

10.

Examples

// Draws text in the upper right corner of panel 1

DrawTextFixed("tag1", "Text to draw", TextPosition.TopRight);

-o-

DrawTriangleDown()
Definition
Draws a triangle point down.

Syntax
DrawTriangleDown(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of
Custom Indicator, Custom Strategy

Parameters

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingfontclasstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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tag A user defined unique id used to reference the draw object. For example,
if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

Examples

// Paints a red triangle pointing down on the current bar 1 tick below the low

DrawTriangleDown("tag1", true, 0, Low[0] - TickSize, Color.Red);

-o-

DrawTriangleUp()
Definition
Draws a triangle point up.

Syntax
DrawTriangleUp(string tag, bool autoScale, int barsAgo, double y, Color color)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

autoScale Determines if the draw object will be included in the y-axis scale
barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
y The y value
color The draw object color (reference)

Examples

// Paints a red triangle pointing up on the current bar 1 tick below the low

DrawTriangleUp("tag1", true, 0, Low[0] - TickSize, Color.Red);

-o-

DrawVerticalLine()
Definition
Draws a vertical line.

Syntax
DrawVerticalLine(string tag, int barsAgo, Color color)
DrawVerticalLine(string tag, int barsAgo, Color color, DashStyle dashStyle, int width)

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
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Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id used to reference the draw object. For example,

if you pass in a value of "myTag", each time this tag is used, the same
draw object is modified. If unique tags are used each time, a new draw
object will be created each time.

barsAgo The bar the object will be drawn at. A value of 10 would be 10 bars ago.
color The draw object color (reference)
dashStyle DashStyle.Dash

DashStyle.DashDot
DashStyle.DashDotDot
DashStyle.Dot
DashStyle.Solid
(reference)

width The width of the draw object

Examples

// Draws a horizontal line

DrawVerticalLine("tag1", 10, Color.Black);

-o-

RemoveDrawObject()
Definition
Removes a draw object from the chart based on its tag value.

Syntax
RemoveDrawObject(string tag)

Method Of
Custom Indicator, Custom Strategy

Parameters
tag A user defined unique id value that was passed into any of the draw

methods. This will identify which object needs to be removed from the
chart.

Examples

// Removes a draw object with the tag "tag1"

RemoveDrawObject("tag1");

-o-

RemoveDrawObjects()
Definition
Removes all draw object from the chart.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingcolormemberstopic.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/frlrfsystemdrawingdrawing2ddashstyleclasstopic.asp
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Syntax
RemoveDrawObjects()

Method Of
Custom Indicator, Custom Strategy

Examples

// Removes all draw objects

RemoveDrawObjects();

-o-

Shared Indicator Methods

Overview
The indicator reference provides definitions, syntax, parameter definitions and examples for
NinjaTrader internal indicator methods.

-o-

Valid Input Data for Indicator Methods
Indicator method can accept the following valid forms of input data.

Default Input
Default input of the custom indicator, Market Analyzer column or strategy is used as default
input if input is not specified.

// Printing the current value of the 10 period SMA of closing prices

// using the default input.

double value = SMA(10)[0];

Print("The current SMA value is " + value.ToString());

Price Series
Open, High, Low, Close and Volume can all be used as input for an indicator method.

// Passing in the a price series of High prices and printing out the current

value of the

// 14 period simple moving average

double value = SMA(High, 14)[0];

Print("The current SMA value is " + value.ToString());

Indicator
Indicators can be used as input for indicators.

// Printing the current value of the 20 period simple moving average of a 14

period RSI

// using a data series of closing prices

double value = SMA(RSI(Close, 14), 20)[0];

Print("The current SMA value is " + value.ToString());

DataSeries
DataSeries can be used  as input for indicators.
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// Instantiating a new DataSeries object and passing it in as input to

calculate

// a simple moving average

DataSeries myDataSeries = new DataSeries(this);

double value = SMA(myDataSeries, 20)[0];

Bars Object
A Bars object (holds a series of bar object that contain OHLC data) can be used  as input for
indicators.

// Passing in the second Bars object held in a multi-instrument and timeframe

strategy

// The default value used for the SMA calculation is the close price

double value = SMA(BarsArray[1], 20)[0];

Print("The current SMA value is " + value.ToString());

-o-

Aroon
Definition
Courtesy of www.stockcharts.com

Syntax
Aroon(int period)
Aroon(IDataSeries inputData, int period)

Returns up value
Aroon(int period).Up[int barsAgo]
Aroon(IDataSeries inputData, int period).Up[int barsAgo]

Returns down value
Aroon(int period).Down[int barsAgo]
Aroon(IDataSeries inputData, int period).Down[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current up/down values of a 20 period Aroon using default price

type

double upValue = Aroon(20).Up[0];

double downValue = Aroon(20).Down[0];

Print("The current Aroon up value is " + upValue.ToString());

Print("The current Aroon down value is " + downValue.ToString());

http://stockcharts.com/education/IndicatorAnalysis/indic-Aroon.htm
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Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Accumulation/Distribution Line (ADL)
Definition
Courtesy of www.stockcharts.com

Syntax
ADL()
ADL(IDataSeries inputData)

ADL()[int barsAgo]
ADL(IDataSeries inputData)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)

Examples

// Checks if ADL is rising

bool isRising = Rising(ADL());

Print("Is ADL rising? " + isRising);

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Adaptive Price Zone (APZ)
Definition
The Adaptive Price Zone indicator from the S&C, September 2006 article "Trading With An
Adpative Price Zone" by Lee Leibfarth is a set of bands based on a short term double smooth
exponential moving average. The bands form a channel that surrounds the average price and
tracks price fluctuations quickly, especially in volatile markets. As price crosses above the
zone it can signal an opportunity to sell in anticipation of a reversal. As price crosses below
the zone it can signal an opportunity to buy in anticipation of a reversal.

Syntax
APZ(double barPct, int period)
APZ(IDataSeries inputData, double barPct, int period)

Returns upper band value
APZ(double barPct, int period).Upper[int barsAgo]
APZ(IDataSeries inputData, double barPct, int period).Upper[int barsAgo]

http://stockcharts.com/school/doku.php?id=chart_school:technical_indicators:accumulation_distribution_line
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Returns lower band value
APZ(double barPct, int period).Lower[int barsAgo]
APZ(IDataSeries inputData, double barPct, int period).Lower[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
barPct The number of standard deviations
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current upper band value of a 20 period APZ

double upperValue = APZ(2, 20).Upper[0];

Print("The current APZ upper value is " + upperValue.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Aroon Oscillator
Definition
Courtesy of www.stockcharts.com

Syntax
AroonOscillator(int period)
AroonOscillator(IDataSeries inputData, int period)

Returns default value
AroonOscillator(int period)[int barsAgo]
AroonOscillator(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

http://stockcharts.com/education/IndicatorAnalysis/indic-Aroon.htm
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// Prints the current values of a 20 period AroonOscillator using default

price type

double upValue = AroonOscillator(20)[0];

Print("The current AroonOscillator value is " + upValue.ToString());

// Prints the current values of a 20 period AroonOscillator using high price

type

double upValue = AroonOscillator(High, 20)[0];

Print("The current AroonOscillator value is " + upValue.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Average Directional Index (ADX)
Definition
Courtesy of www.stockcharts.com

Syntax
ADX(int period)
ADX(IDataSeries inputData, int period)

Returns default value
ADX(int period)[int barsAgo]
ADX(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period ADX using default price type

double value = ADX(20)[0];

Print("The current ADX value is " + value.ToString());

// Prints the current value of a 20 period ADX using high price type

double value = ADX(High, 20)[0];

Print("The current ADX value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

http://stockcharts.com/education/IndicatorAnalysis/indic_ADX.html
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Average Directional Movement Rating (ADXR)
Definition
The ADXR is equal to the current ADX plus the ADX from n bars ago divided by 2. 

Syntax
ADXR(int interval, int period)
ADXR(IDataSeries inputData, int interval, int period)

Returns default value
ADXR(int interval, int period)[int barsAgo]
ADXR(IDataSeries inputData, int interval, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
interval The interval between the first ADX value and the current ADX value
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period ADXR using default price type

double value = ADXR(10, 20)[0];

Print("The current ADXR value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Average True Range (ATR)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
ATR(int period)
ATR(IDataSeries inputData, int period)

Returns default value
ATR(int period)[int barsAgo]
ATR(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

http://stockcharts.com/education/IndicatorAnalysis/indic_ATR.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=28
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Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period ATR using default price type

double value = ATR(20)[0];

Print("The current ATR value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Balance of Power (BOP)
Definition
The balance of power (BOP) indicator measures the strength of the bulls vs. bears by
assessing the ability of each to push price to an extreme level.

Syntax
BOP(int smooth)
BOP(IDataSeries inputData, int smooth)

Returns default value
BOP(int smooth)[int barsAgo]
BOP(IDataSeries inputData, int smooth)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
smooth The smoothing period
inputData Indicator source data (?)

Examples

// Prints the current value of BOP using default price type and 3 period

smoothing

double value = BOP(3)[0];

Print("The current BOP value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-
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Bollinger Bands
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
Bollinger(double numStdDev, int period)
Bollinger(IDataSeries inputData, double numStdDev, int period)

Returns upper band value
Bollinger(double numStdDev, int period).Upper[int barsAgo]
Bollinger(IDataSeries inputData, double numStdDev, int period).Upper[int barsAgo]

Returns lower band value
Bollinger(double numStdDev, int period).Lower[int barsAgo]
Bollinger(IDataSeries inputData, double numStdDev, int period).Lower[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
numStdDev The number of standard deviations
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current upper band value of a 20 period Bollinger using default

price type

double upperValue = Bollinger(2, 20).Upper[0];

Print("The current Bollinger upper value is " + upperValue.ToString());

// Prints the current upper band value of a 20 period Bollinger using low

price type

double value = Bollinger(Low, 2, 20).Upper[0];

Print("The current Bollinger upper value is " + upperValue.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

BuySell Pressure
Definition
More information...

Syntax
BuySellPressure()
BuySellPressure(IDataSeries inputData)

http://stockcharts.com/education/IndicatorAnalysis/indic_Bbands.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=29
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Returns buy pressure value
BuySellPressure().BuyPressure[int barsAgo]
BuySellPressure(IDataSeries inputData).BuyPressure[int barsAgo]

Returns sell pressure value
BuySellPressure().SellPressure[int barsAgo]
BuySellPressure(IDataSeries inputData).SellPressure[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar. Value range between 0 and 100 representing a percentage.

Parameters
inputData Indicator source data (?)

Important Tips!
1. This indicator only calculates relevant values on real-time active data. This is since it needs
current bid/ask data to determine the buying/selling pressure.
2. This indicator will return constant values of 50 on historical data and therefore its of no
value in a historical back test.
3. This indicator MUST have it's 'CalculateOnBarClose' property set to false otherwise
buying/selling pressure will not be accurately calculated.
4. You should only use this indicator when coding NinjaScript objects manually and not using
the Strategy Wizard.

Examples
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// Initialize method

protected override void Initialize()

{

    // You have to set this specific indicator's CalculateOnBarClose property

    // to false if the strategy, indicator or Quote Board Column's

CalculateOnBarClose

    // property is set to true, otherwise  the indicator will not calculate

it's values

    BuySellPressure().CalculateOnBarClose = false;

}

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Looking for a long breakout signal

    if (Close[0] > DonchianChannel(20).Upper[5])

    {

        // !! See notes below !!

        if (Historical || BuySellPressure().BuyPressure[0] > 70)

            EnterLong();

    }

}

// !! Since this indicator operates in a real-time environment, you must take

special

// care in coding your strategy so that it is only evaluated in in real-time

and not 

// in a backtest on historical data. In the above example, we check for our

breakout

// long signal but we also want to make sure that the breakout bar saw 70% or

more

// of its trades hit the ask or higher. Our statement checks if the data is

being

// calculated on historical data first, if true, we enter long, if not true

(live), the

// the statement then checks for the BuyPressure condition.

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

BuySellVolume
The BuySell Volume indicator can not be accessed programmatically. Alternatively, use the 
BuySell Pressure indicator for programmatic access. 

Learn about this indicator...

-o-

CandeStickPattern
Definition
Detects the specified candle stick pattern.

Syntax

CandleStickPattern(ChartPattern pattern, int trendStrength)
CandleStickPattern(IDataSeries inputData, ChartPattern pattern, int trendStrength)

Returns a value indicating if the specified pattern was detected
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CandleStickPattern(ChartPattern pattern, int trendStrength)[int barsAgo]
CandleStickPattern(IDataSeries inputData, ChartPattern pattern, int trendStrength)[int
barsAgo]

Return Type
double; Accessing these methods via an index value [int barsAgo] returns the indicator value
of the referenced bar. A value of 0 (zero) indicates that a pattern was not found, a value of 1
(one) indicates that a pattern was found.

Parameters
inputData Indicator source data (?)
pattern Possible values are:

ChartPattern.BearishBeltHold
ChartPattern.BearishEngulfing
ChartPattern.BearishHarami
ChartPattern.BearishHaramiCross
ChartPattern.BullishBeltHold
ChartPattern.BullishEngulfing
ChartPattern.BullishHarami
ChartPattern.BullishHaramiCross
ChartPattern.DarkCloudCover
ChartPattern.Doji
ChartPattern.DownsideTasukiGap
ChartPattern.EveningStar
ChartPattern.FallingThreeMethods
ChartPattern.Hammer
ChartPattern.HangingMan
ChartPattern.InvertedHammer
ChartPattern.MorningStart
ChartPattern.PiercingLine
ChartPattern.RisingThreeMethods
ChartPattern.ShootingStar
ChartPattern.StickSandwich
ChartPattern.ThreeBlackCrows
ChartPattern.ThreeWhiteSoldiers
ChartPattern.UpsideGapTwoCrows
ChartPattern.UpsideTasukiGap

trendStrength The number of required bars to the left and right of the swing point used
to determine trend. A value of zero will exclude the requirement of a
trend and only detect based on the candles themselves.

Examples

// Go long if the current bar is a bullish engulfing pattern

if (CandelStickPattern(ChartPattern.BullishEngulfing, 4)[0] == 1)

    EnterLong();

-o-

Commodity Channel Index (CCI)
Definition
Courtesy of www.stockcharts.com

http://stockcharts.com/education/IndicatorAnalysis/indic_CCI.html
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Courtesy of www.marketscreen.com

Syntax
CCI(int period)
CCI(IDataSeries inputData, int period)

Returns default value
CCI(int period)[int barsAgo]
CCI(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period CCI using default price type

double value = CCI(20)[0];

Print("The current CCI value is " + value.ToString());

// Prints the current value of a 20 period CCI using high price type

double value = CCI(High, 20)[0];

Print("The current CCI value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Chaikin Money Flow
Definition
Courtesy of www.stockcharts.com

Syntax
ChaikinMoneyFlow(int period)
ChaikinMoneyFlow(IDataSeries inputData, int period)

Returns default value
ChaikinMoneyFlow(int period)[int barsAgo]
ChaikinMoneyFlow(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=35
http://stockcharts.com/education/IndicatorAnalysis/indic_ChaikinMoneyFlow1.html
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Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period ChaikinMoneyFlow using default

price type

double value = ChaikinMoneyFlow(20)[0];

Print("The current ChaikinMoneyFlow value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Chaikin Oscillator
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
ChaikinOscillator(int fast, int slow)
ChaikinOscillator(IDataSeries inputData, int fast, int slow)

Returns default value
ChaikinOscillator(int fast, int slow)[int barsAgo]
ChaikinOscillator(IDataSeries inputData, int fast, int slow)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to calculate the fast EMA
slow The number of bars to calculate the slow EMA
inputData Indicator source data (?)

Examples

// Prints the current value of a ChaikinOscillator using default price type

double value = ChaikinOscillator(3, 10)[0];

Print("The current ChaikinOscillator value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

http://stockcharts.com/education/IndicatorAnalysis/indic_ChaikinOscillator.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=34
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-o-

Chande Momentum Oscillator (CMO)
Definition
The Chande Momentum Oscillator was developed by Tushar S. Chande and is described in the
1994 book The New Technical Trader by Tushar S. Chande and Stanley Kroll. This indicator is
a modified RSI. Where the RSI divides the upward movement by the net movement (up / (up
+ down)), the CMO divides the total movement by the net movement ((up - down) / (up +
down)). Values under -50 indicate oversold conditions while values over  50 indicate
overbought conditions.

Syntax
CMO(int period)
CMO(IDataSeries inputData, int period)

Returns default value
CMO(int period)[int barsAgo]
CMO(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period CMO using default price type

double value = CMO(20)[0];

Print("The current CMO value is " + value.ToString());

// Prints the current value of a 20 period CMO using high price type

double value = CMO(High, 20)[0];

Print("The current CMO value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Constant Lines
The Constant Lines indicator cannot be accessed programmatically.

-o-

Current Day OHL
Definition
The current day (session) open, high and low values.



p435

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Syntax
CurrentDayOHL()
CurrentDayOHL(IDataSeries inputData)

Returns current session open value
CurrentDayOHL().CurrentOpen[int barsAgo]
CurrentDayOHL(IDataSeries inputData).CurrentOpen[int barsAgo]

Returns current session high value
CurrentDayOHL().CurrentHigh[int barsAgo]
CurrentDayOHL(IDataSeries inputData).CurrentHigh[int barsAgo]

Returns current session low value
CurrentDayOHL().CurrentLow[int barsAgo]
CurrentDayOHL(IDataSeries inputData).CurrentLow[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)

Examples

// Prints the current value of the session low

double value = CurrentDayOHL().CurrentLow[0];

Print("The current session low value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Directional Movement (DM)
Definition
Same as the ADX indicator with the addition of the +DI and -DI values.

Syntax
DM(int period)
DM(IDataSeries inputData, int period)

Returns default ADX value
DM(int period)[int barsAgo]
DM(IDataSeries inputData, int period)[int barsAgo]

Returns +DI value
DM(int period).DiPlus[int barsAgo]
DM(IDataSeries inputData, int period).DiPlus[int barsAgo]

Returns -DI value
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DM(int period).DiMinus[int barsAgo]
DM(IDataSeries inputData, int period).DiMinus[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period +DI using default price type

double value = DM(20).DiPlus[0];

Print("The current +DI value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Directional Movement Index (DMI)
Definition

Syntax
DMI(int period)
DMI(IDataSeries inputData, int period)

Returns default value
DMI(int period)[int barsAgo]
DMI(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

http://www.prophet.net/analyze/popglossary.jsp?studyid=DYMI
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// Prints the current value of a 20 period DMI using default price type

double value = DMI(20)[0];

Print("The current DMI value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Donchian Channel
Definition
A moving average indicator developed by Richard Donchian. It plots the highest high and
lowest low over the last period time intervals.

Syntax
DonchianChannel(int period)
DonchianChannel(IDataSeries inputData, int period)

Returns mean value (middle band)
DonchianChannel(int period)[int barsAgo]
DonchianChannel(IDataSeries inputData, int period)[int barsAgo]

Returns upper band value
DonchianChannel(int period).Upper[int barsAgo]
DonchianChannel(IDataSeries inputData, int period).Upper[int barsAgo]

Returns lower band value
DonchianChannel(int period).Lower[int barsAgo]
DonchianChannel(IDataSeries inputData, int period).Lower[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current upper value of a 20 period DonchianChannel using default

price type

double value = DonchianChannel(20).Upper[0];

Print("The current DonchianChannel upper value is " + value.ToString());

// Prints the current lower value of a 20 period DonchianChannel using high

price type

double value = DonchianChannel(High, 20).Lower[0];

Print("The current DonchianChannel lower value is " + value.ToString());
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Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Dynamic Momentum Index (DMIndex)
Definition
Courtesy of prophet.net

Syntax
DMIndex(int smooth)
DMIndex(IDataSeries inputData, int smooth)

Returns default value
DMIndex(int period)[int barsAgo]
DMIndex(IDataSeries inputData, int smooth)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
smooth The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of DMIndex using default price type

double value = DMIndex(3)[0];

Print("The current DMIndex value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Ease of Movement
Definition
The Ease of Movement indicator was designed to illustrate the relationship between volume
and price change. It shows how much volume is required to move prices. 

High Ease of Movement values occur when prices are moving upward with light volume. Low
values occur when prices are moving downward on light volume. If prices are not moving or if
heavy volume is required to move prices then the indicator will read near zero. A buy signal is
produced when it crosses above zero. A sell signal is produced when the indicator crosses
below zero (prices are moving downward more easily).

Syntax
EaseOfMovement(int smoothing, int volumeDivisor)
EaseOfMovement(IDataSeries inputData, int smoothing, int volumeDivisor)

http://www.prophet.net/analyze/popglossary.jsp?studyid=DYMI
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Returns default value
EaseOfMovement(int smoothing, int volumeDivisor)[int barsAgo]
EaseOfMovement(IDataSeries inputData, int smoothing, int volumeDivisor)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
smoothing The number of bars used to smooth the signal
volumeDivisor The value used to calculate the box ratio
inputData Indicator source data (?)

Examples

// Prints the current value of Ease of Movement using default price type

double value = EaseOfMovement(14, 10000)[0];

Print("The current Ease of Movement value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Fisher Transform
Definition
Courtesy of prophet.net

Syntax
FisherTransform(int period)
FisherTransform(IDataSeries inputData, int period)

Returns default value
FisherTransform(int period)[int barsAgo]
FisherTransform(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

http://www.prophet.net/analyze/popglossary.jsp?studyid=FISH
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// Prints the current value of a 10 period using default (median) price type

double value = FisherTransform(10)[0];

Print("The current Fisher Transform value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Forecast  Oscillator (FOSC)
Definition
Courtesy of FM Labs.

Syntax
FOSC(int period)
FOSC(IDataSeries inputData, int period)

Returns default value
FOSC(int period)[int barsAgo]
FOSC(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Checks if the current bar FOCS is above zero

    if (FOSC(14)[0] > 0)

        Print("FOSC is above zero indicating prices may rise");

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Keltner Channel
Definition
Keltner Channel indicator is based on volatility using a pair of values placed as an "envelope"
around the data field. 

http://www.fmlabs.com/reference/default.htm?url=ForecastOscillator.htm


p441

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Syntax
KeltnerChannel(double offsetMutiplier, int period)
KeltnerChannel(IDataSeries inputData, double offsetMutiplier, int period)

Returns midline value
KeltnerChannel(double offsetMutiplier, int period)[int barsAgo]
KeltnerChannel(IDataSeries inputData, double offsetMutiplier, int period)[int barsAgo]

Returns upper band value
KeltnerChannel(double offsetMutiplier, int period).Upper[int barsAgo]
KeltnerChannel(IDataSeries inputData, double offsetMutiplier, int period).Upper[int barsAgo]

Returns lower band value
KeltnerChannel(double offsetMutiplier, int period).Lower[int barsAgo]
KeltnerChannel(IDataSeries inputData, double offsetMutiplier, int period).Lower[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
offsetMultiplier Value indicating the expansion offset
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current upper value of a 20 period KeltnerChannel using default

price type

double value = KeltnerChannel(1.5, 20).Upper[0];

Print("The current KeltnerChannel upper value is " + value.ToString());

// Prints the current lower value of a 20 period DonchianChannel using high

price type

double value = KeltnerChannel(High, 1.5, 20).Lower[0];

Print("The current KeltnerChannel lower value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

KeyReversalDown
Definition
Returns a value of 1 when the current close is less than the prior close and the current high
has penetrated the highest high of the last n bars.

Syntax
KeyReversalDown(int period)
KeyReversalDown(IDataSeries inputData, int period)
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Returns default value
KeyReversalDown(int period)[int barsAgo]
KeyReversalDown(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

protected override void OnBarUpdate()

{

    // If we get a reversal over the past 10 bars go short

    if (KeyReversalDown(10)[0] == 1)

        EnterShort();

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

KeyReversalUp
Definition
Returns a value of 1 when the current close is greater than the prior close and the current low
has penetrated the lowest low of the last n bars.

Syntax
KeyReversalUp(int period)
KeyReversalUp(IDataSeries inputData, int period)

Returns default value
KeyReversalUp(int period)[int barsAgo]
KeyReversalUp(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)
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Examples

protected override void OnBarUpdate()

{

    // If we get a reversal over the past 10 bars go long

    if (KeyReversalUp(10)[0] == 1)

        EnterLong();

}

Source Code
You can open up the indicator source code via the NinjaScript Editor

-o-

Linear Regression
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
LinReg(int period)
LinReg(IDataSeries inputData, int period)

Returns default value
LinReg(int period)[int barsAgo]
LinReg(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period LinReg using default price type

double value = LinReg(20)[0];

Print("The current LinReg value is " + value.ToString());

// Prints the current value of a 20 period LinReg using high price type

double value = LinReg(High, 20)[0];

Print("The current LinReg value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

http://stockcharts.com/education/IndicatorAnalysis/indic_movingAvg.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=67
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MACD
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
MACD(int fast, int slow, int smooth)
MACD(IDataSeries inputData, int fast, int slow, int smooth)

Returns MACD value
MACD(int fast, int slow, int smooth)[int barsAgo]
MACD(IDataSeries inputData, int fast, int slow, int smooth)[int barsAgo]

Returns average value
MACD(int fast, int slow, int smooth).Avg[int barsAgo]
MACD(IDataSeries inputData, int fast, int slow, int smooth).Avg[int barsAgo]

Returns difference value
MACD(int fast, int slow, int smooth).Diff[int barsAgo]
MACD(IDataSeries inputData, int fast, int slow, int smooth).Diff[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to calculate the fast EMA
slow The numbers of bars to calculate the slow EMA
smooth The number of bars to calculate the EMA signal line
inputData Indicator source data (?)

Examples

// Prints the current MACD value

double value = MACD(12, 26, 9)[0];

Print("The current MACD value is " + value.ToString());

// Prints the current MACD average value

double value = MACD(12, 26, 9).Avg[0];

Print("The current MACD average value is " + value.ToString());

// Prints the current MACD difference value

double value = MACD(12, 26, 9).Diff[0];

Print("The current MACD difference value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Maximum (MAX)
Definition

http://stockcharts.com/education/IndicatorAnalysis/indic_MACD1.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=59
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Returns the highest value over the specified period.

Syntax
MAX(int period)
MAX(IDataSeries inputData, int period)

Returns default value
MAX(int period)[int barsAgo]
MAX(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the highest high value over the last 20 periods

double value = MAX(High, 20)[0];

Print("The current MAX value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Money Flow Index (MFI)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
MFI(int period)
MFI(IDataSeries inputData, int period)

Returns default value
MFI(int period)[int barsAgo]
MFI(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation

http://stockcharts.com/education/IndicatorAnalysis/indic_MFI.htm
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=66
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inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period MFI using default price type

double value = MFI(20)[0];

Print("The current MFI value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Exponential (EMA)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
EMA(int period)
EMA(IDataSeries inputData, int period)

Returns default value
EMA(int period)[int barsAgo]
EMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period EMA using default price type

double value = EMA(20)[0];

Print("The current EMA value is " + value.ToString());

// Prints the current value of a 20 period EMA using high price type

double value = EMA(High, 20)[0];

Print("The current EMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

http://stockcharts.com/education/IndicatorAnalysis/indic_movingAvg.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=67
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Moving Average - Hull (HMA)
Definition
The HMA manages to keep up with rapid changes in price activity whilst having superior
smoothing over an SMA of the same period. The HMA employs weighted moving averages and
dampens the smoothing effect (and resulting lag) by using the square root of the period
instead of the actual period itself. Developed by Alan Hull.

Syntax
HMA(int period)
HMA(IDataSeries inputData, int period)

Returns default value
HMA(int period)[int barsAgo]
HMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period HMA using default price type

double value = HMA(20)[0];

Print("The current HMA value is " + value.ToString());

// Prints the current value of a 20 period HMA using high price type

double value = HMA(High, 20)[0];

Print("The current HMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Kaufman's Adaptive (KAMA)
Definition
Developed by Perry Kaufman, this indicator is an EMA using an Efficiency Ratio to modify the
smoothing constant, which ranges from a minimum of Fast Length to a maximum of Slow
Length.

Syntax
KAMA(int fast, int period, int slow)
KAMA(IDataSeries inputData, int fast, int period, int slow)

Returns default value
KAMA(int fast, int period, int slow)[int barsAgo]
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KAMA(IDataSeries inputData, int fast, int period, int slow)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast Fast length
period The number of bars to include in the calculation
slow Slow length
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period KAMA using default price type

double value = KAMA(2, 20, 30)[0];

Print("The current KAMA value is " + value.ToString());

// Prints the current value of a 20 period KAMA using high price type

double value = HMA(High, 2, 20, 30)[0];

Print("The current KAMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Mesa Adaptive (MAMA)
Definition
The MESA Adaptive Moving Average (MAMA) adapts to price movement in an entirely new and
unique way. The adaptation is based on the rate change of phase as measured by the Hilbert
Transform Discriminator. The advantage of this method of adaptation is that it features a fast
attack average and a slow decay average so that composite average rapidly ratchets behind
price changes and holds  the average value until the next ratchet occurs.

Syntax
MAMA(double fastLimit, double slowLimit)
MAMA(IDataSeries inputData, double fastLimit, double slowLimit)

Returns MAMA value
MAMA(double fastLimit, double slowLimit)[int barsAgo]
MAMA(IDataSeries inputData, double fastLimit, double slowLimit)[int barsAgo]

Returns Fama (Following Adaptive Moving Average) value
MAMA(double fastLimit, double slowLimit).Fama[int barsAgo]
MAMA(IDataSeries inputData, double fastLimit, double slowLimit).Fama[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.



p449

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Parameters
fastLimit Upper limit of the alpha value
slowLimit Lower limit of the alpha value
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period MAMA using default price type

double value = MAMA(0.5,0.05).Default[0];

Print("The current MAMA value is " + value.ToString());

// Prints the current value of a 20 period Fama using high price type

double value = MAMA(High, 0.5, 0.05).Fama[0];

Print("The current Fama value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Simple  (SMA)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
SMA(int period)
SMA(IDataSeries inputData, int period)

Returns default value
SMA(int period)[int barsAgo]
SMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

http://stockcharts.com/education/IndicatorAnalysis/indic_movingAvg.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=67
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// Prints the current value of a 20 period SMA using default price type

double value = SMA(20)[0];

Print("The current SMA value is " + value.ToString());

// Prints the current value of a 20 period SMA using high price type

double value = SMA(High, 20)[0];

Print("The current SMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Triangular (TMA)
Definition
The Triangular Moving Average is a form of Weighted Moving Average wherein the weights
are assigned in a triangular pattern. For example, the weights for a 7 period Triangular
Moving Average would be 1, 2, 3, 4, 3, 2, 1. This gives more weight to the middle of the time
series and less weight to the oldest and newest data. 

Syntax
TMA(int period)
TMA(IDataSeries inputData, int period)

Returns default value
TMA(int period)[int barsAgo]
TMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period TMA using default price type

double value = TMA(20)[0];

Print("The current TMA value is " + value.ToString());

// Prints the current value of a 20 period TMA using high price type

double value = TMA(High, 20)[0];

Print("The current TMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-
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Moving Average - Triple Exponential (TEMA)
Definition

The TEMA is a smoothing indicator. It was developed by Patrick Mulloy and is described in his
article in the January, 1994 issue of  Technical Analysis of Stocks and Commodities
magazine. 

Syntax
TEMA(int period)
TEMA(IDataSeries inputData, int period)

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period TEMA

double value = TEMA(20)[0];

Print("The current TEMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Triple Exponential (TRIX)
Definition
Courtesy of www.investopedia.com

Syntax
TRIX(int period, int signalPeriod)
TRIX(IDataSeries inputData, int period, int signalPeriod)

Returns trix value
TRIX(int period, int signalPeriod)[int barsAgo]
TRIX(IDataSeries inputData, int period, int signalPeriod)[int barsAgo]

Returns signal value
TRIX(int period, int signalPeriod).Signal[int barsAgo]
TRIX(IDataSeries inputData, int period, int signalPeriod).Signal[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

http://www.prophet.net/analyze/popglossary.jsp?studyid=TSI
http://www.investopedia.com/articles/technical/02/092402.asp
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Parameters
period The number of bars to include in the calculation
signalPeriod Period for signal line
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period TRIX using default price type

double value = TRIX(20, 3).Default[0];

Print("The current TRIX value is " + value.ToString());

// Prints the current signal value of a 20 period TRIX using high price type

double value = TRIX(High, 20, 3).Signal[0];

Print("The current TRIX signal value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Variable (VMA)
Definition
A Variable Moving Average is an exponential moving average that automatically adjusts its
smoothing percentage based on market volatility. Giving more weight to the current data
increases sensitivity thus making it a better signal indicator for short and long term markets.

Syntax
VMA(int period, int volatilityPeriod)
VMA(IDataSeries inputData, int period, int volatilityPeriod)

Returns default value
VMA(int period, int volatilityPeriod)[int barsAgo]
VMA(IDataSeries inputData, int period, int volatilityPeriod)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
volatilityPeriod The number of bars used to calculate the CMO based volatility index
inputData Indicator source data (?)

Examples
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// OnBarUpdate method of a strategy

protected override void OnBarUpdate()

{

    // Print out the VMA value of lows 3 bars ago for fun

    double value = VMA(Low, 9, 9)[3];

    Print("The value is " + value.ToString());

    // Go long if price closes above the current VMA value

    if (Close[0] > VMA(9, 9)[0])

        EnterLong();

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Moving Average - Weighted (WMA)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
WMA(int period)
WMA(IDataSeries inputData, int period)

Returns default value
WMA(int period)[int barsAgo]
WMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period WMA using default price type

double value = WMA(20)[0];

Print("The current WMA value is " + value.ToString());

// Prints the current value of a 20 period WMA using high price type

double value = WMA(High, 20)[0];

Print("The current WMA value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

http://stockcharts.com/education/IndicatorAnalysis/indic_movingAvg.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=67
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-o-

Moving Average - Volume Weighted (VWMA)
Definition

The Volume Weighted Moving Average is a weighted moving average that uses the volume as
the weighting factor, so that higher volume days have more weight. It is a non-cumulative
moving average, in that only data within the time period is used in the calculation.

Syntax
VWMA(int period)
VWMA(IDataSeries inputData, int period)

Returns default value
VWMA(int period)[int barsAgo]
VWMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Checks for a VWMA cross over to the long side

    if (CrossAbove(VWMA(14), VWMA(40), 1))

        Print("We have a moving average cross over long");

    // Prints the current 14 period VWMA of high prices to the output window 

    double value = VWMA(High, 14)[0];

    Print("The current VWMA value of high prices is " + value.ToString());

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Minimum (MIN)
Definition
Returns the lowest value over the specified period.

Syntax
MIN(int period)
MIN(IDataSeries inputData, int period)
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Returns default value
MIN(int period)[int barsAgo]
MIN(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the lowest low value over the last 20 periods

double value = MIN(Low, 20)[0];

Print("The current MIN value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Momentum
Definition
Courtesy of www.marketscreen.com

Syntax
Momentum(int period)
Momentum(IDataSeries inputData, int period)

Returns default value
Momentum(int period)[int barsAgo]
Momentum(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=65
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// Prints the current value of a 20 period Momentum using default price type

double value = Momentum(20)[0];

Print("The current Momentum value is " + value.ToString());

// Prints the current value of a 20 period Momentum using high price type

double value = Momentum(High, 20)[0];

Print("The current Momentum value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

n Bars Down
Definition
Checks for n number of consecutive lower closes. Returns a value of 1 when the condition is
true or 0 when false.

Syntax
NBarsDown(int barCount, bool BarDown, bool lowerHigh, bool lowerLow)
NBarsDown(IDataSeries inputData, int barCount, bool BarDown, bool lowerHigh, bool
lowerLow)

Returns default value
NBarsDown(int barCount, bool BarDown, bool lowerHigh, bool lowerLow)[int barsAgo]
NBarsDown(IDataSeries inputData, bool barCount, int BarDown, bool lowerHigh, bool
lowerLow)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
barCount The number of required consecutive lower closes
BarDown Each bar's open must be less than the close; true or false
lowerHigh Consecutive lower highs required; true or false
lowerLow Consecutive lower lows required; true or false
inputData Indicator source data (?)

Examples

// Checks if we have 3 consecutive lower closes

double value = NBarsDown(3, true, true, true)[0];

if (value == 1)

   Print("We have three consecutive lower closes);

Source Code
You can open up the indicator source code via the NinjaScript Editor.



p457

© NinjaTrader, LLC, 2005

www.ninjatrader.com

-o-

n Bars Up
Definition
Checks for n number of consecutive higher closes. Returns a value of 1 when the condition is
true or 0 when false.

Syntax
NBarsUp(int barCount, bool BarUp, bool higherHigh, bool higherLow)
NBarsUp(IDataSeries inputData, int barCount, bool BarUp, bool higherHigh, bool higherLow)

Returns default value
NBarsUp(int barCount, int barCount, bool BarUp, bool higherHigh, bool higherLow)[int
barsAgo]
NBarsUp(IDataSeries inputData, int barCount, bool BarUp, bool higherHigh, bool higherLow)[
int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
barCount The number of required consecutive higher closes
BarUp Each bar's open must be higher than the close; true or false
higherHigh Consecutive higher highs required; true or false
higherLow Consecutive higher lows required; true or false
inputData Indicator source data (?)

Examples

// Checks if we have 3 consecutive higher closes

double value = NBarsUp(3, true, true, true)[0];

if (value == 1)

   Print("We have three consecutive higher closes);

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

On Balance Volume (OBV)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
OBV()
OBV(IDataSeries inputData)

http://stockcharts.com/education/IndicatorAnalysis/indic-obv.htm
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=75
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Returns default value
OBV()[int barsAgo]
OBV(IDataSeries inputData)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)

Examples

// Prints the current value of OBV

double value = OBV()[0];

Print("The current OBV value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Parabolic SAR
Definition
Courtesy of www.investopedia.com

Syntax
ParabolicSAR(double acceleration, double accelerationStep, double accelerationMax)
ParabolicSAR(IDataSeries inputData, double acceleration, double accelerationStep, double
accelerationMax)

Returns default value
ParabolicSAR(double acceleration, double accelerationStep, double accelerationMax)[int
barsAgo]
ParabolicSAR(IDataSeries inputData, double acceleration, double accelerationStep, double
accelerationMax)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
acceleration Acceleration value
accelerationStep Step value used to increment acceleration value
accelerationMax Maximum acceleration value
inputData Indicator source data (?)

http://www.investopedia.com/articles/technical/02/042202.asp
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Examples

// Prints the current value of ParabolicSAR using default price type

double value = ParabolicSAR(0.02, 0.02, 0.2)[0];

Print("The current ParabolicSAR value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Percentage Price Oscillator (PPO)
Definition
The Percentage Price Oscillator shows the percentage difference between two exponential
moving averages.

Syntax
PPO(int fast, int slow, int smooth)
PPO(IDataSeries inputData, int fast, int slow, int smooth)

Returns default value
PPO(int fast, int slow, int smooth)[int barsAgo]
PPO(IDataSeries inputData, int fast, int slow, int smooth)[int barsAgo]

Returns smoothed value
PPO(int fast, int slow, int smooth).Smoothed[int barsAgo]
PPO(IDataSeries inputData, int fast, int slow, int smooth).Smoothed[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to calculate the fast EMA
slow The number of bars to calculate the slow EMA
smooth The number of bars to calculate the EMA signal line
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period Percentage Price Oscillator

double value = PPO(12, 26, 9)[0];

Print("The current Percentage Price Oscillator value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-
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Pivots
Definition
Courtesy of Investopedia

Syntax
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width)
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width)

Returns pivot point value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).PP[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).PP[int barsAgo]

Returns R1 value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).R1[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).R1[int barsAgo]

Returns R2 value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).R2[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).R2[int barsAgo]

Returns R3 value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).R3[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).R3[int barsAgo]

Returns S1 value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).S1[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).S1[int barsAgo]

Returns S2 value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).S2[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).S2[int barsAgo]

Returns S3 value
Pivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).S3[int
barsAgo]
Pivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode priorDayHLC,
int width).S3[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)

http://www.investopedia.com/articles/technical/04/041404.asp
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pivotRangeType Sets the range for the type of pivot calculated. Possible values are:
PivotRange.Daily
PivotRange.Weekly
PivotRange.Monthly

priorDayHLC Sets how the prior range High, Low, Close values are calculated. Possible
values are:
HLCCalculationMode.CalcFromIntradayData
HLCCalculationMode.DailyBars
HLCCalculationMode.UserDefinedValues

Examples

// Prints the current pivot point value

double value = Pivots(PivotRange.Daily, HLCCalculationMode.DailyBars,

20).PP[0];

Print("The current Pivots pivot value is " + value.ToString());

// Prints the current S2 pivot value

double value = Pivots(PivotRange.Daily, HLCCalculationMode.DailyBars,

20).S2[0];

Print("The current Pivots S2 pivot value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Price Oscillator
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
PriceOscillator(int fast, int slow, int smooth)
PriceOscillator(IDataSeries inputData, int fast, int slow, int smooth)

Returns default value
PriceOscillator(int fast, int slow, int smooth)[int barsAgo]
PriceOscillator(IDataSeries inputData, int fast, int slow, int smooth)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to calculate the fast EMA
slow The number of bars to calculate the slow EMA
smooth The number of bars to calculate the EMA signal line
inputData Indicator source data (?)

http://stockcharts.com/education/IndicatorAnalysis/indic_priceOscillator.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=87
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Examples

// Prints the current value of a 20 period PriceOscillator using default price

type

double value = PriceOscillator(12, 26, 9)[0];

Print("The current PriceOscillator value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Prior Day OHLC
Definition
The prior day (session) open, high, low and close values.

Syntax
PriorDayOHLC()
PriorDayOHLC(IDataSeries inputData)

Returns prior session open value
PriorDayOHLC().PriorOpen[int barsAgo]
PriorDayOHLC(IDataSeries inputData).PriorOpen[int barsAgo]

Returns prior session high value
PriorDayOHLC().PriorHigh[int barsAgo]
PriorDayOHLC(IDataSeries inputData).PriorHigh[int barsAgo]

Returns prior session low value
PriorDayOHLC().PriorLow[int barsAgo]
PriorDayOHLC(IDataSeries inputData).PriorLow[int barsAgo]

Returns prior session close value
PriorDayOHLC().PriorClose[int barsAgo]
PriorDayOHLC(IDataSeries inputData).PriorClose[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)

Examples

// Prints the value of the prior session low

double value = PriorDayOHLC().PriorLow[0];

Print("The prior session low value is " + value.ToString());

Source Code



p463

© NinjaTrader, LLC, 2005

www.ninjatrader.com

You can open up the indicator source code via the NinjaScript Editor.

-o-

Range
Definition
Returns the range of a bar.

Syntax
Range()
Range(IDataSeries inputData)

Returns default value
Range()[int barsAgo]
Range(IDataSeries inputData)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period ROC using default price type

double value = Range()[0];

Print("The current bar's range is " + value.ToString());

// Prints the 20 period simple moving average of range

double value = SMA(Range(), 20)[0];

Print("The 20 period average of range is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Rate of Change (ROC)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
ROC(int period, int smooth)
ROC(IDataSeries inputData, int period)

Returns default value
ROC(int period, int smooth)[int barsAgo]
ROC(IDataSeries inputData, int period)[int barsAgo]

http://stockcharts.com/education/IndicatorAnalysis/indic_ROC.htm
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=65
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Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period ROC using default price type

double value = ROC(20)[0];

Print("The current ROC value is " + value.ToString());

// Prints the current value of a 20 period ROC using high price type

double value = ROC(High, 20)[0];

Print("The current ROC value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Regression Channel
Definition
A Regression Channel is created by drawing parallel lines above and below the Linear
Regression line. 

Parallel and equidistant lines are drawn n standard deviations (width parameter) above and
below a Linear Regression trendline. The distance between the channel lines and the
regression line is the greatest distance that any one closing price is from the regression line.
Regression Channels contain price movement, the top channel line provides resistance and
the bottom channel line provides support. A reversal in trend may be indicated when prices
remain outside the channel for a longer period of time. 

A Linear Regression trendline shows where equilibrium exists but Linear Regression Channels
show the range prices can be expected to deviate from a trendline.

Syntax
RegressionChannel(int period, int width)
RegressionChannel(IDataSeries inputData, int period, int width)

Returns default midline value
RegressionChannel(int period, int width)[int barsAgo]
RegressionChannel(IDataSeries inputData, int period, int width)[int barsAgo]

Returns upper channel value
RegressionChannel(int period, int width).Upper[int barsAgo]
RegressionChannel(IDataSeries inputData, int period, int width).Upper[int barsAgo]

Returns lower channel value
RegressionChannel(int period, int width).Lower[int barsAgo]
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RegressionChannel(IDataSeries inputData, int period, int width).Lower[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
width The number of std deviations to calculate the channel lines
inputData Indicator source data (?)

Tips
You should not access historical values of this indicator since the values can change from bar
to bar. The values from n bars ago does not reflect what the values of the current bar really
are. It is suggested that you only access the current bar value for this indicator.

Examples

// Prints the current value of a 20 period channel using default price type

double value = RegressionChannel(20, 2).Upper[0];

Print("The current upper channel value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Relative Strength Index (RSI)
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
RSI(int period, int smooth)
RSI(IDataSeries inputData, int period, int smooth)

Returns default value
RSI(int period, int smooth)[int barsAgo]
RSI(IDataSeries inputData, int period, int smooth)[int barsAgo]

Returns avg value
RSI(int period, int smooth).Avg[int barsAgo]
RSI(IDataSeries inputData, int period, int smooth).Avg[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

http://stockcharts.com/education/IndicatorAnalysis/indic_RSI.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=93
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Parameters
period The number of bars to include in the calculation
smooth Smoothing period
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period RSI using default price type

double value = RSI(20, 3)[0];

Print("The current RSI value is " + value.ToString());

// Prints the current value of a 20 period RSI using high price type

double value = RSI(High, 20, 3)[0];

Print("The current RSI value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Relative Volatility Index (RVI)
Definition
Developed by Donald Dorsey, the Relative Volatility Index is the RSI using the standard
deviation over the indicator period in place of the daily price change. The RVI measures the
direction of volatility on a scale from 0 to 100. Readings below 50 indicate that the direction
of volatility is to the downside and that you should be looking to sell, readings above 50
indicate that the direction of volatilty is to the upside and that you should be looking to buy.

Syntax
RVI(int period)
RVI(IDataSeries inputData, int period)

Returns default value
RVI(int period)[int barsAgo]
RVI(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples
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// OnBarUpdate method of a stratgegy

protected override void OnBarUpdate()

{

    // Check for buy condition

    if (RVI(14)[0] > 50 && CrossAbove(SMA(9), SMA(14), 1))

    {

        // System logic here...

    }

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Range Indicator (RIND)
Definition

The Range indicator compares the intraday range (high - low) to the inter-day (close -
previous close) range. When the inter-day range is less than the intraday range, the Range
Indicator will be a high value. This signals an end to the current trend. When the Range
Indicator is at a low level, a new trend is about to start.

The Range Indicator was developed by Jack Weinberg and was introduced in his article in the
June, 1995 issue of Technical Analysis of Stocks & Commodities magazine. 

Syntax
RIND(int periodQ, int smooth)
RIND(IDataSeries inputData, int periodQ, int smooth)

Returns default value
RIND(int periodQ, int smooth)[int barsAgo]
RIND(IDataSeries inputData, int periodQ, int smooth)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
periodQ The number of bars to include in the calculation for the short term

stochastic range lookback
smooth The number of bars to include for the EMA smoothing of the indicator
inputData Indicator source data (?)

Examples
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// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Prints out a historical RIND value

    double value = RIND(3, 10)[5];

    Print("RIND value of 5 bars ago is " + value.ToString());

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Standard Deviation
Definition
Courtesy of wikepedia

Syntax
StdDev(int period)
StdDev(IDataSeries inputData, int period)

Returns default value
StdDev(int period)[int barsAgo]
StdDev(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period StdDev using default price type

double value = StdDev(20)[0];

Print("The current StdDev value is " + value.ToString());

// Prints the current value of a 20 period StdDev using high price type

double value = StdDev(High, 20)[0];

Print("The current StdDev value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Standard Error

http://en.wikipedia.org/wiki/Standard_deviation
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Definition
Courtesy of wikepedia

Syntax
StdError(int period)
StdError(IDataSeries inputData, int period)

Returns default value which is the mid line (also known as linear regression)
StdError(int period)[int barsAgo]
StdError(IDataSeries inputData, int period)[int barsAgo]

Returns upper value
StdError(int period).Upper[int barsAgo]
StdError(IDataSeries inputData, int period).Upper[int barsAgo]

Returns lower value
StdError(int period).Lower[int barsAgo]
StdError(IDataSeries inputData, int period).Lower[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current upper value of a 20 period StdError using default price

type

double value = StdError(20).Upper[0];

Print("The current upper Standard Error value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Stochastics
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
Stochastics(int periodD, int periodK, int smooth)
Stochastics(IDataSeries inputData, int periodD, int periodK, int smooth)

Returns %D value
Stochastics(int periodD, int periodK, int smooth).D[int barsAgo]
Stochastics(IDataSeries inputData, int periodD, int periodK, int smooth).D[int barsAgo]

http://en.wikipedia.org/wiki/Standard_error_(statistics)
http://stockcharts.com/education/IndicatorAnalysis/indic_stochasticOscillator.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=99
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Returns %K value
Stochastics(int periodD, int periodK, int smooth).K[int barsAgo]
Stochastics(IDataSeries inputData, int periodD, int periodK, int smooth).K[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
periodD The period moving average of periodK
periodK The number of bars to include in the calculation
smooth The period moving average of periodD
inputData Indicator source data (?)

Examples

// Prints the current %D value

double value = Stochastics(3, 14, 7).D[0];

Print("The current Stochastics %D value is " + value.ToString());

// Prints the current %K value

double value = Stochastics(3, 14, 7).K[0];

Print("The current Stochastics %K value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Stochastics Fast
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
StochasticsFast(int periodD, int periodK)
StochasticsFast(IDataSeries inputData, int periodD, int periodK)

Returns %D value
StochasticsFast(int periodD, int periodK).D[int barsAgo]
StochasticsFast(IDataSeries inputData, int periodD, int periodK).D[int barsAgo]

Returns %K value
StochasticsFast(int periodD, int periodK).K[int barsAgo]
StochasticsFast(IDataSeries inputData, int periodD, int periodK).K[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

http://stockcharts.com/education/IndicatorAnalysis/indic_stochasticOscillator.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=99
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Parameters
periodD The period moving average of periodK
periodK The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current %D value

double value = StochasticsFast(3, 14).D[0];

Print("The current StochasticsFast %D value is " + value.ToString());

// Prints the current %K value

double value = StochasticsFast(3, 14).K[0];

Print("The current StochasticsFast %K value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Stochastics RSI (StochRSI)
Definition
This is an indicator on indicator implementation. It is simply a Stochastics indicator applied
on RSI.

Syntax
StochRSI(int period)
StochRSI(IDataSeries inputData, int period)

Returns default value
StochRSI(int period)[int barsAgo]
StochRSI(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples
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// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Checks if the current bar StochRSI value is greater than the value one

bar ago

    if (StochRSI(14)[0] > StochRSI(14)[1])

        Print("Stochastics RSI is rising");

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Summation (SUM)
Definition
Returns the sum over the specified period.

Syntax
SUM(int period)
SUM(IDataSeries inputData, int period)

Returns default value
SUM(int period)[int barsAgo]
SUM(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period SUM using default price type

double value = SUM(20)[0];

Print("The current SUM value is " + value.ToString());

// Prints the current value of a 20 period SUM using high price type

double value = SUM(High, 20)[0];

Print("The current SUM value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-
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Swing
Definition
The Swing indicator will plot lines that represent the swing points based on the strength
(number of bars to the left and right of the swing point) parameter provided. You can access
methods within this indicator to determine the number of bars ago a swing point occured or
the current swing value

Syntax - Bars Ago

High Bar
Swing(int strength).SwingHighBar(int barsAgo, int instance, int lookBackPeriod)
Swing(IDataSeries inputData, int strength).SwingHighBar(int barsAgo, int instance, int
lookBackPeriod)

Low Bar
Swing(int strength).SwingLowBar(int barsAgo, int instance, int lookBackPeriod)
Swing(IDataSeries inputData, int strength).SwingLowBar(int barsAgo, int instance, int
lookBackPeriod)

Return Type
A int value representing the number of bars ago. Returns a value of -1 if a swing point is not
found within the look back period.

Syntax - Value

High Value
Swing(int strength).SwingHigh[int barsAgo]
Swing(IDataSeries inputData, int strength).SwingHigh[int barsAgo]

Low Value
Swing(int strength).SwingLow[int barsAgo]
Swing(IDataSeries inputData, int strength).SwingLow[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

* A return value of 0 (zero) will be returned if the CurrentBar is less than the
"strength" value or a swing pivot has not yet been found.

Parameters
strength The number of required bars to the left and right of the swing point
barsAgo The number of bars ago that serves as the starting bar and works

backwards
instance The occurence to check for (1 is the most recent, 2 is the 2nd most

recent etc...)
lookBackPeriod Number of bars to look back to check for the test condition
inputData Indicator source data (?)

Examples
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// Prints the high price of the most recent swing high

Print("The high of the swing bar is " + High[Math.Max(0,

Swing(5).SwingHighBar(0, 1, 10))]);

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Tick Counter
The Tick Counter indicator is implemented as a custom plot indicator and can not be accessed
programmatically. As an alternative, use the TickCount property.

-o-

Time Series Forecast (TSF)
Definition
Courtesy of www.prophet.net

Syntax
TSF(int forecast, int period)
TSF(IDataSeries inputData, int forecast, int period)

Returns default value
TSF(int forecast, int period)[int barsAgo]
TSF(IDataSeries inputData, int forecast, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
forecast Forecast period
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period TSF using default price type

double value = TSF(3, 20)[0];

Print("The current TSF value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

http://www.prophet.net/analyze/popglossary.jsp?studyid=TSF
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True Strength Index (TSI)
Definition
Courtesy of www.prophet.net

Syntax
TSI(int fast, int slow)
TSI(IDataSeries inputData, int fast, int slow)

Returns default value
TSI(int fast, int slow)[int barsAgo]
TSI(IDataSeries inputData, int fast, int slow)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to include in the calculation
slow The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period TSI using default price type

double value = TSI(20)[0];

Print("The current TSI value is " + value.ToString());

// Prints the current value of a 20 period TSI using high price type

double value = TSI(High, 20)[0];

Print("The current TSI value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Ultimate Oscillator
Definition
Developed by Larry Williams and introduced in his article in the April, 1985 issue of Technical
Analysis of Stocks and Commodities magazine, this indicator  is the weighted sum of three
oscillators of different time periods. The there time periods represent short, intermediate and
long term market cycles. Typical periods are 7, 14 and 28. The values of the Ultimate
Oscillator range from zero to 100. Values over 70 indicate overbought conditions, and values
under 30 indicate oversold conditions.

Syntax
UltimateOscillator(int fast, int intermediate, int slow)
UltimateOscillator(IDataSeries inputData, int fast, int intermediate, int slow)

Returns default value
UltimateOscillator(int fast, int intermediate, int slow)[int barsAgo]

http://www.prophet.net/analyze/popglossary.jsp?studyid=TSI
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UltimateOscillator(IDataSeries inputData, int fast, int intermediate, int slow)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to include in the short term period
intermediate The number of bars to include in the intermediate term period
slow The number of bars to include in the long term period
inputData Indicator source data (?)

Examples

// Prints the current value of a typical Ultimate Oscillator using default

price type

double value = UltimateOscillator(7, 14, 28)[0];

Print("The current Ultimate Oscillator value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Volume
Definition
Courtesy of www.marketscreen.com

Syntax
VOL()
VOL(IDataSeries inputData)

Returns default value
VOL()[int barsAgo]
VOL(IDataSeries inputData)[int barsAgo]

Return Type
int; Accessing this method via an index value [int barsAgo] returns the indicator value of the
referenced bar.

Parameters
inputData Indicator source data (?)

Examples

http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=114
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// Prints the current value VOL

int value = VOL()[0];

Print("The current VOL value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Volume Counter
The Volume Counter indicator is implemented as a custom plot indicator and can not be
accessed programmatically.

-o-

Volume Moving Average (VOLMA)
Definition
The Volume Moving Average indicator is an indicator on indicator implementation. It
calculates and returns the value of a simple moving average of volume.

Syntax
VOLMA(int period)
VOLMA(IDataSeries inputData, int period)

Returns default value
VOLMA(int period)[int barsAgo]
VOLMA(IDataSeries inputData, int period)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// OnBarUpdate method

protected override void OnBarUpdate()

{

    // Checks if the current volume is greater than the 20 period SMA of

volume

    if (Volume[0] > VOLMA(20)[0])

        Print("Volume has risen above its 20 period average");

}

Source Code
You can open up the indicator source code via the NinjaScript Editor.
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-o-

Volume Oscillator
Definition
The Volume Oscillator uses the difference between two moving averages of volume to
determine if the trend is increasing or decreasing. A value above zero indicates that the
shorter term volume moving average has risen above the longer term volume moving
average. This  indicates that the shorter term trend is higher than the longer term trend.
Rising prices with with increased short term volume is bullish as is falling prices with
decreased volume. Falling prices with increased volume or  rising prices with decreased
volume indicate market weakness.

Syntax
VolumeOscillator(int fast, int slow)
VolumeOscillator(IDataSeries inputData, int fast, int slow)

Returns default value
VolumeOscillator(int fast, int slow)[int barsAgo]
VolumeOscillator(IDataSeries inputData, int fast, int slow)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
fast The number of bars to include in short term moving average
slow The number of bars to include in the long term moving average
inputData Indicator source data (?)

Examples

// Prints the current value of a Volume Oscillator

double value = VolumeOscillator(12, 26)[0];

Print("The current Volume Oscillator value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Volume Profile
The Volume Profile indicator is implemented as a custom plot indicator and can not be
accessed programmatically.

Learn about this indicator...

-o-

Volume Rate of Change (VROC)
Definition
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Volume Rate of Change is identical to Price Rate Of Change (ROC) indicator except that it
uses volume instead of price.

Syntax
VROC(int period, int smooth)
VROC(IDataSeries inputData, int period, int smooth)

Returns default value
VROC(int period, int smooth)[int barsAgo]
VROC(IDataSeries inputData, int period, int smooth)[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
smooth The number of bars for smoothing the signal
inputData Indicator source data (?)

Examples

// Prints the current value of VROC

double value = VROC(13, 3)[0];

Print("The current VROC value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

Volume Zones
The Volume Zones indicator is implemented as a custom plot indicator and can not be
accessed programmatically.

Learn about this indicator...

-o-

Williams %R
Definition
Courtesy of www.stockcharts.com
Courtesy of www.marketscreen.com

Syntax
WilliamsR(int period)
WilliamsR(IDataSeries inputData, int period)

Returns default value
WilliamsR(int period)[int barsAgo]
WilliamsR(IDataSeries inputData, int period)[int barsAgo]

http://stockcharts.com/education/IndicatorAnalysis/indic_williamsR.html
http://www.marketscreen.com/help/atoz/default.asp?hideHF=&Num=119
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Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
period The number of bars to include in the calculation
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period WilliamsR using default price type

double value = WilliamsR(20)[0];

Print("The current WilliamsR value is " + value.ToString());

// Prints the current value of a 20 period WilliamsR using high price type

double value = WilliamsR(High, 20)[0];

Print("The current WilliamsR value is " + value.ToString());

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

WoodiesCCI
Definition
NinjaTrader provides the Woodies CCI indicator. It's implemented as specified by Woodie. 

Syntax

WoodiesCCI()
WoodiesCCI(IDataSeries inputData)

Returns default value
WoodiesCCI()[int barsAgo]
WoodiesCCI(IDataSeries inputData)[int barsAgo]

Returns turbo value
WoodiesCCI().Turbo[int barsAgo]
WoodiesCCI(IDataSeries inputData).Turbo[int barsAgo]

Returns histogram bar color
WoodiesCCI().ZoneBars[int barsAgo]
WoodiesCCI(IDataSeries inputData).ZoneBars[int barsAgo]

Return values representing the chopzone plot color are as follows:

0 = Negative (default color is red)
1 = Positive (default color is blue)
2 = Neutral (default color is gray)
3 = Last neutral bar (default color is yellow)

Returns chopzone value
WoodiesCCI().ChopZone[int barsAgo]
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WoodiesCCI(IDataSeries inputData).ChopZone[int barsAgo]

Return values representing the chopzone plot color are as follows:

-4 = DarkRed
-3 = LightRed
-2 = DarkOrange
-1 = LightOrange
0 = Yellow
1 = Lime
2 = LightGreen
3 = DarkGreen
4 = Cyan

Returns sidewinder value
WoodiesCCI().Sidewinder[int barsAgo]
WoodiesCCI(IDataSeries inputData).Sidewinder[int barsAgo]

Return values representing the sidewinder plot value are as follows:

-1 = Warning
0 = Neutral
1 = Trending

Return Type
double; Accessing these methods via an index value [int barsAgo] returns the indicator value
of the referenced bar.

Parameters
inputData Indicator source data (?)

Examples

// Prints the current value of a 20 period WoodiesCCI using default price type

double value = WoodiesCCI(20)[0];

Print("The current WoodiesCCI value is " + value.ToString());

// Prints the current turbo value of a 20 period WoodiesCCI using default

price type

double value = WoodiesCCI(20).Turbo[0];

Print("The current WoodiesCCI turbo value is " + value.ToString());

-o-

Woodies Pivots
Definition
Woodies CCI Club pivots indicator.

Syntax
WoodiesPivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width)
WoodiesPivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode
priorDayHLC, int width)

Returns pivot point value
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WoodiesPivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).PP[
int barsAgo]
WoodiesPivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode
priorDayHLC, int width).PP[int barsAgo]

Returns R1 value
WoodiesPivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).R1[
int barsAgo]
WoodiesPivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode
priorDayHLC, int width).R1[int barsAgo]

Returns R2 value
WoodiesPivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).R2[
int barsAgo]
WoodiesPivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode
priorDayHLC, int width).R2[int barsAgo]

Returns S1 value
WoodiesPivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).S1[
int barsAgo]
WoodiesPivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode
priorDayHLC, int width).S1[int barsAgo]

Returns S2 value
WoodiesPivots(PivotRange pivotRangeType, HLCCalculationMode priorDayHLC, int width).S2[
int barsAgo]
WoodiesPivots(IDataSeries inputData, PivotRange pivotRangeType, HLCCalculationMode
priorDayHLC, int width).S2[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

Parameters
inputData Indicator source data (?)
pivotRangeType Sets the range for the type of pivot calculated. Possible values are:

PivotRange.Daily
PivotRange.Weekly
PivotRange.Monthly

priorDayHLC Sets how the prior range High, Low, Close values are calculated. Possible
values are:
HLCCalculationMode.CalcFromIntradayData
HLCCalculationMode.DailyBars
HLCCalculationMode.UserDefinedValues

Examples
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// Prints the current pivot point value

double value = WoodiesPivots(PivotRange.Daily, HLCCalculationMode.DailyBars,

20).PP[0];

Print("The current Pivots pivot value is " + value.ToString());

// Prints the current S2 pivot value

double value = WoodiesPivots(PivotRange.Daily, HLCCalculationMode.DailyBars,

20).S2[0];

Print("The current Pivots S2 pivot value is " + value.ToString());

-o-

ZigZag
Definition
The ZigZag indicator highlights trends based on user defined threshold values. You can access
methods within this indicator to determine the number of bars ago a zigzag high or low point
occured or the current zigzag value.

Syntax - Bars Ago

High Bar
ZigZag(DeviationType deviationType, double deviationValue,dbool useHighLow).HighBar(int
barsAgo, int instance, int lookBackPeriod)
ZigZag(IDataSeries inputData, DeviationType deviationType, double deviationValue,dbool
useHighLow).HighBar(int barsAgo, int instance, int lookBackPeriod)

Low Bar
ZigZag(DeviationType deviationType, double deviationValue,dbool useHighLow).LowBar(int
barsAgo, int instance, int lookBackPeriod)
ZigZag(IDataSeries inputDataDeviationType deviationType, double deviationValue,dbool
useHighLow).LowBar(int barsAgo, int instance, int lookBackPeriod)

Return Type
A int value representing the number of bars ago. Returns a value of -1 if a zigzag point is not
found within the look back period.

Syntax - Value

High Value
ZigZag(DeviationType deviationType, double deviationValue,dbool useHighLow).ZigZagHigh[
int barsAgo]
ZigZag(IDataSeries inputData, DeviationType deviationType, double deviationValue,dbool
useHighLow).ZigZagHigh[int barsAgo]

Low Value
ZigZag(DeviationType deviationType, double deviationValue,dbool useHighLow).ZigZagLow[
int barsAgo]
ZigZag(IDataSeries inputData, DeviationType deviationType, double deviationValue,dbool
useHighLow).ZigZagLow[int barsAgo]

Return Type
double; Accessing this method via an index value [int barsAgo] returns the indicator value of
the referenced bar.

* A return value of 0 (zero) indicates that a zigzag high or low has not yet formed
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Parameters
deviationType Possible values are:

DeviationType.Points
DeviationType.Percent

deviationValue The deviation value
useHighLow Determines if a bar's high/low value is used instead of the default value

(Close)
barsAgo The number of bars ago that serves as the starting bar and works

backwards
instance The occurence to check for (1 is the most recent, 2 is the 2nd most

recent etc...)
lookBackPeriod Number of bars to look back to check for the test condition
inputData Indicator source data (?)

Examples

// Prints the high price of the most recent zig zag high

Print("The high of the zigzag bar is " + High[Math.Max(0,

ZigZag(DeviationType.Points, 0.5, false).HighBar(0, 1, 100))]);

Source Code
You can open up the indicator source code via the NinjaScript Editor.

-o-

User Defined Methods

Overview
You can create user defined methods (global methods or functions) that can be accessed by
all custom indicators and strategies. User defined methods should ONLY be created if you
intend to re-use these methods over and over again across different custom indicators or
strategies. Otherwise, just code your method logic directly into your indicator or strategy.

UserDefinedMethods.cs
You can define and manage all of your user defined methods from within one of two available
UserDefinedMethods.cs files.

 There is one UserDefinedMethods.cs file that contain your user defined methods for custom
strategies

 There is one UserDefinedMethods.cs file that contain your user defined methods for custom
indicators

You can not share user defined methods created for custom strategies with custom indicators.
You can edit and manage the UserDefinedMethods.cs file via Tools-->Edit
NinjaScript-->Indicators or Tools-->Edit NinjaScript-->Strategies menus from within the
NinjaTrader Control Center window.

UserDefinedMethods.cs files have unique icons in the Indicators or Strategy Dialog windows.



p485

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Creating A Separate File Per User Defined Method (Function)
If you do not want to have one file that manages all of your user defined methods, you can
create a separate file for each user defined method.

1. Via Tools-->Edit NinjaScript-->Indicators open the "UserDefinedMethods" file
2. From within the NinjaScript Editor, right click and select the menu "Save As..."
3. From within the Dialog window, enter a name, for example "MyMethod"
4. Add your user defined method and then compile 

-o-

Sample 1
The following sample illustrates two user defined methods within the strategy
UserDefinedMethods.cs file. You can add methods or edit methods by:

1. Tools-->Edit NinjaScript-->Strategy... select UserDefinedMethods
2. Add or edit your method
3. From within the NinjaScript Editor, right click and select the menu "Compile"

In the image below, there are two user defined methods as examples:

1. IsMorningSession() method which checks if the bar time is in the morning trading session
2. HigherPrices() method which checks if there are n number of higher prices
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The following image illustrates the use of the two user defined methods from above in a
custom strategy.
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-o-

Sample 2
The following sample is a user defined method created in a separate file used for a custom
strategy. This method returns true or false depending if the current bar time is in a valid user
define trade time.

1. Tools-->Edit NinjaScript-->Strategy... select UserDefinedMethods
2. From within the NinjaScript Editor, right click and select the menu "Save As..."
3. Enter the name "ValidTradeTime" and press "OK"
4. Add the following code in the NinjaScript Editor

5. From within the NinjaScript Editor, right click and select the menu "Compile"

You have now created the user defined method "ValidTradeTime" that can be used within any
custom strategy.

6. From within a custom strategy you can call this user defined method as per the image
below.
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-o-

 C# Method (Functions) Reference
The Microsoft .NET environment has a rich class library that you can access when developing
custom indicators and strategies. There is a plethora of information available online and in
print that details class libraries in great depth. Below are quick links to the Microsoft
Developers Network for some of the basic classes whose functionality you may harness when
developing in NinjaScript.

Complete list of classes in the Microsoft .NET environment.

MSDN (Microsoft Developers Network) C# Language Reference
Keywords
Operators
Arrays

System.Math
Provides constants and static methods for trigonometric, logarithmic, and other common
mathematical functions.
Full list of members of the System.Math class.

// Example of the Max method of the System.Math class

int myInteger = Math.Max(10, 20);

Print("The larger value between 10 and 20 is " + myInteger.ToString());

System.DateTime
Represents an instant in time, typically expressed as a data and time of day.
Full list of members of the Sytem.DateTime structure.

// Example of the Now property member of the System.DateTime structure

DateTime startTime = DateTime.Now;

Print("Time elapsed is " + DateTime

.Now.Subtract(startTime).TotalMilliseconds.ToString() + " milliseconds.");

System.String
Represents text; that is, a series of unicode characters.
Full list of members of the System.String class.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpref/html/cpref_start.asp
http://msdn.microsoft.com/library/default.asp?url=/library/en-us/csspec/html/CSharpSpecStart.asp
http://msdn.microsoft.com/library/en-us/csref/html/vclrfCSharpKeywords_PG.asp?frame=true
http://msdn.microsoft.com/library/en-us/csref/html/vclrfCSharpOperators.asp?frame=true
http://msdn.microsoft.com/library/en-us/csref/html/vclrfarrayspg.asp?frame=true
http://msdn.microsoft.com/library/en-us/cpref/html/frlrfSystemMathMethodsTopic.asp?frame=true
http://msdn.microsoft.com/library/en-us/cpref/html/frlrfsystemdatetimememberstopic.asp?frame=true
http://msdn.microsoft.com/library/en-us/cpref/html/frlrfsystemstringmemberstopic.asp?frame=true
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// Example of the ToUpper() method of the System.String class

string myString = "ninjatrader";

Print("The following word is in uppercase " + myString.ToUpper());

-o-

Distribution: NinjaScript Import and Export

Distribution: NinjaScript  Import and Export
You can distribute custom indicators and strategies to any user of NinjaTrader.

-o-

Import
You should only import NinjaScript Archive files (.zip) that you have obtained from a trusted
source.

To import:

1. Just double click on the NinjaScript Archive file (.zip) and it will automatically start the
import process

or

1. From the Control Center window select the menu File > Utilities > Import NinjaScript to
open the Import NinjaScript dialog window

2. Select the file you want to import
3. Press the "Open" button

* Prior to NinjaTrader Version 6.5, NinjaScript Archive files had the file extension .zip. These
files can still be imported by following the 3 steps above

-o-

Export
You can export NinjaScript indicators and strategies for others to import in several formats:

 Source files - NinjaScript indicator and strategy source files that can be imported and
edited by others

 Assemblies - A compiled assembly (DLL) of NinjaScript indicators and strategies that "hide"
your source code

Exporting NinjaScript Indicators or Strategies as Source Files
You may want to provide other NinjaTrader users with source files of your NinjaScript
indicators or strategies in a format where they are able to view and edit them.

1. From the Control Center window select the menu File > Utilities > Export NinjaScript to
open the "Export NinjaScript" dialog window

2. Select the option "Export selected source files"
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3. Enter a user defined file name
4. Select all of the files that you want to export and either double click on them or press the

">" button
5. A list of all files that will be exported
6. Press the "Export" button to export the selected files
7. A NinjaScript Archive File (.zip) file will be created in My Documents\<NinjaTrader

Folder>\bin\Custom\ExportNinjaScript
8. The file can be imported by another NinjaTrader application on a different PC

Exporting NinjaScript Indicators or Strategies as an Assembly
You may want to provide other NinjaTrader users with access to your proprietary indicators or
strategies in a secure format preventing them from being able to see your proprietary source
code. You can do this by exporting your NinjaScript indicators as a compiled Microsoft .NET
assembly (DLL) file. 

 This is a great distribution option if your proprietary indicator or strategy files do not
reference external DLL's

 If your proprietary indicator or strategy references external DLL's then its advised to create
your own custom installer

1. From the Control Center window select the menu File > Utilities > Export NinjaScript to
open the "Export NinjaScript" dialog window

2. Select the option "Export compiled assembly of selected source files"
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3. You can optionally select "Protect compiled assemblies" (see additional "Protection"
information below)

4. Enter a user defined file name
5. Select all of the files that you want to export and either double click on them or press the

">" button
6. A list of all files that will be exported
7. Optionally enter information that describes the assembly
8. Press the "Export" button to export the selected files
9. A NinjaScript Archive File (.zip) file will be created in My Documents\<NinjaTrader

Folder>\bin\Custom\ExportNinjaScript
10.The file can be imported by another NinjaTrader application on a different PC

Protection
Although .NET DLL files are compiled which prevents users from being able to see your
proprietary source code, they are still subject to decompilation and reverse engineering
attempts. If you want a higher level of security, you can select the "Protect compiled
assemblies" option (step #3 above) which adds an additional layer of protection. This
additional protection layer is provided by RemoteSoft's Salamander .NET Protector product
and a valid license of their product is required to enable this option during the export process.
This product claims to completely stop MSIL disassembly and decompilation. We use it
oruselves and are extremely happy with it. We have worked out discount policy for
NinjaTrader customers. Their product sells for $1,800 USD but they will license their Protector
version for only $299 USD to NinjaTrader customers and partners. To take advantage of this
offer please send an email to info@remotesoft.com and in the subject include "Special
pricing for NinjaTrader customers".

-o-

Export Problems

http://www.remotesoft.com
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If you are having difficulties exporting NinjaScript it could be due to one of the following
reasons:

 NinjaScript compile error
 .NET referencing

NinjaScript Compile Error

If you receive the above error, you will need to compile your NinjaScript error-free before you
can export. To see if your NinjaScript file is error free, open the NinjaScript Editor (Tools Edit
NinjaScript) and press F5 to compile. If you are trying to check a NinjaScript Strategy created
from the Strategy Wizard you can do the same by finishing the wizard and seeing if you
receive the “Strategy successfully generated” message.

If you receive any errors when compiling you will need to address them before exporting. For
more information on compile errors please see this article.

.NET Referencing

If you are able to compile without errors and still experience exporting difficulties like the one
above, check to see if you receive an error similar to this in the Control Center logs:

"3/6/2009 9:25:30 AM|2|4|Error compiling export assembly:
C:\Users\NinjaTrader\Documents\NinjaTrader
6.5\bin\Custom\Indicator\MyCustomIndicator.cs(42,18) : error CS0118:
NinjaTrader.Indicator.SMA is a type but is used like a variable"

Note:  This error may have a different error code and message depending on which variant of
.NET you have installed. An error message indicative of this issue would include an indicator
name without quotation marks.

If you experience this error, please follow this procedure:

1. Take note of which indicator is referenced by the error. In the above example, it is the SMA
2. Go to your NinjaScript Export utility. (New ? Utilities ? Export NinjaScript…)
3. Under “Export objects”, select “System indicators”
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4. Add the indicator that was referenced in the error to the export list along with your custom
NinjaScript by pressing the > button
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5. Press the “Export” button to create your NinjaScript Archive File. If you receive the same
error again, repeat this procedure until you add all the referenced system indicators and are
able to successfully export your custom NinjaScript.

Note: If the indicator referenced in the error is another custom indicator you will need to
follow the same procedure to add the custom indicator.

-o-

Commercial Distribution

Overview
As a commercial developer, you can distribute your proprietary indicators and and strategies
to the growing universe of NinjaTrader users. This section contains information you should
understand before distributing your work to the public.

-o-

Licensing/User Authentication
NinjaTrader provides a free vendor license management service for user authentication to
qualified 3rd party developers. 

The service includes the following features:

 One method call within your NinjaScript indicator or strategy will enable the authentication
process

 GUI for license management
 Licenses are exclusively tied to a unique PC machine id value ensuring that licenses can't

be shared
 Create unique module names
 Licenses have time based expirations
 Create free trial periods

Qualifications include:

 You must be a commercial 3rd party developer
 Have a website
 Promote NinjaTrader on your website and meet our minimum advertising requirements

For more information please contact sales@ninjatrader.com.

-o-

Best Practices
The following are what we suggest for best practices.

1. Do not deploy NinjaScript Source Files - If you are a commercial vendor you should
never distribute the NinjaScript .cs source code files even if your IP is contained within an
assembly or proprietary DLL. Source code files are editable by users and can result in
unnecessary support issues.

2. Naming Conventions - Please use consistent naming convention with your indicators and
strategies. We suggest adding a prefix to an indicator name. If your company name is
"Hyper" you could name your indicators "HyperTrend" or "HyperOscillator" for example.

3. Clean up your resources - Always free up resources such as external windows DLL's or
license management related resources. Resources should be freed within the Dispose()
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method. NinjaTrader calls this method as an indicator or strategy is no longer used.
4. User Authentication Trigger - If you have proprietary user authentication process

ensure that it is triggered within the OnBarUpdate() method. This ensures that users are
not forced to endure unnecessary delays on NinjaTrader start up or dialog windows that
display available indicators and strategies are loaded. NinjaTrader, LLC provides a free
licensing service for qualified 3rd party developers.

5. User Authentication Check State - A license check should only be performed once and
maintain its check state.

6. User Authentication Time Out - A license check should have a time out in case of
internet issues. This ensures that NinjaTrader does not lock up.

7. Custom Installer - If you provide a custom installer, the installer should not overwrite
any NinjaTrader deployed files (such as UserDefinedMethods.cs) and you should provide an
uninstall option which removes all installed files

8. Test on Windows XP, Vista and 2000 - NinjaTrader customers run on XP, Vista and
2000 and you should make sure that your indicators, custom installers and external DLLs
(if any are used) properly run on all operating systems

9. Expose Indicator States - If your proprietary indicator acts as a trend state (green bars
are bullish, red bearish) its good practice to expose the indicators's state so that
consumers of your indicators can use them within their own custom indicator or strategy.

-o-

Distribution Procedure
You must first determine if our standard "Export" feature is sufficient for distribution purposes
or if you need to create your own custom installer.

If...

 Your proprietary indicator or strategy files DO NOT reference external DLL's
 You do not require any custom or unique processes during an installation such as

requesting user information

Then we suggest exporting your indicators or strategies as an assembly using our standard
export feature. Otherwise follow the instructions below for correct distribution.

Distributing Custom Indicators
NinjaTrader makes it easy for consumers of your custom indicators to use your indicators
within their own custom indicators and/or strategies. To make this possible, the NinjaScript
Editor automatically generates the required code to make this happen. If you have developed
your custom indicator within the NinjaScript Editor you can skip over this section however, if
you have developed outside of the NinjaScript Editor, it is important that you follow these
instructions.

1. Transfer your code to the NinjaScript Editor and save the file
2. During either the save or compile process, code is generated in a new region in your
indicator file as per the image below



p496

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Vendor File
A vendor file is only releveant for distribution of custom indicators. You can skip over this is
you are distributing a strategy. In order to allow your custom indicators to be called as a
method from within a users custom indicator or strategy it is necessary to create a vendor
file. Please name this file "NinjaTrader.YourName.cs". The contents of this file contain
program code (partial classes) that make your indicator methods available to your users. This
additional code acts as a wrapper and only enables your indicators to be used within other
indicators and strategies and DOES NOT EXPOSE ANY OF YOUR PROPRIETARY
PROGRAMMMING CODE.

To create a vendor file follow these steps:

See the file: "Program Files\<NinjaTrader Folder>\bin\Backup\NinjaTrader.Vendor.cs file for
reference sample.

1. Open Microsoft Notepad or any other text editor
2. Copy the code from Figure 1 below into the text editor
3. Open each one of your custom indicators and copy the NinjaScript generated code within
the region "NinjaScript generated code. Neither change nor remove." to the text editor.
4. Save this file as "NinjaTrader.YourCompanyName.cs" where "YourName" is the name of
your company or product as per the naming conventions section.

Figure 1

#region Using declarations

using System;

using System.ComponentModel;

using System.Drawing;

using System.Drawing.Drawing2D;

using System.Xml.Serialization;

using NinjaTrader.Data;

using NinjaTrader.Gui.Chart;

#endregion

Creating a Compiled .NET Assembly (DLL)
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You should distribute your proprietary indicator or strategy files as a compiled .NET assembly
(DLL) which does not expose your proprietary programming code. To safeguard against
decompilation or reverse engineering, you can add additional layers of security to protect
your intellectual property through 3rd party tools.

From within the folders: 

My Documents\<NinjaTrader Folder>\bin\Custom\Indicator
My Documents\<NinjaTrader Folder>\bin\Custom\Strategy
My Documents\<NinjaTrader Folder>\bin\Custom\MarketAnalyzer

1. Temporarily remove any irrelevant .cs files that are not required for the custom assembly
you wish to distribute with the exception of any system .cs files which are marked with a "@"
prefix
2. Open any indicator or strategy compile it which will create a new assembly (DLL) that
contains only the relevant indicators, strategies and Market Analyzer columns
3. Make a copy of the file "My Documents\<NinjaTrader
Folder>\bin\Custom\NinjaTrader.Custom.dll" and rename it (myCustomObject.dll for
example)

You now have created your DLL.

Distribution of your Assembly
You should now have the following 

 YourCompanyName.dll (compiled assembly)

If you are distributing Indicators you should also have the following:

 NinjaTrader.YourCompanyName.cs (vendor file)

These files need to be saved on the end users PC in the following folder:

My Documents\<NinjaTrader Folder>\bin\Custom

You can either create a custom installer that installs these files on the user PC or provide
them with instructions to receive and save the files in the folder specified above.

Critical: It is important to let your customers know that NinjaTrader Version 6 indicators and
strategies are NOT compatible with NinjaTrader Version 5.

Using 3rd Party Indicators in a Custom Indicator or Strategy
Once your custom indicators are installed on the user's PC, please let them know that in order
to access the methods contained in your custom DLL they must add a reference to this DLL
via the NinjaScript Editor right mouse click context menu, sub menu "References" and then
add your custom DLL as a reference. This only needs to be done once since adding a
reference to your DLL is via the NinjaScript Editor is a global setting. See the section
Developing Strategies > "Using 3rd Party Indicators".

-o-
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DLL Security
DLL Security
Although .NET DLL files are compiled which prevents users from being able to see your
proprietary source code, they are still subject to decompilation and reverse engineering
attempts. If you want a higher level of security, we suggest adding an additional layer of
protection for your intellectual property through the use of the following 3rd party tool below.

RemoteSoft (www.remotesoft.com)
NinjaTrader uses and recommends their Salamander .NET Protector. This product claims to
completely stop MSIL disassembly and decompilation. We use it and are extremely happy
with it. We have worked out discount policy for NinjaTrader customers. Their product sells for
$1,800 USD but they will license their Protector version for only $299 USD to NinjaTrader
customers and partners. To take advantage of this offer please send an email to
info@remotesoft.com and in the subject include "Special pricing for NinjaTrader customers".

NOTE: We have tested multiple 3rd party obfuscation and protecion tools. The
product listed above is the only one that we did not run into issues with and thus we
ONLY recommend and highly suggest you use this one.

-o-

NinjaScript Editor

Overview
The NinjaScript Editor is a powerful scripting editor that allows you to create custom
indicators and strategies efficiently.

1. Caption bar - Displays file type (strategy or indicator) and file name
2. Tool bar - Moving your mouse over each icon will display the function of the icon button
3. Line numbers
4. Line modification marking - Yellow flags unsaved line modifications where green flags
saved modifications

www.remotesoft.com
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-o-

Intellisense
What is Intellisense?
Intellisense is a form of automated autocompletion popularized by the Microsoft Visual Studio
Integrated Development Environment. It also serves as documentation 
and disambiguation for variable names, functions and methods. Intellisense is built into the
NinjaScript Editor resulting in an efficient environment to code your custom indicators and
strategies.
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Accessing the Intellisense List Box
Within the NinjaScript Editor you can type "this." to bring up the Intellisense list box. The list
box contains all methods (functions) and properties available for use. You can select a
method or property by simply selecting it via your mouse, or scrolling with your up or down
arrow key. Pressing either the "Tab" or "Enter" key will automatically insert the code into the
NinjaScript Editor. While in the list box, you can press any letter key to rapidly scroll down to
the next property or method beginning with the letter of the key you pressed.

In the image below:

1. A property
2. A method

If you know that you want to access the Simple Moving Average indicator method which is
SMA(), you think it starts with "SM" in "SM" and press CTRL-SpaceBar which would display
the Intellisense list box below.

Pressing CTRL-SpaceBar after any text will always either:

 Bring up the Intellisense list box with related methods and properties
 Automatically insert code if the text can uniquely identify a method or property
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Method Description and Signatures
When selecting a method:

1. Type in "(" to display the method description and signature
2. A light yellow colored frame will appear with the method description and availabe
signatures
3. In the image below you will see "2 of 2" which means that we are looking at the 2nd of 2
available method signatures. You can scroll through all available signatures by pressing on
the arrow up and down keys.

What is a method signature? A method signature is a common term used in object-orientated
programming to uniquely identify a method. This usually includes the method name, the
number and type of its parameters and its return type.

From the image below, the DMI() method which represents the Dynamic Momentum Index
indicator has two method signatures:

DMI(int period)
DMI(IDataSeries inputData, int period)

Accessing Method and Property Descriptions
You can hover your mouse cursor over any method or property in the NinjaScript Editor to
display any associated description.

-o-

Code Snippets
Code Snippet Shortcuts
You can quickly add commonly used methods and code structures via 
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 Short cut characters
 Right mouse button click context menu "Insert Code Snippet"
 Pressing the F2 key on your keyboard

Via keyboard:
Enter the text in the left column and press the "Tab" key within the NinjaScript Editor.

Current Bar Values
cb CurrentBar
o Open[0]
h High[0]
l Low[0]
v Volume[0]

Previous Bar Values
c1 Close[1]
o1 Open[1]
h1 High[1]
l1 Low[1]
v1 Volume[1]

Arithmetic
abs Math.Abs(value)
min Math.Min(value1, value2)
max Math.Max(value1, value2)

Control Statements
if if (expression)

{

}
else
{

}
for for (int index = 0; index < count; index++)

{

}
switch switch (expression)

{
    case value1:
        
        break;
    case value2:

        break;
    default:

        break;
}

Drawing
dd DrawArrowDown("MyArrowDown", 0, High[0], Color.Red);
du DrawArrowUp("MyArrowUp", 0, Low[0], Color.Red);
ddi DrawDiamond("MyDiamond", 0, High[0] + 2 * TickSize, Color.Blue);
dt DrawDot("MyDot", High[0] + 2 * TickSize, Color.Blue);
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de DrawEllipse("MyEllipse", 10, Low[10], 0, High[0], Color.Blue);
di DrawExtendedLine("MyExtendedLine", 10, Close[10], 0, Close[0],

Color.Blue);
df DrawFibonacciLevels("MyFibonacciLevels", 10, Close[10], 0, Close[0]);
dh DrawHorizontalLine("MyHorizontalLine", Close[0], Color.Blue);
dl DrawLine("MyLine", 10, Close[10], 0, Close[0], Color.Blue);
dy DrawRay("MyRay", 10, Close[10], 0, Close[0], Color.Blue);
dr DrawRectangle("MyRectangle", 10, Low[10], 0, High[0], Color.Blue);
ds DrawSquare("MySquare", 0, High[0] + 2 * TickSize, Color.Blue);
dx DrawText("MyText", "Sample text ", 0, High[0] + 2 * TickSize,

Color.Blue);
dtd DrawTriangleDown("MyTriangleDown", 0, High[0] + 2 * TickSize,

Color.Red);
dtu DrawTriangleUp("MyTriangleUp", 0, Low[0] - 2 * TickSize, Color.Blue);
dv DrawVerticalLine("MyVerticalLine", 0, Color.Blue);

Via mouse or pressing the "F2" key:

Right click on the NinjaScript Editor and select the menu "Insert Code Snippet"

A menu will display all available code snippets.
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-o-

Automatically Inserting Actions and Conditions
The NinjaScript Editor can automatically generate code for you by accessing the right mouse
button click context menu sub menu's "Insert Action..." and/or "Insert Condition...". These
features  can help you in your learning curve of NinjaScript and C# and also provide correct
syntax in the event that you need a little assistance.

Using the image below for an example:

1. After typing in "if (" right mouse button click and select "Insert Condition..."
2. The Condition Builder will appear which allows you to point and click to create conditions.
Below we have build a condition that checks to see if the 5 period EMA has crossed above the
15 period EMA within the last bar.
3. Press "OK" to have the Condition Builder generate the NinjaScript program code
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The result is the code generated below.

-o-

Compile Errors
When compiling a custom indicator or strategy it is possible and likely that you will generate
compile errors.

 NinjaTrader will compile ALL NinjaScript files NOT only the file you are working on
 A list of compile errors for all files will be displayed in the lower portion of the NinjaScript

Editor
 Double click on an error will load the problem file and highlight the problem area
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 Click on the error code to bring up Help Documentation on a specific error

The image below illustrates a compile error:

1. Section where compile errors are displayed. Errors in the current loaded file are color coded
a light color while errors in other files have a darker color code.
2. The file that contains the error
3. A description of the error
4. A error code link that will open the Help Guide with any relevant error code information
5. Line number and column number of the error
6. Error is underlined with a red wavy line

The error highlighted by icon (6) below shows that the expression is not closed with a
semicolon. The expression should be

double myValue = SMA(20)[0];

-o-

Visual Studio Debugging
You can debug your NinjaScript objects using Microsoft Visual Studio 2005 or higher.
 Debug Mode" disabled so your DLL is compiled as a release version.

 The Express versions of Visual Studio are not supported
 NinjaScript objects are compiled into a single DLL, when debugging, a Debug DLL is

created which does carry performance impact. Please ensure once you are done with
debugging that you recompile with "

1. In the NinjaScript Editor enable "Debug Mode"
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2. From within Microsoft Visual Studio select Debug > Attach to Process... and select
NinjaTrader from the process list and press the "Attach" button
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3. Open the NinjaScript source file within Microsoft Visual Studio and set your break point(s)

4. Run your NinjaScript object in NinjaTrader and it should stop at your break points and all
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the debugging tools and information should be available to inspect the current state of the
code.

-o-

Compile Error Codes

CS0019
The following CS0019 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
Strings cannot be compared with relational operators (<, >, <=, >=, ==, !=) to other object
types. Strings can only be compared to other strings and only through the use of equality
operators (==, !=).

Error Description #1
Operator '==' cannot be applied to operands of type 'string' and 'int'

// Erroneous Sample Code – Cannot compare a string to an

integer

if ("string" == 5)

// Resolution Sample Code – Compare a string with another

string

if ("string" == intValue.ToString());

Error Description #2
Operator ‘<’ cannot be applied to operands of type ‘string’ and ‘double’

// Erroneous Sample Code - Cannot compare a string to a double

if ("string" >= 1.2)

// Resolution Sample Code - Testing to see if the strings are

not the same

if ("string" != "string2")

Error Description #3
Operator ‘>’ cannot be applied to operands of type ‘string’ and ‘string’

// Erroneous Sample Code - Cannot quantitatively compare a

string to another string

if ("string" > "string2")

// Resolution Sample Code - Testing to see if both strings are

the same

if ("string" == "string2")

Additional Error Descriptions
Operator ‘<’ cannot be applied to operands of type ‘string’ and ‘string’
Operator ‘<=’ cannot be applied to operands of type ‘string’ and ‘string’
Operator ‘>=’ cannot be applied to operands of type ‘string’ and ‘string’
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-o-

CS0021
The following CS0021 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This is a common error when calling indicators methods. It occurs when an indicator is called
without its required parameter arguments before accessing an indexed value.

To fix this error you will need to first pass to the indicator method all the necessary parameter
arguments. You can do this with '()' after the indicator name. Please note that you will still
need to pass an empty parameter argument list even if your indicator requires no arguments.

Error Description #1
Cannot apply indexing with [] to an expression of type 'method group'

EXAMPLE #1

// Erroneous Sample Code - SMA is an indicator and requires

parameter arguments

double value = SMA[0];

// Resolution Sample Code -  SMA() properly called

double value = SMA(14)[0];

EXAMPLE #2

// Erroneous Sample Code - EMA is an indicator and requires

parameter arguments

double maDelta = EMA[0] - EMA[1];

// Resolution Sample Code -  SMA() properly called with an

overload method (one of several variations)

double maDelta = EMA(High, 14)[0] - EMA(High, 14)[1];

-o-

CS0029
The following CS0029 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you try to convert from one 'type' to another 'type'.

To fix this error, ensure that you are assigning the correct value type.

Error Description #1
Cannot implicitly convert type 'int' to 'bool'
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// Erroneous Sample Code - 'CurrentBar' is an integer

if (CurrentBar) 

// Resolution Sample Code - Compares an integer with another

integer

if (CurrentBar < 1) 

Error Description #2
Cannot implicitly convert type 'double' to 'bool'

// Erroneous Sample Code – Close[0] returns a double value

if (Close[0])

// Resolution Sample Code – Compares a double with another

double

if (Close[0] > Close[1])

Error Description #3
Cannot implicitly convert type 'NinjaTrader.Indicator.SMA' to 'double'

// Erroneous Sample Code - Incorrect since assigning an

indicator to a variable of double type

double myValue = SMA(20);

// Resolution Sample Code - Correct expression since we are

accessing the current bar's value of the SMA indicator

double myValue = SMA(20)[0];

-o-

CS0103
The following CS0103 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
When a variable is used before declaration, the compiler will not know what it is. This error is
also commonly invoked by typos.

Please ensure that you have declared your variables prior to using them. If variables are
declared or properties already exist, please check for typos.

Error Description #1
The name 'identifier' does not exist in the current context

EXAMPLE #1

// Erroneous Sample Code - 'CurentBar' does not exist since it

has been spelled incorrectly (missing an 'r')

if (CurentBar < 10)

// Resolution Sample Code - 'CurrentBar' exists since it is

spelled correctly

if (CurrentBar < 10)
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EXAMPLE #2

// Erroneous Sample Code - 'newVariable' is not declared

newVariable = 10; 

// Resolution Sample Code - 'newVariable' is now declared as

an integer

int newVariable = 10; 

-o-

CS0117
The following CS0117 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you try to use a method or access an exposed property that does
not exist for your particular object.

Please check the methods and exposed property available for your particular object.

Error Description #1
'double' does not contain a definition for 'Set'

// Erroneous Sample Code - DataSeries object’s value does not

have a Set() method. Only a DataSeries object does

SMA(5)[0].Set(5);

// Resolution Sample Code - DataSeries using the Set() method

Plot0.Set(SMA(5)[0]);

Error Description #2
'NinjaTrader.Indicator.CurrentDayOHL' does not contain a definition for 'CurentOpen'

// Erroneous Sample Code - CurrentDayOHL()’s property is

'CurrentOpen' not 'CurentOpen' (typo)

double value = CurrentDayOHL().CurentOpen[0];

// Resolution Sample Code - 'CurrentOpen' property available

double value = CurrentDayOHL().CurrentOpen[0];

-o-

CS0118
The following CS0118 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can happen when you use a '()' instead of '[]' for indexing when you reference
indicators or properties.

To fix this error, please replace the round brackets '()' with the proper square brackets '[]'.



p513

© NinjaTrader, LLC, 2005

www.ninjatrader.com

Error Description #1
'NinjaTrader.Indicator.IndicatorBase.Close' is a 'property' but is used like a 'method'

// Erroneous Sample Code - Miscall of Close property due to

use of round brackets

double value = Close(0);

// Resolution Sample Code - Proper call of Close property

double value = Close[0];

-o-

CS0200
The following CS0200 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error is most common when you try to assign values to a particular DataSeries index
through the use of assignment operators (=). Since DataSeries objects have their values set
through the Set() method, you cannot modify the value after it has been set through the use
of assignment operators.

DataSeries indexed values are read only and cannot be changed through assignment
operators. If you wish to set the latest value of the DataSeries please use the Set() method.

Error Description #1
Property or indexer 'NinjaTrader.Data.IDataSeries.this[int]' cannot be assigned to -- it is read
only

EXAMPLE #1

// Erroneous Sample Code - Cannot reassign values to

DataSeries indexed value

Close[0] = 25;

// Resolution Sample Code - Assigns value to a DataSeries

myClose.Set(25);

EXAMPLE #2

// Erroneous Sample Code - Cannot reassign values to

DataSeries indexed value and cannot have an if statement based

// on an assignment operator

if (Close[0] = Open[0]) 

// Resolution Sample Code - Properly compares two DataSeries

values

if (Close[0] == Open[0])  

-o-

CS0201
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The following CS0201 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you make a statement solely from an indicator or variable call.

You will need to do something with the value you called for the statement to be complete.

Error Description #1
Only assignment, call, increment, decrement, and new object expressions can be used as a
statement

// Erroneous Sample Code - Statement that does nothing

SMA(5)[0];

// Resolution Sample Code -  'currentSMA' takes on the current

bar's SMA(5) value

double currentSMA = SMA(5)[0]; 

-o-

CS0234
The following CS0234 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when an imported dll (could be a 3rd party indicator) you are referencing
no longer exists/has been removed. 

To resolve this the dll must be re-imported.

To re-import a 3rd party dll:

1. Open the NinjaScript Editor via Tools > Edit NinjaScript and selecting any indicator or
strategy

2. Right mouse click in the NinjaScript Editor and select the menu "References"
3. In the "References" dialog window press the button "Add"
4. Select the 3rd party dll

Error Descriptions
The type or namespace name '<name>' could not be found (are you missing a using directive
or an assembly reference?)
The type or namespace name '<name>' does not exist in the namespace
'NinjaTrader.Indicator' (are you missing an assembly reference?)

-o-

CS0246
See CS0234.

-o-

CS0428
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The following CS0428 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you miscall a method such as indicator methods.

If you are calling an indicator please ensure that you have both the parameters '()' and the
indexing value '[]' set. For other methods please ensure you pass all required parameters
through the parameters set '()'.

Error Description #1
Cannot convert method group 'SMA' to non-delegate type 'double'. Did you intend to invoke
the method?

EXAMPLE #1

// Erroneous Sample Code - SMA() indicator method is

improperly called

double myValue = SMA;

// Resolution Sample Code - SMA() indicator method is properly

called

double myValue = SMA(5)[0];

EXAMPLE #2

// Erroneous Sample Code - ToString is a method and requires

round brackets () to be properly called

string str = Close[5].ToString; 

// Resolution Sample Code - ToString() is properly called

string str = Close[5].ToString();  

-o-

CS0443
The following CS0443 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error is most commonly invoked when no index value is used inside the indexing
brackets.

Please ensure you place a value inside the '[]'.

Error Description #1
Syntax error, value expected

// Erroneous Sample Code - Missing index value

double myValue = SMA(20)[];

// Resolution Sample Code - 'myValue' takes on the current

bar's SMA(20) value

double myValue = SMA(20)[0];

-o-
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CS0665
The following CS0665 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you mistake using assignment (=) instead of checking for equality
(==).

Please ensure that you use (==) when checking if two objects are equal.

Error Description #1
Assignment in conditional expression is always constant; did you mean to use == instead of
= ?

// Erroneous Sample Code - Incorrect since the expression is

assigning a value of 'true' to the property Historical

if (Historical = true)

    // Do something

// Resolution Sample Code - Correct

if (Historical == true)

    // Do something

-o-

CS1002
The following CS1002 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can be invoked when statements are not ended properly.

All statement lines must be closed with a semicolon.

Error Description #1
; expected

// Erroneous Sample Code - Statement is not closed

double myValue = SMA(20)[0]

// Resolution Sample Code - Statement is closed

double myValue = SMA(20)[0];

-o-

CS1501
The following CS1501 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you use use an overload (method parameter signature) that does
not exist. This could either be because you are passing in 3 arguments when the method only
requires 2.
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You can cycle through the available overloads with the use of the up and down arrows on the
Intellisense when you call an indicator method or any other method.

Error Description #1
No overload for method 'SMA' takes '0' arguments

EXAMPLE #1

// Erroneous Sample Code - SMA() does not contain an overload

that has 3 arguments

double myValue = SMA(Close, 5, 2)[0];

// Resolution Sample Code -  SMA() has an overload consisting

of 2 arguments

double myValue = SMA(Close, 5)[0];

EXAMPLE #2

// Erroneous Sample Code - EMA() does not contain an overload

that has 0 arguments

double myValue = EMA()[0]; 

// Resolution Sample Code - EMA() has an overload consisting

of 1 argument

double myValue = EMA(5)[0];  

-o-

CS1503
The following CS1503 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you try to assign a value to a DataSeries that is not a double value
type.

Please ensure you are passing in or double in the Set() method. DataSeries objects can only
contain double values.

Error Description #1
Argument '1': cannot convert from 'string' to 'double'

// Erroneous Sample Code - Cannot pass in a string to a

DataSeries Set() method

Value.Set("Close[0]");

// Resolution Sample Code - Sets DataSeries to the current

bar's Close value

Value.Set(Close[0]);

Error Description #2
Argument '1': cannot convert from 'NinjaTrader.Indicator.SMA' to 'double'
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// Erroneous Sample Code - Cannot pass in a DataSeries object

to a DataSeries Set() method

Values[0].Set(SMA(20));

// Resolution Sample Code - Sets DataSeries to the current

bar's SMA(20) value

Values[0].Set(SMA(20)[0]);

-o-

CS1502
The following CS1502 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can occur when you pass in incorrect parameter object types into a method such as
an indicator.

Please check the overload methods for the proper parameter object types and pass in the
proper object. You can check the overload methods with NinjaScript editor’s Intellisense when
you call a method.

Error Description #1
The best overloaded method match for 'NinjaTrader.Data.DataSeries.Set(double)' has some
invalid arguments

// Erroneous Sample Code - Close is a DataSeries object type

and is not a valid value to the Set() method

Plot0.Set(Close);

// Resolution Sample Code - The Set() method takes a double

value so pass in Close[0]

Plot0.Set(Close[0]);

Error Description #2
The best overloaded method match for
'NinjaTrader.Indicator.Indicator.SMA(NinjaTrader.Data.IDataSeries, int)' has some invalid
arguments

// Erroneous Sample Code - Using an integer when the first

parameter should be a DataSeries

double myValue = SMA(5, 5);

// Resolution Sample Code - 'myValue' will take the value of

the current bar's SMA

double myValue = SMA(Close, 5)[0];

-o-

CS1513
The following CS1503 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error is most common with chaining if-else or loop statements.
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Please check all code segments and statements are closed. Every opening curly brace '{'
needs a matching closing curly brace '}' .

Error Description #1
} expected

// Erroneous Sample Code - If statement is not closed

if (CurrentBar < 1)

{

    // Do something

 <--- Missing closing curly brace

// Resolution Sample Code - If statement is closed

if (CurrentBar < 1)

{

    // Do something

}

-o-

NT0019
The following NT0019 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
This error can happen when a DataSeries is compared to another object via the use of
relational operators. Relational operators (==, <, >, <=, >=) can be used to compare the
values of the DataSeries but not the DataSeries object itself.

To fix this error ensure that you are actually comparing the values of the DataSeries to
another object. You can do this by adding the index value to the DataSeries call. The index
value is on a zero-based referencing system. [0] references the latest bar while [1] references
one bar ago and [2] references two bars ago.

Error Description #1
Operator '>' cannot be applied to operands of type 'NinjaTrader.Data.IDataSeries' and 'int'

// Erroneous Sample Code - DataSeries objects cannot be

compared with integers

if (Close == 5)

// Resolution Sample Code - Checks to see if the current close

is equal to 5

if (Close[0] == 5) 

Error Description #2
Operator '==' cannot be applied to operands of type 'int' and 'NinjaTrader.Data.IDataSeries'

// Erroneous Sample Code - DataSeries objects cannot be

compared with each other

if (Close > Open)

// Resolution Sample Code - Checks to see if the current bar’s

close is greater than the current bar’s open

if (Close[0] > Open[0]) 
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Error Description #3
Operator '>' cannot be applied to operands of type 'NinjaTrader.Data.IDataSeries' and
'NinjaTrader.Data.IDataSeries'

// Erroneous Sample Code - DataSeries objects cannot be

compared with doubles

while (Low < Close[1])

// Resolution Sample Code - While the current low is less than

the previous close continue with this code segment

while (Low[0] < Close[1])

-o-

NT0029
The following NT0029 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
DataSeries objects cannot be converted to another object type implicitly. You cannot simply
assign the DataSeries object to an integer or a double. Please keep in mind that this does not
mean the DataSeries cannot carry values that are integers or doubles, it just means you
cannot assign the DataSeries itself to an integer or double.

To properly assign the values of a DataSeries to a variable, ensure you have included the
index value to the DataSeries object.

Error Description #1
Cannot implicitly convert type 'NinjaTrader.Data.IDataSeries' to 'double'

// Erroneous Sample Code - Cannot set a DataSeries object to a

double value

double closeValue = Close;

// Resolution Sample Code - Assign the value at index 0

(current bar)

double closeValue = Close[0];

Additional Error Descriptions
Cannot implicitly convert type 'double' to 'NinjaTrader.Data.IDataSeries'
Cannot implicitly convert type 'NinjaTrader.Data.IDataSeries' to 'int'
Cannot implicitly convert type 'int' to 'NinjaTrader.Data.IDataSeries'
Cannot implicitly convert type 'NinjaTrader.Data.IDataSeries' to 'bool'
Cannot implicitly convert type 'bool' to 'NinjaTrader.Data.IDataSeries'

-o-

NT1503
The following NT1503 error code information is provided within the context of NinjaScript. The
examples provided is only a subset of potential problems that this error code may reflect. In
any case, the examples below provide a reference of coding flaw possibilities.

Error Code Explanation
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This error can occur when you try to set the value of a DataSeries object to another
DataSeries. DataSeries objects can only take on values that are integers or doubles.

To ensure you are not setting the value of your DataSeries object to another DataSeries
object, use an index value on the DataSeries object that contains the value you want.

Error Description #1
Argument '1': cannot convert from 'NinjaTrader.Data.IDataSeries' to 'double'

// Erroneous Sample Code – Cannot set a DataSeries to another

DataSeries

Value.Set(Low);

// Resolution Sample Code – Assign the value at index 1

(previous bar)

Value.Set(Low[1]);

Additional Error Descriptions
Argument '1': cannot convert from 'int' to 'NinjaTrader.Data.IDataSeries'

-o-

No Documentation Available
Unfortunately we do not have NinjaScript context based Help information on this specific error
code. You can check the Microsoft MSDN site section on error codes for futher information.

-o-

Options

Options Overview
The Options window allows you to set your global NinjaTrader application options and
preferences. The Options window is accessible via the Tools-->Options menu from within the
Control Center window.

-o-

General Tab
The General tab sets general application options.

http://msdn2.microsoft.com/en-us/library/5feh24w0(VS.71).aspx
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Sounds Enables or disables various application sound events
Confirm order
placement

Enables or disables order confirmation dialog window

Show diagnostics tab Enables or disables the display of the diagnostics tab
Show tool tips Enables or disables showing tool tips
Use last price for P/L When enabled, the last trade price is used to calculate profit and loss

values.
When disabled, the bid is used for long positions, the ask is used for
short positions.

Apply commission to
P/L calculations

Enables or disables commissions to be included in profit and loss
displays

Use FIFO for position
avg. price calculations

Enables or disables calculation of position average entry price based
on the FIFO (First in First Out) method.

-o-

Strategies Tab
The Strategies tab sets options regarding handling of ATM Strategies and NinjaScript
strategies for automated system trading.
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Modify inner bracket When enabled and scaling into a position strategy, the inner bracket
(stop loss and profit target orders) quantities will be modified to
reflect the increased position strategy size else the outer bracket is
modified

Modify nearest
bracket

When enabled, the nearest bracket (stop loss and profit target orders)
quantities are modified when changing the quantity of a stop loss or
target order in a multi target strategy. This property is used in
conjunction with "Modify inner bracket". For example, if both "Modify
inner..." and "Modify nearest..." are enabled and you modify target 2
from 1 contract to 2 contracts, target 1 order size will be reduced by
1. If you had "Modify inner..." disabled, target 3 order size will be
reduced by 1.

Use last price for auto
trail and auto
breakeven

When enabled, the last trade price is used to trigger auto trail or auto
breakeven functions. When disabled, the bid is used for long positions,
the ask is used for short positions.

Wait until flat before executing live
When a NinjaScript strategy that relies on historical data to calculate it's current position and
orders state is started, it will wait until the strategy position has a flat position before
executing any live orders. 

Immediately submit live working historical orders
When a NinjaScript strategy that relies on historical data to calculate it's current position and
orders state is started, it will immediately submit live any working orders that reflect the
current strategy's overall order state. It is IMPORTANT to understand that the position of the
strategy reported in the Strategies tab may not reflect the actual account-based position
reported in the Accounts tab at the time the strategy is started. Should you wish to
synchronize your strategy position with your account position you will have to manually place
an order to your account via the Control Center Orders tab.

Seconds before session end
If a NinjaScript strategy's "Exit on close" property is enabled, the strategy will close the
current strategy position and send cancel requests for all strategy submitted working orders.
"Seconds before session end" determines how many seconds prior to the session end time the
"Exit on close" routine is triggered.
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Stop & target submission - Per entry execution
When a NinjaScript strategy submits stop and target orders, it will do so on each incoming
execution (fill) in real-time. For example, if you have a 2 lot limit order working that has a
partial fill of 1 and another partial fill of 1 five seconds later, the strategy will have submitted
two separate 1 lot stop loss orders and two separate 1 lot profit target orders.

 Upside is that individual orders are immediately sent to the market taking advantage of
the FIFO principle where first orders in are the first to get filled

 Downside is that if your strategy trades large volume and you receive a lot of partial fills,
the strategy will be managing a lot of live orders, the more orders the more potential
things that can go wrong

Attention Equity Traders: This option is NOT suggested since it can result in seriously
increased commissions depending on your commission plan. For example, if you are charged
$9.95 per order and you trade 1000 shares and have 10 partials for 100 shares each, you will
have 10 stops and targets for 100 shares each instead of 1 stop and target pair for 1000
shares. Once filled the difference would be $9.95 x 10 vs $9.95.

* This setting can be overridden

Stop & target submission - By strategy position
When a NinjaScript strategy submits stop and target orders, it will submit only one stop and
target and ammend the quantity of these orders as incoming entry executions are reported.

 Downside is that each time the stop and target quantity is ammended the order is
re-inserted at the end of the exchange order queue

 Upside is there are less orders to manage making things more simple with less exposure
for things to go wrong

 Upside is that it can be seriously less expensive in commissions for equity traders

Cancel strategy orders on strategy termination
When a NinjaScript strategy is terminated (stops running) cancel requests to cancel all
strategy submitted working orders are sent. 

-o-

Simulator Tab
The Simulator tab sets options for the NinjaTrader simulation engine.

The account section sets account options.
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Account

Delay comm. (msec)* Simulated delay of sending an order from your PC to a virtual
exchange server

Delay exchange
(msec)*

Simulated delay of a virtual exchange server processing an order

Initial cash Start cash value of your simulation account

Margin

Maintenance margin

Wait for data (secs) Sets the time that the simulator will wait for market data to come in
to trigger simulation before it rejects the order

Futures margin Sets a global property for the required margin all futures contract
(there is an instrument level over ride for this property)

*Delays are not effective in Market Replay

The Misc sections sets miscellaneous simulator options.

Misc

Always start in
simulation

Enables or disables the application always starting in global
simulation mode as default

Enforce partial fills Enables or disables the forcing of partial fills on each order. If
enabled, orders will always get filled with partial fills. When disabled
orders are filled completely or partially depending on trade volume.

Enforce immediate
fills

Enables or disables limit orders to fill immediately instead of using
NinjaTrader Advanced simulation fill engine

Accounts... Add/Remove simulation accounts

Reset... Resets the simulator values

Resetting the Simulator

To reset the simulator, press the "Reset" button in the Misc section and optionally enable
"Clear history" which will remove all historical simulated trades from the database. Then press
the "OK" button.

-o-
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Commission Tab
The Commission tab allows you to set up global level commission rate information against
different instrument types and connectivity providers. Global commission rates can be over
ridden by specifying instrument level commission rates. Therefore, when NinjaTrader
calculates a trades commission costs, it will use a commission rate value at the instrument
level and if one does not exist, it will use the global commission rate.

Adding Commission Rates
We are going to add global commission rate for trading stocks on our Market Replay
connection. This means, whenever we connect to our Market Replay connection and trade
against it, commission costs will be calculated against the values we will enter below.

1. Locate the Stocks - Market Replay connection and expand the options branch by clicking on
the "+" icon. You will a "Commission levels" property (none defined) and a "Minimum
commission" property. 

2. A lot of brokers who support trading equities have a minimum commission rate. Let's
assume that our Market Replay connection minimum commission is $1.00 by setting that
value in the property. Then put your mouse cursor in the "Commission levels" property which
makes visible the "..." button which allows us to add multiple commission levels.

3. Once you click on the "..." button, a commission level collection editor  will appear. We are
going to add (press the "New" button) two commission rate levels.  $0.01 for the first 500
shares and then $0.005 for every share after that. The image below displays this
configuration. 

IMPORTANT: If you are setting up a commission rate for futures and you have a single rate,
you would enter one commission level with the commission value and the units set to zero.
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4. Once complete, the final configuration looks like the image below.

-o-

Log Tab
The Log tab sets properties for the log display in the Control Center window.

Information Sets the background color for information level log events
Warning Sets the background color for warning level log events
Error Sets the background color for error level log events
Alert Sets the background color for alert level log events
# entries loaded Sets the max number of historical log events loaded upon application

start up
Days maintained Sets the number of days that historical log information is maintained

on your PC

-o-

Data
The Data tab sets options related to market data.
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Store real-time bar
data

Enables or disables the storage of incoming real-time Chart or Market
Analyzer data to your local PC for future historical data requests. If
you are connected to a provider that supports historical data, disable
this feature. 

Run market data
recorder

Enables or disables market data recording for use with the market
replay connection

Split adjust historical
data

Enables or disables split adjusting historical data for use with any
function that requires historical market data

Dividend adjust
historical data

Enables or disables dividend adjusting historical data for use with any
function that requires historical market data

Interval Sets the time interval when recorded market data is written to a file
Tick, Volume and
Range bars

Sets the default number of days of historical data to load for tick and
volume charts

Minute bars Sets the default number of days of historical data to load for minute
charts

Daily bars Sets the default number of days of historical data to load for daily
charts

Weekly bars Sets the default number of days of historical data to load for weekly
charts

Monthly bars Sets the default number of days of historical data to load for monthly
charts

Yearly bars Sets the default number of days of historical data to load for yearly
charts

Enabled Enables or disables the real-time tick filter
Bad tick offset as % Sets the real-time tick filter offset percentage (0.1 equals 1/10 of a

percent)
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URL Sets the URL for the NinjaTrader Historical Data Server (this option
may not be visible if your broker does not support this feature)

Port Sets the port for the NinjaTrader Historical Data Server (this option
may not be visible if your broker does not support this feature)

-o-

ATI Tab
The ATI tab sets options for the Automated Trading Interface.

ATI server port Default port number for communicating with NinjaTrader via the COM
or DLL interface

Default account Sets the default account for automated trading. If no account is
specified in an OIF file or function, the default account is used.

Enable SMTP server Enables or disables the local NinjaTrader SMTP server used with the
TradeStation Email interface
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Ignore  duplicate OIF
files

Enables or disables ignoring duplicate OIF files. If enabled, any OIF
files with the same name during the current NinjaTrader session will
be ignored.

OIF Builder... Opens the Automated Trading OIF Builder window

Detailed information on the TradeStation Email interface can be found here.

ORDER HANDLING
Submit market orders
on TS fill

Enables or disables the submission of market orders when NinjaTrader
receives a strategy order filled email notification from TradeStation

Submit "as-is" When enabled, NinjaTrader will submit the specified order type
(market, limit and stop) when a strategy active order email
notification is received from TradeStation and then wait to convert it
to market based on ...

Convert unfilled... Number of seconds NinjaTrader will wait after receiving a strategy
order filled email notification to convert any unfilled contracts/shares
to market

Submit and forget When enabled, NinjaTrader will submit the specified order type
(market, limit and stop) when a strategy active order email
notification is received from TradeStation

seconds
synchronization
timeout

Number of seconds NinjaTrader will provide a pop up notification if
order are out of synchronization (For example; TS reports a fill but
NinjaTrader live order is not filled)

STOP ORDERS
Submit "as-is" When enabled, submits the specified stop order when NinjaTrader

receives a strategy active order email notification from TradeStation
Convert to stop limit When enabled, submits a stop limit order when NinjaTrader receives a

strategy active order email notification from TradeStation for any stop
order type

Limit price offset as
ticks

Sets the amount of ticks the limit price is offset from the stop price

Convert to simulated
stop market

When enabled, submits a local PC held simulated stop market order
when NinjaTrader receives 
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Submit market order
if stop order was
rejected

If a stop order is rejected for any reason, a market order will be
immediately sent. Please see the following section for disclaimer and
risks of this feature.

-o-

Misc Tab
The Misc tab contains miscellaneous options.

Time to flatten Sets the time (local PC time) where a position will be flattened and
working orders cancelled. This feature can be enabled per position via
any of the Order Entry windows right mouse click menu

Flatten all Enables or disables the flattening of all positions and cancelling of
working orders across all positions and accounts

Repair DB Repairs the database. Should only be used at the request of a
Ninjatrader technical support representative.

Reset DB Removes historical trade data from the database. Should only be used
at the request of a NinjaTrader technical support representative.

Reset Instruments Reset instrument settings to installation default
Account Groups Manage account groups
Support Sets the email address where support questions are sent to
Server Sets the SMTP server address (if left blank, NinjaTrader server is

used)
Port Sets the SMTP port
User Sets the SMTP server user name
Password Sets the SMTP server password
Test Will send a test message through the SMTP server
Currencies (FX) sub
pip support

Enables or disables sub pip support for currency (forex) trading

-o-
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Order Entry Windows

Order Entry Windows Overview
NinjaTrader provides two graphical interfaces for order, position and strategy management.
These are the Basic Entry and SuperDOM windows. These interfaces provide complete
functionality for the management of orders, positions and discretionary exit and stop
strategies in a highly visual and efficient manner. The majority of the time using NinjaTrader
will be spent in one of these two interfaces if you are primarily a discretionary trader.
Although both interfaces can be used to trade any of NinjaTrader supported asset classes, the
Basic Entry window is geared towards trading equities while the SuperDOM is geared towards
trading futures

-o-

FIFO Optimization
All order entry interfaces preserve FIFO (First In First Out) status with the exchanges when
possible.

Why is this important?
This is important since getting filled on your orders is dependant on a FIFO algorithm which
basically means orders submitted ahead of yours at your order's price level will get filled
ahead of you. Think of it like a long line up at the grocery store. You are checked out only
when those in line ahead of you have been checked out. NinjaTrader preserves your place in
line when possible giving you the best possible advantage of getting your orders filled.

So what exactly is NinjaTader doing?

Both order entry interfaces simplify the visualization of orders. Let's say that you have a buy
limit order for 1 contract. You now want to modify this order from 1 contract to 2 contracts.
Most other programs will simply change this order directly. In behind the scenes (at the
broker's order servers) what is really happening is that the original order is canceled
(removed from the line) and then a new order for 2 contracts is submitted which then goes to
the back of the line putting you at a disadvantage. Imagine waiting in the grocery store check
out line for ten minutes. You forgot to get some bread, you leave the line in order to get the
bread that you wanted (changing your order) and upon your return to the check out line, you
have to start at the back of the line and wait all over again! With NinjaTrader, when you
modify the order from 1 contracts to 2 contracts, an additional order for 1 contract is
submitted. Now you have the original order for 1 contract waiting in the middle of the line
somewhere and the new order for 1 contract at the back of the line. Your original order is not
penalized and you maintain your position in line. The opposite is true for decreasing an order
size. Although there are two working orders NinjaTrader consolidates the display so it looks as
if there is only one order working. You decide to decrease the order size from 2 contracts back
to 1. NinjaTrader will modify the newest orders first and the oldest orders last in order to
preserve your FIFO status. Following our example, the second order that was placed would be
canceled and you would be left with the original order for 1 contract with its maintained
position in the order queue. 

-o-

Closing a Position or ATM Strategy
On all entry windows there is an action button "CLOSE" which will close a position or a
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strategy depending on what mouse button is pressed.

When a position or strategy is closed, NinjaTrader goes through the following process:

Assume we are long the SP Emini contract at an entry price of 1000.

1. Identifies any working sell limit orders
2. Cancel all other orders
3. Modifies the price of the identified working sell limit orders below the market so that they

get filled instantly
4. Submit a sell market order if necessary for any left over contracts that are not covered by

the identified working sell limit orders

The exception are currencies traded at FOREX.com where all working orders are cancelled and
then a market order is submitted to close the position.

Why not just submit a market order?
A lot of traders consume near 100% of their available margin. For example, you may have 1
contract position with one stop and target that consumes 90% of your margin. If you close a
position by submitting a market order, the market order will get rejected due to insufficient
funds and therefore cause grief if getting out of the position is critical.

The NinjaTrader approach offers several benefits:

 Modifying existing limit orders avoids the potential problem of breaching your account
margin limitations when closing a position

 With some brokers, modifying existing orders is more efficient than submitting new orders
by up to 500 milliseconds

 Cancellation of non essential orders unlocks available margin that could potentially get
consumed if a market order is required to close out any remaining contracts that are not
covered by existing limit orders

This approach essentially guarantees the most efficient way to exit a position.

-o-

Basic Entry

Market Display
The market display region of the Basic Entry window is used to display market prices and
position information.
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1. Current best ask price and size
2. Current best bid price and size
3. Last traded price and size
4. Market position (FLAT or green background with position size for long, red background for
short)
5. Position average entry price
6. Unrealized profit or loss for current position (Clicking on this cell with your left mouse
button will change the display between points, currency and percent)

-o-

Order Grid Display
The order grid display represents orders in a consolidated format. Orders of the same price
and type and function (entry, stop loss, profit target) are grouped together and displayed in
one row.

Column Definitions
Name Order name such as Stop1 or Target 1
Action Buy or sell
Type Order type
Price Order price
Remaining Number of contracts/shares remaining to be filled
Increase (+) Increases the order price
Decrease (-) Decreases the order price
Cancel (X) Cancels the order(s)

By moving your mouse cursor over an order and pressing down on your right mouse button,
you will see a context menu listing all individual orders consolidated at the corresponding
price and any relevant actions that you can perform on those orders.
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-o-

Selecting Instrument and Accounts

1. The "Instrument" drop down list contains instruments from the instrument list that you
have set up in the instrument manager. To change an instrument you can either select an
instrument from this list or, type in the name of an instrument directly such as "MSFT" for
Microsoft.

2. A list of all connected accounts will be listed in the "Account" drop down list. To change the
account select the account you wish to trade through via this drop down list.

-o-

Submitting Orders
It is highly recommended that you review the section regarding Position Strategy Parameters
for a complete understanding of order submission and subsequent actions that you can have
NinjaTrader automate.

To submit an order:
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1. Set the "Order qty" field
2. Set the "TIF" (Time In Force) field
3. Set the strategy option
        a) <None> : Orders are submitted independent of a strategy
        b) <Custom> : Stop loss and profit target orders are created "on the fly" using the
selected strategy parameters
        c) * Active Strategy X: Apply this order to this selected strategy, the selected strategy's
stops and targets are automatically updated
        d) User Defined Strategy Template: Stops and targets are submitted from a predefined
user template
4. Click with the appropriate order action button to submit the order

A more thorough explanation of these concepts are found under the Position Strategy section.

Quick Order Buttons
You can enter orders rapidly by pressing on any one of the quick order buttons.

BUY ASK Places a buy limit order at the best ask price
BUY MARKET Places a buy market order
BUY BID Places a buy limit order at the best bid price
SELL ASK Places a sell limit order at the best ask price
SELL MARKET Places a sell market order
SELL BID Places a sell limit order at the best bid price

Custom Orders
You can place a custom order by setting order parameters.

1. Select the order type
2. Set the limit price if applicable (middle click in the field to retrieve the last traded price)
3. Set the stop price if applicable (middle click in the field to retrieve the last traded price)
4. Press either the "BUY" or "SELL" button

Scaling In or Out of an Active Strategy
When you have an active strategy selected in the strategy control list (see Submit Standard
Order step 3 above) orders submitted scale into or out of the strategy. Once filled or partially
filled, existing stop loss and profit target orders are modified to reflect the new position
strategy size. You can preset a default scale in or out quantity via the "Scale quantity"
property accessible via the Basic Entry properties window. As an example, your initial
strategy may call for opening a position of four contracts but you want subsequent scale
orders to be only one contract. If the Basic Entry "Scale quantity" property is set to a value of
one, when an active strategy is selected in the strategy control list, the Basic Entry "Order
qty" field will be set to a value of one automatically.
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OCO Orders (One Cancels Other)
Stop loss and profit target orders (submitted automatically via a strategy) are always sent as
OCO however, you can submit entry or exit orders as OCO orders as well. Why? The market
may be trading in a channel and you wish to sell at resistance or buy at support, whichever
comes first by placing two limit orders at either end of the channel. To place OCO orders, via
the right mouse click context menu select the menu "OCO Entry" or use the short cutkey
CTRL+Z.

The "oc" (OCO indicator) will light up green. All orders placed while this indicator is lit will be
part of the same OCO group. Once any order of this group is either filled or cancelled, all
other orders that belong to this group will be cancelled. If you want each OCO order to create
it's own set of stop loss and profit target brackets ensure that the Strategy Control List is set
to either "<Custom>" or a strategy template name before you submit each OCO order.

NOTE: It is important to reset the OCO indicator after the completion of submitting an OCO
order group otherwise you may run into problems where orders are rejected due to usage of
duplicate OCO id values.

Example: Below are steps for submitting a sell stop and a buy stop order via OCO.

1. Enable OCO
2. Place buy stop
3. If initiating two orders to enter a new strategy then re-select the strategy in the strategy

selection list
4. Place sell stop
5. Disable OCO (this is critical that  you disable OCO before submitting another OCO group)

Simulated Stop Orders (Simulated Order)
To submit a simulated stop order (entry and exit NOT stop loss; simulated stop loss orders
are enabled via a stop strategy) you must enable simulated order mode via the right mouse
click context menu by selecting the "Simulated Order" menu or use the shortcut key CTRL+A.
The "so"  (Simulated Order indicator) will light up green. All stop orders placed while this
indicator is lit will be submitted as a simulated stop order.

-o-
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Modifying and Cancelling Orders
You can modify orders directly in the Basic Entry order grid.

1. You can increase the price of an order by one tick by pressing the "+' button. Holding the
CTRL key down will modify the order by 5 ticks, ALT key by 10 ticks
2. You can decrease the price of an order by one tick pressing on the "-" button. Holding the
CTRL key down will modify the order by 5 ticks, ALT key by 10 ticks
3. You can cancel an order by pressing on the "X" button
4. You can change the size of an order by clicking in the "Remaining" column, typing in a new
quantity value and pressing the "Enter" key

-o-

Action Buttons

1. Clicking on the "BE" (breakeven) button with your left mouse button will adjust any stop
orders in the opposite direction of your open position (if position is long it will adjust stop sell
orders) to the positions average entry price. Clicking on this button with your middle mouse
button (scroll wheel) will only adjust any stop loss orders associated to the selected active
strategy in the strategy drop down list to the strategy's average entry price. Orders resting at
a better price than the average entry price will NOT be modified.

2. Clicking on the "REVERSE" button will close the current open position and open a reverse
position.

3. Clicking on the "CLOSE" button with your left mouse button will close the current position
and cancel any working orders associated to the instrument/account combination. Clicking on
this button with your middle mouse button (scroll wheel) will close the selected active
strategy only. This means that the position size of  the strategy will be closed and any
working orders associated to that strategy will be cancelled.

-o-

Adding or Removing Targets
If you have an active strategy displayed in the Basic Entry window, you can add or remove
targets. For example, you may have a 2 contract position with 1 stop loss and profit target for
2 contracts each. You may decide to split this target (add target) so that you can exit the final
contract at a higher price. You can add or remove a target via the right mouse click context
menu when an active strategy is selected in the strategy control list.

It is important to understand the following logic:
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 You can have a maximum of 3 targets (if you had 3 and the first two targets are filled you
can not split the 3rd target)

 If you have 1 target and you remove a target, you will be left with a stop loss order only
 New targets are added 4 ticks from your current outside target for futures, $0.20 for stocks

-o-

Window Linking
See the "Window Linking" section.

-o-

Basic Entry Properties
Basic Entry properties are accessible via the right mouse click menu.

Set Default
Once you have your Basic Entry properties set up to your liking, you can press the "Set
Default" button which will save these settings as the default setting used every time you open
a new Basic Entry window. If you change your settings and later wish to go back to default
settings you can press the "Reset" button.

Property Definitions
Action buttons color Sets the color for action buttons (CLOSE, BE etc...)
Buy buttons color Sets the color for all the buy buttons
Highlight color Sets the color for button highlighting
Sell buttons color Sets the color for all the sell buttons
Simulation color Sets the color of the Basic Entry window background when a

simulation account (Sim101) is selected
Advanced options Enables or disables the display of Basic Entry advanced options
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Caption bar display Sets the text displayed in the caption bar of the Basic Entry
Parameter type Sets the parameter type used for entering strategy information. *Price

parameter type is absolulte price NOT an offset value (Example: Stop
Loss = 1 will submit an order at a price of 1 NOT 1 point away from
entry)

Profit/loss display unit Sets the display unit for profit and loss
Scale Quantity Sets the scale order quantity amount.
Show realized P/L
when flat

Displays realized profit and loss for the selected account when flat

Simulated order
volume trigger

Sets the value for a simulated order volume trigger (for entry and exit
orders and NOT used for stop loss)

Strategy selection
mode

Sets the behavior mode of the price ladder display and strategy
selector (see more)

Use stop market for
stop loss orders

When true, a stop market order will be submitted for automatic
submission of stop loss orders are part of a position strategy. By
default, when selecting any instruments that trade on Eurex, CBOT
and CME this setting is set to true.

-o-

Chart Trader

Enabling Chart Trader
Chart Trader can be enabled within any chart window via the chart properties dialog window
or by clicking on the "Chart Trader" chart toolbar icon.

When enabled, the Chart Trader control will be visible on the right side of chart window. You
will be able to submit, modify and cancel orders directly from within the chart.

-o-

Order & Position Display
Orders and positions are displayed in a highly visual manner. An order is visualized as a color
coded line with the order price label in the right margin and a label indicating the order qty,
action and either order type or name.

Visualization
Limit Order Default color is cyan with the text "LMT"
Stop Market Order Default color is pink with text "STP"
Stop Limit Order Default color is violet with text "SLM"

Market Order Market orders are not displayed (see Control Center Order Tab)
Stop Loss Order Default color is red
Profit Target Order Default color is lime

Chart trading color properties can be set via the Chart Trader properties window. 

The next two images are examples of how orders are visualized in a NinjaTrader chart.

1. Sell limit order for 1 contract at a price of 1441.25
2. Sell stop market order for 1 contract at a price of 1438.5
3. Sell stop limit order for 1 contract at a price of 1438
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1. Two profit target orders (T1 and T2)
2. Average position and PnL indicator for 2 contracts long
3. *Stop loss order (S2)
4. Current position size
5. Average position price
6. PnL

* The stop loss order is actually comprised of two orders as indicated by the letter "s" next to
the qty number "2".
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-o-

Collapsed View
You can collapse the Chart Trader control by pressing the arrow button in the top right hand
corner of the chart. This will hide/unhide the right side Chart Trader control from view.

-o-

Submitting Orders
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It is highly recommended that you review the section regarding Position Strategy Parameters
for a complete understanding of order submission and subsequent actions that you can have
NinjaTrader automate.

There are several methods to submit an order through a chart.

To submit an order:

1. Set the "Order qty" field
2. Set the strategy option
        a) <None> : Orders are submitted independent of a strategy
        b) <Custom> : Stop loss and profit target orders are created "on the fly" using the
selected strategy parameters
        c) * Active Strategy X: Apply this order to this selected strategy, the selected strategy's
stops and targets are automatically updated
        d) User Defined Strategy Template: Stops and targets are submitted from a predefined
user template
3. Clicking the "..." button will display the strategy parameters window
4. Enter an order with any of the methods described below

A more thorough explanation of these concepts are found under the Position Strategy section.

Order Menus
Order menus will appear via the right mouse click context menu as per the image below when
you have Chart Trader enabled. The menus are filled with pre-defined order types and prices
based on the location of your mouse cursor. Click on the desired order menu to submit an
order.
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Stop Limit Order
When submitting a stop limit A numeric field (image below) will appear that represents the
number of ticks away you wish the limit price of the stop limit order to be placed at. Either by
using your mouse scroll wheel or clicking on the up/down arrows in the numeric field, set the
number of ticks and press the "checkmark" button to complete the order submission. Pressing
the "x" button will cancel the order submission operation. For example, if you intend to have
an order with a stop price of 1000 and a limit price of 1001 (4 ticks spread for the SP Emini
contract) you would set the numeric field value to 4. Following the same example submitting
a sell stop limit, setting the numeric field value to 4 would result in a stop price of 1000 and a
limit price of 999.

The numeric field also supports negative values. By selecting a negative value, you
automatically submit a simulated stop order. This allows you to place orders that trigger at a
break out price but try to fill you at a better price. You can also enable simulated stop order
by putting the Chart Trader control into simulated order mode. You can enable this via the
right mouse click context menu and select the menu "Simulated Order" or via the shortcut
key CTRL+A.

Quick Buttons
You can quickly submit orders via the Chart Trader control's Quick Buttons.
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Buy Market - Submits buy order at market
Sell Market - Submits sell order at market
Buy Ask - Submits buy limit order at ask price
Sell Ask - Submits sell limit order at ask price
Buy Bid - Submits  buy limit order at bid price
Sell Bid - Submits  sell limit order at ask price

Scaling In or Out of an Active Strategy
When you have an active strategy selected in the strategy control list orders submitted scale
into or out of the strategy. Once filled or partially filled, existing stop loss and profit target
orders are modified to reflect the new position strategy size. You can preset a default scale in
or out quantity via the "Scale quantity" property accessible via the Chart Trader properties
window. As an example, your initial strategy may call for opening a position of four contracts
but you want subsequent scale orders to be only one contract. If the Chart Trader's "Scale
quantity" property is set to a value of one, when an active strategy is selected in the strategy
control list, the SuperDOM "Order qty" field will be set to a value of one automatically.

OCO Orders (One Cancels Other)
Stop loss and profit target orders (submitted automatically via a strategy) are always sent as
OCO however, you can submit entry or exit orders as OCO orders as well. Why? The market
may be trading in a channel and you wish to sell at resistance or buy at support, whichever
comes first by placing two limit orders at either end of the channel. To place OCO orders, via
the right mouse click context menu select the menu "OCO Entry" or use the shortcut key
CTRL+Z.

All orders placed while this indicator is lit will be part of the same OCO group. Once any order
of this group is either filled or cancelled, all other orders that belong to this group will be
cancelled. If you want each OCO order to create it's own set of stop loss and profit target
brackets ensure that the Strategy Control List is set to either "<Custom>" or a strategy
template name before you submit each OCO order.

NOTE: It is important to reset the OCO indicator after the completion of submitting an OCO
order group otherwise you may run into problems where orders are rejected due to usage of
duplicate OCO id values.

Example: Below are steps for submitting a sell limit and a buy limit order via OCO.

1. Enable OCO
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2. Place buy limit
3. If initiating two orders to enter a new strategy then re-select the strategy in the strategy

selection list
4. Place sell limit
5. Disable OCO (this is critical that  you disable OCO before submitting another OCO group)

Simulated Stop Orders (Simulated Order)
To submit a simulated stop order (entry and exit NOT stop loss; simulated stop loss orders
are enabled via a stop strategy) you must enable simulated order mode via the right mouse
click context menu by selecting the "Simulated Order" menu or use the shortcut key CTRL+A.
All stop orders placed while this indicator is lit will be submitted as a simulated stop order.

One of the powerful features of simulated stop orders is that you can submit a "negative limit
stop limit" order. This means that you can place an order where the limit price is better than
the stop price. As an example, you may want to buy on strength indicated by a move up to a
particular price. Once that occurs, you want to enter at a better price using a limit order
several ticks below (if you are buying) the stop price. To see how you can accomplish this
watch the video below.

-o-

Modifying and Cancelling Orders
Modify Order Price
To modify the price of an order left click with your mouse on the order line or the right section
of the label. A ghost order line will appear and display the number of ticks you are away from
the inside market. When above the ask the label will display a positive value , below the bid
the label (in the image below we are 8 ticks below the bid) will display a negative value. At
the ask the label will display @ask and at the bid the label will display @bid. Once you have
ghost order at the price you desire left click with your mouse to complete the modification. To
cancel a pending order price modification press the "Esc" key on your keyboard.

Modify Order Size
To modify the size of an order left click with your mouse on the area of the label that displays
the order qty.
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A order size modification control will appear.

Cancel an Order
To cancel an order left click with your mouse on the red "X".

-o-

Action Buttons
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1. Clicking on the "REV" button will close the current open position and open a reverse
position.

2. Clicking on the "CLOSE" button with your left mouse button will close the current position
and cancel any working orders associated to the instrument/account combination. Clicking on
this button with your middle mouse button (scroll wheel) will close the selected active
strategy only. This means that the position size of  the strategy will be closed and any
working orders associated to that strategy will be cancelled.

-o-

Properties
The Chart Trader properties window can be accessed via the right mouse click context menu
"Chart Trader Properties..." sub menu. Make sure your mouse is hovering over the Chart
Trader control to access the Chart Trader context menu otherwise you will access the Chart
context menu.
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Property Definitions
Action buttons color Sets the color for action buttons (CLOSE, BE etc...)
Buy buttons color Sets the color for all the buy buttons
Highlight color Sets the color for button highlighting
Limit orders Sets the drawing properties for limit orders
Order display bar
length

Sets the length an order bar is displayed horizontally across the chart
in %

Position entry price Sets the drawing properties for average position
Profit target Sets the drawing properties for profit target orders
Sell buttons color Sets the color for all sell buttons
Simulation color Sets the color of the Chart Trader window background when a

simulation account (Sim101) is selected
Stop limit orders Sets the drawing properties for stop limit orders
Stop loss Sets the drawing properties for stop loss orders
Stop market orders Sets the drawing properties for stop market orders
Parameter type Sets the parameter type used for entering strategy information. *Price

parameter type is absolulte price NOT an offset value (Example: Stop
Loss = 1 will submit an order at a price of 1 NOT 1 point away from
entry)

PnL display unit Sets the display unit for profit loss in currency, percent or points
Scale quantity Sets the scale order quantity amount
Show realized PnL
when flat

Displays realized profit and loss for the selected account when flat

Simulated order
volume trigger

Sets the value for a simulated order volume trigger (for entry and exit
orders and NOT used for stop loss)
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Stop limit offset Sets the offset the limit price is away from the stop price for entry/exit
stop limit orders. Set to 'Off' to disable single click stop limit order
submission.

Strategy selection
mode

Sets the behavior mode of the price ladder display and strategy
selector (see more)

Use stop market for
stop loss orders

When true, a stop market order will be submitted for automatic
submission of stop loss orders are part of a position strategy. By
default, when selecting any instruments that trade on Eurex, CBOT
and CME this setting is set to true.

-o-

FX Pro

Overview
The FX Pro order entry window is comprised of several components.

1. Order grid
2. Optional Level II panel that is displayed *only* for brokerages that support ECN style FX
trading. If your brokerage does not support ECN FX then you will not see this panel on your
FX Pro window.
3. Position and level 1 (current inside market) display
4. Order entry and ATM Strategy management

* If your FX provider supports sub pip display you must enable sub pip support via the Misc
tab. The various brokerage technology connection guides will state clearly if the brokerage
technology offers sub pip support.

http://www.ninjatrader.com/webnew/support_connectionguides.htm
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Order Grid Display
The order grid display represents orders in a consolidated format. Orders of the same price
and type and function (entry, stop loss, profit target) are grouped together and displayed in
one row.
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Column Definitions
Name Order name such as Stop1 or Target 1
Action Buy or sell
Type Order type
Price Order price
Remaining Number of contracts/shares remaining to be filled
Increase (+) Increases the order price
Decrease (-) Decreases the order price
Cancel (X) Cancels the order(s)

By moving your mouse cursor over an order and pressing down on your right mouse button,
you will see a context menu listing all individual orders consolidated at the corresponding
price and any relevant actions that you can perform on those orders.

-o-

Level II (Market Depth) Display
The Level II panel displays bid and ask market depth data color coded by price.
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Price - The bid or ask price
Size - The number of lots at that price level available for buy or sell (represented in short
hand notation where M represents 1,000,000)
Time - The last time the bid/ask was refreshed

* If a price is at a sub pip level, the sub pip value is displayed as a value after an apostrophe
as per the following example where the sub pip is highlighted in red. The blue arrow in the
image above depicts how this is displayed in the Level II panel.

Example: 1.4115'5 (The price  is at 1.4115 pips plus 5 sub pips which is 5/10 of a pip)

-o-

Market Display
The Market Display panel shows the inside bid and ask along with current position
information.

For clarification, the current market as displayed above is 1.41181 bid by 1.4119 ask

1. The current spread between the best bid and best ask (the above display is showing a
spread of 9 sub pips (9/10 of a pip)
2. Position information
3. Last tick directional arrow
4. The handle of the current bid (current ask is on the right side of the blue "X")
5. The current bid
6. Sub pip value, so the current bid is 1.4118 and 1/10 of a pip displayed as 1.4118'1
7. Current bid size displayed as 0.01M (in millions) which is 10,000

* FX brokerage technologies that do not support an ECN model will NOT display sub pips nor
will bid/ask size be displayed

-o-
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Selecting Instruments and Accounts

1. The "Instrument" drop down list contains curency pairs from the instrument list that you
have set up in the instrument manager. To change an instrument you can either select an
instrument from this list.

2. A list of all connected accounts will be listed in the "Account" drop down list. To change the
account select the account you wish to trade through via this drop down list.

-o-

Submitting Orders
It is highly recommended that you review the section regarding Position Strategy Parameters
for a complete understanding of order submission and subsequent actions that you can have
NinjaTrader automate.

To submit an order:

1. Set the "Order qty" field
2. Set the strategy option
        a) <None> : Orders are submitted independent of a strategy
        b) <Custom> : Stop loss and profit target orders are created "on the fly" using the
selected strategy parameters
        c) * Active Strategy X: Apply this order to this selected strategy, the selected strategy's
stops and targets are automatically updated
        d) User Defined Strategy Template: Stops and targets are submitted from a predefined
user template
3. Clicking the "..." button will display the strategy parameters window
4. Enter an order with any of the methods described below

A more thorough explanation of these concepts are found under the Position Strategy section.

Quick Order Buttons
You can enter limit orders at the inside market rapidly by pressing either the "BID" or "OFF
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ER" buttons.

BID Places a buy limit order at the best bid price
OFFER Places a sell limit order at the best bid price

Custom Orders
You can place a custom order by setting order parameters.

1. Select the order type
2. Set the limit price if applicable (middle click in the field to retrieve the last traded price)
3. Set the stop price if applicable (middle click in the field to retrieve the last traded price)
4. Press either the "BUY" or "SELL" button

TIPS:

 Hold down the CTRL key when increasing/decreasing limit/stop prices to change the price
in steps of 10 tick increments

 Left clicking on a price in the Level II panel will load that price into the limit and stop price
fields

Scaling In or Out of an Active Strategy
When you have an active strategy selected in the strategy control list (see Submit Standard
Order step 3 above) orders submitted scale into or out of the strategy. Once filled or partially
filled, existing stop loss and profit target orders are modified to reflect the new position
strategy size. You can preset a default scale in or out quantity via the "Scale quantity"
property accessible via the FX Prop properties window. As an example, your initial strategy
may call for opening a position of four contracts but you want subsequent scale orders to be
only one contract. If the FX Pro "Scale quantity" property is set to a value of one, when an
active strategy is selected in the strategy control list, the FX Pro "Order qty" field will be set
to a value of one automatically.

OCO Orders (One Cancels Other)
Stop loss and profit target orders (submitted automatically via a strategy) are always sent as
OCO however, you can submit entry or exit orders as OCO orders as well. Why? The market
may be trading in a channel and you wish to sell at resistance or buy at support, whichever
comes first by placing two limit orders at either end of the channel. To place OCO orders, via
the right mouse click context menu select the menu "OCO Order".
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The "oc" (OCO indicator) will light up green. All orders placed while this indicator is lit will be
part of the same OCO group. Once any order of this group is either filled or cancelled, all
other orders that belong to this group will be cancelled. If you want each OCO order to create
it's own set of stop loss and profit target brackets ensure that the Strategy Control List is set
to either "<Custom>" or a strategy template name before you submit each OCO order.

NOTE: It is important to reset the OCO indicator after the completion of submitting an OCO
order group otherwise you may run into problems where orders are rejected due to usage of
duplicate OCO id values.

Example: Below are steps for submitting a sell stop and a buy stop order via OCO.

1. Enable OCO
2. Place buy stop
3. If initiating two orders to enter a new strategy then re-select the strategy in the strategy

selection list
4. Place sell stop
5. Disable OCO (this is critical that  you disable OCO before submitting another OCO group)

Simulated Stop Orders (Simulated Order)
To submit a simulated stop order (entry and exit NOT stop loss; simulated stop loss orders
are enabled via a stop strategy) you must enable simulated order mode via the right mouse
click context menu by selecting the "Simulated Order" menu. The "so"  (Simulated Order
indicator) will light up green. All stop orders placed while this indicator is lit will be submitted
as a simulated stop order.

-o-

Modifying and Cancelling Orders
You can modify orders directly in the FX Pro order grid.

1. You can increase the price of an order by one tick increment by pressing the "+' button.
Holding the CTRL key down will modify the order by 5 tick increments, ALT key by 10 tick
increments
2. You can decrease the price of an order by one tick increment pressing on the "-" button.
Holding the CTRL key down will modify the order by 5 ticks increments, ALT key by 10 tick
increments
3. You can cancel an order by pressing on the "X" button
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4. You can change the size of an order by clicking in the "Remaining" column, typing in a new
quantity value and pressing the "Enter" key

* A tick increment for a brokerage that supports sub pips (ECN model) is equal to 1/10 of a
pip also known as a sub pip. Otherwise  a tick increment is one pip value. 

-o-

Adding or  Removing Targets
If you have an active strategy displayed in the FX Pro window, you can add or remove
targets. For example, you may have a 2 lot position with 1 stop loss and profit target for 2
lots each. You may decide to split this target (add target) so that you can exit the final lot at
a higher price. You can add or remove a target via the right mouse click context menu when
an active strategy is selected in the strategy control list.

It is important to understand the following logic:

 You can have a maximum of 3 targets (if you had 3 and the first two targets are filled you
can not split the 3rd target)

 If you have 1 target and you remove a target, you will be left with a stop loss order only
 New targets are added 4 pips from your current outside target

-o-

Window Linking
See the "Window Linking" section.

-o-

FX Pro Properties
FX Pro window properties are accessible via the right mouse click menu.

Set Default
Once you have your FX Pro window properties set up to your liking, you can press the "Set
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Default" button which will save these settings as the default setting used every time you open
a new FX Pro window. If you change your settings and later wish to go back to default
settings you can press the "Reset" button.

Property Definitions
Actions button color Sets the color for action buttons (CLOSE, BE etc...)
Buy buttons color Sets the color for all the buy buttons
Highlight color Sets the color for button highlighting
Sell buttons color Sets the color for all the sell buttons
Simulation color Sets the color of the FX Pro window background when a simulation

account (Sim101) is selected
ATM Strategy
Selection Mode

Sets the behavior mode of the price ladder display and strategy
selector (see more)

Caption bar display Sets the text displayed in the caption bar of the Basic Entry
Level II font Sets the font style for the Level II display
Parameter type Sets the parameter type used for entering strategy information. *Price

parameter type is absolulte price NOT an offset value (Example: Stop
Loss = 1 will submit an order at a price of 1 NOT 1 point away from
entry)

PnL display unit Sets the display unit for profit and loss
Scale Quantity Sets the scale order quantity amount.
Show realized P/L
when flat

Displays realized profit and loss for the selected account when flat

Simulated order
volume trigger

Sets the value for a simulated order volume trigger (for entry and exit
orders and NOT used for stop loss)

-o-

SuperDOM

Price Ladder Display
The price ladder region is used to display stacked static market prices, market depth, the
current inside market, order and strategy information. It is also used for the submission,
modification, and cancellation of orders.

Columns
The price ladder is broken down into three functional columns. The left column (referred to as
the "BUY" column) is used to submit/modify buy orders and to display market depth on the
bid side of the market. The center column (referred to as the "PRICE" column) displays
market prices, displays current inside market and is used to modify stop loss and profit target
orders. The right column (referred to as the "SELL" column) is used to submit/modify sell
orders and to display market depth on the ask side of the market.
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Bottom Row
The bottom row of the price ladder contains three functions:

MARKET (left cell) Submits buy market, limit at ask or limit at bid orders
P/L (center cell) Displays unrealized profit or loss for the current position
MARKET (right cell) Submits sell market, limit at ask or limit at bid orders

You can change the type of order the market cells submit by holding down the SHIFT key to
place limit orders at the ask or, by holding down the CTRL key to place limit orders at the bid.
Clicking with your left mouse button on the P/L cell will change the display of P/L between
points, currency and percent.

Inside Market
The inside market is displayed as follows:

Best Ask (1) Default color is dark green with bold font
Best Bid (2) Default color is blue with bold font
Last Traded Price Center price cell is highlighted to default color yellow
Ask Depth Size (3) Displayed in the corresponding price row's "SELL" column
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Bid Depth Size (4) Displayed in the corresponding price row's "BUY" column
Last Trade Size (5) Displayed in the corresponding price row in either the center column

or, "BUY"/"SELL" column depending on user defined property. Volume
is indicated in parentheses.

Cumulative Depth (6) The bottom integer value in the "BUY" column and the top integer
value in the "SELL" column

Daily High and Low
The market's daily high and low can be optionally displayed. 

1. Daily high marker
2. Daily low marker

You can set this option and customize the markers color in the SuperDOM properties dialog
window.

Open Position and Profit/Loss
The image below displays the current unrealized loss of our current position (-0.25). Our
current position is displayed in the green box which represents a long position of 1 contract. A
red box would be displayed for a short position.

Adjusting the Price Ladder Display
Move your mouse cursor into the price ladder region and use your mouse scroll wheel to
adjust market prices up or down. You can also press the "C" button to center the inside
market. Optionally, the "Auto center price" property will automatically center the inside
market price should the last traded price trade outside the visible range on the price ladder.
You can also set the number of visible price rows via the properties window.
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-o-

Static vs Dynamic Price Ladder Display
You may have the option of using either a static (original SuperDOM) or dynamic price ladder
display SuperDOM depending on your FCM or broker. The difference between these options is
how the inside market is displayed in the price ladder display.

Static
 The inside market (ask/bid and last price) climb up and down the price ladder in response

to a change in market price
 The price rows are static (do not change)

Dynamic
 The inside market (ask/bid and last price) is fixed in location in the price ladder display
 The price rows are dynamic in that each row's price changes in response to a change in

market price

To assist with submitting and modifying orders in the dynamic price ladder display during
volatile market activity you can choose to suspend (freeze) the price ladder display by
pressing the 'HOLD' button with your left mouse button or by pressing the 'Space' bar of your
keyboard.

Once suspended, the button will highlight red in color and display 'HELD'. You can now safely
submit or modify an order without the price of the underlying row change. Be sure to enable
the dynamic updating of the price action in the price ladder display after you have completed
your order submission or modification by pressing on the 'HELD' button or your keyboard
'Space' bar. In addition, the inside market will be displayed in the top row.

1. Best bid
2. Net change (last traded price) from the time the display was suspended
3. Best ask

 

-o-
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Order Display
Displaying Orders
Orders are displayed in a highly visual manner. Different order types and order objectives
(stop loss or profit target orders) are uniquely color coded.

Limit Order Default color is cyan with the text "LMT"
Stop Market Order Default color is pink with text "STP"
Stop Limit Order Default color is violet with text "SLM"

Market Order Color not displayed but quantity and order state displayed in the
bottom row

Stop Loss Order Default color is red
Profit Target Order Default color is lime

Below is an image of a price ladder with a working limit, stop market and stop limit order for
1 contract each.

All orders are displayed by coloring a cell or group of cells within the price ladder. There is
also an associated size marker which displays the remaining contracts to be filled for the
order(s) at the corresponding price. The color of the size marker indicates the current order(s)
sate.

Size Marker - Order State Color Definitions
Orange Pending Submit, Pending Change
Lime Working (at the exchange)
Grayish Blue Accepted (resting on your connectivity providers order servers or your

local PC)
Red Pending Cancel
Yellow Simulated Stop Order

Consolidated Order Display
The SuperDOM will consolidate the display of all orders resting at the same price and mark an
"s" within the size marker display to indicate that there are multiple orders stacked at that
price. The size marker then indicates the cumulative remaining contracts for all orders resting
at that price. The image below depicts a consolidated display of two limit orders for 1 contract
each.
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By moving your mouse cursor over the order (cyan colored cell) and pressing down on your
right mouse button, you will see a context menu listing all individual orders consolidated at
the corresponding price and any relevant actions that you can perform on those orders.

Orders submitted as stop loss and profit target orders are uniquely displayed by coloring all
three cells in the price row where the order(s) are working. This makes it very easy to
visualize your stop and profit objectives relative to the current market. All other orders are
displayed by coloring a single cell in either the "BUY" or "SELL" column.

Below is an image of a stop loss and profit target pair, notice that the size marker colors on
the right side reflect the current state of the orders and that they are sell orders since they
are displayed on the sell side of the price ladder. Also note the brown colored cell at price
level 1243.75, this represents the average entry price for the open position.

-o-

Out of range Stop Loss & Profit Targets
Displaying Stop Loss and Profit Targets Outside The Visible Range
There maybe times where your stop loss or profit target orders are outside of the visible price
range of the SuperDOM price ladder. You can easily bring these orders in range by clicking
with your middle mouse button in the price column. Clicking on the bid or above with your
middle mouse button will bring into visible range the first stop loss or profit target order
above the highest displayed price of the price ladder. Clicking below the bid with your middle
mouse button will bring into visible range the first stop loss or profit target order below the
lowest displayed price of the price ladder.
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NOTE: This function only works if "Single click order modification" is set to false under the 
Properties window. If set to true, middle click will instantly modify your stop loss or profit
target orders.

-o-

Selecting Instruments and Accounts

1. The "Instrument" drop down list contains instruments from the instrument list that you
have set up in the instrument manager. To change an instrument select an instrument from
this list.

2. A list of all connected accounts will be listed in the "Account" drop down list. To change the
account select the account you wish to trade through via this drop down list.

-o-

Submitting Orders
It is highly recommended that you review the section regarding Position Strategy Parameters
for a complete understanding of order submission and subsequent actions that you can have
NinjaTrader automate.

Standard Orders
Entry or exit orders are submitted via the mouse using the following conventions:

Limit Order Left mouse button click
Stop Market Order Middle mouse button click (scroll wheel) + CTRL key
Stop Limit Order Middle mouse button click (scroll wheel)

You can set the middle mouse button to submit stop market orders as default by setting the
"Middle mouse button is stop market" property.

To submit an order:
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1. Set the "Order qty" field
2. Set the "TIF" (Time In Force) field
3. Set the strategy option
        a) <None> : Orders are submitted independent of a strategy
        b) <Custom> : Stop loss and profit target orders are created "on the fly" using the
selected strategy parameters
        c) * Active Strategy X: Apply this order to this selected strategy, the selected strategy's
stops and targets are automatically updated
        d) User Defined Strategy Template: Stops and targets are submitted from a predefined
user template
4. Click with the appropriate mouse button in the price ladder to submit the order

A more thorough explanation of these concepts are found under the Position Strategy section.

Limit Order
To submit a limit order, select either the "BUY" column for buy orders or the "SELL" column
for sell orders and press down on your left mouse button in the cell that corresponds to the
price you wish the limit order to be submitted at. Clicking at location (1) in the image below
would submit a sell limit order at the price 1248.50.

Stop Market Order
To submit a stop market order, select either the "BUY" column for buy orders or the "SELL"
column for sell orders and press down on your middle mouse button (mouse scroll wheel)
while holding the CTRL key down in the cell that corresponds to the price you wish the stop
market order to be submitted at.

Stop Limit Order
To submit a stop limit order, select either the "BUY" column for buy orders or the "SELL"
column for sell orders and press down on your middle mouse button (scroll wheel) in the cell
that corresponds to the price you wish the stop limit order to be submitted at. A numeric field
(image below) will appear that represents the number of ticks away you wish the limit price
of the stop limit order to be placed at. Either by using your mouse scroll wheel or clicking on
the up/down arrows in the numeric field, set the number of ticks and press the "checkmark"
button to complete the order submission. Pressing the "x" button will cancel the order
submission operation. For example, if you intend to have an order with a stop price of 1000
and a limit price of 1001 (4 ticks spread for the SP Emini contract) you would set the numeric
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field value to 4. Following the same example submitting a sell stop limit, setting the numeric
field value to 4 would result in a stop price of 1000 and a limit price of 999.

You will notice in the image above that there are also negative values. By selecting a negative
value, you automatically submit a simulated stop order. This allows you to place orders that
trigger at a break out price but try to fill you at a better price. You can also enable simulated
stop order by putting the SuperDOM into simulated order mode. You can enable this via the
right mouse click context menu and select the menu "Simulated Order" or via the shortcut
key CTRL+A.

Stop Limit Order (single click)
If you generally always place stop limit orders using the same offset between limit and stop
price, you can enable single click submission of stop limit orders by setting the "Stop limit
offset" property to an integer value. By default, this setting is set to "Off" which forces the
numeric field image above to display. Setting this property to a value of 1 would instantly
place a stop limit order with a stop price of X and a limit price of X + 1 for buy orders or X - 1
for sell orders.

Scaling In or Out of an Active ATM Strategy
When you have an active ATM strategy selected in the strategy control list (see Submit
Standard Order step 3 above) orders submitted scale into or out of the strategy. Once filled or
partially filled, existing stop loss and profit target orders are modified to reflect the new
position strategy size. You can preset a default scale in or out quantity via the "Scale
quantity" property accessible via the SuperDOM properties window. As an example, your
initial strategy may call for opening a position of four contracts but you want subsequent
scale orders to be only one contract. If the SuperDOM "Scale quantity" property is set to a
value of one, when an active strategy is selected in the strategy control list, the SuperDOM
"Order qty" field will be set to a value of one automatically.

OCO Orders (One Cancels Other)
Stop loss and profit target orders (submitted automatically via a strategy) are always sent as
OCO however, you can submit entry or exit orders as OCO orders as well. Why? The market
may be trading in a channel and you wish to sell at resistance or buy are support, whichever
comes first by placing two limit orders at either end of the channel. To place OCO orders, via
the right mouse click context menu select the menu "OCO Entry" or use the shortcut key
CTRL+Z.

The "oc" (OCO indicator) will light up green. All orders placed while this indicator is lit will be
part of the same OCO group. Once any order of this group is either filled or cancelled, all
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other orders that belong to this group will be cancelled. If you want each OCO order to create
it's own set of stop loss and profit target brackets ensure that the Strategy Control List is set
to either "<Custom>" or a strategy template name before you submit each OCO order.

NOTE: It is important to reset the OCO indicator after the completion of submitting an OCO
order group otherwise you may run into problems where orders are rejected due to usage of
duplicate OCO id values.

Example: Below are steps for submitting a sell limit and a buy limit order via OCO.

1. Enable OCO
2. Place buy limit
3. If initiating two orders to enter a new strategy then re-select the strategy in the strategy

selection list
4. Place sell limit
5. Disable OCO (this is critical that  you disable OCO before submitting another OCO group)

Simulated Stop Orders (Simulated Order)
To submit a simulated stop order (entry and exit NOT stop loss; simulated stop loss orders
are enabled via a stop strategy) you must enable simulated order mode via the right mouse
click context menu by selecting the "Simulated Order" menu or use the shortcut key CTRL+A.
The "so"  (Simulated Order indicator) will light up green. All stop orders placed while this
indicator is lit will be submitted as a simulated stop order.

One of the powerful features of simulated stop orders is that you can submit a "negative limit
stop limit" order. This means that you can place an order where the limit price is better than
the stop price. As an example, you may want to buy on strength indicated by a move up to a
particular price. Once that occurs, you want to enter at a better price using a limit order
several ticks below (if you are buying) the stop price. To see how you can accomplish this
watch the video below.

 

Quick Buttons
You can optionally enable the "Quick Buttons" display via the SuperDOM Properties dialog
window accessible via the right mouse click context menu. The bottom of the price ladder
display will show "ASK", "BID" and "MARKET" cells in both the "BUY" and "SELL" columns
when enabled. When disabled, only the "MARKET" cells will appear.

When enabled
Pressing an "ASK" cell with the left mouse button will submit a limit order at the ask price,
pressing a "BID" cell will submit a limit order at the bid price and pressing the "MARKET" cell
will submit a market order.

When disabled 
Pressing a "MARKET" cell with the left mouse button will submit a market order. Holding down
the CTRL key will change the text display to "BID" and when clicked on with the left mouse
button in this state will submit a limit order at the bid price. Holding down the SHIFT key will
change the text display to "ASK" and when clicked on with the left mouse button in this state
will submit a limit order at the ask price. 
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-o-

Cancelling Orders
To cancel an order, click on the red "X" located at the outside edge of the order's displayed
size marker. If multiple orders are consolidated at that price, all orders at that price will be
cancelled.

1. Pressing on the red "X" will cancel all orders consolidated at the corresponding price level
2. Pressing down on the right mouse button with the mouse cursor hovering over the order
will display all orders consolidated at that price. You can select any individual order for
cancellation.
3. Pressing on the large red "X" will cancel all orders on either the "BUY" side (in this
example) or the sell side

You can also cancel "ALL" orders via the right mouse click context menu.

-o-

Modifying Orders
Modifying Price of Entry and Exit Orders
Click and drop approach is used to modify the price of an order. This approach is more
effective than drag and drop since it eliminates the potential errors made by accidentally
letting go of your mouse button and dropping an order on the wrong price.
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1. Click using your left mouse button on the order you wish to modify
2. Once selected, you will see the cursor change to a hand from an arrow, then choose the
price you are modifying the order to and click using your left mouse button to complete the
modify process

The left mouse button is used to modify the price of limit, stop market and stop limit orders.
You can cancel out of a price modification (remove the hand cursor) by pressing the ESC key.

Modifying Price of Stop Loss and Profit Target Orders

1. Click with your left mouse button in the center column on the stop loss or profit target
order you want to modify
2. Once selected, you will see the cursor change to a hand from an arrow, then choose the
price you are modifying the order to and click using your left mouse button to complete the
modify process

*If there are multiple orders consolidated at a price level, modifying the price will modify all
orders at that price level.

Single Click Modification of Stop Loss and Profit Target Orders
You have the option of enabling single click modification for stop loss and profit target orders
via the SuperDOM Properties dialog window accessible by right mouse click context menu.
This is an advanced feature that can provide you with a clear advantage of efficiently
modifying orders in fast moving markets. If you are a scalper then this option is for you.

Once enabled, to modify stop loss and profit target orders click in the center "PRICE" column.
Clicking in the "PRICE" column on the BID or above when long will adjust your profit target
order prices, below the BID will adjust stop loss order prices. Clicking in the price column on
the ASK or below when short will adjust your profit target order prices, above the ASK will
adjust your stop loss order prices.

Left Mouse Click - Modifies the closest stop loss or profit target order
Middle Mouse Click - Modifies the second closest stop loss or profit target order
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Middle Mouse Click + CTRL Key - Modifies the third closest stop loss or profit target order

* If you have more than one active strategy working in the market, single click modification
will be applied to the stops and targets associated to the selected strategy as indicated in the
strategy control list (drop down list) in the lower portion of the SuperDOM window.

NOTE: Do not forget, this advanced mode DOES NOT provide single click access to working
orders (Entry/Exit) that reside in either the BUY/SELL columns.

Modifying Order Size
To modify the size of an order, click on the size marker (marked by the blue  arrow in the
image below) with your left mouse button or your middle mouse button. Using your left
mouse button will increment the quantity field by 1, middle mouse button will decrement the
quantity field by 1.

The quantity field will appear which allows you to set the new order quantity by either
entering a new quantity or using the mouse wheel to scroll the value higher or lower. Either
press the "Checkmark" button to submit the change or the "X" button to cancel the operation.
Order size changes are handled according to NinjaTrader's advanced FIFO optimization
capabilities.

-o-

Action Buttons

1. Clicking on the "<" button collapses or expands the SuperDOM

2. Clicking on the "REV" button will close the current open position and open a reverse
position.

3. Clicking on the "CLOSE" button with your left mouse button will close the current position
and cancel any working orders associated to the instrument/account combination. Clicking on
this button with your middle mouse button (scroll wheel) will close the selected active
strategy only. This means that the position size of  the strategy will be closed and any
working orders associated to that strategy will be cancelled.
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4. Clicking on the "C" button will center the last traded price in the price ladder.

-o-

Adding or Removing Targets
If you have an active strategy displayed in the SuperDOM, you can add or remove targets. For
example, you may have a 2 contract position with 1 stop loss and profit target for 2 contracts
each. You may decide to split this target (add target) so that you can exit the final contract at
a higher price.

There are two locations within the SuperDOM where you can add or remove a target.

1. Left mouse button click on the "+ TARGET" (to add) or "- TARGET" (to remove) when
"Show Quick Buttons" is set to true in the SuperDOM properties dialog window
2. Right mouse click context menu

It is important to understand the following logic:

 You can have a maximum of 3 targets (if you had 3 and the first two targets are filled you
can not split the 3rd target)

 If you have 1 target and you remove a target, you will be left with a stop loss order only
 New targets are added 4 ticks from your current outside target for futures, $0.20 for stocks

-o-

Window Linking
See the "Window Linking" section.

-o-

SuperDOM Properties
SuperDOM properties are accessible via the right mouse click menu.
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Set Default
Once you have your SuperDOM properties set up to your liking, you can press the "Set
Default" button which will save these settings as the default setting used every time you open
a new SuperDOM window. If you change your settings and later wish to go back to default
settings you can press the "Reset" button.

Property Definitions
Ask price color Sets the color of the ask price font
Bid price color Sets the color of the bid price font
Buy column color Sets the color of the buy column
Entry price color Sets the color of the average entry price marker
Font color Sets the color of the font
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Highlight color Sets the color for row and button highlighting
Last trade color Sets the color of the last trade marker
Limit order color Sets the color of a limit order
Price column color Sets the color of the price column
Profit target color Sets the color of a profit target
Sell column color Sets the color of  the sell column
Simulation color Sets the color of the SuperDOM background when a simulation

account (Sim101) is selected
Stop limit order color Sets the color of a stop limit order
Stop loss color Sets the color of a stop loss order
Stop market order
color

Sets the color of a stop market order

Advanced options Enables or disables the display of SuperDOM advanced options
ATM Strategy
selection mode

Sets the behavior mode of the price ladder display and strategy
selector (see more)

Auto center price Enables or disables auto centering of the last traded price when it
trades outside of range

Caption bar display Sets the text displayed in the caption bar of the SuperDOM
Font Sets the font
Last trade displayed
in price column

When true, the last trade volume is displayed in the center price
column otherwise it is displayed in either the buy or sell column

Middle mouse button
is stop market

When true, the middle mouse button (scroll wheel) is used for
submitting stop market orders otherwise a stop limit order is
submitted

Number of price rows Sets the number of price rows in the SuperDOM price ladder
Parameter type Sets the parameter type used for entering strategy information. *Price

parameter type is absolulte price NOT an offset value (Example: Stop
Loss = 1 will submit an order at a price of 1 NOT 1 point away from
entry)

Profit/loss display unit Sets the display unit for profit and loss
Relocate center
button

Relocates the center "C" button to the top center of the price ladder
display

Scale Quantity Sets the scale order quantity amount
Show market depth Enables or disables market depth
Show cumulative
depth

Enables or disables cumulative market depth to be shown

Show quick buttons Enables or disables the quick buttons rapid order entry section
Show realized P/L
when flat

Displays realized profit and loss for the selected account when flat

Simulated Order
Volume Trigger

Sets the value for a simulated order volume trigger (for entry and exit
orders and NOT used for stop loss)

Single click order
modification

Enables or disables single click stop loss and profit target order
modification

Stop limit offset Sets the offset the limit price is away from the stop price for entry/exit
stop limit orders. Set to 'Off' to disable single click stop limit order
submission.

Use stop market for
stop loss orders

When true, a stop market order will be submitted for automatic
submission of stop loss orders are part of a position strategy. By
default, when selecting any instruments that trade on Eurex, CBOT
and CME this setting is set to true.

-o-
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Simulated Stop Orders

Simulated Stop Orders Overview
A Simulated Stop order (SS) is a conditional locally PC simulated order type that allows you
to execute either a market or a limit order once the market touches your order price and
satisfies a user defined volume trigger. SS orders are very powerful and can be misused if not
fully understood. Please take the time to review this section in it's entirety prior to using this
order type.

NOTE: Simulated Stop (SS) orders are not supported in the NinjaTrader Direct Edition.

Benefits
There are several benefits to using SS orders:
 Hide your order from the market place
 Delay the triggering of a stop market or stop limit order (prevent having your position

stopped out prematurely due to a quick drop and pop into your stop loss price level)
 Execute a limit order at an improved price from the stop price trigger (for example, you

wish to trigger a buy limit order at 999 once the market price reaches 1000)

Risks
There are associated risks with using SS orders:
 SS orders are held and simulated locally on your PC and is therefore subject to issues such

as loss of internet connection and computer crashes
 SS orders require stable and reliable market data since they are simulated; if market data

stops flowing the S order stops simulating
 SS market order types can experience slippage during high volume periods and/or highly

volatile markets
 Since SS orders are held on your PC and submitted live when they trigger, it is possible

that the order is rejected should you not have available margin to place this order. 
PLEASE BE AWARE OF YOUR ACCOUNT MARGIN LIMITATIONS.

Volume Trigger
A SS order requires a volume trigger value to be set. This is the number of shares/contracts
that represents a floor that once penetrated will trigger the SS order. SS orders trigger once
the market price is trading at the SS order price and the volume trigger condition is breached.
Volume triggers for stop loss orders are set as part of a stop strategy, volume triggers for all
other stop orders are set via properties dialog window of an order entry window.

SS orders are set to Initialized state (see Appendix A) and color coded yellow in any of the
NinjaTrader order display windows. Once triggered, either a limit order or a market order is
submitted.

The following are some examples of SS orders in action:

Buy Stop Market Example

Order Type - Buy Stop Market
Stop Price - 1000
Volume Trigger - 500

This example will trigger once the market trades at a price of 1000 and the ask volume is
less than 500 contracts. Once triggered, a market order is submitted. If this was a sell order,
the bid volume would be monitored.
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Buy Stop Limit Example

Order Type - Buy Stop Limit
Stop Price - 1000
Limit Price - 1001
Volume Trigger - 500000

This example will trigger once the market trades at a price of 1000 and the ask volume is
less than 500000 contracts. The volume trigger is set to a ridiculous high number because
the intent is for the order to trigger right away. Once triggered, a limit order is submitted to
buy at a price of 1001 or better. If this was a sell order, the bid volume would be monitored.

Sell Stop with Improved Limit Price Example

Order Type - Sell Stop Limit
Stop Price - 999
Limit Price - 1000
Volume Trigger - 600

This example will trigger once the market trades at a price of 999 and the bid volume is less
than 600 contracts. The interesting thing about this set up is that what we are doing is
triggering a limit order at a higher price in order to try and get a better fill. This order
strategy is not possible with standard order types and can only be done using NinjaTrader SS
technology. Once triggered, a limit order is submitted to sell at a price of 1000 or better. If
this was a buy order, the ask volume would be monitored.

Avoid SS Orders
 During high volume and trade rate periods such as the first five minutes of trading
 During major economic events that can substantially affect volatility
 Markets that consistently trade with a large spread between the ask and bid price
 Markets that trade where the ask or bid price can consistently change by more than one

tick

-o-

Simulator

Simulator Overview
NinjaTrader provides a state of the art internal simulation engine that you can use to test
trading ideas and hone your skills. The simulation engine is not a simple algorithm that fills
your order once the market trades at your order price. The engine uses a scientific approach
to determine fill probability by including a number of variables including ask/bid volume,
trade volume, time (to simulate order queue position) and random time delay for switching
between order states.

-o-

The Sim101 Account
The Sim101 account is a default account that represents your own simulated account through
which you place simulated trades. The Sim101 account behaves identical to a live account in
that it has a cash balance, profit and loss and other financial parameters. When placing
orders to the simulator, the Sim101 account is checked to ensure that you are not exceeding
your buying power.
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You can set initial Sim101 account values, reset simulator values, clear historical order
history and set simulation engine parameters via the Control Center window
Tools-->Options, Simulator Tab.

-o-

Multiple Simulation Accounts
You can create an unlimited number of user defined simulation accounts.

See the Tools-->Options-->Simulator tab.

NOTE: Users of the free version are limited only to the single Sim101 account. 

-o-

Live/Simulation Environment
NinjaTrader is a true mixed live/simulation platform. You can have multiple entry windows
open and simultaneously route orders to your live broker in one window while routing orders
to the simulator in another. This provides you the flexibility to trade live while testing
different methods or ideas in simulation.

-o-

Global Simulation Mode
You can enable global simulation mode via the Control Center window File-->Global
Simulation Mode menu item. When enabled, all order entry interfaces will be set exclusively
to the Sim101 account. Enabling this is not necessary in order to route orders through
simulation. You can still set any order entry interface to the Sim101 account individually but
global simulation mode provides you a method to ensure that you do not accidentally place
an order to your live trading account. In addition, you can set NinjaTrader to always start in
simulation mode via the Simulator Tab in the Options window.

-o-

Trading in Simulation
NinjaTrader routes orders based on the account that you select in any of the order entry
interfaces. Simulation is no different. You must select the Sim101 account from any of the
NinjaTrader order entry interfaces for orders to be simulated. When selecting the Sim101
account in any of the NinjaTrader order interfaces, the background color will change to the
user defined simulation mode color which is a dark slate gray by default.

-o-
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Strategy Analyzer

Strategy Analyzer Overview
The Strategy Analyzer allows you to run historical analysis on your NinjaScript based
automated trading strategies.

You can:

 Backtest strategies
 Optimize strategies
 Walk forward test strategies
 Review performance results

The Layout

1. Tool bar (in order from left to right)
 Load saved back test results
 Save back test results
 Open the NinjaScript output window (for debugging a strategy)
 Run backtest
 Run optimizer
 Run walk forward test
 Create new strategy
 Edit strategy
 Delete strategy
 Calculate Mode

2. Run a historical test on an instrument not in a list
3. Individual instruments
4. Instrument lists
5. Strategies
6. Performance results
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Backtest a Strategy
A backtest allows you to analyze the historical performance of a strategy. In order to run a
backtest you will need:

 Access to historical data
 Custom NinjaScript *strategy

*There are several pre-defined sample strategies that are installed with NinjaTrader that you
can explore.

Start a Backtest
Select either an instrument or an instrument list (to basket test the entire list of instruments)
and via the right mouse button click context menu, select the sub-menu "Backtest...".
Alternatively, you can press the "b" icon from the tool bar or press the short cut key
combination Ctrl-B.
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Select the strategy (1) and set the backtest properties and press "OK".

Historical Fill Processing
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NinjaTrader provides two system fill algorithms that can be used in a backtest. In addition, if
you have some experience programming, you can script your own algorithm. 

The two system fill algorithms are:

Default
An algorithm that takes a conservative and more realistic approach to filling limit and stop
limit orders.
 Limit orders only fill if the limit price was penetrated
 Limit orders are always filled at the limit price specified never better (for example, if a

limit order is submitted on bar n, NT will check if the order is filled on bar n+1, if this bar
gaps down and the limit order was a buy, the order would be filled at the limit price and 
NOT the high of bar n+1)

Liberal
An algorithm that takes a liberal approach to filling limit and stop limit orders.
 Limit orders fill if the limit price was touched
 On gap down bars, buy limit orders will fill at the high of the gap down bar
 On gap up bars, sell limit orders  will fill at the low of the gap up bar

Slippage can also be set expressed in "ticks" or, the minimum value of fluctuation for an
instrument. Slippage is only applied to market and stop market orders since slippage is
impossible with a limit order.

Special Circumstances with GAIN Forex
During a backtest, order quantity is an absolute value which is in most cases different than in
a real-time brokerage account. As an example, 1 traded FX lot at a live brokerage account
might be the equivalent to 100,000 of notional value (check with your broker) however, in
backtest a value of 1 is a literal value of 1 and not 100,000. Thus, if you want to trade
100,000 in a backtest you need to put in a value of 100,000. Just remember that if you
convert your strategy from backtest to live you will need to amend the order quantities
appropriately.

Property Definitions
Parameters section Sets any strategy specific user defined inputs
From Sets the start date for the backtest period
To Sets the end date for the backtest period
Exclude weekend If true, will exclude weekend data from the historical dataseries
Session begins Starting time of the intraday session for the historical dataseries
Session ends Ending time of the intraday session for the historical dataseries
Dataseries - Type Interval type for the historical dataseries
Dataseries - Value Interval value for the historical dataseries
Include commission Include commission in the backtest performance results (see setting 

commissions)
Label Sets a text value that will be displayed on the chart to represent the

strategy
Min. bars required Sets the minimum number of bars required before the backtest will

start processing
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Fill type Sets the algorithm for processing and filling orders during backtest
Slippage Sets the slippage amount in ticks per execution
Entries per direction Sets the maximum number of entries allowed per direction while a

position is active based on the "Entry handling" property
Entry handling Sets the manner in how entry orders are handled. If set to

"AllEntries", the strategy will process all entry orders until the
maximum allowable entries set by the "Entries per direction" property
has been reached while in an open position. If set to "UniqueEntries",
strategy will process entry orders until the maximum allowable entries
set by the "Entries per direction" property per each uniquely named
entry.

Exit on close When enabled, open positions are closed on the last bar of a session
Set order quantity Sets how the order size is determined, options are:

"by default quantity" - User defined order size
"by strategy" - Takes the order size specified programmatically within
the strategy
"by account" - Allows you to set a virtual account value that is used to
determine maximum order size based on margin settings per
instrument set in the Instrument Manager

Time in force Sets the order time in force

-o-

Optimize a Strategy
You can fine tune the input parameters of a strategy through optimization. Optimization is the
process of testing a range of values through iterative backtests to determine the optimal input
values over the historical test period based on your best result criterion. To run an
optimization you will need:

 Access to historical data
 Custom NinjaScript *strategy
 A thorough understanding of the Strategy Analyzer's backtesting capabilities
 
*There are several pre-defined sample strategies that are installed with NinjaTrader that you
can explore.

Start an Optimization
Select either an instrument or an instrument list (to basket test the entire list of instruments)
and via the right mouse button click context menu, select the sub-menu "Optimize...".
Alternatively, you can press the "o" icon from the tool bar or press the short cut key
combination Ctrl-O.
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The "Optimize" properties dialog window will appear. Select the strategy you would like to
optimize and set your parameters. Apart from the optimization specific properties described
below, the properties are identical to the ones found in the backtest dialog window.

Setting the Test Range
The strategy input parameters can be expanded to display the following sub-parameters:

Min. value - The starting value you want to test
Max. value - The last value to test
Increment - The increment value (step value) used to increment the starting value by for
each subsequent optimization pass

In the image below, the input "BandPeriod" has a starting (initial) value of 10 and an ending
value of 30 with an increment of 1. This means that the first value tested will be 10, then 11,
then 12 all the way through 30. The input "CumUp" has a starting value of 6, ending value of
16 with an increment of 1. Based on these settings, a total of 200 (20 unique values for
"BandPeriod" multiplied by 10 unique values for "CumUp") backtest iterations will be
processed in order to find the optimal combination of input values based on the best result
criterion.

Setting the Best Result Criterion
Optimization is based on the best result criterion you select. If you set the property "Optimize
on..." to "Max. net profit", the optimizer will seek the optimal input values that return the
maximum profit possible. There are over 10 different optimization criterion you can select.
The property "Keep best # results" will display the 10 best results in the performance results.
NinjaTrader comes with a "Default" optimizer algorithm. You can program your own 
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optimization algorithm using NinjaScript.

The Optimization Process
After all the optimization properties have been set, press "OK" to run the optimizer. As per
the image below, a window will appear providing you with the current status of time elapsed
and estimated  time remaining for the optimization process.

The Best Optimization Result
Once the optimization process is complete, you will see a "Instruments" tab and a "Optimizer"
tab. The "Instruments" tab will display the best optimization result for each unique
instrument that was selected for optimization. Selecting each result row will display the
performance data for that instrument.
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The Top Optimization Results
The "Optimizer" tab will display the top number of results based on the value you set for the
"Keep best # results" property in the Optimizer dialog window. The column "Parameters"
displays the optimized  input values.

1. The optimal value for the "BandPeriod" input for the demonstration strategy used for this
optimization
2. The optimal value for the "CumUp" input for the demonstration strategy used for this
optimization
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Walk Forward Optimize a Strategy
Walk forward optimization is the process by where you optimize strategy input parameters on
a historical segment of market data, then test the strategy forward in time on data following
the optimization segment using the optimized input values. The central idea is that you
evaluate strategy performance data on the test data, not the data used in the optimization.
This process is then repeated by moving the optimization and test segments forward in time.
To run a walk forward optimization you will need:

 Access to historical data
 Custom NinjaScript *strategy
 A thorough understanding of the Strategy Analyzer's backtesting and optimization

capabilities
 
*There are several pre-defined sample strategies that are installed with NinjaTrader that you
can explore.

Start a Walk Forward Optimization
Select either an instrument or an instrument list (to basket test the entire list of instruments)
and via the right mouse button click context menu, select the sub-menu "Walk Forward...".
Alternatively, you can press the "w" icon from the tool bar or press the short cut key
combination Ctrl-W.
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The "Walk Forward Optimization" properties dialog window will appear. Select the strategy
you would like to walk forward optimize and set your parameters. Apart from the walk
forward optimization specific properties described below, the properties are identical to the
ones found in the Optimizer dialog window.

1. Optimization period (days) - Sets the number of days used for the "in sample" optimization
data set
2. Test period (days) - Sets the number of days used for the "out of sample" real back test
using the optimized input values generated from the "in sample" period  

-o-

Basket Test
You can backtest, optimize or walk forward optimize a basket of instruments by highlighting
an instrument list "Stocks" in the image below and via the right mouse button click context
menu, select any of available the sub-menus. Alternatively, you can press the "b", "o" or "w"
icons from the tool bar or press the short cut key combinations.
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Once the test is complete, a listing of all the results will be displayed. Select an individual row
to display in the Performance tabs indidual performance results.

-o-

Reviewing Performance Results
Strategy Analyzer generates performance data that can be viewed in the Performance Data
tabs.

-o-

Saving Performance Results
You can save testing results for future reference.

1. Click the icon to Save results
2. Click the icon to load prior saved results
3. Saved results are displayed underneath the parent strategy and can be double clicked on
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to load

-o-

Discrepancies Real-Time vs Backtest
You should expect that a strategy running real-time (live brokerage account, live market
simulation, Market Replay etc...) will produce different results than the performance results
generated during a backtest.

Getting Filled on an Order
 During a backtest you can select conservative or liberal fill algorithms which will produce

different results. Fills are determined based on 4 data points, OHLC of a bar since that is
the only information that is known during a backtest.

 During simulation using real-time live market data or Market Replay, the fill algorithm is
dynamic in that it uses incoming market data (both price and volume) to determine if an
order should be filled or not.

 During real-time live brokerage trading, orders are filled according to market dynamics.

As you can see, there are three distinctly different models for how and when an order may be
filled. This is why you may see orders NOT fill in real-time that you may otherwise expect to
see filled based on your backtesting results.

The Fill Price of Orders
 During a backtest assumptions are made on the fill price of an order is based on the OHLC

of a bar and the price of the order itself. You can also have differences depending on which
fill algorithm you choose.

 During simulation using real-time market data or Market Replay, the fill price is based on
incoming market data and volume, you may receive better or worse fill prices dependant
on where the bid or ask price is and what volume is available at this market prices.

 During real-time brokerage trading, orders are filled according to market dynamics.

As you can see, there are three different models on what price an order can be filled at.
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Running a Strategy at the Close of a Bar or Tick by Tick
 During backtest, strategies can ONLY be processed at the close of each bar
 During real-time operation, you have a choice to run a strategy tick by tick

(CalculateOnBarClose set to false) which can produce different results. This is because you
can have a signal that executes an order at the close of a bar but when running tick by
tick, while in a bar a signal condition can be true although its false at the close of the same
bar.

Differences in chart data
 If you run a strategy in real-time on DAY1 and then DAY2, you backtest your strategy on

DAY1 data, there could be differences. You should understand how chart bars are built

-o-

Strategy Wizard

Strategy Wizard Overview
The Strategy Wizard is used to generate NinjaScript based strategies for automated systems
trading.

In conjunction with understanding how to build strategies using the Strategy Wizard, it is 
imperative that you:

 Understand the overall concepts of developing strategies and how they work
 Understand the backtesting options available in the Strategy Analyzer

Once you have developed a NinjaScript strategy you can run it live in full automation.

-o-

Wizard Screens
To create a new NinjaScript strategy select the menu Tools-->New NinjaScript-->Strategy
from within the Control Center window.

Whether you are going to self program your strategy or use the wizard exclusively, a strategy
is always initially created via the wizard.

The Opening Screen
1. Press the "Help" button to open the NinjaTrader Help documentation
2. Press the "View Code..." button at any time to view the wizard generated NinjaScript code
3. Press the "Unlock Code" button at any time to open the NinjaScript editor and edit your
strategy code. Once the code is unlocked you can no longer user the wizard for
subsequent strategy editing.
4. Press the "<Back" or "Next>" buttons to move back for forth between wizard screens
5. Press the "Cancel" button to leave the wizard
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The General Screen
1. Sets the name of the strategy
2. Description of the strategy
3. Enables or disables the default setting for CalculateOnBarClose (can override when starting
a strategy)

The User Defined Inputs Screen
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This screen allows you to define user defined inputs of your strategy. User defined inputs are
important if you require input values that may vary the performance of your strategy. If for
example you have simple moving average cross over system, you may want to create an
input for the fast moving average and another for the slow moving average. This then allows
you to change the values of the moving averages at run time. Inputs are also required if you
plan to use the Strategy Optimizer or the Walk Forward Optimization.

1. Sets the name of the input
2. Sets the value type of the input to either "int" (integer value - whole numbers) or a
"double" (double value - decimals) or a "bool" (true or false) or a "string"
3. Sets the default value of the input
4. Sets the minimum value of the input
5. Sets the description for the input

The Conditions and Actions Screen
This screen allows you to set conditions and subsequent actions that control the flow of your
strategy.

Conditions - Take the speficied action when true
Actions - Execute an action (submit orders, draw objects on the chart etc...) based on its
parent condition evaluating to true

Via the wizard, you can have up to ten different condition sets with related actions. If you
require more than ten condition sets then you should self code your strategy via the 
NinjaScript Editor. Conditions are created using the Condition Builder. Actions are specified by
the Strategy Action window.

1. Selects the condition set you wish to edit
2. Displays conditions associated with the currently selected condition set
3. Add or delete a condition
4. Edits the currently selected condition
5. Displays the actions associated with the currently selected condition set
6. Add or delete an action
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7. Edits the currently selected action

You can copy and paste conditions from one set to another and you can even save a condition
set as a template and load for future use via the right mouse button click context menu as
show in the image below. You can also save a condition set as a template (selecting the "Save
As..." menu) and then re-use it in another strategy at a later time by selecting the "Load..."
menu.

The Stops and Targets Screen
This screen allows you to set stop loss, trail stop and profit target orders that are
automatically submitted and managed once your strategy opens a position. Stops and targets
are added by the Strategy Action window.

1. Displays stops and targets associated with your strategy
2. Adds or deletes a stop or target
3. Edits the selected stop or target
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The Finished Screen
Once you reach this screen you are finished with developing your strategy. Press the "Finish"
button to compile your strategy which will then be ready for testing or live execution.

-o-

Condition Builder Overview
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The Condition Builder is a very powerful feature that allows you to define complex conditions
for your automated trading systems without having to know how to program. Most if not all
automated trading system code wizards are limited in scope in that they provide canned
pre-defined expressions and only allow you to change a few parameters on those expressions.
The NinjaTrader Condition Builder is advanced in that you can develop powerful expressions
without limitations. Due to it's power and flexibility, it is extremely important that you read
through and understand it's capabilities.

The Condition Builder is also a very powerful aid for those of you learning NinjaScript or
learning how to program. You can build your conditions within the Condition Builder and
instantly see NinjaScript code generated by having the NinjaScript Editor open (pressing the
"View Code..." button in the wizard screen). You can also use the Condition Builder from
within the NinjaScript Editor directly. By doing so, NinjaScript code is automatically generated
and inserted into your code.

The Condition Builder can be accessed via the "Conditions and Actions" wizard screen or the
right mouse button click menu of the NinjaScript Editor.

Basic Operation
The general concept of the Condition Builder to generate a Boolean expression also known as
comparison expressions or conditional expressions. What does that mean? It is simply an
expression that results in a value of either TRUE or FALSE. For example, the expression

2 < 7 (2 is less than 7)

is a Boolean expression because the result is TRUE. All expressions that contain relational
operators are Boolean. Boolean expressions or "Conditions" as they are known in NinjaTrader
is used to determine when to take a specified action such as submitting an order or drawing
on the chart.

Looking at the image below, you can instantly see that the Condition Builder is set up like a
Boolean expression. Select an item from the left window, select the relational operator (2)
and compare it to a selected item in the right window.

1. Available items such as indicators, price data, etc. to use for the comparison
2. List of relational operators

-o-

Condition Builder - Price Data Comparisons
You can compare a bar's price data such as checking for a higher close. The following is an an
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example and represents one of many possible combinations.

1. Expand the "Price data" category and select the "Close"
2. Select the ">" (greater than) relational operator
3. Expand the "Price data" category and select the "Close" 
4. Set the "Bars ago" parameter to a value of "1"

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current closing price is greater than the closing price of 1 bar ago"

-o-

Condition Builder - Offsetting an Item Value
You can offset the value of most items available in the Condition Builder. An offset is a value
that is added or subtracted from the actual item's value. When an item is selected such as an
indicator or price data, the "Offset type" and "Offset" parameters become visible in the
window directly below the item selected. You can see this in the highlighted portion of the
image below.

Offset type can be set to:

Percent - Adds or subtracts a percentage value of the item's value. A value of 1 is equal to
100% where a value of 0.1 is equal to 10%.
Price - Adds or subtracts an absolute value
Ticks - Adds or subtracts the number of ticks (0.01 for stocks and the ticksize for futures or
currencies) from the item's value

Once the "Offset type" is selected you must set the value "Offset". In addition to the example
below, you can see the "Checking for Volume Expansion" for another example that uses the
Percent  "Offset type". The following is an example and represents one of many possible
combinations.
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1. Expand the "Price data" category and select the "Close"
2. Select the ">" (greater than) relational operator
3. Expand the "Price data" category and select the "High" 
4. Set the "Bars ago" parameter to a value of "1"
5. Set the "Offset type" parameter to "Ticks"
6. Set the "Offset" parameter to a value of "1"

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current closing price is greater than the high price of 1 bar ago + 1 tick"

-o-

Condition Builder - Indicator to Value Comparisons
You can compare an indicator's value to a numeric value. This can come in handy if you
wanted to check if ADX is over a value of 30 (trending) or if Stochastics is under a value of 20
(oversold) or any other conditions you can think of. The following is an an example and
represents one of many possible combinations.

1. Expand the "Indicators" category and select the "ADX" indicator
2. Set the item parameters
3. Select the ">" (greater than) relational operator
4. Expand the "Misc" category and select "Numeric value"
5. Enter the numeric value

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current value of a 14 period ADX is greater than 30"
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-o-

Condition Builder - Comparing Plot Values of
Multi-Plot Indicators
You can compare plots in the same indicator or select any individual plot within an indicator
to create a condition. The following is an example and represents one of many possible
combinations.

1. Expand the "Indicators" category and select the "Stochastics" indicator
2. Set the indicator input parameters and select the "K" plot (blue arrow)
3. Select the ">" (greater than) relational operator
4. Expand the "Indicators" category and select the "Stochastics" indicator
5. Set the indicator input parameters and select the "D" plot (blue arrow)

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current K plot value of a Stochastics indicator is greater than the current D plot
value of the same Stochastics indicator"
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Condition Builder - User Defined Inputs & Variables
User defined inputs are simply variables that can be used in place of absolute values. They
increase the flexibility of your strategy since you can subsitute a variable for the period
parameter of a simple moving average instead of provide an absolute value.

SMA(9) is how you express a 9 period simple moving average in NinjaScript. If you run a
strategy, you would always be using a 9 period simple moving average. At run time, you
might want to change this value to 10. User defined inputs accomplish this. If you created an
input named "MyInput", you could express the simple moving average as SMA(MyInput). At
run time, you can then configure your strategy by setting the value of "MyInput" to whatever
value you like. In addition, user defined inputs are required when optimizing a strategy.

User variables (not to be confused with inputs) behave in the same manner with the
exception that they can not be configured when starting a strategy but can only be set
programmatically during run time.

 User defined inputs are created from the wizard screen
 User variables can be set in the strategy logic through the Condition Builder (see Strategy

Action)

The following is an an example and represents one of many possible combinations. The
example demonstrates the user of a user defined input however the sample approach applies
to user variables.

1. Expand the "Price data" category and select the "Close"
2. Select the ">" (greater than) relational operator
3. Expand the "Indicators" category and select the "SMA" indicator 
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4. Set the "Period" parameter to a user defined input by pressing the "..." button to open the
"Value" window
5. Expand the "User defined inputs" category and select the value "Period" and press the "OK"
button

6. The Condition Builder will look as per the image below with the user defined input "Period"
assigned to the parameter Period. When you apply this strategy to a chart, you will be able to
set the value for the user defined input which will then be used to drive the SMA indicator.
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Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current closing price is greater than the user defined Period simple moving
average"

-o-

Condition Builder - Cross Over Conditions
You can check for either a "CrossAbove" or "CrossBelow" condition with a user defined look
back period. The look back period sets the number of bars to look back to check for the cross
over condition. The following is an an example and represents one of many possible
combinations.

1. Expand the "Indicators" category and select the "EMA" indicator
2. Set the "Period" parameter to a value ("9" is used in this example)
3. Select "CrossAbove"
4. Set the "Look back period"
5. Expand the "Indicators" category and select the "EMA" indicator
6. Set the "Period" parameter to a value ("20" is used in this example)

Once the "OK" button is pressed, a condition is created that would translate to the following:

"9 period exponential moving average crosses above the 20 period exponential
moving average in the last bar"
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-o-

Condition Builder - Indicator on Indicator
You can use indicators as input for other indicators...actually, you can nest indicators within
indicators infintely if you really wanted to! The following example is an example of applying a
simple moving average (SMA) to a 14 period ADX indicator and is one of many possible
combinations.

1. Expand the "Indicator" category and select "SMA" indicator
2. Set Input series to the ADX indicator by pressing the "..." button to open the "Value"
window
3. Select the "ADX" indicator and set any properties in the Parameters window
4. Press "OK"
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Once you have pressed the "OK" button, you will notice on the left lower window, the "Input
series" parameters has now been set to the ADX(14) which is the 14 period ADX indicator.

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current value of a 14 period simple moving average of a 14 period ADX is greater
than 30"
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Condition Builder - Checking for Volume Expansion
You can compare if the current bar's volume is greater than the prior bar's volume plus an 
offset amount. The following is an an example and represents one of many possible
combinations.

1. Expand the "Indicators" category and select the "VOL" indicator
2. Select the ">=" (greater than or equal to) relational operator
3. Expand the "Indicators" category and select the "VOL" indicator
4. Set the "Bars ago" parameter to a value of "1"
5. Set "Offset type" parameter to "Percent"
6. Set the "Offset" parameter to a value of "3"

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current value of Volume is greater than or equal to the value of Volume of 1 bar
ago + 300%"

-o-

Condition Builder - Market Position Comparisons
You can compare a strategy state information such as but not limited to market position or
position size. The following is an an example and represents one of many possible
combinations.

1. Expand the "Strategy" category and select "Current market position"
2. Select the "==" (equals to) relational operator
3. Expand the "Strategy" category and select "Flat" 

Once the "OK" button is pressed, a condition is created that would translate to the following:
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"Current market position equals flat"

-o-

Condition Builder - Time Comparisons
You can compare a bar's time data to a user defined time or date value. The following is an
an example and represents one of many possible combinations.

Note: Time series represents a collection of bar Date/Time values of a bar series

1. Expand the "Time" category and select "Time series"
2. Select the ">=" (greater than or equal to) relational operator
3. Expand the "Time" category and select "Time series" 
4. Set the "Value" parameter to a user defined value of "10:00 AM"

Once the "OK" button is pressed, a condition is created that would translate to the following:

"Current bar's time is greater or equal to 10:00 AM"
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Strategy Action Overview
The Strategy Action window allows you to select actions to execute. Actions are executed
when a strategy condition is true. The Strategy Action window can be accessed via the
"Conditions and Actions" wizard screen or the right mouse button click menu of the
NinjaScript Editor.

Within a NinjaScript strategy you can invoke miscellenaneous actions such as issue an alert,
play a sound or set a user defined variable.

You can also submit various order types for entering and exiting positions.
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You also have access to various drawing methods.

-o-

Strategy Action - Entering a Position
Using the various "Order Management" actions, you can enter a position using market, limit,
stop market and stop limit orders. Following is an an example and represents one of many
possible combinations.

1. Expand the "Order management" category and select "Enter a long position by a limit
order"
2. You can set the number of contracts/shares for the order or leave the "DefaultQuantiy"
value which allows you set the quantity when starting a strategy
3. Set the *"Signal name" property to any user defined value to identify the entry (you can
also leave this name blank)
4. We can set the limit price dynamically by setting it to another item's value, press the "..."
button to open the "Value" window

* Signal names are important in that they are used as unique identifiers if you have more
than one unique entry in a strategy. By providing unique entry signal names for each entry on
a strategy, you can then identify which position you want closed via the exit position
methods. Signals names are also used to identify executions on a chart.
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5. Expand the "Price data" category and select "Bid"
6. Set the "Offset type" to "Ticks" and enter a value of "-1" for "Offset" (see Offsetting an
Item Value)

Once the "OK" button is pressed, an action is created that would translate to the following:

"Enter a buy limit order at a price 1 tick below the current bid price to enter a long
position"

-o-
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Strategy Action - Exiting a Position
Using the various "Order Management" actions, you can exit a position using market, limit,
stop market and stop limit orders. Following is an an example and represents one of many
possible combinations.

1. Expand the "Order management" category and select "Exit long position" (Exits via market
order)
2. Set the "Signal name" property to any user defined value to identify the entry (you can
also leave this name blank)
3. Set the "From entry signal" property to a named entry signal within the strategy. Providing
a value will exit only the quantity associated to the position created by the named signal.
Leaving it blank will exit the total net position.

-o-

Strategy Action - Drawing on a Chart
Using the various "Drawing" methods, you can draw lines, text, squares and more on a chart.
You can review detailed information on supported drawing methods in the NinjaScript
Language Reference section of this Help Guide. Following is an an example and represents
one of many possible combinations.

1. Expand the "Drawing" category and select "Diamond"
2. Set the "Tag" parameter with a user defined name that identifies this drawing object.
Providing a tag is of value if you are going to draw more than one of the same draw type
object (Diamond in this case) on the same bar.
3. Set the "Bars ago" parameter to "0" which will draw the diamond on the current bar x
location
4. Set the "Y" parameter to the High of the current bar plus one tick by pressing the "..."
button to display the "Value" window
5. Set the "Color" parameter to any user defined color
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Once the "OK" button is pressed, an action is created that would translate to the following:

"Draw a red diamond above the high of the current bar"

-o-

Time & Sales

Time & Sales Overview
The Time & Sales window displays the current Bid/Ask price and volume and color coded last
traded time, price and size. You can optionally filter for large trades (BLOCKS) by setting the
block size in the Time & Sales Properties dialog window.
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To use:

1. From within the Control Center window select File-->New-->Time And Sales... menu
2. To select an instrument, right click in the Time & Sales window and select the menu

Instrument -->

-o-

Time & Sales Properties
Time & Sales properties are accessible via the right mouse click menu.
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Property Definitions
Above ask color Sets the text color trades above the ask price
At ask color Sets the text color trades at the ask price
At bid color Sets the text color trades at the bid price
Below bid color Sets the text color for trades below the bid price
Between color Sets the text color for trades between the bid and ask price
Block alert color Sets the back color for block alerts
Daily high color Sets the row color for trades at the daily high
Daily low color Sets the row color for trades at the daily low
Row color Sets the back color of the display rows
Block alert trade size Sets a value indicating the minimum trade size required to register a

block trader alert
Rows Sets the number of display rows
Size filter Sets a value indicating the minimum trade size (trades less than this

size are filtered out)
Timer refresh When enabled the display updates 4x per second otherwise it is

update on each incoming tick (can be CPU intensive depending on
data provider)

-o-

Window Linking

Overview
Chart, SuperDOM and Basic Entry windows all have link buttons in the top right hand corner.
Any window that is linked by color (each link button is set to the same color) will receive the
same change of instrument request. That means, change an instrument in one window and
the instrument in all linked windows will also change.

-o-

Workspaces

Workspaces Overview
Workspaces provide a way for you to manage, organize and group together windows (such as
charts and order entry windows) in manner that makes sense for the way you work and trade.

-o-

Managing Workspaces
All workspace management functions are accessible via the Control Center window menu File
> Workspaces.

 A workspace named "Default" will load automatically and can not be deleted or closed
 The currently displayed workspace is listed in the caption bar of the Control Center window

(see image below "My Workspace")
 The currently displayed workspace has a check mark beside it in the Workspaces > menu

(see image below, the workspace "My Workspace" is checked)
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 You can have multiple workspaces open simultaneously
 You can toggle the currently displayed workspace by selecting the workspace you wish to

display from the Workspaces > menu
 On application shut down you will be given the opportunity to save changes in the current

open workspaces

Quickly Switching Between Workspaces
Pressing Shft+F3 keys together will cycle to the next active workspace.

Create a Workspace
1. Select the menu File > Workspaces > New Workspace
2. A new workspace will be created (unsaved) with a generic title such as "Untitled1"
3. Once you have customized the workspace to your liking you must then save the workspace

via File > Workspaces > Save Workspace As... menu

Open a Workspace
1. Select the menu File > Workspaces > Open Workspace...
2. Within the dialog window "Open Workspace" select the workspace you wish to open and

press the "OK" button
3. The selected workspace will open, a menu item representing the workspace will be

displayed  in the menu (see "My Workspace" in above image) and will be set as the
currently displayed workspace

Close a Workspace
1. Select the menu File > Workspaces > Close  Workspace
2. The currently displayed workspace will be closed

Save a Workspace
1. Select the menu File > Workspaces > Save Workspace or Save Workspace As...
2. Any changes made to the currently displayed workspace will be saved

Delete a Workspace
1. Select the menu File > Workspaces > Open Workspace...
2. Within the dialog window "Open Workspace" select the workspace you wish to delete and

press the "Delete" button
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Appendixes

Appendix A -  Order State Definitions -
Order State Definitions

NinjaTrader Order State Definitions
Order State Definition Color Code
Initialized Order information validated on local

PC
Yellow

PendingSubmit Order submitted to the connectivity
provider

Orange

Accepted Order confirmation received by
broker

Light blue

Working Order confirmation received by
exchange

Green

PendingChange Order modification submitted to the
connectivity provider

Orange

PendingCancel Order cancellation submitted to the
connectivity provider/exchange

Red

Cancelled Order cancellation confirmed
cancelled by exchange

Rejected Order rejected locally, by
connectivity provider or exchange

PartFilled Order partially filled Green
Filled Order completely filled

-o-

Copyright Acknowledgements
NinjaTrader, LLC acknowledges the following:

Trading Technologies, Inc. 
NinjaTrader SuperDOM is licensed under U.S. Patent Nos. 6,766,304 and 6,772,132, U.K.
Patent Nos. GB 2,377,527 and GB 2, 390,451 and European Patent No. EP 1 319 211 from
Trading Technologies, Inc.

QuickFIX
The QuickFIX Software License, Version 1.0
Copyright (c) 2001-2005 quickfixengine.org All rights reserved.
NinjaTrader includes software developed by quickfixengine.org 
http://www.quickfixengine.org/

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
QUICKFIXENGINE.ORG OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
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PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

SourceGrid
SourceGrid - .NET(C#) Grid control
Copyright (c) 2004, Davide Icardi
All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

openSmtp.net - C# SMTP library
Copyright (C) 2001-2004 Ian Stallings
OpenSmtp.Net is free software; you can redistribute it and/or modify it under the terms of the
Lesser GNU General Public License as published by the Free Software Foundation; either
version 2 of the License, or (at your option) any later version.

OpenSSL

Copyright (c) 1998-2004 The OpenSSL Project.  All rights reserved.

 
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
 
1. Redistributions of source code must retain the above copyright
    notice, this list of conditions and the following disclaimer. 
 
2. Redistributions in binary form must reproduce the above copyright
    notice, this list of conditions and the following disclaimer in
    the documentation and/or other materials provided with the
    distribution.
 
3. All advertising materials mentioning features or use of this
    software must display the following acknowledgment:
    "This product includes software developed by the OpenSSL Project
    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
    endorse or promote products derived from this software without
    prior written permission. For written permission, please contact
    openssl-core@openssl.org.
 
5. Products derived from this software may not be called "OpenSSL"
    nor may "OpenSSL" appear in their names without prior written
    permission of the OpenSSL Project.
 
6. Redistributions of any form whatsoever must retain the following
    acknowledgment:
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    "This product includes software developed by the OpenSSL Project
    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.
==========================================================
==========
 
This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com).  This product includes software written by Tim
Hudson (tjh@cryptsoft.com).
 
Original SSLeay License
-----------------------

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.
 
This package is an SSL implementation written
by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.
  
This library is free for commercial and non-commercial use as long as
the following conditions are aheared to.  The following conditions
apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code.  The SSL documentation
included with this distribution is covered by the same copyright terms
except that the holder is Tim Hudson (tjh@cryptsoft.com).
  
Copyright remains Eric Young's, and as such any Copyright notices in
the code are not to be removed.
If this package is used in a product, Eric Young should be given attribution
as the author of the parts of the library used.
This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.
  
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:
1. Redistributions of source code must retain the copyright
    notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright
    notice, this list of conditions and the following disclaimer in the
     documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software
    must display the following acknowledgement:
    "This product includes cryptographic software written by
    Eric Young (eay@cryptsoft.com)"
    The word 'cryptographic' can be left out if the rouines from the library
    being used are not cryptographic related :-).
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4. If you include any Windows specific code (or a derivative thereof) from 
    the apps directory (application code) you must include an acknowledgement:
    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
  
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
  
The licence and distribution terms for any publically available version or
derivative of this code cannot be changed.  i.e. this code cannot simply be
copied and put under another distribution licence
[including the GNU Public Licence.]

-o-
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